Third-Party Trademarks

Trademarks not owned by Tecplot, Inc. are used in this software and documentation to indicate compatibility with, or to describe use of Tecplot products with, particular products not owned by Tecplot, Inc. No endorsement by any third party of any Tecplot product (or vice versa) is intended.

3D Systems is a registered trademark or trademark of 3D Systems Corporation in the U.S. and/or other countries.

Mac, Macintosh, Mac OS, and Mac OS X are registered trademarks or trademarks of Apple, Incorporated in the U.S. and/or other countries.

Reflection-X is a registered trademark or trademark of Attachmate Corporation in the U.S. and/or other countries.

EnSight is a registered trademark or trademark of Computation Engineering Information (CEI), Incorporated in the U.S. and/or other countries.

EDEM is a registered trademark or trademark of DEM Solutions Ltd in the U.S. and/or other countries.

Exceed, Exceed 3D, and Hummingbird, are registered trademarks or trademarks of OpenText Corporation in the U.S. and/or other countries.

Konqueror is a registered trademark or trademark of KDE e.V. in the U.S. and/or other countries.

VIP and VDB are registered trademarks or trademarks of Halliburton in the U.S. and/or other countries.

ECLIPSE FrontSim is a registered trademark or trademark of Schlumberger Information Solutions (SIS) in the U.S. and/or other countries.

Debian is a registered trademark or trademark of Software in the Public Interest, Incorporated in the U.S. and/or other countries.

X Window System is a registered trademark or trademark of X Consortium, Incorporated in the U.S. and/or other countries.

ANSYS, Fluent and any and all ANSYS, Inc. branded, product, service and feature names, logos and slogans are registered trademarks or trademarks of ANSYS Incorporated or its subsidiaries in the U.S. and/or other countries.

LS-DYNA is a registered trademark or trademark of Livermore Software Technology Corporation in the U.S. and/or other countries.

MSC/NASTRAN is a registered trademark or trademark of MSC.Software Corporation in the U.S. and/or other countries.

FLOWSI is a registered trademark or trademark of Flow Science, Incorporated in the U.S. and/or other countries.

Adobe, Flash, Flash Player, Premier, and PostScript are registered trademarks or trademarks of Adobe Systems, Incorporated in the U.S. and/or other countries.

Abaqus, the 3DS logo, SIMULIA and CATIA are registered trademarks or trademarks of Dassault Systèmes or its subsidiaries in the U.S. and/or other countries. The Abaqus runtime libraries are a product of Dassault Systèmes Simulia Corp., Providence, RI, USA. © Dassault Systèmes, 2007

FLOW-3D is a registered trademark or trademark of Flow Science, Incorporated in the U.S. and/or other countries.

AutoCAD and DXF are registered trademarks or trademarks of Autodesk, Incorporated in the U.S. and/or other countries.

Ubuntu is a registered trademark or trademark of Canonical Limited in the U.S. and/or other countries.

Helvetica Font Family and Times Font Family are registered trademarks or trademarks of Linotype GmbH in the U.S. and/or other countries.

Linux is a registered trademark or trademark of Linus Torvalds in the U.S. and/or other countries.


Firefox is a registered trademark or trademark of The Mozilla Foundation in the U.S. and/or other countries.

Netcage is a registered trademark or trademark of Netcage Communications Corporation in the U.S. and/or other countries.

SUSE is a registered trademark or trademark of Novell, Incorporated in the U.S. and/or other countries.

Red Hat is a registered trademark or trademark of Red Hat, Incorporated in the U.S. and/or other countries.

Courier is a registered trademark or trademark of Monotype Imaging Incorporated in the U.S. and/or other countries.

Qt is a registered trademark or trademark of Digia Plc in the U.S. and/or other countries.
# Table of Contents

## Introduction to Tecplot RS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome to Tecplot RS</td>
<td>21</td>
</tr>
<tr>
<td>Using This Manual</td>
<td>21</td>
</tr>
<tr>
<td>Manual Organization</td>
<td>22</td>
</tr>
<tr>
<td>Welcome Screen</td>
<td>22</td>
</tr>
<tr>
<td>Input Devices</td>
<td>23</td>
</tr>
<tr>
<td>Tecplot RS Workspace</td>
<td>24</td>
</tr>
<tr>
<td>Plot Area</td>
<td>25</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>25</td>
</tr>
<tr>
<td>Plot Controls Sidebar</td>
<td>26</td>
</tr>
<tr>
<td>Toolbar</td>
<td>29</td>
</tr>
<tr>
<td>Status Line</td>
<td>35</td>
</tr>
<tr>
<td>Basic Style Editing Concepts</td>
<td>35</td>
</tr>
<tr>
<td>Data Queries</td>
<td>36</td>
</tr>
<tr>
<td>Help</td>
<td>36</td>
</tr>
</tbody>
</table>

## Creating Plots

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Basic Plot in Tecplot RS</td>
<td>37</td>
</tr>
<tr>
<td>Retrieving Your Plot</td>
<td>40</td>
</tr>
<tr>
<td>Viewing Data Set Information</td>
<td>40</td>
</tr>
<tr>
<td>Zone/Variable Info Page</td>
<td>40</td>
</tr>
<tr>
<td>Data Set Page</td>
<td>42</td>
</tr>
<tr>
<td>Auxiliary Data Page</td>
<td>43</td>
</tr>
</tbody>
</table>

## Tecplot RS Workspace Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Frames</td>
<td>45</td>
</tr>
</tbody>
</table>
XY Plots

Basic XY Plots ................................................................. 53
Loading XY Data ............................................................... 53
Loading a Folder of XY Data Files .................................. 54
XY Data Files .................................................................. 56
VDB Folder .................................................................... 57
Loading History Data ..................................................... 58
Additional Information about XY Data ......................... 59
Managing XY Data .......................................................... 59
XY Data Settings ............................................................ 59
Unloading Data Files ....................................................... 60
Swapping Data Files ....................................................... 60
Writing XY Data ............................................................. 60
Aligning Start Times ....................................................... 61
Common Controls ......................................................... 61
Common Sidebar Controls ............................................. 62
Common Axes Controls ................................................. 62
XY Variables .................................................................. 63
XY Entities ................................................................... 65
XY Subsets ................................................................... 67
XY Freestyle ................................................................. 69
Creating an XY Freestyle Plot ...................................... 69
Customizing the Line Styles for XY Freestyle ............. 72
Working With Multiple Pages, Frames and Mappings .... 78

Custom XY Plots ............................................................. 79
XY Custom Plot ............................................................. 79
XY Custom Entities ....................................................... 80
Custom Plot Options Dialog ......................................... 81
Frames ......................................................................... 81
17 Working with Grid Data ................................................................. 217

Data Spreadsheet ............................................................................. 217
Value Location .................................................................................. 218
Loading Variables ............................................................................ 218
Spreadsheet Formatting .................................................................... 218
Editing Spreadsheet Data ................................................................ 219
Grid Equations ................................................................................ 219
Testing Grid Equations .................................................................... 220
Integration ......................................................................................... 220
Cell Value Blanking, .......................................................................... 221
Blanking in Multi-Frame Plots ............................................................ 222
Pick Blanking ..................................................................................... 222
KSum, KAvg, and RMap .................................................................... 224
KSum ................................................................................................. 224
KAvg ................................................................................................. 225
RMap ................................................................................................. 225
KSum/KAvg Options ......................................................................... 225
Restricting K Values ......................................................................... 226

18 Comparing Grid Data ...................................................................... 227

Using the Compare Toggle ............................................................... 227
Loading Multiple Data Files .............................................................. 227
Active Data Set ................................................................................ 228
Selecting Data Sets for Comparison .................................................... 229
Comparing Dissimilar Data Sets .......................................................... 230
Delta Comparisons .......................................................................... 231
Creating Delta Files .......................................................................... 231

19 Data Analysis ................................................................................... 233

Statistical Plots ................................................................................ 233
Histograms ....................................................................................... 233
Cross Plots ....................................................................................... 235
Performing Integrations ................................................................... 237
Choosing Cells ................................................................................ 237
Binning Results ............................................................................... 237
Applying Volume Values ................................................................. 238
Integration Results .......................................................................... 238

20 Data Export .................................................................................... 239

Property Modifier ............................................................................. 239
Property Modifier Output ................................................................. 241
Extract Data by Cell ......................................................................... 244
CSV Extractions by Cell ................................................................. 245
Sector Data Extractions by Cell ................................................... 246
Extract Data by Well ................................................................... 247
Well Editor .................................................................................. 248
Add Node Series ......................................................................... 249
Well Data Output ......................................................................... 249

Project Files, Templates, Gallery

21 Projects ...................................................................................... 253
Creating a New Project File .......................................................... 253
Saving a Project File ..................................................................... 253
Opening Existing Project Files .................................................... 254
Project File Contents ................................................................... 254
Viewing Project Files ................................................................... 255

22 Saving and Reusing Views and Plots ........................................ 257
Custom 3D View .......................................................................... 257
Templates .................................................................................... 258
Saving Template Files .................................................................. 258
Applying Template Files ............................................................... 259
Template File Contents ................................................................. 259
Managing Template Files ............................................................. 260
Plot Gallery .................................................................................. 260
Saving a Plot ............................................................................... 261
Managing the Gallery ................................................................. 261
Moving Gallery Plots Between Projects ........................................ 261

Advanced Topics

23 Batch Processing .......................................................................... 265
Batch Processing Overview .......................................................... 265
Batch Processing Setup ................................................................. 265
Batch Processing Using a Project File ........................................... 266
Batch Processing Diagnostics ....................................................... 266

24 Macros: Task Automation .......................................................... 267
Creating a Macro .......................................................................... 267
Playing a Macro ........................................................................... 269
Writing and Editing a Macro ......................................................... 270
Working with Macros: Going Farther .......................................... 271
Exploring Basic Macro Structure ................................................. 271
Understanding Basic Macro Structure ....................................... 272
Exporting an Animation or Group of Images ................................................................. 380
Saving a Tecplot Product File ........................................................................................ 382
Data File Writing ........................................................................................................... 382
Antialiasing Images ....................................................................................................... 384
Movie File Creation with Macros .................................................................................... 384
Advanced Animation Techniques ................................................................................... 384
Text Changes ................................................................................................................ 384
Multiple Frames Animation ............................................................................................. 385
Movie File Viewing ......................................................................................................... 385
AVI Files ......................................................................................................................... 385
Flash Files ....................................................................................................................... 386

**Plot Options** .................................................................................................................. 387
Load/Save ........................................................................................................................ 387
Load/Save Settings ......................................................................................................... 387
Miscellaneous Settings ................................................................................................... 388
Variables .......................................................................................................................... 390
Master Variables List ....................................................................................................... 390
Sort and Active Toggles ................................................................................................. 390
Aliases .............................................................................................................................. 391
Default Styles ................................................................................................................ 391
RSVariables ..................................................................................................................... 392
XY Lines .......................................................................................................................... 392
Style Set ......................................................................................................................... 392
Variables ......................................................................................................................... 393
Style Selections ................................................................................................................. 393
Multi-Edit XY Line Styles ............................................................................................... 394
XY Axes ............................................................................................................................ 395
Variables .......................................................................................................................... 396
Axis Scale ......................................................................................................................... 396
Axis Style ........................................................................................................................ 397
Grids ................................................................................................................................... 397
Active Cell Grid Styles ................................................................................................. 398
Inactive Cell Styles ........................................................................................................ 399
See-through Grid Styles ................................................................................................. 400
Grid Legend ...................................................................................................................... 401
Variables ......................................................................................................................... 401
Variable Range ............................................................................................................... 401
Contour Legend .............................................................................................................. 402
Grid Axes ........................................................................................................................ 403
Axes Styles ...................................................................................................................... 403
3D Views ......................................................................................................................... 403
Cell Labels ....................................................................................................................... 404
Wells .................................................................................................................................. 404
Well Symbols .................................................................................................................. 405
Well Symbol Offset ........................................................................................................ 405
Labels ................................................................................................................................ 405
Connect Nodes ................................................................................................................. 406
2D View Settings ............................................................................................................ 406
Where Are Styles Set? ................................................................. 406

G

Shortcuts ................................................................. 409

Keyboard Shortcuts ................................................................. 409

Rotate Tool ................................................................. 409

Polyline Tool ................................................................. 410

Probe Tool ................................................................. 410

Streamtrace Placement tools (3D grid plots only) ....................... 411

Translate/Magnify Tool ................................................................. 411

Zoom Tool ................................................................. 411

Picked Object Options ................................................................. 411

Other Keyboard Operations ................................................................. 412

Extended Pointer Operations ................................................................. 412

H

Command Line Options ................................................................. 413

Tecplot RS Command Line ................................................................. 413

Using Command Line Options in Windows Shortcuts ............... 414

Changing Shortcuts ................................................................. 415

Additional Command Line Options on Linux Platforms .............. 416

I

License Management ................................................................. 417

Entering Your License ................................................................. 417

License Roaming ................................................................. 421

Starting Roaming ................................................................. 422

Ending Roaming ................................................................. 422

Additional Command Line Options on Linux Platforms .............. 416

J

Utility Programs ................................................................. 425

ResetRS ................................................................. 425

Running RSPreprocess ................................................................. 426

Additional RSPreprocess Parameters ................................................................. 427

K

Tecplot RS Files ................................................................. 429

XY Data Files ................................................................. 429

Generic ASCII Files ................................................................. 430

CHEARS CSV Files ................................................................. 432

Well Allocation Factor Data Files ................................................................. 432

XYMulti File ................................................................. 437

UTCHEM Files ................................................................. 437

Grid Files ................................................................. 437

Eclipse Data Files ................................................................. 437

VIP Data Files ................................................................. 437

17
Streamline Files ................................................................. 438
Survey Well Files ............................................................ 438
VDB Folder ......................................................................... 438
Sensor Map Files .............................................................. 438
CMG Files ........................................................................ 438
UTCHEM Grid Files .......................................................... 438
Files Created by Tecplot RS ............................................. 439
State Files ........................................................................ 439
Style Files ......................................................................... 440
Template Files ................................................................. 440
Project Files ....................................................................... 441
Well Files .......................................................................... 441
RSGRID File Format .......................................................... 441

Index ..................................................................................... 445
Part 1 Introduction to Tecplot RS
Welcome to Tecplot RS

Welcome to Tecplot RS, our visualization environment tailored specifically for reading and displaying reservoir data. We're pleased to include you among our customers!

This manual contains most of what you need to know to create plots and view reservoir data in Tecplot RS. We encourage you to begin by browsing this manual for all the reservoir visualization features that we can hardly wait to help you understand and use.

You can get help using Tecplot RS from the following resources:

- **User's Manual** The Tecplot RS User's Manual provides a complete description of all the features in Tecplot RS.
- **Installation Guide** The instructions in this guide give a detailed description of how to install Tecplot RS on your machine.
- **Release Notes** Check the Release Notes for information on which new and updated features your release includes.
- **Tecplot Talk** Our user and developer-supported forum discusses questions and details about Tecplot products, scripting, writing add-ons, TecIO, and more. This is a great place to ask us any questions you have about using Tecplot RS. Join the conversation at www.tecplottalk.com.
- **Tecplot 360 Scripting Guide** For advanced users, the Tecplot 360 Scripting Guide provides a valuable reference to understand macro command syntax and information on working with macro files and commands. You can download this manual from our Tecplot Web site.
- **Tecplot RS Help** For the simplest way to get help on any Tecplot RS feature, click any Help button in Tecplot RS. The whole User’s Manual is available and searchable.

1 - 1 Using This Manual

You can access the material in this manual by searching for a key term, referencing the Index, referring to the Table of Contents, or exploring topically by choosing “Tecplot RS Help” in the Help menu of Tecplot RS. Although the material is so interesting that we expect you will want to read the manual straight through, do not feel obligated to do so.
Welcome to Tecplot RS

1 - 1.1 Manual Organization
This document includes the following parts.

- **Part 1: Introduction to Tecplot RS** provides an overview of the Tecplot RS interface as well as an introduction to creating plots.
- **Part 2: XY Plots** discusses the line plots typically used to display observed or simulated data for wells, groups, fields and other entities.
- **Part 3: Grid Plots** contains instructions for Grid Plots (2D and 3D plots) of the entire reservoir.
- **Part 4: Project Files, Templates, Gallery** provides an overview of project files and templates.
- **Part 5: Advanced Topics** details the functions that can be applied to either XY or Grid Plots, including the macro language.
- **Part 6: Appendices** provides detailed descriptions of certain options within Tecplot RS, including those that allow you to customize the final plots to your specifications.

1 - 2 Welcome Screen
When you start Tecplot RS, the Welcome Screen, shown below, appears. You can also open it at any time (even while working on a plot in Tecplot RS) by choosing View> Welcome Screen.
The Welcome screen contains links that help you quickly get started working with your data and Tecplot RS.

- Across the top are links for opening projects and data files.
- The left section provides a list of projects you have recently worked with.
- The right column contains links to documentation and other resources to help you get the most out of Tecplot RS.
- At the very bottom of the right column is information for contacting Technical Support, including the version and platform information you will need for a support incident.

The Welcome Screen automatically disappears when you open a project or data file. You may also close it manually by clicking the red X button in the upper right corner; this returns you to your existing session if you have chosen View> Welcome Screen while you were working with a plot.

1 - 3 Input Devices

Tecplot RS supports the following input devices:

- **Standard mouse** - Used for pointing at, selecting, and manipulating objects in the workspace; changing the view; choosing fields and manipulating controls in dialogs and sidebars; and performing actions or commands using the toolbar or menus. Most mice have multiple buttons and a scroll wheel, which provide quick access to specific functions.

- **Keyboard** - Used for entering data and text and for activating commands using menu shortcuts. In conjunction with a mouse, can be used to switch modes when clicking or dragging.

- **3D mouse** - A secondary input device that allows 3D grid plots to be zoomed, translated, and rotated with a touch. Additionally, the always-active 3D mouse doesn’t make you select mouse modes, commands, or keyboard shortcuts. A 3D mouse can therefore enable faster exploration of your data and improve the experience of working with your 3D plots.

Actions available with a 3D mouse include:

- **Translation** - Push the mouse cap left or right, pull it up, or push it down, to translate the plot left/right or up/down on the screen.

- **Zooming** - Push the mouse cap toward you or away from you to zoom the plot. Hold down the Alt key while zooming to switch zoom methods. The default zoom method depends on whether the current frame's 3D view mode is perspective or orthographic (see Section 13 - 2.1 "3D View Details" on page 160). The results of zooming using the 3D mouse and the Alt key are shown here.

<table>
<thead>
<tr>
<th>Pushing or pulling mouse cap</th>
<th>In perspective mode</th>
<th>In orthographic mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (without Alt key)</td>
<td>Changes view distance</td>
<td>Changes view width</td>
</tr>
<tr>
<td>Alternate (pressing Alt key)</td>
<td>Changes view width</td>
<td>Changes view distance</td>
</tr>
</tbody>
</table>

- **Rotation** - Rotation is around the defined center of rotation, by default the center of the data. However, the axis of rotation is relative to the screen rather than to the data.

  - **X axis** - Tilt the mouse cap forward or back to rotate around the screen’s X axis, as if rolling your plot toward you or away from you.

Tecplot RS supports 3D mouse products from 3Dconnexion, such as the SpaceMouse, SpaceNavigator, and SpacePilot lines, and only on the Windows platform.
Welcome to Tecplot RS

- **Y axis** - Twist the mouse cap clockwise or counterclockwise to rotate around the screen's Y axis, as if on a lazy susan.
- **Z axis** - Tilt the mouse cap left or right to rotate around the screen’s Z axis, like the hands of a clock.

With practice, it is possible to perform more than one of these operations at the same time. At first, though, it is best to be careful to invoke only one function at a time.

Most 3D mice also have one or more buttons, which can be mapped to commands that you use frequently using the software provided with the device.

A handy command to assign to a 3D mouse button is the keystroke "o" (lowercase letter O), which is used to set the center of rotation to the current mouse pointer position in Tecplot RS.

Tecplot RS supports the following actions (built-in to the 3D mouse software) that may be mapped to buttons using the device software:

- **Fit**
- **Front, Back, Top, Bottom, Left, and Right View**
- **Isometric View 1** (Tecplot RS default view) and 2 (theta 180° from default)
- **Roll CW and CCW** (in 90° increments)

### 1 - 4 Tecplot RS Workspace

Five major sections make up the Tecplot RS workspace, as you can see when you launch Tecplot RS:
Refer to the following sections to learn about each area of Tecplot RS. You can think of the five sections like this:

- View your plots in the plot area.
- Use the menu bar for systematic access to almost every feature in Tecplot RS, and for feature configuration dialogs.
- Use the toolbar for quick access to accomplish the common tasks in your workflow.
- Use the sidebar to configure your plot and its settings.
- Watch the status line for helpful information about your current task.

1 - 4.1 Plot Area

The plot area makes up the largest space of the Tecplot RS environment. All created plots appear in this area, inside one or more frames. Tecplot RS considers each visible measure of the workspace as a page. The current state of the plot workspace, including the data files loaded, the plot type chosen, the templates applied, and most attributes of your plot, make up a project.

Frames

By default, the plot area contains one empty frame. Frames, inside the plot area, contain all the elements of your plot. Your plot can contain one or more frames, and you can independently scale and position each frame in your plot area (although most plot types will revert to standard frame layout when you change plot type). Because most items in a plot scale relative to the frame by default, you can create layouts that will automatically adjust to different paper sizes (for printing), or resize frames to add an extra image. Tecplot RS displays the frame background as white; you can customize this in the frame menu. To learn more, see Section 3 - 1 “Using Frames”.

Pages

Usually, Tecplot RS allows only one page, or visual measure of the workspace, in the workspace. However, when you are using the XY Freestyle plot type, you can add additional pages to your project. See Section 4 - 8 “XY Freestyle” for more information.

Projects

Tecplot RS creates projects as very small files that keep track of the work done in your plots so you do not have to repeat work to retrieve a previously created plot. Learn more in Chapter 21: “Projects”.

1 - 4.2 Menu Bar

The Tecplot RS menu bar appears across the top of the Tecplot RS workspace. Each menu provides access to various related Tecplot RS functions and their settings.

Tecplot RS’s features are organized into the following menus:

- Project When you use the Tecplot RS interface, you are always working within a project. The Project menu enables you to save your project, open a new one, load data files into your project, manage loaded data, print and export your project, and more. To learn more about projects, see Chapter 21: “Projects”.
Welcome to Tecplot RS

- **Edit** Use the Edit menu to cut, copy, paste, or clear objects in your project. You can also copy your plot to your operating system’s clipboard to quickly export it. To read about these functions, see [Section 3 - 3 “Using the Edit Menu”](#).

  **Cut, Copy, and Paste** work only within Tecplot RS. To paste a graphic image of your project into another program, use **Copy Plot to Clipboard**. This option is available on Windows® platforms.

- **View** Use the View menu to manipulate your perspective of your data, including scale, range, and rotation. You can also use the View menu to copy and paste views between frames, choose whether to display the sidebar or menu bar, and more.

  The View menu includes the following convenient sizing options:
  - **Fit Everything** The Fit Everything control resizes a plot so that all data points, text, and geometries fit visibly in the frame.
  - **Fit Data** Choose “Fit Data” to fit all the loaded data points visibly in the frame.

  For more information about controls in the View menu, see [Section 3 - 2 “Changing the View”](#).

- **Plot Type** With the Plot Type menu, you can control which plot type to display. For more information, see [Plot Types](#) in this chapter.

- **Templates** With the Templates menu, you can save or apply templates to your plot. To learn about templates, go to [Section 22 - 2 “Templates”](#).

- **Gallery** Provides access to plot settings you’ve saved, as described in [Section 22 - 3 “Plot Gallery”](#).

- **Data** Use the Data menu to create, manipulate, and examine data. In Tecplot RS, you can manipulate your data through blanking, probing, extracting data, and creating or altering variables.

- **Options** With the Options menu, you can control the attributes of your workspace, including the plot, display, and performance attributes. Learn more in [Chapter 27: “Customization”](#).

- **Insert** Use the Insert menu to add text, geometries (polylines, squares, rectangles, circles, and ellipses), or image files to your plot. Learn more in [Section D - 4 “Adding Text”](#), [Section D - 5 “Adding Geometries”](#), and [Section D - 6 “Adding Images”](#).

- **Plot** Use the Plot menu to control variable assignments and streamtrace attributes in your plots.

- **Frame** Use the Frame menu to create, edit, and control frames in your plot. To learn more, see [Section 3 - 1 “Using Frames”](#).

- **Analyze** Go farther understanding your data with the advanced features available in the Analyze menu. Read more in [Chapter 19: “Data Analysis”](#).

- **Macro** The Macro menu controls the ability to record or play macros. Read more in [Chapter 24: “Macros: Task Automation”](#).

**Help** The Help menu gives access to information about Tecplot RS. Choose “Tecplot RS Help” from the Help menu to view specific, complete help articles about features or operations within Tecplot RS. By choosing “About Tecplot RS” from this menu, you can obtain specific information about your license.

### 1 - 4.3 Plot Controls Sidebar

The Plot Controls sidebar appears along the left side of the Tecplot RS window and provides easy access to modify plot settings. Although some operations use dialogs, you can control most inputs and make plot modifications directly in the sidebar.
You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words “Plot Controls”). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.

While the sidebar contents depend on the plot type displayed, many regions of the sidebar display for multiple plot types and serve common purposes in Tecplot RS, as discussed in the following sections.

**Plot Layers**

The layer controls at the top of the sidebar set the display of various drawing layers in your plot. The control must be checked (active) to display the corresponding layer. You can choose to have the controls applied on a frame-by-frame basis (giving you the ability to turn off the mesh on one frame and have it on in a second), or have them applied to all frames in a multi-frame plot. To investigate these settings, look in the Multi-Frame Options dialog.

The plot layers available depend on the active plot type. Generally, one set of controls displays for XY plot types, and a different set of controls displays for grid plot types. Several plot layers that display for grid plot types display only for 3D Grid plots. For additional plot layer information, review the chapters corresponding to each plot type.

**Paging: Animation and Scrolling Controls**

A series of animation and scrolling buttons display in the sidebar for most plot types.

- [ ] and [ ] (Next and Previous) Retreat or advance a single step.

- [ ] (Play) Cycle through all entities in the list or play through all time steps in the data. The play list normally begins at the current entity or time step and progresses to the final item in the list (or time step in the data).

- [ ] (Reverse Play) Click the Reverse button to view the animation sequence in reverse.

- [ ] (Stop) Click the Stop button to interrupt the animation process.

- [ ] (Export) Click the Export button to launch the Auto-Export dialog for a variety of output choices. See Exporting an Animation or Group of Images for more information.

- [ ] (Details) Click the Details button to launch the Time Options dialog (2D or 3D Grid plot only). Similar Details buttons in other locations of the interface access other settings dialogs.

Not every button is available for every plot type, and the functions may differ slightly according to the different plot types.

Use the Load/Save page of the Plot Options dialog to adjust the delay between animation steps.
Welcome to Tecplot RS

**Toolbar Buttons**

Tecplot RS includes a toolbar of buttons to provide quick access to the most important steps in your workflow, and most of these buttons also appear in the sidebar. To learn more about these buttons, see Section 1 - 4.4 "Toolbar". Hover your pointer over each button to see that button's tool tip.

**Expanded Lists**

Whenever you see the Plus button next to a list in the sidebar or a dialog, you can click this button to open an expanded dialog of the list. To find an item in the list more easily, you can type letters in the Filter field at the top of the list. Only items that include those letters in that order will appear in the expanded list. For example, to display only items with the word “well” in their name, type “well” into the Filter field.

**Plot Types**

The current plot type displays at all times in a menu at the bottom of the sidebar. This reflects the plot type chosen in the Plot Type menu, and you can change the plot type in either place.

Tecplot RS includes the following plot types.

- **XY Plots** Tecplot RS includes eight specific types of XY plots, each with smart defaults to optimize different types of data or plot specifications:
  - **XY Variables** XY Variable plots depict a single independent (x-axis) variable with up to five dependent (y-axis) variables. The axis variable selections apply to all entities (such as wells, fields and groups).
  - **XY Entities** XY Entity plots depict an entity or group of entities plotted for a single XY axes variable pair.
  - **XY Subsets** XY Subset plots allow you to view all of the components of a single well, user group or branch at one time (for a single variable).
  - **XY Freestyle** XY Freestyle plots allow you to manually specify the components of your plot.
  - **Custom XY Plots** XY Custom plots allow you to define a set of plots for which you can select the variables to plot and the order in which they appear.
  - **XY Custom Entities** XY Custom Entities plots combine XY Custom and XY Entity plots. As with XY Custom plots, you can select the variables to plot and the order they should appear. XY Custom Entities expands this function by allowing you to plot multiple entities.
  - **RFT Plots** RFT plots display observed or simulated values at one or more depths along a well at a given time.
  - **Completion Profiles** Completion Profile plots display variables versus level (completion) at a single point in time.
- **Flow Tables** Flow Tables contain an N-dimensional array of bottom hole pressure (BHP) values plotted for N-independent variables. BHP is shown on the Y-axis of the plot.
- **Grid Plots** Tecplot RS includes 2D and 3D Grid plots. For further discussion of these plot types, see Chapter 13: “Basic Grid Plots”.
- **Paper Layout** Use the Paper Layout to control the styles of your plot frames, headers and footers on the paper for display or printing.
Tecplot RS Workspace

1 - 4.4 Toolbar

Tecplot RS includes a toolbar of buttons to provide quick access to the most important steps in your workflow. By default, the toolbar appears below the menu bar, but you can move the toolbar to whichever edge of the application window you find most useful.

To move the toolbar to a new location, drag the left edge of the toolbar to the new location. Drag it to an edge of the Tecplot RS application window to dock the toolbar on that edge.

You can use these buttons to control the pointer mode, execute an action, or gain quick access to a popular dialog. Hover over each button for a tool tip about that button.

The toolbar buttons are organized into common workflow steps.

Load Data

The first group of tools control bringing your data into Tecplot RS with minimal effort so that you can visualize it in your plot.

Create Project

Use the Create Project button to begin a new project in Tecplot RS.

A project is the highest level of organization in Tecplot RS; everything you do in Tecplot RS happens inside a project, in which you can save plots and groups of data to easily come back to later. A Project file is small, taking up very little space (because it consists of an XML macro file that Tecplot RS runs when you open the project to replicate your previous work on your plot).

Open Project

Use the Open Project button to quickly return to a previously saved project. With this button, you can browse to a saved project. You can also use the Project menu to quickly return to a listed recent project.

Load XY Data, Load Grid Data, Load VDB Data

With the three Load Data buttons, you can quickly open the dialog to load either XY or grid data into your project. Click the Load XY Data button to load XY data, click the Load Grid Data button to load grid data, or click the Load VDB Data button to load data from a Virtual Database (VDB) folder.

You can also load XY data by dragging a folder containing XY data files onto the Tecplot RS icon or onto the Tecplot RS application window. To learn more, see Section 4 - 1.1, "Loading a Folder of XY Data Files".

Manage Data

The Manage Data button opens a dialog with which you can manage your loaded data, such as choosing which data set is active. (This is useful if you have more than one data file loaded.) To learn more about the Manage Data dialog, go to Basic XY Plots: Section 4 - 2 "Managing XY Data".

29
Welcome to Tecplot RS

Save Project
Save the current state of your open project by clicking the Save Project button. This way, you can quickly return to the exact data, settings, and view that you are working with when you save your project. To learn more about the value of using projects, see Chapter 21: “Projects”.

Adjust View
The second group gives you the ability to change the view of your data.

Zoom
With the Zoom tool you can control how much of your plot fills the frame by zooming into and out of your plot.

- Click the Zoom tool on an area in your plot to zoom in, centered around the position that you clicked.
- Hold down the Ctrl key while clicking the zoom tool to zoom out, centered around the position that you clicked.
- Drag the Zoom tool in your plot to create a rectangle around the desired view area. Tecplot RS will fit the selected rectangle into the frame.
- To zoom the entire paper of the Tecplot RS workspace, hold down the Shift key while dragging the Zoom tool in your plot, creating a rectangle around the desired view area. Tecplot RS will resize the plot so that the longest dimension of the zoom box fits into the workspace. You can fit one or all frames to the workspace by using the “Fit Selected Frames to Workspace” or “Fit All Frames to Workspace” options in the View menu (after choosing “Workspace” in the View menu).

3D mouse - Tecplot RS also supports a 3D mouse, an input device that allows zooming (and translation and rotation) of 3D plots with a touch. You do not need to activate the Zoom tool to use the 3D mouse for zooming. Simply push the mouse’s cap toward or away from you to zoom. Hold the Alt key while zooming with the 3D mouse to switch the zoom method (see “Input Devices” on page 23 for details). Avoid tilting the mouse cap, as this may induce unintended rotation.
To return to the previous view, choose “Last” from the View menu.

Translate
Use the Translate tool to reposition your plot within the frame. With the Translate tool, drag your pointer to move your plot within its frame. Hold down the Shift key while dragging with the Translate tool to move the paper within the Tecplot RS workspace.

3D mouse - Tecplot RS also supports a 3D mouse, an input device that can be used to translate 3D plots at any time with just a touch, regardless of the tool or mode selected.

- Pull the mouse’s cap up or push it down to translate up or down on the screen.
Move the mouse’s cap left or right to translate left or right on the screen.

Avoid tilting or rotating the mouse when using these motions to avoid rotating the plot.

**Rotate about Z-Axis**

- Click the Z-axis Rotation button and drag the pointer in your plot to rotate it about the Z-axis.

When using either the Rollerball or the Z-Axis Rotation tools, you can switch to the other rotation tool by pressing the Z key (to switch to the Z-Axis Rotation tool) or R (to switch to the Rollerball Rotation tool).

**Rotate (Rollerball)**

- Click the Rollerball button to rotate the plot freely about all axes. After clicking the button in the sidebar, use the left pointer button to “roll” the ball in any direction.

To rotate your plot using only the pointer and the Ctrl key, hold down the Ctrl key, hold down the right pointer button, and move your pointer.

**3D mouse** - Tecplot RS also supports a 3D mouse, an input device that can be used to rotate 3D plots at any time regardless of the tool or mode selected. The axis of rotation is relative to the screen rather than to the data.

- Tilt the mouse’s cap forward or backward to rotate around the screen’s X axis, as if rolling toward or away from you.
- Twist the mouse’s cap clockwise or counterclockwise to rotate around the screen’s Y axis, as if on a lazy susan.
- Tilt the mouse’s cap left or right to rotate around the screen’s Z axis, like the hands of a clock.

**Move Light Source**

With the Lighting tool (available for 3D grid plots), you can adjust the shading to indicate the direction of the light source. To accomplish this, click on the Lighting tool, and then drag on your plot to adjust the light source. Make sure the Light layer is toggled on in the sidebar in order to see the effect.

You can see when you have the Lighting tool active, since the cursor changes to a moveable sun as well. To learn more about the light source feature, see Chapter 14: “Lighting Layer (3D Grid plots only).”

**Redraw**

Click the Redraw button to redraw all frames in your workspace. Tecplot RS sets the redraw mode to automatic (your plot redraws automatically when you make a change), so the Redraw button is seldom needed. However, you can use it to refresh the view if something interrupts the drawing process, or during macro recording.

You can interrupt the auto-redraw at any time by clicking your pointer or pressing any key on the keyboard.
Welcome to Tecplot RS

Reset View

To restore your plot to its initial view, click the Reset View button. This will return the plot to the initial settings. In a 3D plot, this button restores to the saved Custom 3D View, rather than to the default view, if one exists in the current project. (See “Custom 3D View” on page 257 for further details.)

In 2D views, Tecplot RS also resets the view when you change the view plane (for example, from I to J plane views).

Adjust Plot

With the next group of toolbar buttons you can make adjustments to your plot, such as adding text or arranging frames of data.

Selector

Use the Selector tool to select objects in your workspace. This tool is the most multi-purpose of the tools. You can often use it in combination with other tools. For example, after inserting text, use the Selector tool to double-click on the text to reopen the Text Details dialog and edit the text.

You can select and translate the following objects using the Selector tool:
- Frames
- Text and geometries
- Contour labels
- Legends

To select an object and open that object's settings dialog (if available), double-click on the object with the Selector tool.

Adjustor

Use the Adjustor tool to perform any of the following modifications to your plot and data:
- Location of individual data points in a grid plot (2D Grid plots)
- Values of data set variables at a particular point (XY plots)
- Length or placement of individual axes (2D grid and XY plots)
- Spacing between an axis label and its axis (2D grid and XY plots)
- Shape of a polyline

For all other scenarios, the Adjustor tool acts the same as the Selector tool.

Since the Adjustor tool can alter your data, be sure you want to use the Adjustor tool before dragging points in the plot area.
To use the Adjustor tool, click to select the point you wish to adjust, and then drag the Adjustor from the point to the desired location.

For XY Line plots, if several mappings are using the same data for one of the variables, adjusting one of the mappings will result in simultaneous adjustments to the others. You can avoid this by pressing the H or V key on your keyboard while adjusting the selected point. The H and V keys restrict the adjustment to the horizontal and vertical directions, respectively.

**Insert Text**

Use the Insert Text tool to add text to your plot. To learn more about adding text to your plot, see Section D - 4 “Adding Text”.

**Plot Options**

Click this button to launch the *Plot Options* dialog, with which you can customize many plot settings. Refer to Appendix F: “Plot Options” for additional information.

**Multi-Frame Options**

Click this button to launch the *Multi-Frame Options* dialog, with which you can customize the arrangement of frames in your workspace. Refer to *Multi-Frame Options* to learn more about this feature.

**Update Paper Layout**

With the Update Paper Layout button, you can set style or positioning changes in the current plot type as the new default for all plot types. For example, if you wish to change the position of the legend for all plot types, use the selector tool to move the legend in the current plot type and then click the Update Plot Layout to make this position the new default. Now when you switch plot types, the legend will appear in the new position, rather than reverting to the old default position. Refer to Section D - 3 “Modifying your Paper Layout” for additional information.

**Analyze Data**

With this more advanced group of buttons, you can examine your data or make more complicated adjustments.

**Measure Distance**

The Measure Distance tool displays the straight-line distance between two points clicked on a 2D or 3D grid in the Tecplot RS status bar. Each pair of clicks sets a start and end point for distance measurement.

**Probe**

With the Probe tool, you can view variable values of any selected data point.

Click the Probe tool to activate it, and then click in your plot to view variable values at that point:

- To obtain interpolated values of the data set variables at a specified location, click at any point in the data region.
- To obtain exact values for the data point nearest the specific location, Ctrl-click at the desired location.
Welcome to Tecplot RS

See Section 1.6 “Data Queries” and Chapter 15: “Data Probing”, to learn more.

Quick Probe

The Quick Probe tool, available in 2D and 3D Grid plots, lets you see the value of the contour variable at the probed point. Instead of displaying a dialog, as the Probe tool does, this tool quietly displays the coordinates and probed value in the status bar at the bottom of the Tecplot RS window. See Chapter 15: “Data Probing” to learn more.

Streamtrace

Click this button to activate the Streamtrace tool, with which you can add a streamtrace interactively by clicking in your plot. Drag to add a rake of streamtraces. Choose the number of streamtraces to include when adding a rake by prefacing the dragging with pressing a number (1-9) on the keyboard. See Chapter 16: “Streamtraces” for more information.

Cell Blanking

Clicking this button launches the Cell Blanking dialog. Cell blanking allows you to remove data points above or below a specified threshold. Refer to Section 17-3 “Cell Value Blanking” and Section 17-4 “Pick Blanking” for more information.

Property Modifier

This button opens the Property Modifier dialog, which allows you to create an ASCII file to use as input into reservoir simulators, optionally changing the values of properties throughout the entire grid or in a subset. See Section 20-1 “Property Modifier” for more information.

Histogram

Click the Histogram button to display a histogram of your data in the Tecplot RS workspace. For more information, see Section 19-1.1 “Histograms”.

Cross plot

Click the Cross plot button to display a quick cross plot of your data in the Tecplot RS workspace. For more information, see Section 19-1.2 “Cross Plots”. You cannot view a cross plot and a histogram at the same time.

Integrate

This button opens the Integration dialog, with which you can run integrations on your data.
Calculate

Use the Calculate button to open the equations dialog corresponding to the current plot type (either the XY Equations dialog or the Grid Equations dialog). With this dialog, you can use equations to create new variables that are expressions of existing variables (for example, PRESSURE divided by SOIL).

Automate Your Processes

With the final button, you can automate repetitive processes to save time analyzing additional data.

Play a Macro

Use the Robot button to quickly browse to an existing macro and play it.

Template and Filter Data

Although we do not have toolbar buttons for this section, you may wish also to apply templates and/or filters to customize your output.

To create or edit templates, switch to the Paper Layout plot type. To apply a template, choose “Apply” from the Templates menu. To learn more about templates, see Chapter 22: “Saving and Reusing Views and Plots”.

To apply filters to your data, you can use the Grid Equations and XY Equations dialogs from the Analyze Data section of the toolbar.

Export and Interpret Results

Finally, Tecplot RS provides quick access to full views or export options for your data.

To give a full screen view of your data, choose “Toolbar” from the View menu to turn off the sidebar. Choose “Plot Controls Sidebar” from the View menu to turn off the sidebar.

You can export an animation by clicking the Export button in the Times region of the sidebar, or export an image by choosing “Export” from the Project menu or “Copy Plot to Clipboard” from the Edit menu. To learn more about exporting, see Chapter E: “Printing and Exporting”.

1 - 4.5 Status Line

The status line that appears along the bottom edge of the Tecplot RS environment displays “hover help”. When you move the pointer over a tool in the toolbar, a button in a dialog, or a menu item, a description of the control appears. The status line also provides a progress bar and information during non-trivial calculations.

During calculations for which the progress bar displays, you can stop the operation by clicking the Stop button in the status line.

1 - 5 Basic Style Editing Concepts

The Plot Options dialog provides numerous options for modifying the style of various plot objects.

You can use the button to launch the Plot Options dialog, or choose “Plot Options” from the Options menu. Even more conveniently, you can double-click with the selector tool on any plot object to open its associated options dialog. For example, to change the color of a line in an XY plot, double-click the pointer on that line. This opens the Plot Options dialog on the page that controls the associated style options and selects the variable illustrated by that line in the plot. You can make the
Welcome to Tecplot RS

desired style changes and click Apply to update the plot. Similarly, you can double-click on an axis to change the range for that axis or edit the axes styles. For grid plots, you can double-click on the grid itself to open the Plot Options dialog on the Grids page, where you can modify the grid-related style options. You can also double-click on the grid color legend to bring up the Grid Legend page, on which you can change the range settings and other options associated with the style of the legend.

To gain a greater understanding of how the options dialogs interact with features in your plot, double-click on various plot objects.

1 - 6 Data Queries

At any point while using Tecplot RS, you can look up the value(s) of your data using one of the following functions:

- **Probing** Use the probe or quick probe tool (in the toolbar), or choose “Probe” or “Quick Probe” from the Data menu to look up the value of your variables at a given grid cell. Refer to Chapter 15: “Data Probing” for additional information.
- **Data Set Info** Use the Data Set Info dialog (accessible by choosing “Data Set Info” from the Data menu) to view information about your data set, including variable ranges and auxiliary data. Refer to Section 2 - 3 “Viewing Data Set Information” for additional information.
- **Spreadsheet** Use the Data Spreadsheet dialog (accessed by choosing “Spreadsheet” from the Data menu) to view variable values in spreadsheet form. Refer to Chapter 9: “Viewing XY Data” for additional information.
- **Data Range** Launch the Data Ranges dialog (accessed by choosing “Data Ranges” from the Data menu) to quickly view the range of each variable (for all time steps) in your data set.

1 - 7 Help

In addition to the manuals, the standard installation of Tecplot RS includes a fully integrated help system, Tecplot RS Help. This searchable group of help pages (HTML) display in your default Internet browser. To access this help quickly:

- Click a Help button in any Tecplot RS dialog
- Click an additional Help or Question (?) button within Tecplot RS. For example, the Question button next to the Plot type menu in the sidebar will display help for the active plot type.
- Choose “Tecplot RS Help” from the Help menu.

From each of these locations you can navigate throughout the entire Tecplot RS Help Library. The Tecplot RS Help Library supports text search, includes hypertext links, and provides detailed information on all menus and dialogs.

If you are covered by an active TecPLUS subscription, help is also available from 6:30 A.M. to 5 P.M. Pacific Standard Time from Tecplot Technical Support at 425.653.9393.

You can also send an e-mail to support@tecplot.com with your questions.
Creating Plots

In this chapter, you can learn how to create a basic plot in Tecplot RS, as well as how to retrieve it easily. Read the end of the chapter to learn how to view your data files from within Tecplot RS.

2 - 1 Creating a Basic Plot in Tecplot RS

To create a basic plot of your data in Tecplot RS:

1. Load your data as either XY or grid data.

To do this, choose "Load XY Data" or "Load Grid Data" from the Project menu, or click the Load XY Data or Load Grid Data button in the toolbar. In the appropriate Load Data dialog that appears, choose the file type that you wish to load. Tecplot RS 2019 R1 supports the following file types.

- **XY Data:**
  - Eclipse .unsmry, .rft files, and .user files
  - Chears .hist and .csv files
  - Intersect .obsb files
  - VIP .rft, .plt and .obs files
  - General ASCII .txt and .prn files
  - Log ASCII Std .las files
  - XY Multi .xymulti files
  - VDB folder for VIP or NEXUS data
  - CMG .inf, .surf, .ar3 files
  - Sensor .sfi files
  - UTCHEM *OVERAL files

- **Grid Data:**
  - Eclipse/Chears grid files (various extensions)
  - VIP Map grid files (various extensions)
  - VDB folder for VIP or NEXUS data
Creating Plots

- CMG .irf, .mrf, .sr3 files
- Sensor .71 files
- UTCHEM INPUT files

- Tecplot Data Loader In addition to XY and grid data, you can load text and geometries in Tecplot ASCII (.dat) format or Tecplot (.plt) format. To do this, choose "Tecplot Data" and then "Read Tecplot Text/Geometry File" from the Project menu. For detailed information about loading your data, see Section 4 - "Loading XY Data" and Chapter 12: "Loading Grid Data". For details on each type of file that Tecplot RS supports, refer to Appendix K: Section "Tecplot RS Files".

2. Set up your initial plot by choosing a plot type.
To do this, once you have loaded your data, choose from any of the following plot types (by using the sidebar or the Plot Type menu):

- **XY Plots** Tecplot RS includes the following types of XY plots:
  - **XY Variables** XY Variable plots depict a single x-axis (independent) variable with up to five y-axis (dependent) variables. The axis variable selections are applied to all entities (such as wells, fields and groups).
  - **XY Entities** XY Entity plots depict an entity or group of entities plotted for single XY axes variable pair.
  - **XY Subsets** XY Subset plots allow you to view all of the components of a single well, user group or branch at one time (for a single variable).
  - **XY Freestyle** XY Freestyle plots allow you to manually specify the components of your plot.
  - **Custom XY Plots** XY Custom plots allow you to define a set of plots in which you select the variables to plot and the order they should appear.
  - **XY Custom Entities** XY Custom Entities plots combine XY Custom and XY Entity plots. As with XY Custom plots, you can select the variables to plot and the order they should appear. XY Custom Entities expands this function by allowing you to plot multiple entities.
  - **RFT Plots** RFT plots display observed or simulated values at one or more depths along a well at a given time.
  - **Completion Profiles** Completion Profile plots display variables versus level (completion) at a single point in time.

- **Flow Tables** Flow Tables contain an N-dimensional array of bottom hole pressure (BHP) values plotted for N-independent variables. BHP is shown on the Y-axis of the plot.

- **Grid Plots** Tecplot RS includes 2D and 3D Grid plots. For further discussion of these plot types, see Chapter 13: "Basic Grid Plots".

- **Paper Layout** Use the Paper Layout plot type to control the styles of your plot frames, headers and footers on the paper for display or printing. After selecting your plot type, use the sidebar to customize the variable and entity settings for your plot type.

3. **Optional** Perform data manipulation.
Tecplot RS provides several methods for you to manipulate and customize your data, including:

- **Filtering** For XY plots, use filtering and selection sets to display only entities that meet your criteria (such as a water production rate threshold). Refer to Chapter 7: "Filters, Selection Sets, Groups, Well Patterns, and Branches" for additional information.
Creating a Basic Plot in Tecplot RS

- **Comparing XY Data** For XY plots, use the comparison option to display differences between multiple data files. Refer to Chapter 10: “Comparing XY Data” for additional information.
- **Equations** Use the equation dialogs to create or modify variable values directly in Tecplot RS. Refer to Chapter 8: “XY Equations” and Section 17 - 2 “Grid Equations” to learn about these features.

4. **Optional** Incorporate derived objects or additional plot views.

   - In 2D and 3D Grid plots, you can:
     - Add multiple layers to your plot, such as a contour layer, wells or bubbles (Chapter 13, “Basic Grid Plots”)
     - Customize the view of your grid plot using pointer tools and the options in the View menu
     - Add alternate views of the data, such as a histogram (see Chapter 14: “Grid Plot Controls” for more information)

   - In 3D Grid plots, you can also:
     - Create custom inside views (see Section 14 - 3 “Inside Views”)
     - Create custom slices (see Section 14 - 3 “Inside Views”)

5. Output your final plot(s).

   - Once you have completed your plot, you can output the plot or data with any of the following methods:
     - **Printing** Choose “Print” from the Project menu to print your plot. Refer to Chapter E: “Printing and Exporting” for additional information.
     - **Animation** Click the Export button in the sidebar to open the Auto-Export dialog to export an animation of your plot(s). Refer to Chapter E: “Printing and Exporting” for additional information.
     - You can also use the Chapter 1: “Paging, Animation and Scrolling Controls” in the sidebar to animate your frames on the screen.
     - **Export** Choose “Export” from the Project menu to export your plots to a graphics file. See Chapter E: “Printing and Exporting” for additional information.
     - **Copy Plot to Clipboard** (Windows platforms only) Choose “Copy Plot to Clipboard” from the Edit menu to add the active frame to your clipboard for pasting into another program, such as Microsoft Word or PowerPoint.
     - **Write Data to a File** There are several methods for writing your data to a file that include the data in simulator input.
       - **Layout Package File** Choose “Tecplot Data” and then “Save Tecplot Layout” from the Project menu to create a Tecplot Layout Package file. This is the best way to share plots with users who have Tecplot 360 or Tecplot Focus but not Tecplot RS. Refer to Section E - 4 “Saving a Tecplot Product File” for additional information on layout package files.
       - For XY plots, choose “Write Data as Formatted Text” from the Data menu to output a comma-separated value (csv) file of your XY data.
       - For Grid plots:
         - Use the Extract Data by Cell dialog (accessible by choosing “Extract Cell Data” from the Data menu) to save information about the cells in your plot and output it either as a .csv file or as sector data (to a .txt file). Refer to Section 20 - 2 “Extract Data by Cell” for additional information.
         - Use the Extract Data by Well dialog (accessible by choosing “Extract Cell Data” from the Data menu) to save cell information for a well or group of wells to .csv file. See Section 20 - 3 “Extract Data by Well” for more information.
Creating Plots

- Use the Property Modifier dialog (open by choosing Data > Sim Input > Cell) to output your data based on the value blanking properties and/or any variable modifications. This function outputs an ASCII file that can be used by the VIP, Eclipse, or CHEARS simulator. Refer to Section 20 - 1 “Property Modifier” for additional information.

- Use the Modify Wells dialog (open by choosing Data > Sim Input > Well) to create and modify node locations and then output the adjusted data to an ASCII data file. Refer to Section 20 - 4 “Well Editor” for additional information.

2 - 2 Retrieving Your Plot

Whenever you load data into Tecplot RS, you are working within a project. In order to quickly return to your plot later, you can save your project. Saving and reusing your project makes working with data more efficient, while taking up only trivial file space. When you save your project, Tecplot RS creates a simple ASCII text file and writes a macro to represent the loaded data, plot type, and many other plot characteristics. Later, to get back to your previously created and saved plot, just open the project. Tecplot RS will run the ASCII file as a macro to retrieve your previous plot.

To save your project, choose “Save” or “Save As” from the Project menu.

After saving your project and then making further changes to your plot, to update your project to the current state of your plot, choose “Save” from the Project menu.

Refer to Chapter 21: “Projects” for additional information.

2 - 3 Viewing Data Set Information

You can view information about the currently loaded data in the active frame in the Data Set Information dialog. To access this dialog, you must have data loaded. Then click on a frame to make it active and choose “Data Set Info” from the Data menu.

The Data Set Information dialog that appears gives summary information about the data set, including the variables names and minimum and maximum values of each variable.

2 - 3.1 Zone/Variable Info Page

The Zone/Variable Info page of the Data Set Information dialog contains the following information.
• Zone(s)  This page lists all zones included in the data set.

• Zone Type (Ordered or Finite Element, FE, data) The Zone Type field displays the type of zones selected in the Zone(s) box. For ordered data, index values for IMax, JMax, and KMax follow this information (described following). Finite element (FE) data includes the element type, number of points, and number of elements.
  • IMax (ordered data) This indicates the IMax value of the selected zone.
  • JMax (ordered data) This indicates the JMax value of the selected zone.
  • KMax (ordered data) This indicates the KMax value of the selected zone.
  • Pts (finite element data) This indicates the number of data points in the selected zone.
  • Elem (finite element data) This indicates the number of elements in the selected zone.

• Variable(s) The Variable(s) box lists all variables by number, with their names.

• Var Type The next line displays the type of data of the selected variable in the Variable(s) field.

• Var Location Indicates if variables are located at nodes or cell-centers.

• Var Status Use the Var Status field in the dialog to determine the status of the current variable. The variable status can indicate the variable passivity, lock state, and additional system state information.

• Var Range - Selected Zone This control displays the minimum and maximum values of the selected variable in the selected zone.

• Var Range - Referenced Zone This control displays the minimum and maximum values of the selected variable for all referenced zones.
Creating Plots

2 - 3.2 Data Set Page

The Data Set page provides information about your data set, including: title, filenames, number of zones, variables, elements, and lock status.

The following information can be found on the Data Set page:

- **Data Set Title** - Enter a title for the current dataset, or edit an existing title. The default is the result of concatenating the titles specified in each Title record encountered in the data files making up the dataset.
- **Data File(s)** - Lists the names and paths of all external data files making up the current dataset.
- **Num Zones** - Number of zones in the dataset.
- **Num Vars** - Number of variables in the dataset.
- **Total Elements** - Total number of elements in the dataset.
- **Total Points** - Total number of points in the dataset.
- **Locked By** - This field will inform you if the current dataset has been locked by an add-on. Add-ons can lock a dataset which in turn prevents you from deleting zones or deleting the last frame associated with the dataset.
Auxiliary data, or meta data attached to zones, data sets, or frames, displays in the second page of the Data Set Information dialog.

This page includes the following information.

- **Show Auxiliary Data** Use this menu to display auxiliary data for a zone, data set, frame, variable, line map, or page.
- **Data Name/Value** Use this menu to choose to display either the names or values of any auxiliary data.

You can use the Tecplot 360 Data Format Guide (available at the Tecplot Web site) to learn how to create a data file that includes auxiliary data.
Creating Plots
Tecplot RS Workspace Features

Tecplot RS includes certain features that function independently of plot type. Understanding these features of the Tecplot RS workspace, as described in this chapter, can help you work with your data easily in Tecplot RS.

These features include:

- Using Frames
- Changing the View
- Using the Edit Menu
- Using Color in Your Plot

### 3 - 1 Using Frames

All plots in Tecplot RS appear inside a frame. By default, the Tecplot RS workspace contains one frame.

To conveniently create additional frames and/or arrange frames in your plot, you can use the Multi-Frame Options dialog. This dialog contains options for managing plots with multiple frames on a single page, allowing you to create multiple views of the same data set, or view multiple data sets. When working with multiple frames, you can also use this dialog to link features between frames.

**Multi-Frame Options**

To access the Multi-Frame Options dialog, click the Multi-Frames button in the toolbar, or choose "Multi-Frame Options" from the Options menu. The dialog includes the following controls.
• **Frame Mode** Use the Frame Mode region of the dialog to choose a frame management mode.

  • **Single Frame** - Tecplot RS will automatically create a single frame for the requested plot type. Any time you change the plot type, Tecplot RS will clear the old frame to display the new plot type.

  • **Multi Frame** - In this mode, Tecplot RS creates multiple frames to display the data for the chosen plot type. Each frame will display a different view of the data set. The variation depends on the plot type. For example, grid plots will display a different variable in each frame, while XY-Variables plots will cycle through the entity list.

Several plot types do not support using multiple frames: RFT Plots, Completion Profiles, and Flow Tables. When using one of these plot types, you can only use a single frame.

Tecplot RS cannot fully support frame linking with dual porosity grids loaded. Refer to Section 13 - 3.3 "Grid Options" on page 163 for additional information.

• **Multi-Frames** The Multi-Frames region of the dialog allows you to control the configuration of frames when using the “Multi Frame” mode. The region has the following options:

  • **Columns and Rows** Use these controls to set the number of frames appearing across and down the paper. The settings immediately below the Columns and Rows fields let you to link frames, to share settings for view, value blanking, or toggles:

  • **Link Grid View/Rotation** When the views are linked, changing the viewing angle or distance on one frame will make the changes in all frames. Without linking, you can set the views independently in each frame.

  • **Link Inside Views/Blanking** With the inside views and blanking linked, a single set of value blanking and inside views criteria will apply to all frames. When this option is toggled-off, you can set cell and pick blanking constraints and inside views independently in each frame. See Section 17 - 3 “Cell Value Blanking” for a discussion of value blanking, Section 17 - 4 “Pick Blanking” for a discussion of pick blanking, and Section 14 - 3 “Inside Views” for a discussion of inside views.

  • **Link Layer Toggles** Layer Toggles include the Mesh, Contour, Connect, Shade, Translucency, and Light toggles at the top of the grid sidebars, and the Lines and Symbols toggles in the XY plot sidebars. When linked, any change to these toggles will affect all frames. Toggle-off “Link Layer Toggles” to set these options independently for each frame.

  • **Link Well Toggle** When toggled-off, wells will be displayed only in the first frame. When on, wells will display in all frames. Unlike the layer toggles, well display cannot change from frame to frame. This option simply lets you control whether wells are shown in one frame or all. See Section 14 - 1.8 “Wells” for additional information about wells.
Changing the View

- **Frame Spacing** These options control the spacing between frames and the margin from the edge of the paper to the plot frame(s). The first value sets the spacing as a percentage of the longer dimension of the paper, and may range from 0 to 5. The second value represents a minimum distance in inches, and is independent of the paper size.

For no spacing at all around frames, set both values to 0. Otherwise, you may use both options or just one. If both are set, the frames will be spaced according to whichever setting results in the larger spacing.

- **Quick Plots** Quick Plots are available in the 2D and 3D Grid plot types. These provide plots of statistical data (histogram and cross plots), plots of value for one cell over all time steps, or one location at each cell depth. See “Additional Data Views” on page 181 for more information on the Quick Plots.

The Quick Plots options allow you to control where these plots are placed in relation to the main plots (below or to the right), and how much of the paper area is allocated for the quick plots (between 20% and 50% of the page).

3 - 2 Changing the View

The View menu contains controls with which you can adjust the active frame's view, the view of the entire workspace.

3 - 2.1 Display of the Toolbar or Sidebar

You can turn off the toolbar and/or Plot Controls sidebar by choosing “Toolbar” or “Sidebar”, respectively, from the View menu. To turn them back on, choose the corresponding menu item again.

3 - 2.2 Redraw a Frame

By default, Tecplot RS automatically redraws the current plot whenever you make changes to it. If you choose to turn off this Auto Redraw feature (in the Performance dialog, accessible from the Options menu), or while recording macros, you can redraw the active frame by choosing “Redraw Frame” from the View menu. You can also redraw the active frame by pressing Ctrl-R, or clicking the Redraw Frame button in the toolbar.

3 - 2.3 Redraw All

To redraw your entire plot when the Auto Redraw feature is turned off (in the Performance dialog, accessible from the Options menu) or when recording a macro, choose “Redraw All” from the View menu. You can also press Ctrl-D or click the Redraw button in the toolbar or sidebar to redraw your plot.

3 - 2.4 Zoom

Tecplot RS includes the capability to zoom in several ways, adjusting the perceived distance between the viewer and the plot.

**Plot Zooming**

As well as clicking the Zoom tool in the Plot Controls Sidebar, you can also zoom your plot interactively by choosing “Zoom” from the View menu to access the Zoom tool. Drag the pointer to draw a box: the region within the view box will resize to fit in the frame according to the longest dimension of the box.

To return to the previous view, choose "Last" in the View menu (or press Ctrl-L). Choose "Center" from the View menu to center the data in the active frame.
Tecplot RS Workspace Features

**Paper Zooming**

You can also zoom your workspace, rather than the plot, by pressing the Shift key while drawing a box with the Zoom tool. Tecplot RS will resize the plot so that the longest dimension of the zoom box fits in the entire workspace.

![Zooming to workspace](image)

You can also fit one or all frames to the workspace by choosing "Fit Selected Frames to Workspace" or "Fit All Frames to Workspace" from the View menu.

**Interactive Zooming and Translation**

You can also use the middle and right buttons of the pointer to smoothly zoom and translate your plot view. Drag with the middle button up and down to zoom smoothly; drag with the right button to translate your plot view.

*3D mouse* - Tecplot RS also supports a 3D mouse, an input device that allows zooming (and translation and rotation) of 3D plots with a touch. You do not need to activate the Zoom tool to use the 3D mouse for zooming. Simply push the mouse’s cap toward or away from you to zoom.

Hold the Alt key while zooming with the 3D mouse to switch the zoom method (see "Input Devices" on page 23 for details).

Avoid tilting the mouse cap, as this may induce unintended rotation. Hold down the Alt key to switch between zooming by moving the data and by moving the viewer.

**3 - 2.5 Last**

Choose “Last” from the View menu to restore the previous view of your plot. With this command, you can step backward through resizing and repositioning a plot. Tecplot RS remembers the last fifteen view changes, including zooming, centering, translating, or fitting, for each frame.

**3 - 2.6 Center**

Choose "Center" from the View menu to center the plot within its frame. This command centers only the data, neglecting text, geometries, and 3D axes. Neither axes or plot change in size with this command.

**3 - 2.7 Fit Everything**

Choose “Fit Everything” from the View menu to resize the plot so that all data, text, and geometries fit visibly in the frame. You can also fit everything by pressing Ctrl-E. This view can be useful to restore a standard view of your plot after extensive zooming, scaling, or translating.

**3 - 2.8 Fit Data**

Choose “Fit Data” from the View menu to resize the plot so that all data points fit visibly in the frame. This command ignores text and geometries when resizing. You can include the text by setting the text to be positioned by grid coordinates (in the Text Details dialog).

**3 - 2.9 Copy View**

Use “Copy View” in the View menu to copy the active frame view; you can then paste the frame view into another frame. The copied view includes all view attributes affected by the View menu: zoom position, translation, scale, and (in 3D grid plots) the degree of rotation and perspective projection.
3 - 2.10 Paste View
Choose “Paste View” from the View menu to paste a copied view onto the active frame (click on the frame you wish to copy the view onto first to make it the active frame). When working with multiple frames in one plot type, this command (and the Copy View command) can help make you more efficient, since you can make view changes to one frame and then copy and paste those changes to the other frames in your plot.

3 - 2.11 Custom 3D View
Use the commands Save Custom 3D View and Apply Custom 3D View to save the current view (rotation, center, and perspective) and to reset the current view to the saved settings. The Reset View toolbar button can also be used to apply the saved view. Available only when a 3D plot is active. See “Custom 3D View” on page 257 for further details.

3 - 2.12 Workspace Commands
The View menu contains several advanced commands to optimize your viewing of the workspace. To type the keyboard shortcuts, hold down the Ctrl and Shift keys while pressing the corresponding letter key.

- **Fit Selected Frames to Workspace (Ctrl-Shift-F)**: Choose this command to resize all frames proportionally so that the selected frame(s) fill the workspace either vertically or horizontally.
- **Fit All Frames to Workspace (Ctrl-Shift-A)**: Choose “Fit All Frames to Workspace” or type the keyboard shortcut to resize all frames proportionally so that all frame(s) fill the workspace either vertically or horizontally.
- **Fit Paper to Workspace (Ctrl-Shift-P)**: This command resizes the paper to fill the Tecplot RS workspace.
- **Last Workspace View (Ctrl-Shift-L)**: Choose this command to restore the workspace to the previous view. This command undoes the last “Fit Selected Frames to Workspace” or “Fit All Frames to Workspace” command.

3 - 2.13 View Presets
When viewing 3D grid plots, you can access additional advanced commands in the View menu. The View Presets in the View menu control preset rotations. Choose “View Presets” from the View menu to choose from 4 standard orthographic projections or a plan (aerial) view.

3 - 3 Using the Edit Menu
You can duplicate frames, text, and geometries with the copy and paste commands in the Edit menu. (You can also use the keyboard equivalents, Ctrl-C and Ctrl-V.) You can also cut objects from one location and paste them into another, or throw them away completely (by choosing “Clear” from the Edit menu).

- **Cut**: Choose “Cut” from the Edit menu, or press Ctrl-X, to remove the selected item from the plot and the active data set (if applicable), and store the removed item in Tecplot RS's memory for pasting within Tecplot RS.
- **Copy**: Choose “Copy”, or press Ctrl-C, to store the selected item in Tecplot RS's memory for pasting within Tecplot RS.
Tecplot RS Workspace Features

- **Paste** Use the “Paste” command in the Edit menu, or press Ctrl-V, to add the most recently cut or copied item to the active frame. If you are pasting a copied object into the same frame as the original, Tecplot RS will position the new object directly over the original. Use the Selector or Adjustor tool to move the copied item to a new location in the frame.
- **Clear** With the “Clear” command in the Edit menu, you can remove the selected item from the plot and the active data set. Tecplot RS does not store cleared items in its memory for pasting.

3 - 4 Using Color in Your Plot

You can change the color of many attributes of your plot. Often, this is done using a drop-down list right next to the setting whose color you wish to specify.

For example, in the Plot Options dialog shown here, there are drop-down lists for specifying the colors of lines and symbols.

In some places, you may use the **Color Chooser** dialog. Use the **Color Chooser** dialog to apply another color to the selected plot attribute. The place of access determines the element in your plot for which the color applies. For example, if you open the **Color Chooser** dialog from the **Text Details** dialog, the chosen color will apply to the currently selected text.

To change the color of the selected object, simply click on the color you wish the object to appear.
Part 2 XY Plots
**Basic XY Plots**

When you load an XY data file, it displays by default as an XY Variables plot type. You can change the plot type at any time using the Plot Type menu or the Plot Type menu at the bottom of the sidebar. Tecplot RS supports the following basic XY plot types:

- **XY Variables** XY variable plots depict a single X-axis (independent) variable with up to five Y-axis (dependent) variables. The axis variable selections are applied to all entities.
- **XY Entities** XY entity plots depict an entity or group of entities plotted for single XY axes variable pair.
- **XY Subsets** XY Subset plots display all of the components of a single well, user group or branch at one time (for a single variable).
- **XY Freestyle** XY Freestyle plots allow you to manually specify the components of your plot.

This chapter contains a discussion of each of the above plot types and examples for each type.

### 4 - 1 Loading XY Data

Tecplot RS allows you to load as many XY data sets as your computer’s memory will allow, and supports several different XY data set formats, including those used by Eclipse, Chears, VIP, Sensor, CMG, Landmark, and UTCHEM. The VIP .plt and VDB loaders include the capability to read compositional plot data.

CMG-format files are supported only on Windows.
Basic XY Plots

You can use multiple data sets for comparison or to switch from one to another. For example, you can load Chears HIST files for comparison with Eclipse .unsmry files. For a complete description of the supported formats, refer to Section K - 1 "XY Data Files".

When loading a CMG-format data file, you can choose the units for the file from Tecplot RS’s Options menu using the CMG System Units menu item. You must choose the desired units before loading the data. This choice is saved in the project file and your most recent choice will be remembered for future use. All files in a project must use the same units.

To start creating an XY plot in Tecplot RS, load a data set. Tecplot RS supports two methods of loading XY data. The first, and most comprehensive method, is the Load XY Data dialog, accessible by clicking the Load XY Data button in the toolbar or choosing "Load XY Data" from the Project menu.

In the Load XY Data dialog, choose Individual Files or VDB Folder from the File type menu to specify the type of XY data file to load. Use the Individual Files choice to load all types of XY Data Files except for VDB folders. In that case, use the VDB Folder choice.

The second method optimizes data loading if you wish to load a large number of XY data files. You can drag a folder containing XY data files onto the Tecplot RS icon on your desktop (Windows platforms) or drag the folder onto the Tecplot RS application window.

The following sections explain each method.

4 - 1.1 Loading a Folder of XY Data Files

To load multiple XY data files most efficiently, drag and drop a folder containing XY data files onto either the Tecplot RS icon or onto the Tecplot RS application window. Tecplot RS loads the following recognized XY data files contained in the dragged folder:

- Eclipse (*.unsmry and *.uns)
- Chears HIST (*.hist)
- Intersect Observed History data (*.obsh)
- Eclipse/VIP RFT (*.rft, *.frft)
- Eclipse USER (*.user)
- VIP plt (*.plt)
- VIP Observed Data (*.obs)
- Log ASCII Std (*.las)
- CMG .irf, .mrf, .sr3 files
- Sensor well production data (*.61)
- Landmark VDB cases (if the folder has “VDB” in its name)
- UTCHEM (*.OVERAL and *.HIST#)

This load operation adheres to the following rules:

- Loading the folder of data will not unload any loaded data; Tecplot RS adds the files to any already loaded data.
Loading XY Data

- If the current project has loaded data, the active data set does not change. If the current project has no loaded data, the first file loaded from the folder becomes the active file.
- If some files in the folder are already loaded into Tecplot RS, Tecplot RS will keep these files loaded and will load the remaining recognized files in the folder.
- If a file with an .rft, .frft, .waf, or .rswaf extension has a base name matching the base name of another data file in the folder, Tecplot RS appends this file as secondary data (RFT or WAF, depending on the extension) to the data file with the matching name.
- If the folder name includes “VDB”, Tecplot RS loads all cases recognized in the file, as well as other XY data file types (VIP, Observed, and compositional).
- Tecplot RS does not load data from any folders contained within the dragged folder, except for VDB cases.

To stop loading a folder of XY data files, click the Stop button in the status line of Tecplot RS.

You can also load a folder of these XY data file types from the command line, by navigating to the bin folder of the installation and then using the following syntax:

tecplotrs %data%/folder-to-load

In this example, include the path to the bin folder of the Tecplot RS installation if you did not first navigate to that location via the command line. Typing tecplotrs will launch Tecplot RS, and including the folder that you wish to load, represented by folder-to-load (including its path, represented by %data%), will indicate to Tecplot RS the folder that you wish to load. If the path to the folder to load or the folder name itself contains any spaces, enclose the entire item in quotes.

Tecplot RS processes the command line arguments in order. So, for example, if you wish to include other arguments in the command line, such as a macro to run, list the folder to load before the macro.
Basic XY Plots

4 - 1.2 XY Data Files

Choose “XY Files” from the File type menu in the Load XY Data dialog to load individual XY data files or a VDB folder of XY data. (Access the Load XY Data dialog by choosing “Load XY Data” from the Project menu.)

The Load XY Data dialog has the following options:

- **Add** Click the Add button to launch the Open Files dialog, which will allow you to choose the data file(s) you wish to load. In the Open Files dialog, navigate to and choose the desired file(s). Click the Open button, and then click OK in the Load XY Data dialog to complete the loading process. You may click Add again to add files from a different folder. Each time you click Add, the files you select are added to the list of files to be loaded.

- **Enable reload** Toggle on “Enable reload” in the Load XY Data dialog to allow reloading of the data file (Eclipse .unsmry) during your Tecplot RS session. If you toggle on “Enable reload” when loading your data set, you can reload the entire data file at any time by clicking the Reload button on the sidebar. This helps when you want to monitor the output from a long simulator run. When the Reload button is clicked, the entire file will be reloaded, and you can view the most recent output during the run.

- **Auto-append secondary (RFT and WAF) files** Toggle on “Auto-append secondary (RFT and WAF) files” in the Load XY Data dialog to automatically append RFT and/or WAF files to the data set. If you toggle on this option, for each Eclipse .unsmry file that Tecplot RS loads, it loads an RFT file (with either an .rft or .frft extension) and/or a WAF file (.waf or .rswaf extension) having the same root file name, if found, and appends it to the corresponding Eclipse .unsmry file. With RFT data loaded, you can create Quick RFT plots (see Section 14 - 2.2 “Depth”).

If you want to load both XY and grid data from a single simulation, you can do this through the Load Grid Data or Load VDB Data functions. See “Loading Grid Data” on page 131 for details.
If you load only an RFT or WAF file with data already loaded, Tecplot RS will automatically append the RFT or WAF data to the corresponding .unsmry file. Refer to Section 6.1 “Loading RFT Data” for information on loading an RFT Data file separately. In brief, click the Add button in the Load XY Data dialog, and choose *.rft as the file extension in the Open Files dialog.

The auto-append checkbox also applies to .unsmry files loaded by dragging them into the Tecplot RS application window or onto the Tecplot RS icon. The state of this checkbox persists between RS sessions.

Create history data set
If you load an Eclipse file with this control toggled-on, Tecplot RS will create a data set consisting of all the history data contained in the Eclipse file. This way, you can use the file to compare simulation data to history data when using the history match feature in your reservoir model. Tecplot RS creates and reads this history data set from the Eclipse file; it does not require the creation of a new data file. If you save data loaded with a created history data set as a project, Tecplot RS will re-create the history data set when you re-open the project.

If you have Tecplot RS create a history data set from the data in an Eclipse file, when you finish loading, Tecplot RS will prompt you to choose the active data set, since you now have more than one loaded.

A good way to compare your simulator data with the history data is to use the History Match plot type.

Load derived vars (when available)
If you load a file with this checkbox activated, Tecplot RS automatically computes additional variables from the variables stored in the data file, where this supported by the loader. For example, most CMG files do not include rates or ratios; where these variables are missing, they will be calculated from the cumulative variables. Loading will be somewhat slower with these additional calculations performed. Inside Tecplot RS, derived variables are indistinguishable from variables that were actually read from the file.

4.1.3 VDB Folder
Choose “VDB folder” in the File type menu of the Load XY Data dialog to open a VDB. To open the Load XY Data dialog, choose “Load XY Data” in the Project menu.

Data from the following class types can be loaded into Tecplot RS from within a VDB folder:

- WELL
- WLLYR
Basic XY Plots

- AREA
- REGION
- FIELD
- FLOSTA
- GATHER
- TRACER

The Load XY Data dialog for a VDB folder has the following options:

- **Browse** Click the Browse button to launch the **Browse For Folder** dialog, which will allow you to choose the VDB folder from which to load case data. Choose the root VDB folder (this folder typically ends in a `.vdb` extension).
- **Case** When you load a valid VDB folder with the Browse button, the Case region of the dialog will display a list of case names read from the database. Choose one or more cases to load. Data from different cases will be loaded as different data sets in Tecplot RS.
- **Data types (Optional)** Use the Load VIP Case Data, Load Compositional Case Data, and Load Observed Case Data, and Quick Load options to specify which sets of XY data to load from the database. (Quick Load reads only field, well, and region data and skips loading completions and network connections.) If you choose to load multiple types of data, each data type will be loaded into a separate data set in Tecplot RS.

4 - 1.4 Loading History Data

Tecplot RS provides several ways to load history data. You can load a CHEARS HIST file (`.hist`), load an Eclipse file containing history data, or create an ASCII file. If you use the History Match plot type, you can choose which data file to use as the history data in the Plot Controls sidebar.

- **Chears or Intersect History File** To load a Chears or Intersect history data file (wells only), click the Load XY Data button in the toolbar (or choose “Load XY Data” in the Project menu) to open the Load XY Data dialog. Click the Add button in that dialog, and choose “Chears HIST (*.hist)” or “Intersect OBSH (*.obsh)” as the file type to load. Navigate to and select the file and click Open and OK to finish loading it.

- **Chears CSV File** You can create a CSV file of history data and load it as the “Chears CSV (*.csv)” file type. With this file type you can include wells, fields, groups, and regions, rather than just wells. To create this file type, use a spreadsheet program such as Microsoft Excel and create a table of your data. The file should include one header row labeling the following required columns:
  - **Date or Time** Use one column to give each row a date or time. Tecplot RS accepts most standard date and time formats.
  - **Category** In this column, label each row “Well”, “Group”, “Field”, or “Region”.
  - **Name** Include the name of the entity
  - **Variable** value Name the variable in the header row and give the entity’s value for it in its row.

Save the file as a CSV (*.csv) file and load it into Tecplot RS through the **Load XY Data** dialog.

- **Eclipse Data File Containing History Data** If you load an Eclipse file with the “Create history data set” control turned on, Tecplot RS will create a data set consisting of all the history data contained in the Eclipse file. This way, you can use the file to compare simulation data to history data when using the history match feature in your reservoir model. Tecplot RS creates and reads this history data set from the Eclipse file; it does not require the creation of a new data file. If you save data loaded with a created history data set as a project, Tecplot RS will re-create the history data set when you re-open the project.
Managing XY Data

• ASCII Data File You can create an ASCII file of your history data (wells only). For more information on how to build this file, see XY Data Files: “Generic ASCII Files”.

After you load your data, a good way to compare your simulator data with the history data is to use the History Match plot type.

4 - 1.5 Additional Information about XY Data

Please note the following points regarding XY Data:

• Undefined Values Tecplot RS recognizes -999999 as an undefined value. Data points with a value of -999999 are treated as zero when plotted and ignored during any routine that uses minimum or maximum values.

• Online Variable For XY data with field data, Tecplot RS creates a variable called ONLINE. The ONLINE variable stores a count of all wells that have OPR (or any appropriate alias) greater than zero at a given time step.

4 - 2 Managing XY Data

If you load a single data file, that file will display as the Active Data Set. Otherwise, the first file you selected of multiple files will display as the Active Data Set. You can manage your currently loaded data sets by clicking the Manage Data button in the toolbar, or choosing “Manage Data” from the Project menu. Switch to the XY page of the Manage Data dialog to manage XY data sets.

4 - 2.1 XY Data Settings

The XY page of the Manage Data dialog offers the following options:

• Display As - Optional After loading your data file(s), you can use the Display As text field on the XY page of the Manage Data dialog to designate a display name for the Active data set.
**Basic XY Plots**

The display name will display instead of the file name in your plots. The file name will display if the Display As field contains no name.

You must click the Update button to save your changes to the Display As field.

- **Available Data Sets** - The available data set area displays information about the number of wells, groups, and other related information. To change active data sets on the XY page of the Manage Data dialog, choose the desired file name in the “Available Data Sets” region of the dialog. This will highlight the Active Data Set in the “Available Data Sets” list.

4 - 2.2 Unloading Data Files

Use the Unload page of the Manage Data dialog to unload data files from Tecplot RS. To conserve memory you can selectively unload data. Choose the files to unload and click the Unload Highlighted Files button.

If you unload a file that acts as part of an XY Freestyle plot, Tecplot RS will delete any line mappings from the data file from the plot(s).

4 - 2.3 Swapping Data Files

You can exchange any loaded data file for another by using the Swap Files dialog, accessible from Project>Swap Files. This is particularly useful for plots in the Plot Gallery and for XY Freestyle plots, which are tied to a specific data set. For complete information on using this dialog, see “Swapping Data Files” on page 149.

4 - 2.4 Writing XY Data

By choosing “Write XY Data” from the Data menu, you can create ASCII text files containing data from the displayed XY plots. This option will be available only when the current plot is an XY line plot. The Write Data dialog appears when you choose this option.

Start by clicking the Open File button to display a standard file opening dialog from which you can either choose an existing file or provide the name of a new one. If the file exists, you will be given the option of replacing it or appending to it.

You can also choose the Value Separator. Commas are usually the best choice, particularly if your goal is to load the data into Excel or other spreadsheet applications. Tab and Space are other options.

All values of variables shown in all frames of your current plot are exported to the specified file. What you see is what will be written to the file, so use the sidebar options to choose variables, entities, comparison options, delta computations, etc.
When using the XY Custom plot type, the output may not include some of the headings that identify the data being output. Although the tool may be used with this plot type, you will have more complete data with the others.

When you have the desired data on your screen, press the Write Data button to output those values to the file. The data being written appears in the Write Data dialog as well as being written to the file.

You can continue to append to the selected file by choosing additional plots to be displayed and pressing Write Data again. You can also open a different file at any time and begin writing to it.

When exporting to Excel, it can be useful to have a date format it can interpret correctly. By default, RS outputs dates as a decimal year. However, you can get more descriptive date information by choosing a formatted date option in Plot Options, as shown here.

4 - 3 Aligning Start Times

XY plots are often generated with a date or time variable on the X-axis so that you can see the value of variables over time for one or more entities, such as wells. It is often convenient to align the date or time that entities started production so that you can see how they compare to each other over their lifetimes. However, creating the plot with a date or time variable on the X-axis will show the production curve of each entity at the date or time it actually started production.

To align the start time of the entities, use the “Solve pTime” command on the Data menu and select a production variable, such as OPR, that becomes non-zero when a well or other entity begins production. A new variable called “PTIME” (for Production Time) is created that represents the time since an entity began production. You may then use this variable on the X-axis to produce a plot in which the start times of the selected entities are aligned.

4 - 4 Common Controls

You can choose from a variety of XY plot types and plot customization choices to achieve your desired plot display. Explore the buttons in the sidebar and the Options menu for the bulk of plot customizations.
Basic XY Plots

4 - 4.1 Common Sidebar Controls
Each XY plot type includes the following controls in the Plot Controls sidebar:

- **Drawing Layers** Use any combination of the Lines and Symbols toggles to adjust an XY plot.
- **Reload** Click the Reload button at any time to refresh your data set.

The Reload option is available only if “Enable reload” was toggled-on in the Load XY Data dialog during the file loading process. See Section 4 - 1 "Loading XY Data" for more information.

- **Filter** To manage the entities, such as wells, groups, and fields, shown in the Entities list, use the Filter button. Refer to Section 7 - 1 "Filtering" for more information.
- **Expanded List button** Whenever you see the Plus button, next to a list in the sidebar or a dialog, you can click this button to open an expanded version of the list contents. To find an item in the list more easily, you can type letters in the Filter field at the top of the list. Only items that include those letters in that order will appear in the expanded list. For example, to display only items with the word “well” in their name, type “well” into the Filter field.

4 - 4.2 Common Axes Controls
You can customize most cosmetic aspects of your plot display by using the Plot Options dialog. To open this dialog, choose “Plot Options” from the Options menu.

Tecplot RS supports time and date axis formatting for XY Line plots. When “Time” or “Date” is selected as a variable in the sidebar, the appropriate axis will display with Time (Days) or Date (Years) formatting. You can customize the date or time format using the Load/Save page of the Plot Options dialog.

For more information on the Plot Options dialog, and other methods of customizing your plot display, see Appendix F: “Plot Options”.
**4 - 5 XY Variables**

An XY Variables plot depicts a single x-axis (independent) variable with up to five y-axis (dependent) variables. The axis variable selections applies to all entities. To create an XY variable plot, load an XY data file and choose “XY Variables” from the Plot Type menu in the sidebar.

You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words "Plot Controls"). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.

The sidebar for XY Variable plots has the following options:

- **Lines and Symbols** Use any combination of the Lines and Symbols controls to customize whether to display lines and/or symbols for each line in your XY plot.
- **Reload** Click the Reload button at any time to refresh your data set.

The Reload control is available only if “Enable Reload” was selected in the **Load XY Data** dialog during the file loading process. Refer to Section 4 - 1 "Loading XY Data" for additional information.
Basic XY Plots

- **Filter** To manage the entities shown in the list, use the Filter button. Refer to Section 7 - 1 “Filtering” for more information.

- **Entities** The Entities box allows you to select wells and other structures to display. Use the scrolling tools (< or >) to move through the entity list. See Paging: Animation and Scrolling Controls for additional information. To select a specific entity from a long list of entities, click the button in the upper-right corner of the Entities box. This will launch an expanded entity list that you can filter to find an entity.

The variables highlighted in the Variables section of the sidebar will display for the selected Entity.

When you have multiple frames displayed, the selected entity displays in the first frame, and subsequent entities display in subsequent frames.

- **Variables** Use the Variables section of the sidebar to specify the axes variable assignments.
  - **X-axis** Use the X menu to choose the X-axis variable. Tecplot RS allows only one variable displayed at a time for the X-axis.
  - **Y1-axis** The Y1 box allows you to select multiple variables for Tecplot RS to plot against the Y1-axis. When plotting multiple variables with different value ranges or units, try using two or more Y-axes with different scales.
  - **Y2-5 Axes** Use the Y2-5 menu to specify for which of the available axes you wish to customize the variables. When no variables are selected for an axis, that axis does not display. To deselect a variable, hold down the Ctrl key while clicking on the appropriate variable. Remember, a single variable cannot display on more than one Y-axis.

To make multiple selections in a box, use any of the following methods:

- **To choose two or more consecutive items** Drag your pointer from the first item you wish highlighted to the last item, or click the first one and hold down the Shift key while clicking the last item.

- **To choose two or more non-consecutive items** Hold down the Ctrl key and click the desired items.

- **To un-select a single item** Use Ctrl-click.

- **Zoom Lock** The lock icon next to the X menu can be engaged to hold the active frame’s X-axis range (zoom) when switching to XY Subsets or XY Entities plots. It is disengaged automatically when the X-axis variable is changed.

**Data Set** The Data Set region of the sidebar allows you to compare data when you have multiple data files loaded. Refer to Chapter 10: “Comparing XY Data” for additional information.
An XY Entity plot depicts a set of entities for a single X-axis and Y-axis variable pair. For example, you can compare oil production for a selected set of wells in one plot.

To create an XY Entities plot, load an XY data file and choose “XY Entities” from the Pot Type menu at the bottom of the sidebar.

The sidebar for XY Entity plots has the following options:

- **Lines and Symbols** Use the Lines and Symbols controls to customize your XY plot.
- **Reload** Click the Reload button at any time to refresh your data set.

The Reload control works only if “Enable Reload” was selected on the Load XY Data dialog during the file loading process. Refer to [Section 4 - 1 "Loading XY Data"] for additional information.
Basic XY Plots

- **Filter** To manage the entities shown in the list, use the Filter button. Refer to **Section 7 - 1. "Filtering"** for more information.
- **Variables** Use the Variables section of the sidebar to specify the axes variable assignments.
  - **X-axis** Use the X menu to choose the X-axis variable. You can choose only one X-axis variable.
  - **Y-axis** Use the Y-axis box to choose a Y-axis variable. You can choose only one Y-axis variable.
- **Zoom Lock** The lock icon next to the X menu can be engaged to hold the active frame’s X-axis range (zoom) when switching to XY Subsets or XY Variables plots. It is disengaged automatically when the X-axis variable is changed.
- **Scrolling** Use the animation control buttons to scroll through the available Y-axis variables. See **Paging: Animation and Scrolling Controls** for additional information.
- **Entities** The Entities box allows you to select wells and other structures to display.
  - **Sum** Toggling on “Sum” allows you to sum the variable being plotted for all entities that have been chosen.
  - **Avg** Toggling on “Avg” to show the average value for all chosen entities.
  - **Ignore 0 Values** When displaying averages, toggle-on to ignore zero values.

When you have either Sum or Avg toggled-on, Tecplot RS cannot display comparison data. See Chapter 10: “Comparing XY Data”.

The variables selected in the Variables section of the sidebar will display for the selected Entity. Click the **Entity [1-9]** button to launch an expanded, searchable entity list. This helps for long lists. When you have multiple frames displayed, the selected Y-axis variable displays in the first frame, with subsequent variables in subsequent frames.

- **Data Set** The Data Set region of the dialog allows you to compare data when you have multiple data files loaded. Refer to Chapter 10: “Comparing XY Data” for additional information.

The settings for “Entity [1-9]” in your RS Variables Files file determines the default styles (for example, line color, and symbol shape) that your plot displays. You can change any of the default styles by either updating the file or changing the settings for “Entity [1-9]” (long variable names) or “ST [1-9]” (short variable names) on the XY Lines page of the Plot Options dialog. Double-click on the line in your plot to bring up the appropriate page of the dialog.
4 - 7 X Y Subsets

The XY Subsets plot type allows you to view all of the components of a single well, user group or branch at one time (for a single variable). It is available for data sets that contain entities with subsets, such as completions, segments, branches and user groups. Completion and segment data depend on the simulator output. You can create User Groups, Well Patterns, and Branches using the User Group/Branch dialog (accessed via the Data menu).

In an XY Subset plot, you can view information for one entity at a time. When you select the entity, a plot line is created for each component of the entity.

The sidebar for XY Subset plots has the following options:

- **Lines and Symbols** Use the Lines and Symbols controls to customize your XY plot.
Basic XY Plots

- **Reload** Click the Reload button at any time to refresh your data set.

  The Reload control is available only if "Enable Reload" was selected on the Load XY Data dialog during the file loading process. Refer to Section 4 - 1 "Loading XY Data" for additional information.

- **Variables** Use the Variables section of the sidebar to choose axes variable assignments, by clicking on a variable.
  - **X-axis** Use the X menu to choose the X-axis variable. You are limited to a single selection.
  - **Y-axis** Use the Y box to choose a Y-axis variable. You are limited to a single selection.

- **Zoom Lock** The lock icon next to the X menu can be engaged to hold the active frame's X-axis range (zoom) when switching to XY Variables or XY Entities plots. It is disengaged automatically when the X-axis variable is changed.

- **Scrolling** Use the animation control buttons to scroll through the available Y-axis variables. See Paging: Animation and Scrolling Controls for additional information.

- **Entities** The Entities region of the sidebar displays the available wells, user groups and branches. The number in parentheses after the well name indicates the number of completions and/or segments included in the well.
  - **Sum** Toggle-on “Sum” to sum the currently plotted variable plotted for all chosen entities.
  - **Avg** Toggle-on “Avg” to show the average value for all selected entities.
  - **Ignore 0 Values** When displaying averages, toggle-on to ignore zero values.

The variables selected in the Variables region of the sidebar will display for the selected Entity. Click the button to launch an expanded, searchable entity list. This helps for long lists.

When you have multiple frames displayed, the selected entity displays in the first frame, and subsequent entities in subsequent frames.

Use the scrolling tools (< or >) to move through the entity list. Tecplot RS will plot the same set of variables for each entity. See Paging: Animation and Scrolling Controls for additional information.
4 - 8 XY Freestyle

Compared to the other XY plot types, the XY Freestyle plot type provides greater control over the style and content of your plot. It allows you to create multi-page, multi-frame output, where each frame can contain a unique plot.

For each line map within a frame, you can choose the data file, entity, X-axis and Y-axis variables, Y-axis number, and plot style. For example, you can create a page containing two frames, with the first frame containing content similar to an XY Variables plot and the second frame containing content similar to an XY Entities plot. Within each of those frames, you can manually override the style settings of each line map. However, because of its flexibility, XY Freestyle cannot offer the same level of automation and animation features that other XY plot types can.

The XY Freestyle plot allows plotting entity and variable combinations not possible in other XY plot types. For example, in this plot type, you can plot oil production rate for a group of wells, and include a line map of water injection rate for an associated injector in the same plot.

This plot type also functions well when you would like to compare entities or variables between two or more data files that have different entity or variable names. This often occurs when comparing simulator results and observed data. If the entity or variable names are identical between the files, you may instead want to use the “Compare” toggle in the sidebar for XY Variables or XY Entities plot types (refer to Chapter 10, “Comparing XY Data” for details).

Each XY Freestyle line plot is tied to a particular data set. If you have created complex plots in XY Freestyle and wish to change the referenced file, you can do so using Project>Swap Files. See “Swapping Data Files” on page 149 for further details.

4 - 8.1 Creating an XY Freestyle Plot

To create an XY Freestyle plot, follow this general procedure:

1. First, load one or more XY data files (refer to Section 4 - 1 “Loading XY Data”).
2. If you wish to use multiple frames on a single page, we recommend that you first visit the Multi-Frame Options dialog (accessed with the button in the sidebar) to set the default frame layout for new pages. You do not have to do this; XY Freestyle has its own frame manager to allow you to create different frame layouts for each page. However, the options in the Multi-Frame dialog control the initial frame count and layout for each new page of freestyle plots. You will be able change those easily.
3. In general, if you are currently recording a macro, stop. Most steps to create XY Freestyle plots are not recorded in macros; only the plot type and page number are recorded. (Don’t worry: you will still be able to return to any XY Freestyle plot you created as long as you have saved your project file.) Most of the time we recommend that macro recording be turned off during creation of the XY Freestyle plots.
4. Choose “XY Freestyle” from the Plot Type menu or the sidebar.
5. Before adding line mapping(s) to the first frame in your plot, check the Type menu in the Line
Style region of the sidebar. This region of the dialog allows you to specify how the initial line
style is controlled.

Make any changes necessary here before proceeding:

- **Variable** If you plan to plot multiple variables for the same entity (similar to an **XY
Variables** plot), choose “Variable” from the Type menu. In this case, Tecplot RS will read
the initial style settings for each variable from the settings for that variable on the **XY
Lines** page of the **Plot Options** dialog.

- **Entity** Otherwise, if you plan to display the same variable for multiple entities (similar
to an **XY Entities** plot), choose “Entity” from the Type menu. In this case, Tecplot RS will
read the initial style settings for each entity from the settings for that entity on the **XY
Lines** page of the **Plot Options** dialog. The settings for a given entity display when
“Entity” (long variable names) or “ST” (short variable names) is selected in the
Variable region of the dialog. (Entity 1/ST1 corresponds to the first entity in your plot,
and so forth.) Refer to Section F - 3 “XY Lines” for additional information.

6. Decide how many frames you want displayed on the current page. You may have a different
number and layout for each page, and you can change both the number and arrangement at
any time. To start, click the [+ ] button next to the Frame counter until you get the desired
number of frames. Then, choose one of the layout buttons to arrange the frames. Finally,
choose the frame you want to edit by either clicking on it with the mouse pointer or using the
spin control to choose the frame number.

7. If you loaded more than one XY data file, choose the source file for your first mapping from
the File menu in the sidebar.

This action populates the Entities list, below, with the entities belonging to the chosen data set.
8. Select the entity for your mapping in the Entities box. To select a specific entity from a long list of entities, click the button in the upper-right corner of the Entities box to launch an expanded, searchable entity list.

This action populates the Variables list, below, with those variables associated with the chosen entity type.

9. In the Variables region of the sidebar, choose the X-axis variable and Y-axis variable. Use the Axis menu to choose the axis number to use for the Y-axis variable.

10. Refer to Section 4 - 8.2 “Customizing the Line Styles for XY Freestyle” for information on changing the style settings for each line mapping.

11. To add additional lines to your plot, click the + button next to Line in the sidebar and repeat steps 6 through 9 for each line.

12. To add more frames to your plot, use the +/- buttons next to “Frame” in the sidebar.

Refer to Section 4 - 8.3 “Working With Multiple Pages, Frames and Mappings” for details.

13. To add more pages to your plot, use the +/- buttons next to “Page” in the sidebar.

Refer to Section 4 - 8.3 “Working With Multiple Pages, Frames and Mappings” for details on working with multiple frames.

When you create a new page, Tecplot RS will arrange blank frames according to the settings in the Multi-Frame Options dialog.
14. To save your XY Freestyle plot(s), you must create a project file. Projects contain XML instructions that define the set of XY Freestyle plots. Refer to Chapter 21: “Projects” for details. Your re-loaded project file will include all your XY Freestyle plots, which you can then view and/or modify.

4 - 8.2 Customizing the Line Styles for XY Freestyle

The style of a given line is determined by its settings for both the line and its symbols. The available line styles include color, pattern, length and thickness. The available symbol styles include shape, size, spacing, color and fill-type.

You can customize the styles using either the Plot Options dialog (linked to RS Variables Files) or the Mapping Style dialog. The scope of the style changes depends upon the method used. When you save the style file, you may make any changes made in the Plot Options dialog for a given variable or entity available for future sessions of Tecplot RS. Changes made in the Mapping Style dialog apply to the current line only. You can only use the Mapping Style dialog with the XY Freestyle plot type.

Changing Line Styles With the Plot Options Dialog and the Sidebar

When adding a line to your plot, the style of the line depends upon your selection in the Type menu in the Line Style region of the XY Freestyle sidebar. With “Variable” selected, Tecplot RS will use the settings for each variable on the XY Lines page of the Plot Options dialog for each variable’s initial style settings. With “Entity” selected, the initial style settings for each entity will be taken from the settings for that entity on the XY Lines page of the Plot Options dialog. The settings for a given entity are displayed when “Entity” (long variable names) or “ST” (short variable names) is selected in the Variable region of the dialog. Entity 1/ST1 corresponds to the first entity in your plot and so forth.

You can change the default settings for variables and entities at any time on the XY Lines page of the Plot Options dialog. Refer to Section F - 3 “XY Lines” for additional information. If you would like to apply any changes to your current mappings, you will need to re-apply them with the Line Style: Apply To option in the sidebar.

You can use the Line Style: Apply To menu to switch between the “Variable” and “Entity” types at any time. You have the option to change the style settings for:

- **New Lines** Select “New Lines” to apply new style definitions to new line mapping(s).
- **Current Lines** Select “Current Lines” to apply new style definitions to the line mapping(s) you have selected with your pointer.
- **Active Frame** Select “Active Frame” to apply new style definitions to all of the lines in the active frame.
- **All Frames** Select “All Frames” to apply new style definitions to all of the lines in all of the frames on the current page.

For example, if you apply the Entity style to new lines, and then determine that the Variable option would be a better choice, you can update the line to use the new style using the following steps:

1. Select “Entity” from the Type menu in the “Line Style” region of the sidebar.
2. In the Apply to box, select the lines to which you wish the changes to be applied.
3. Click the Apply button.

Changing Line Styles With the Mapping Style Dialog

When using the XY Freestyle plot type, you can also modify lines in your plot by using the Mapping Style dialog. Use the Lines and Symbols pages of the Mapping Style dialog to customize the line or symbol style of the selected line. Use the Definitions page of the dialog to specify whether to include each line in the legend.
Technically, the lines and symbols together create a map - thus, you can display a map of a relationship between a dependent and independent variable showing only symbols, only a line, or both. In the Mapping Style dialog, the first page (the Definitions page) controls both lines and symbols for each mapping. The Lines page controls only the line element of each mapping, and the Symbols page controls only the symbols of each mapping.

To open the dialog, double-click on a line (mapping) in your plot. To change an attribute, right-click on the attribute you wish to change. You can select and edit multiple lines/mappings simultaneously by dragging your pointer over them to select them and then right-clicking on the column you wish to change.

**Right-click on the attribute you wish to change, and choose the option you wish displayed from the context menu.**

The Definitions Page

On the Definitions page of the Mapping Style dialog, you can modify map names, activate and deactivate maps (both lines and symbols), assign axis variables, sort data points, control the maps’ appearance in the line plot legend, and assign particular X and Y axes to a line.

The Definitions page of the dialog includes the following controls.

- **Map Num**  Tecplot RS uses this number to identify the maps. You cannot edit this indicator of the line order.
- **Map Name**  Double-click on the name of a mapping to edit its name.
  
  By default, Tecplot RS assigns a name to each map that varies with the type of data used to create the line. Tecplot RS usually bases this name on the dependent variable chosen for the map. You can also construct a name by entering text combined with one or more pre-defined dynamic options:
  
  - **Zone Name**  Add &ZN& to the Map Name field to include the name of the zone assigned to that map.
  - **Zone Number**  Add &Z#& to the Map Name field to include the zone number assigned to that map.
  - **Independent Variable**  Add &IV& to the Map Name field to include the name of the independent variable assigned to that map.
Basic XY Plots

- **Independent Variable Number** Add \&I#\& to the Map Name field to include the number of the independent variable assigned to the map.
- **Dependent Variable** Add \&DV\& to the Map Name field to include the name of the dependent variable assigned to the map.
- **Dependent Variable Number** Add \&D#\& to the Map Name field to include the number of the dependent variable assigned to the map.
- **Map Number** Add \&M#\& to the Map Name field to include the number of the map.
- **X-Axis Number** Add \&X#\& to the Map Name field to include the number of the X-axis assigned to that map.
- **Y-Axis Number** Add \&Y#\& to the Map Name field to include the number of the Y-axis assigned to that map.

**In addition to the above items, any dynamic text item can be added to the Map Name field. See Section D - 4.6 “Dynamic Text” on page 365 for more information on dynamic text.**

- **Map Show** You can choose whether to display each map (both lines and symbols) by toggling this control on or off. You can turn on or off multiple maps by dragging to select them and then toggling on or off one of the selected lines.
- **X Axis Variable** Right-click and choose “Select Variable” to change the X-axis variable for the selected map(s). Choose the variable in the dialog that appears.
- **Y Axis Variable** Right-click and choose “Select Variable” to change the Y-axis variable for the selected map(s). Choose the variable in the dialog that appears.
- **Zone** Each map uses variable values from its zone in the data file. You cannot edit the zone.
- **Sort** By default, Tecplot RS sorts each map data points by the order in which they occur in the data file. You can change this order with the Sort control on the Definitions page:
  - **By Independent Variable** Choose this option to sort data points in ascending order of the values of the independent variable.
  - **By Dependent Variable** Choose this option to sort data points in ascending order of the values of the dependent variable.
- **Which X-Axis, Which Y-Axis** XY freestyle mapping (line) plots support five X-axes (X1-X5) and five Y-axes (Y1-Y5). Newly created maps use the X1 and Y1 axes. You can change these assignments using the Which X-Axis and Which Y-Axis controls on the Definitions page.
- **Mapping Style** The controls of the ranges and scales for each axis appear on the XY Axes page of the Plot Options dialog.
  - By default, the X1 axis displays at the bottom of the axis grid area, and subsequent X axes display at the top. Similarly, the Y1 axis displays by default on the left side of the axis grid area, and subsequent Y axes display at the right.
  - You can also use multiple axes to cycle through maps with different ranges or axis settings. You may find it convenient to assign different maps to different axes so that you can set axis ranges, positions, or other attributes independently for each map.
- **Show in Legend** By default, all shown maps appear in the map legend. However, the legend only lists maps with identical entries once. With this control, you can choose to display a map in the legend always, never, or only when shown.
  - **Always** If a map has “Always” chosen in this control, the map appears in the legend even when turned off or when its configuration looks exactly like another map.
  - **Never** If a map has “Never” chosen, the map will never appear in the legend.
**XY Freestyle**

- **Auto** Choose the “Auto” option to instruct Tecplot RS to show the mapping in the legend only when the map is shown. If two maps would result in the same legend, Tecplot RS will show only one of them.

**The Lines Page**

When the Line layer is toggled-on in the sidebar, all mappings in an XY Freestyle plot display as a line connecting each data point in each mapping (set of chosen independent and dependent variables). On the Lines page of the **Mapping Style** dialog (accessible by double-clicking any line in your XY Freestyle plot), you can adjust the appearance of the lines in your plot.

The first two columns on this page replicate the first two columns on **The Definitions Page** of the dialog. These columns list the number and name for each map. The remaining columns on the Lines page of the dialog contain specific line attribute settings.

- **Line Show** This control allows you to turn off lines for selected mappings, while keeping the mapping active (symbols can still display).
- **Line Color** Use this column to change the display color of a line.
- **Line Pattern** Use this column to customize the line pattern displayed for a mapping.
- **Pattern Length** Set the pattern length for patterned lines with this control. Tecplot RS measures pattern length as a percentage of frame height for one cycle of the pattern.
- **Line Thickness** Use this control to set the thickness of the selected lines.

**The Symbols Page**

When the Symbols layer is toggled-on in the sidebar, all mappings in an XY Freestyle plot display with symbols representing each data point in the mapping. (The symbols may or may not be connected by lines, depending on whether the Lines control is toggled on in the sidebar and the settings chosen on the
Basic XY Plots

Lines page of the dialog.) On the Symbols page of the Mapping Style dialog (accessible by double-clicking any line in your XY Freestyle plot), you can adjust the appearance of the symbols in your plot.

The first two columns on this page replicate the first two columns on The Definitions Page of the dialog. These columns list the number and name for each map. The remaining columns on the Symbols page of the dialog contain specific symbol attribute settings.

- **Symb Show** This Symbol Show control allows you to turn symbols on or off for selected mappings, while keeping the mapping active (lines can still display).
- **Symb Shape** Use this control to choose a symbol shape for each mapping.
- **Outline Color** Use this control to assign a color to the outline of the symbol.
- **Fill Mode** Choose whether to fill the symbols, and if so, designate the type of filling, with this control. You can choose from:
  - **None** Choose this option to display unfilled symbols.
  - **Use Line Color** Choose this option to display symbols filled with the same color as the symbol outline.
  - **Use Back Color** Choose this option to display symbols filled with the color of the background of the grid area, appearing hollow (thus obscuring any objects behind the symbol, such as grid lines or other mappings).
  - **Use Specific Color** When you choose this option, the symbols will display filled with the color specified in the Fill Color column.
- **Fill Color** Use this control to assign a color with which to fill the inside of the symbol. To use this control, Fill Mode must indicate “Use Specific Color”.
- **Symb Size** Use this control to specify the size of the symbols. Tecplot RS measures symbol size as a percentage of frame height.
- **Line Thick** Use the Symbol Line Thickness control to indicate the thickness of the lines used to outline the symbols.

In order to make changes on the Symbols page of the dialog, or for those changes to display in your plot, you must have the Symbols layer toggled-on in the sidebar.

To adjust any of these symbol controls, right-click on the attribute you wish to change to access the context menu.
• **Symb Spacing** Use the Symbol Spacing control to specify the spacing between symbols. Tecplot RS measures the spacing either as a percentage of frame height or as the number of indexes to skip. You can either enter a value or use a pre-set value:
  • **Draw All** Choose this option to have all symbols drawn at every data point.
  • **I Skip** = 2, 3, or 4 Choose this to instruct Tecplot RS to draw symbols at every second, third, or fourth data point.
  • **Distance** = 1, 2, or 3% Choose this to have symbols at the first data point and then subsequently at data points at least one, two, or three percent of the frame height distant from the previously plotted data point.
  • **Enter Index** Choose this option to type an index skip between symbols (use for skips other than two, three, or four).
  • **Enter Distance** Choose this option to type a distance between symbols in frame units (use for distances other than one, two, or three percent of the frame height).

**Map Creation**

To create a new line with the **Mapping Style** dialog, click the Create Map button to open the **Create Mappings** dialog.

The Create Mappings dialog contains the following controls.

• **Type of Line to Create** In the first region of the dialog, you can choose which type of line you wish to create.
  • **X-axis Var versus Y-axis Var for One Zone (default)** Choose this option to create a single line with one X and one Y variable for one zone.
  • **X-Axis Var versus Y-Axis Var for All Zones** Choose this option to define one line for each zone, with specified X and Y axis variables. If you choose this option, you only need to specify the X and Y axis variables.
  • **X-Axis Var versus All Other Variables** Choose this option to create a set of lines using one variable as the X variable and each of the other variables as Y variables.
  • **Y-Axis Var versus All Other Variables** Choose this option to create a set of lines using one variable as the Y variable and each of the other variables as X variables.

• **Mapping Name** Type a name for the line(s) in the Mapping Name text field. Tecplot RS defaults to “Map n”, where n represents the number of mappings it will create.

• **X-Axis, Y-Axis** Use these controls to choose the X and Y axis variables for the new line(s).

• **Zone** This control designates the zone to which the new line(s) belong. Usually you will not need to adjust this.

**Mapping Style Dialog Buttons**

Along with the Create Map button, the Mapping Style dialog includes a few other buttons to streamline your workflow.
Basic XY Plots

- **Copy Map** Click the Copy Map button to copy an existing, selected map, creating a new, identical map. This may streamline your map creation process, since you can adjust the copied map rather than creating a new one.
- **Delete Map** Click the Delete Map button to delete any existing, selected map.
- **To Top** Click this button to move a selected map to the top of the list of mappings in the \textit{Mapping Style} dialog.
- **To Bottom** Click this button to move a selected map to the bottom of the list of mappings in the \textit{Mapping Style} dialog.

4 - 8.3 Working With Multiple Pages, Frames and Mappings

The XY Freestyle plot type provides you with significant control over the overall layout of your plot(s) with pages and frames. Each page can have a different number of frames, as well as a different configuration of frames (for example, 2 X 3 versus 3 X 2). Similarly, each frame can have a different number of lines.

Use the + and - buttons to add or delete Pages, Frames or Lines from your workspace. Use the Page:Clr button to remove the lines from every frame on the current page. Similarly, you can use the Frame:Clr button to remove all of the lines from the active frame. The Export button provides an automated export (printing, file creation or animation) of all of the pages of your XY Freestyle plot (refer to Chapter E, “Printing and Exporting” for details).

If you plan to work with multiple frames on every page, we recommend that you first specify the number of frames you would like on the first page using the \textit{Multi-Frame Options} dialog (accessed with the Manage Frames button in the toolbar) before switching to the XY Freestyle plot type. Tecplot RS uses the settings in the \textit{Multi-Frame Options} dialog to establish the default number and positioning of the frames on each new page you create in XY Freestyle. However, these are easily changed from within the XY Freestyle sidebar as you work. Frames may be added or deleted using the + and - Frames buttons, and frame sizes and arrangements may be altered using the Arrange buttons or by simply moving and resizing the frames with the mouse.
Custom XY Plots

Tecplot RS provides two custom XY plot types: XY Custom Plot and XY Custom Entities.

The XY Custom Plot plot type allows you to choose the exact variables to plot and the order they should appear. For example, you can define a page with three frames, designate that frame one displays OPR and GPR, frame two shows WPR, and frame three shows cumulative oil production.

The XY Custom Entities plot type builds upon the XY Custom plot type by allowing you to specify which variables to plot and to plot multiple entities for each variable.

For both plot types, you can name and save custom plot configurations. This enables you to create different schemes for varying data sets or requirements.

5 - 1 XY Custom Plot

To create a custom plot, load an XY data file, and use the Custom Plot Options Dialog to specify which variables to plot. Launch the Custom Plot Options Dialog by clicking the Custom Options button in the sidebar or by choosing “Custom Options” from the Options menu.

After you have made your selections in the Custom Plot Options Dialog, use the XY Custom sidebar to further customize your plot. The XY Custom sidebar has the following options:

- **Filter** Use the Filtering dialog (accessed with the Filter button in the sidebar) to control the items appearing in the Entities box. A primary filter lets you choose entities by type, and a secondary filter lets you further limit the entities shown to only those you designate. The Filtering dialog also lets you sort the list by several different criteria, thus allowing you to control the order that entities are plotted.

- **Entities** The Entities box allows you to select wells and other structures which are part of a loaded data set. You can select one entity at a time. Click the button in the upper-right corner to launch an expanded, searchable entity list. This helps especially for long lists.

- **Paging** Use the Paging region of the sidebar to scroll through the available frames.

- **Custom Plot Options** Use the Custom Options button to launch the Custom Plot Options Dialog. You can use the Custom Plot Options Dialog to specify variables to plot and the number of frames to include in your plot.
Custom XY Plots

5 - 2  XY Custom Entities

The XY Custom Entities plot type is very similar to the XY Custom Plot plot type. The primary difference is that the XY Custom Entities plot type allows you to plot multiple entities at once. Because you can plot multiple entities at once, you can display only one variable per axis.

To create a custom plot, load an XY data file, and use the Custom Plot Options Dialog to specify which variables to plot. To launch the Custom Plot Options Dialog, choose "Custom Options" from the Options menu.

After you have made your selections in the Custom Plot Options Dialog, use the XY Custom Entities sidebar to further customize your plot. The XY Custom sidebar has the following options:

• Filter Use the Filtering dialog (accessible by clicking the Filter button in the sidebar) to control the items appearing in the Entities box. A primary filter lets you choose entities by type, and a secondary filter lets you further limit the entities shown to only those you designate. The Filtering dialog also lets you sort the list by several different criteria, thus allowing you to control the order that entities are plotted.

• Entities The Entities box allows you to select wells and other structures which are part of a loaded data set. Click the button in the upper-right corner to launch an expanded, searchable entity list. This is particularly helpful for very long lists.

• Paging Use the Paging region of the sidebar to scroll through the available frames. The Export button is not available for XY Custom Entities plots.

• Custom Plot Options Use the Custom Options button to launch the Custom Plot Options Dialog. You can use the Custom Plot Options Dialog to specify variables to plot, as well as the number of frames to include in your plot.
5 - 3  Custom Plot Options Dialog

To access the Custom Plot Options dialog, choose “Custom Options” from the Options menu, or click the Custom Options button in the sidebar (when available).

This dialog contains options similar to those in the XY Variables sidebar. It includes controls for choosing one or more variables for each axis and for creating multiple Y axes. However, the variable list does not reflect those in the current file. Only the variables found in the Master Variables list display here, as specified on the Variables page of the Plot Options dialog.

5 - 3.1  Frames

The options available in the Frames region of the dialog let you control how many frames display which entities, with the following choices:

• **Total Frames** Use the Total menu in the Frames region of the dialog to choose the total number of frames to plot for each entity. Each frame will contain a plot of one or more variables. This does not have to correspond to how many frames display on a single page. If you define 6 frames per entity, and set up your multi-plot options for 2 frames/page, 3 pages of plots will display for each entity.

• **Current Frame** To set up each frame, choose a frame number in the Current box in the Frames region of the dialog, and specify which variables to plot and on which axes with the following options:

5 - 3.2  Variables

In the Variables region at the top of the dialog, specify which variables to plot on which axes for the active frame chosen in the Frames region of the dialog. Specify the variables in the following boxes:

• **X-Axis** Choose a single variable for the X-axis on the active frame.

When doing time-dependent comparisons, we recommend using DATE (rather than TIME) as the X-axis variable, because the TIME values often start at 0 but are measured from different references. Because of this, the identical time values may actually not be measured at the same physical time. You can change the default time variable (TIME or DATE) on the Load/Save page of the Plot Options dialog.
Custom XY Plots

- **Y-Axis 1** Choose the appropriate variable(s) from the box to coincide with the first Y-axis on the left side of the plot. Use Ctrl-click to choose multiple variables, or drag to highlight a group of variables.

- **Y-Axes 2-5** When a single frame includes two or more Y-axes, choose an axis number in the menu to display the list of variables accessible for that axis. Then choose the appropriate variable(s) from the list. Use Ctrl-click to highlight multiple variables, or drag to select a group of variables.

  Click the button in any of the variable boxes to launch an expanded, searchable entity list. This helps particularly for very long lists.

Another Variables region, at the bottom of the dialog, controls the way that Tecplot RS displays variables in the X-Axis and Y-Axis boxes described previously. Use the toggles in this region of the dialog to customize the variable displays.

- **Long Names** Toggle-on “Long Names” to display the long variable names in the Variables lists. With “Long Names” toggled-off, Tecplot RS displays the short names.

- **Sort** Toggle-on “Sort” to display the variables in the boxes in alphabetical order according to their short name. With “Sort” toggled-off, variables appear as they do in the active RS Variables file. The latter method helps if you choose to use an RS Variables file to group variables in order of use.

- **Active** The Active toggle becomes available when you have a data set loaded. With “Active” toggled-on, Tecplot RS limits the variable list to only those variables that exist in the active data set(s). In general, leave this toggled-on unless you specifically choose to edit all variables.

5 - 3.3 Custom File

Use the Custom File region of the dialog to save your custom style(s) in a separate file. Custom plot definitions save with an .rscx extension (to signify their RS Custom file type).

You can use custom files interchangeably between XY Custom Plot and XY Custom Entities plot. If the file defines multiple variables within a frame, only the first variable will be used in an XY Custom Entity plot.

Use the following options in the Custom File region of the dialog to save and/or load style(s).

- **Load** Use the Load button to load existing custom option settings. Using the “Files of type” menu in the Open File dialog, you can choose to load either an existing custom file (*.rsc, *.rscx) or to extract the custom settings from an existing project file (*.rsprj). Refer to Chapter 21: “Projects” for additional information regarding project files.

- **Save & Save As** Use the Save and Save As buttons to save your custom options settings to a file. Toggle-on “Load at startup” after saving your settings to load the current settings every time Tecplot RS starts. You may wish to save your custom options if you intend to record macros for custom plots, because when recording macros, the macro does not save the steps to create a custom plot definition. Save your selections to an .rsc file in order for the macro to replay correctly.

  If you would like to associate a custom file with a given XY data file or files, we recommend creating a project file for these files. Refer to Chapter 21: “Projects” for additional information.

82
Specialty Plots

In addition to the XY plot types described in Chapter 4: “Basic XY Plots” and Chapter 5: “Custom XY Plots”, Tecplot RS provides the following specialty plot types:

- RFT Plots
- Completion Profiles
- Flow Tables

You must load applicable data to use any of these plot types. For example, you must load or append RFT data to use the RFT plot type.

You can also create RFT plots and Completion profiles using the basic XY plot types. However, flow tables are a unique plot type that you cannot duplicate in any of the other XY plot types.

6 - 1 RFT Plots

RFT data files provide observed or simulated values at one or more depth(s) along a well at a given time. While Tecplot RS allows you to plot RFT data using any of the three basic XY plotting functions (XY Variables, XY Entities, and XY Custom), Tecplot RS includes a specialized module for RFT data that simplifies some of the selections.

RFT data files (extension .rft or .frft) function as a specialty plot type of “XY Data”. You can append one RFT file to a field, well, or completion data set. (That is, you can append one Eclipse RFT file to a UNSMRY data set.)

6 - 1.1 Loading RFT Data

To begin creating an RFT plot, load an RFT data file. You can load (append) Eclipse RFT data files automatically with their associated UNSMRY file using the “Append RFT” data toggle in the Load XY Data dialog, or manually by choosing “Eclipse/VIP RFT” as the File Type in the Open Files dialog (accessed with the Load XY Data dialog). To use the “Append RFT” toggle when loading both files simultaneously, the RFT or FRFT file must have a root file name identical to the UNSMRY root file name.
Specialty Plots

Appending RFT Data

If you have not yet loaded the UNSMRY file associated with the RFT file, and your UNSMRY data file and RFT data file have identical root file names (for example, chelan.unsmry and chelan.frft), use the following procedure to load both files simultaneously:

1. Choose “Load XY Data” from the Project menu.
2. Toggle-on “Append RFT” in the Load XY Data dialog that appears.
3. Click the Add button.
4. Set the file type to “Eclipse UNSMRY” and choose the UNSMRY file to load.
5. Click Open in the Open Files dialog, and click OK in the Load XY Data dialog.

Tecplot RS will now load both data sets. You can toggle between viewing each data set by choosing the appropriate plot type in the sidebar (for example, choose “RFT” to view the Eclipse RFT data set).

If you have already loaded the UNSMRY file, load the Eclipse RFT file manually, as described in the following section. Remember to toggle-on “Append RFT data” in the Load XY Data dialog. With this toggled-on, Tecplot RS will append the RFT file to the active data set.

You can try appending an Eclipse RFT data file with the chelan.unsmry and chelan.frft files included in your installation. Your Tecplot RS installation includes these files in the %C:\Program Files\Tecplot\TecRS 2019 R1%\examples\tecplotrs\ folder, where %C:\Program Files\Tecplot\TecRS 2019 R1% represents the location of your Tecplot RS installation.

Manually Loading RFT Data

To load an Eclipse/VIP RFT file manually (if you already have the UNSMRY file loaded, or you do not have data files with identical root file names), first load the UNSMRY file by itself if you have not already done so. Then choose “Load XY Data” from the Project menu to launch the Load XY Data dialog. Click the Add button to launch the Open Files dialog.
In the **Open Files** dialog, choose “Eclipse/VIP RFT” from the Files of type menu.

Once you have navigated to the file(s) you would like to load and selected them, click Open.

In the **Load XY Data** dialog, if the RFT data file represents the same reservoir as your current file, you can append the RFT data to the active data set. To do this, toggle-on “Append RFT data” in the **Load XY Data** dialog. Tecplot RS will group the data into its own entity type, in the same manner as wells, regions, quality data, and so forth. The Filter options also include the RFT type.

With the RFT data file appended to the active data set, you can access and switch between the plot types easier. However, you can also load the RFT data file as a separate data set, either replacing the current data set or adding as an additional file. To do this, toggle-off “Append RFT data” in the **Load XY Data** dialog, and choose the action you wish to take in the subsequent **Question** dialog that will appear after you click the OK button.
Specialty Plots

6 - 1.2 RFT Plot Sidebar

Choose "RFT" from the Plot Type menu to switch to the RFT sidebar. By default, the independent variable (Depth) displays on the Y-axis in RFT plots, and the Y-axis is inverted so that values increase downward.

The RFT plot sidebar has the following controls:

- **RFT Plot Text and Layer Details** Use the Add Details buttons to record and adjust text and rectangular geometries to represent geological layers on any RFT well. See Section 6 - 1.3 "RFT Plot Text and Layer Details" for instructions on adding and customizing these details.
• **Entities** In the Entities region of the sidebar, you can choose one or more entity to include in your plot, as well as one or more time/date to include in your plot. Click the button (located in the upper-right corner) to launch an expanded, searchable entity list from either the Entities box or the Time/Date box.

• **Variables** Use the variables region of the sidebar to specify the X- and Y-axes variables.

The entity and variable lists are automatically limited to those associated with the RFT data type.

• **Data Set** You can compare RFT data from two or more files. Chapter 10: "Comparing XY Data" describes the basic operation. (The Delta page of the Compare Data Sets dialog has no effect when comparing RFT data.)

When searching for a match between the active data set and the comparison data set(s), Tecplot RS considers both the well name and the time/date identifier. The well names must match exactly, but the dates or times are not expected to be identical. Tecplot RS uses the time closest to the one chosen for the active data set. The legend displays the time, so that you can see which measurements Tecplot RS has chosen.

In general, setting the time units to Date for RFT plots results in a more intuitive plot. The Date setting removes ambiguity caused by time (days) values. You can change this setting on the Load/Save page of the Plot Options dialog.

### 6 - 1.3 RFT Plot Text and Layer Details

You can add text and rectangular layers as background to any well in an RFT plot. Toggling-on “Details” at the top of the sidebar will make the RFT Details buttons active. With these buttons you can attach text at certain depths or frame positions, color a depth range (such as to represent geologic layers), and save your textual and/or layer additions into the RFT project file.

Text and layer details are associated with the well that is active when you add the details.

The "Details" toggle in the sidebar next to the RFT Details buttons controls whether or not RFT details display on the plot. "Details” must be toggled-on to create or save RFT details.

When you click the Save Details button in this Details region of the RFT sidebar, Tecplot RS saves the added details to the current project file. By this method, when you reopen the project, the details will appear on your plot and you do not have to recreate them.

#### Text Details

The text details button, acts identically to the standard Text tool. Clicking this button converts the selector tool into a crosshair tool. When you click a position in your plot, the Text Details dialog appears, enabling you to type into the text field to add text to your plot.

#### Customizing Text

The Text Details dialog also enables you to customize the text style, including color, font, size, angle, and other options. The style currently chosen when you close the dialog will become the default style for the next text box added.
Specialty Plots

You can also specify the positioning and positioning method of your text on the RFT plot:

- From the Position By menu in the dialog, you can choose the positioning method of the text box. Using “Frame” from the menu will associate the text box with its relative position in the frame. With “Frame” chosen, the text box will remain in the same place in the frame, ignoring zooms, pans, axis range changes, or variable changes. Choosing “Grid” from the menu ties the text box to the Y-axis variable (typically DEPTH in an RFT plot). With “Grid” chosen, the label will follow the line plot when you zoom in or out. Typically, the “Grid” positioning system works better with RFT plots.

With “Grid” positioning, the text box will also maintain the chosen X coordinate, as long as that coordinate falls within the range of the plot. If you switch to a different variable for the X-axis that would cause the text to fall outside the plot range, the text box will automatically reposition to fall within the new range. If this happens, the alignment of the new text position in the frame will match the chosen text anchor position.

- You can choose the alignment of the text position with the Anchor Alignment dialog, accessed from the Text Details dialog.

Saving Text

Tecplot RS automatically saves text when you make a change that updates the plot (such as choosing a different variable, time/date, or well). You can also save the text by clicking the Save Details button in the RFT details region of the sidebar. You may find this ability useful if you decide to reposition the X coordinate of your text box: if you wish to change the default position of your text box relative to the X-axis, move the text box with your selector tool, and then click Save Details to make the new position the default. Otherwise, Tecplot RS will not save the new X coordinate.

Replicating Text in Other Wells

You can copy text from one well to another. To begin, click the text box with the pointer tool.

With the text box highlighted, choose “Copy” from the Edit menu (or press Ctrl-C). Switch to the well on which you wish to paste the text, and choose “Paste” from the Edit menu (or press Ctrl-V). If the text does not appear, you may have pasted the text in a position off the screen (if the depth range differs significantly from the first well). Find the text by zooming out or panning to the appropriate depth. You can also drag the text box to your desired depth. If you change the X coordinate of your text box, click Save Details to save the change.

Layer Details

The RFT layer button, , enable you to add a background color to a selected range of Y-variable values. These rectangular layers, defined by the top and bottom Y-variable value, consist of a solid color. The layers stretch across the frame. (They do not use explicitly defined X coordinates.)
Completion Profiles

RFT Layers Dialog
Clicking the button will launch the RFT Layers dialog, the simplest and most accurate method of adding or modifying layers for the current well.

In the RFT Layers dialog, choose a well in the active data set from the Well menu. Tecplot RS links the well chosen here with the list of wells in the sidebar: highlighting a well in this menu or in the sidebar will update the plot and the other list.

You can add a layer to the highlighted well by specifying a top and bottom Y-variable (normally, Depth) value in the Layer Properties region of the dialog. Choose a color for the layer (by clicking the color button next to Fill Color), and click the Save button to add the new layer to the well. When you click Save, the layer will appear on the plot as well as in the large “Layer” box in the middle region of the dialog.

The “Layer” box in the dialog shows a list of each layer present in the current well. To create a new layer, the <New> line must be highlighted. To modify an existing layer, highlight the layer you wish to modify in the “Layer” box, change the layer properties, and click Save to make the changes. To delete a layer, click that layer in the Layer box, and click the Delete button.

If you create more than one layer, the “Top” value of a new layer will default to the “Bottom” value of the last existing layer, and the “Fill Color” will default to the last color chosen.

The Copy button in the RFT Layers dialog will copy all layers in the currently highlighted well. The Paste button will show the number of layers currently copied. (For example, the Paste button would display as Paste (3) if you clicked Copy when the current well has three layers.)

To paste the layers into another well, choose a well from the menu and click the Paste button. If you paste layers into a well that already contains layers, Tecplot RS will add the pasted layers to the list of existing layers.

You can add layers in any order, but they will always appear in the list sorted by depth. Tecplot RS performs no checks for gaps or overlaps. When layers overlap, the layer with the largest bottom value (greatest depth) will display on top.

Use the Save Details button to save the created rectangle(s). When you click this button, Tecplot RS saves the layers with the well and stretches the rectangle width(s) across the frame.

You can use the selector tool interchangeably with the RFT Layers dialog. For example, you can use the dialog to copy layers from one well to another, and then adjust the depths of the copied layers with the selector tool and the Save Details button.

6 - 2 Completion Profiles
Completion profile plots display variables versus level (completion) at a single point in time. Completions display on the Y-axis. The X-axis scales to encompass the range of variable values.

To create a completion profile plot, you must first load an XY data set containing completions. To determine if a loaded data file contains completions, use the Active Data Set region of XY page of the
Specialty Plots

Manage Data dialog (accessible by clicking the Manage Data button in the toolbar or by choosing “Manage Data” from the Project menu). Refer to Section 4.1 “Loading XY Data” for detailed information about loading data files.

You can also use the Filtering dialog to quickly determine whether your data includes completions.

Once you have loaded a data file containing completions, change the plot type to “Completions” to begin creating your completion profile plot.

The sidebar for completions has the following options:

- **Wells** The list of wells (that displays in the Wells box, in the Wells region of the sidebar) automatically displays only wells that include completion data. Instead of listing each completion separately, this box lists the well name along with the number of completions included in that well in parentheses. Click the button in the upper-right to launch an expanded, searchable entity list. This helps especially for very long lists.

- **Times** The available times display in the Times region in the center of the sidebar. Each plot will reflect values at a selected time. The time unit (date or time) to use is determined by a setting in the Miscellaneous Settings region of the Load/Save page of the Plot Options dialog.

- **Variables** You can choose the variable(s) that Tecplot RS will plot in the Variables region of the sidebar, in the various boxes. You can plot up to three variables at a time. Use the left-hand box to identify the X1 variable and the right-hand box to identify the X2 and X3 axis variables. The bar color matches its associated axis color.
  - **Show Percent** Turn on the Show Percent control to add another X-axis scaled from 0 to 100. The line shows the values at each completion as a percent of the total of all layers.
  - **Label** Use the Label menu to add Depth/Length or X-plane labels to the completion bars in the plot. The labels display in a text box at the end of the bar(s) for each completion.

You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words “Plot Controls”). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.

You can also use the Filtering dialog to quickly determine whether your data includes completions.

You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words “Plot Controls”). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.
Flow Tables

The Flow Tables function requires familiarity with CHEARS flow table (.flot) files. Flow table plots display the information in one or more CHEARS *.flot files. Flow tables contain an N-dimensional array of bottom hole pressure (BHP) values plotted for N-independent variables. BHP is shown on the Y-axis of the plot. Flow tables also include a dependent variable which Tecplot RS places on the X-axis. (Dependent variable applies to the flow table, not to the Tecplot RS plot.) Flow tables are plotted by creating XY-slices from a combination of independent variable settings.

Loading Flow Table Data

A flow table data set acts differently from other data sets used in the other XY plotting options. Because of their uniqueness, you cannot load them from the standard file loading dialogs. You can access them through the Flow Table sidebar (choose “Flow Tables” from the Plot Type menu).

You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words “Plot Controls”). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.
Specialty Plots

Click the Load button to launch the Read Data dialog. To load a flow table file, select .flot file type. To experiment with flow tables, you can load the chelan.flot data set included in the examples folder of your Tecplot RS installation.

You can load more than one flow table file at a time. If you do, you may find it helpful to toggle-on “Show Source” in the sidebar, below the Load button. This will show the file name along with the flow table number.

You can remove the flow tables with the Unload button in the sidebar.

6 - 3.2 Flow Tables Selections

Once you have loaded a flow table data set, the sidebar will display available variables and options. The data file determines the well type (injector or producer) and dependent variable. The sidebar displays these variables for reference.

When you select a variable in the Multi menu, the box beneath shows all the associated independent values of the selected variable. From this list, you can select one or more data values. Each will display on the plot using a different line color.
Single

The Single heading can list one or more variables. When you choose one from the menu, the box beneath will display the independent values for that variable.

You should choose one value for each of the single variables. These selections will determine the data to be plotted. The plot title will also reflect your variable value choices. For example, if you load the example file *chelan.flt*, you will see the following plot.

Whenever you change any value that affects the flow table plot, Tecplot RS redraws the plot with the new settings.
Specialty Plots
Filters, Selection Sets, Groups, Well Patterns, and Branches

Tecplot RS allows you to manage the entities available for plotting with a filtering option. The filtering option allows you to limit entities based on criteria such as entity type, name or variable value. When you use filtering, only the entities that meet the criteria in the Filtering dialog will display in the sidebar as available for your plot.

You can group together items identified by the filtering option into elements referred to as selection sets. As with filtering, the active selection set limits the entities available for plotting. You can save selection sets to a project file and load them in Tecplot RS at any time. This can save time if you repeatedly examine the same set of wells during the history match process.

You can take selection sets a step further by creating user groups or well patterns. User groups and well patterns combine the entities in a selection set into a single entity. This entity is then added to the entity list. Well patterns use weighted values from selection sets of WAF variables to create the new entity.

For example, you can use filtering to identify each well in a group of wells that exceeds a given water cut. You can then create a selection set to reuse that filtering setting in the future, and create a user group from that selection set.
Filters, Selection Sets, Groups, Well Patterns, and Branches

7 - 1 Filtering

Filtering allows you to select a subset of entities from the active XY data set. This will limit the items displayed in the Entities box in the sidebar. To access the Filtering dialog, click the Filter button in the sidebar.

The Filtering dialog has the following options, grouped by region in the dialog:

- **Entity Type** The Entity Type box displays all possible entity types. By default, all entity types (except completions and blocks) are selected. Because of this, you can choose variables that might not exist for a particular entity.

  By choosing items in the Entity Type list, you can limit the entities available in the main dialog. For example, if you choose “Wells” as the entity type, you will filter out all entity types other than wells. Only well entities will display in the Entities box in the sidebar, and only those variables recorded for wells will display in the Variables box.
Filtering

You can select multiple entities in the Entity Type box using the Ctrl and Shift keys.

Some entity types may not seem familiar, since the Entity Type box includes the types used by all of the simulators supported by Tecplot RS. Some of the types may not apply to the simulator software that you are using.

- **Entity List** The Entity List region of the dialog displays the entities from the active data file that are of the type(s) selected in the Entity Type box. For example, if you choose Wells in the Type Filter, the lower box will show you only well entities.

By choosing each entity type in succession, you can see exactly which entities (if any) belong to a classification. You can also see a summary of this information in the Manage Data dialog.

- **Sorting** Use the Sorting options, in the Sorting region of the dialog, to reorder the selected entities according to type, entity name, or variable value. You can sort the entities in ascending or descending order. This sort also controls the order in which Tecplot RS draws entities when scrolling through plots or using the Play button.

When sorting by variable values, Tecplot RS considers the maximum value for the variable over all time steps.

- **Additional Selection Options** The tabbed area of the dialog contains options for automatically highlighting entities in the Selection List.
  
  - **Name** Use the Name page to designate criteria for finding entities by name. The Name page has the following options:
    
    - **Comparison String** Type the search string in the comparison string field.
    - **Search Condition** Use the Search Condition menu to specify whether the string is at the beginning of the entity name or anywhere within the entity name.
  
  - **Value** Use the Values page to specify variable thresholds or ranges. The Values page has the following options:
    
    - **Var** Specify the data set variable to use for comparison.
    - **Is** Specify whether the variable value should be “greater than”, “less than” or “between” the value(s) specified in the value field.
    - **Value** Type the threshold or range values in the Value fields. The second field is sensitive only when “between” is selected in the Is menu.
    - **Search Limits** Use the Search Limits options to limit your search to a given data or time range.
  
  - **Selection Sets** Use the Selection Sets page to create or edit select sets.

After setting the selection criteria, specify whether to add, remove or replace your selections with respect to the current list.

Finally, click the Apply button to make the selections. The changes will be highlighted in the Selection List.

- **Make New SS** The Filtering dialog is the ideal place to create new Selection Sets. To create a new set, simply type the name in the text field (or use the default name provided), and click Make New SS.
At its simplest level, a selection set consists of a list of entity names. These entity names maintain groups of wells that you can use to work with a smaller subset of the available entities, or to combine or identify entities with similar properties (such as injectors vs. producers).

- **Edit SS** Use the Edit SS button to view and manage all the selection sets that currently exist in the data set.

The Filtering dialog (accessed with the Filter button in the sidebar) allows you to choose a subset of wells or other entities that are of interest to you. Those selections limit the entities available for your plot.

Tecplot RS allows you to store your filtering sets in objects called selection sets. At its simplest level, a selection set is simply a list of entity names. When you save a project file, any selection set(s) that you have created are written to the file.

Selection sets are not unique to XY plots. You can also create them for grid plots by using the Wells dialog.

---

**7 - 2 Selection Sets**

The Filtering dialog (accessed with the Filter button in the sidebar) allows you to choose a subset of wells or other entities that are of interest to you. Those selections limit the entities available for your plot.

Tecplot RS allows you to store your filtering sets in objects called selection sets. At its simplest level, a selection set is simply a list of entity names. When you save a project file, any selection set(s) that you have created are written to the file.

Selection sets are not unique to XY plots. You can also create them for grid plots by using the Wells dialog.
Click Edit SS in the Filtering dialog to launch the Selection Sets dialog. (You can also access this dialog by choosing “Selection Sets” in the Data menu). The Selection Sets dialog has the following options:

- **Sel Sets** When you highlight a selection set in the box on the left, in the Sel Sets region of the dialog, the Entities list will update to display the items in that set.
- **Rename** Use the Rename button and the text field to rename the active selection set.
- **Delete** Use the Delete button to delete the highlighted selection set.

- **Entities** The Entities box displays the list of entities included in the selection set, as highlighted in the Sel Sets box. The “-00” after the name in the Entities list identifies the sub-structure (for completions or segment data). Most entity types have a sub-structure of 00.

  To remove entities from a set, simply highlight one or more names in the Entities list and click Remove Items. (You cannot use this dialog to add entities to the list).

- **Load** Click the Load button to import previously-saved selection set definitions from a file. You may also choose either an individual selection set file (*.rss or *.rssx) or a Tecplot RS project file (*.rsprj), as project files also contain selection set definitions.

- **Save** Click the Save button to save the selection set definitions to a file. Selection set data is in XML format and the filename extension is *.rssx.

7 - 3 **User Groups, Well Patterns, and Branches**

Simulator output often includes cumulative quantities for the entire field and one or more groups of wells. Different simulators may classify these as separate entity types under the heading of groups, areas, or regions. Tecplot RS saves each set of cumulative values as an individual entity that can be plotted, and also allows you to interactively create similar cumulative quantities with the Groups/Patterns/Branches dialog.

7 - 3.1 **An Overview: Using Groups, Patterns, and Branches**
User Groups

The User Groups controls allow you to create your own new entities in which Tecplot RS calculates the variable values from two or more wells. You can choose which variables to include and whether to calculate them by summing or averaging the individual well values, or as ratios computed from summed or averaged results. Tecplot RS adds these new entities and variables to the sidebar entities list, from which you can plot them using various XY plot types.

Well Patterns

If you have loaded Well Allocation Factor Data Files into your project, you can create well pattern groups using the Well Patterns controls. With these controls, as with User Groups, you can create new entities that include variable values from one or more wells.

Unlike user groups, however, well patterns use WAF data to apply a weighting factor to each variable value, and can reflect changes in WAF values over time. Once created, you can view well pattern entities using the XY Subsets plot type. In this plot type, the total value for the pattern appears along with the contribution of each producer and injector pair.

You can also view well pattern entities in standard XY plots (XY Variables, XY Entities), but to do this you must first click the Filter button and use the Filtering dialog to select the Well Pattern entity type for display in the entities pane of the sidebar.

Branches

With the Branch controls, you can create summation or average values for all of the segments in each branch of a multi-segmented multilateral well. You can use branches with Eclipse data files that contain segment information. Two or more segments combined make up a branch, and multiple branches make up a well. You can plot the created branches using various XY plot types.

7 - 3.2 Preparing to Use Groups, Patterns, and Branches

User groups, well patterns, and branches require a couple set-up steps before you can use the Groups/Patterns/Branches dialog to create them. Follow the instructions in this section for the entity you wish to create.

User Group Preparation

To create a user group, you must first define one or more Selection Sets. In the selection set, specify which wells you wish to combine. Use only well entity types to create user groups – Tecplot RS will ignore other types (field, RFT data, block data, and so forth).

Tecplot RS will use the selection set name as the user group name, so name the selection set accordingly. To make the
selection sets and user groups reusable, save your selection sets in a permanent file (refer to Section 7-2, "Selection Sets").

Created selection sets display at the bottom of the Groups/Patterns/Branches dialog.

**Well Pattern Preparation**

As with user groups, well patterns require definition of one or more Selection Sets. Specify which wells you wish to combine; for well patterns, the selection set must contain at least one injector well in addition to producer wells. Including at least one injector well enables Tecplot RS to determine which factors to use in its calculations.

You do not have to specify every injector-producer pair that you wish to include in the selection set; just include all the injectors and producers that you wish, and Tecplot RS will use the WAF data to find each pair of injectors and producers that influence each other.

**Branch Preparation**

To create branch information, you must have both the XY (unsmry) and grid restart (unrst) files loaded into Tecplot RS, as well as the XY data file as the active data set (refer to Section 4-2 “Managing XY Data” for more information). The Segment data will load as part of the XY data. (You must instruct the simulator to include the segment information in the output file).

The restart file includes information that identifies to which branch a particular segment belongs. You must identify the restart file in the box at the bottom of the Groups/Patterns/Branches dialog. If you already have the restart file loaded into Tecplot RS, Tecplot RS will automatically include the file name.

**7 - 3.3 New Entities: Creating User Groups, Patterns, and Branches**

Once you have created your selection sets (for user groups or patterns) or restart file (for branches), you can begin creating a new entity. From the menu bar, choose “Groups/Patterns/Branches” in the Data menu to open the Groups/Patterns/Branches dialog.

The variables associated with the current well entity type display in the Vars to Calculate box. By default, the Vars to be summed box includes all the identifiable production rate, injection rate, and cumulative values, and the Unused variables box includes all remaining values.

**Variables to Calculate**

The Vars to calculate box includes four items. Tecplot RS calculates these values after it has summed or averaged all the others, since these variables depend on other values included in the calculations:

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>WOR</td>
<td>Water / Oil Ratio</td>
<td>WPR / OPR</td>
</tr>
<tr>
<td>GOR</td>
<td>Gas / Oil Ratio</td>
<td>GPR / OPR</td>
</tr>
<tr>
<td>WCT</td>
<td>Water Cut</td>
<td>100 * WPR / (WPR + OPR)</td>
</tr>
<tr>
<td>OCT</td>
<td>Oil Cut</td>
<td>100 * OPR / (WPR + OPR)</td>
</tr>
</tbody>
</table>

In the User Groups controls, by default, all four values appear selected for calculation.

**Variables to be Summed, Unused, or Averaged**

To adjust which variables Tecplot RS sums or averages, highlight the variables you wish to move in one of the three adjacent variable boxes and use the Move ( > and < ) buttons to transfer the highlighted variables.
Filters, Selection Sets, Groups, Well Patterns, and Branches

to the box right or left of the Move button. For example, if you do not want to include VPR and VPC values in your user group summation entities, highlight those names in the Vars to be summed box and click Move (>) to move them to the Unused variables box. In addition, if you decide to average some of the pressure data, highlight BHP, WHP, and SWP in the Unused variables box and click Move (>) to move them to the Vars to be averaged box.

The well patterns controls allow only summation, not averaging, since well patterns already represent the WAF-weighted sum of variables. However, you will need to indicate which variables are rate values and which are cumulative values, as these must be summed in different ways. To do this, move each rate or cumulative variable to the Rate Variables or Cumulative Variables box using the Move (>) and (<) buttons.

**Create User Groups for Active or All Data Sets**

Before you create a new user group, you can choose whether to create the group for only the active data set or for all loaded data sets. To set this option, use the Create for menu that appears at the bottom of the Groups/Pattems/Branches dialog, with User Groups chosen as the entity for which to solve.

**User Group, Well Pattern, and Branch Creation**

To create new user groups, well patterns, or branches, choose the variable settings you wish to include, choose whether to create the user group for the active data set only or all data sets (if creating a user group), and click OK. The dialog will close, and the calculation’s progress will display in the status bar at the bottom of the Tecplot RS workspace. Once Tecplot RS has completed the calculations, it will add the new entity names and variables to the entity list in the sidebar, and you can begin plotting the results.

Tecplot RS prefaces well patterns with “WP:” followed by the selection set name, to differentiate them from user groups or branches created with the same selection set. Tecplot RS uses “B-” followed by the selection set name to indicate a branch entity, to distinguish it from the wells and completions of the same name.

When you create user groups, your selections REPLACE any existing user group entities. You cannot add a single new user group to those created earlier. In general, most of the work to build user groups is in the creation of the selection sets, and the actual solution is done in a single operation.

**7 - 3.4 Saving and Automating User Groups and Well Patterns**

When you save or update your project file after creating a user group, Tecplot RS will save the created user group(s) in the project.

However, Tecplot RS does not save well patterns automatically. You can access them as long as you work in the same session of Tecplot RS, but once you close your session, you lose any created well pattern(s). To avoid having to create well patterns repetitively every time you want to use them, use a simple macro to automate recreating them.

To create this macro:

1. Save the current state of Tecplot RS to a project file, if you have not done so already.
2. Choose “Record Macro” from the Macro menu.
3. Assign a name and location for the macro file. We recommend a name that matches the root name of the file containing the XY data, but this is not a requirement.
4. With the macro recording, open (or re-open) the project file.
5. Create the well pattern(s).
6. Finish the macro file by clicking Stop Recording in the Macro Recorder dialog.

Now you have a small macro that will open all the files associated with your reservoir AND create the well pattern(s). The next time you want to work with this data, instead of loading data from the Project menu, click the Play Macro button in the toolbar or choose “Play Macro” from the Macro menu. Choose and play the macro that you created, and the macro will open all your files, complete with solved well patterns.
Filters, Selection Sets, Groups, Well Patterns, and Branches
XY Equations

If you wish to plot variables that your XY data file does not include, but which can be derived from available data, you can use the XY Equations dialog to create additional variables. To access this dialog, choose “XY Equations” in the Data menu. Alternatively, if your current plot is an XY type, you can click the toolbar button.

In the XY Equations dialog, you can use equations to create new variables from combinations of existing variables in your data set. Tecplot RS will include the new variables in the list of variables available for plotting.
XY Equations

Equations are entered and edited in the input line to the left of the Enter and Cancel buttons. You may enter equations by simply typing them using the keyboard. However, the dialog also provides some handy tools to make the job easier.

First, the variables from the current data set are shown in a list. Double-click one of these to insert it into the equation at the current cursor position. Tecplot RS automatically includes the surrounding curly braces ({} that are used to identify a variable.

There are also buttons for frequently-used functions. Pressing these will insert the function name followed by parentheses, and place the cursor inside the parentheses so you can easily insert the value or variable that belongs there. If the function requires multiple parameters, one or more commas will also appear inside the parentheses, alerting you to the required inputs.

The remaining buttons are mostly duplicates of what you have on your keyboard. You can use the keyboard and mouse interchangeably when entering equations. Press the Enter key on your keyboard OR click on the Enter button on the dialog to record an equation.

The list at the top of the dialog shows all current equations. To make changes to these, double-click the desired item, or right-click and select Edit. You'll also use right-click to delete an equation that is no longer needed. The topmost item, shown as [NEW], is a shortcut for starting a new equation. When you double-click, this it inserts the text "[NEWVARn]=" into the editing line. This is a starting point for entering a new equation, but its use is optional—you can simply type what you need.

Tecplot RS holds XY data in memory. Once a new variable has been created, it remains available during your Tecplot RS session and will be saved if you write your data to Tecplot format.

For a full description of the Tecplot RS equation syntax, see Appendix B: Equation Reference.

8 - 1 Equation Files

You can save and update saved equations in a separate file using the Save As and Save buttons, respectively. Use the Load File button to load a previously saved equation file.

8 - 2 Applying Equations

Before computing your equations, specify the entities to which you wish to apply the equation in the Apply to box. If you have multiple XY files open, select whether to apply the equation(s) to “All Files” or the “Active file only”.

Once you have selected the entity types and file settings, click the Apply button.
Once Tecplot RS completes the computation, the new variables appear in the variable lists ready for plotting.

You can use the **XY Equations** dialog to create new variables as well as to modify existing ones.

If a division by zero occurs, Tecplot RS will display an error and will not produce any new variables unless the "Ignore /0 Errors" option in the XY Equations dialog is activated. If instructed to ignore division by zero, Tecplot RS produces zero where the variable being divided is zero and -999999 for non-zero dividends, and suppresses the dialog.

As with User Groups, Well Patterns, and Branches, Tecplot RS does not store the new variable values created from the equations in a file. However, you can store the equations themselves. The equations are saved automatically in your project file. The dialog also contains options for saving these in a separate named file.

Because the **XY Equations** dialog allows you to assign new names to the created variables, it is possible to have variables that do not exist in RS Variables Files. When you create a variable, Tecplot RS automatically adds it to the master variable list. See the Variables page of the Plot Options dialog to modify the properties of newly created variables.
XY Equations
Viewing XY Data

9 - 1 Data Spreadsheet

You can view loaded XY data in the Data Spreadsheet dialog by choosing “Spreadsheet” from the Data menu. In this dialog, you can edit data, adjust the formatting of the displayed data, copy the data to your operating system's clipboard, and paste it into another program.

The Data Spreadsheet dialog displays the entities and variables selected in the sidebar: the entity appears in the Zone menu, and the variables currently chosen for that entity appear in the table below.

9 - 1.1 Spreadsheet Formatting

Using the formatting controls at the top of the Data Spreadsheet dialog, you can change the format of the displayed data without changing your data file(s) or the appearance of your plot.
Viewing XY Data

- **Format** Choose a number format from the Format menu in the dialog that best represents the data. You can choose from displaying the data in Integer, Float, Exponent, or Best Float form.
- **Precision** If you have Float or Exponent chosen as the Format, you can specify the number of places displayed to the right of the decimal.

If some values are too wide to fit in their column, the width of the column may be adjusted by dragging the divider lines in the heading.

9 - 1.2 Editing Spreadsheet Data

To edit any displayed value, double-click it, type the new value, and press Enter. Changes made here are applied only to the plot; they do not affect the underlying data set. If you change the plot type, your changes will be lost.

9 - 2 Periodic Production Rates

You can calculate Production rates on weekly, biweekly, monthly, quarterly, and annual intervals using cumulative variables from the active XY dataset or from all loaded datasets. To use this feature, choose Analyze>Periodic Production Rates.

In the Periodic Production Rates dialog, you first select a time period. You may then select one Entity Type. The supported entity types are Wells, Field, GroupsAreas, Regions, and User Groups. Each entity type is displayed in the list only if it is present in the dataset. After you select the entity type, the available entities and variables are displayed. You can then select one or more entities and/or variables.

To be displayed in the variable list, a variable must be cumulative (never decreasing in value with increasing time) and nonzero across all entities.

Finally, if you have loaded more than one XY dataset, you can choose to have the results displayed for the active file or for all files.
9 - 2.1 Displaying Results

Once the desired selections have been made, click Compute to show the calculated data in the dialog.

After you click Compute, the results are displayed in a table like the one above. The following columns are included:

- **Dataset name** - The first column shows the name of the dataset from which each row’s result was calculated. If you are displaying results from multiple datasets, the number of the dataset (starting with 1) and a colon appear before the name of the dataset.
- **Entity** - The title of this column changes depending on the entity type selected. In the example above, it is Wells. This column identifies the specific entity for which the row’s result was calculated.
- **Period** - The period for which this row was calculated.
- **Days in Period** - The number of days the period spans. Often, this will show the total days in the selected period (e.g., 28, 29, 30, or 31 days for a monthly period), but at the beginning or end of the data’s time range, it may be less, which implies that data for only part of that time period is available.

The following columns appear next, repeating once for each variable. The name of each column is prefixed by the variable name (for example, “OPC Start Value”). For each variable, the following values are displayed:

- **Start Value** - The beginning cumulative variable value in the time period. If data aren’t available at the start time, it’s linearly interpolated from surrounding values.
- **End Value** - The ending cumulative variable value in the time period. If data aren’t available at the end time, it’s linearly interpolated from surrounding values.
- **Period Rate** - The difference between the ending and beginning cumulative variable value in the time period.
- **Avg Daily Rate** - Period Rate divided by Days in Period
- **Prod Days** - Number of days in the period during which the cumulative variable increased, which implies production.
- **Avg Prod Rate** - Period Rate divided by Prod Days

After the above columns for the selected variables, the Start Day column is displayed. This is the Excel serial number (i.e., the number of days since January 1, 1900) of the start day in the period. These values can be used to show dates on the axis label for plots generated in Microsoft Excel and other spreadsheet programs that support this format.
9 - 2.2 Saving Results to CSV

To easily use this information with other programs, save the results as a CSV file. Click either the One File or the Multiple Files button. The two options behave as follows:

- **One File**: You are prompted for a location and a file name. All the results displayed in the table (whether for one dataset or for all loaded datasets) are saved to the specified file.
- **Multiple Files**: For each dataset loaded, a CSV file is created in the directory that contains the original data file. The files are automatically named with the original data file name, the entity type, and the selected period (for example, spe9a_xyp_WELLS_Monthly.csv). If CSV files already exist with these names, they are silently overwritten.

Tecplot RS reminds you of this behavior when you click the Multiple Files button.

The columns in the exported CSV file are as previously described in Displaying Results.
Comparing XY Data

Comparing data from two or more files often gives useful information or results. For example, you may wish to compare the separate data sets of simulator output and observed values, or multiple simulator runs. Tecplot RS contains several tools that allow you to compare data sets.

The method used to compare data sets depends upon both the contents of the data sets and the type of plot you wish to create:

- **Using the Compare Toggle** This powerful option serves as the primary method for comparing data files. It allows you to create unique style sets for each file (used when comparing a large number of files simultaneously), delta plots, and a comparison legend. With this option, Tecplot RS plots your comparison data in a single frame.

  You can use the Compare toggle for XY Variables, XY Entities, XY Custom Plot and XY Custom Entities plot types. However, to use this option, all of the files must use identical names for each entity you wish to compare. The files must also use identical variable names, unless you link the variable names with an alias, which may be set using the Variables tab on the Plot Options dialog. If your files do not meet the requirements for compared entities and identical/aliased variables, use one of the alternate comparison methods.

- **Comparison Using the XY Freestyle Plot Type** Use this option when the entity/variable names in the files you wish to compare do not match and you would like full control over every aspect of your plots. This option allows you to compare data sets in the same frame or in side-by-side frames. Because this option requires manual setup, you may find it requires more time to set up and operate than the other options.

- **Comparison Using the History Match Plot Type** Use the History Match plot type when you wish to compare one set of data (history, or observed, data) with one or more simulation data sets, and/or you wish to use a more quantitative measurement to determine which simulation data set best matches the history data set. This plot type displays three different plot representations of the comparison side-by-side, requires little manual setup, and gives both qualitative and quantitative results.

While this chapter focuses on comparing XY data sets, you can also compare grid data. See Chapter 18: “Comparing Grid Data” for details on this feature.
Comparing XY Data

Each comparison method requires the steps described in Section 10 - 1 “Preparing for Comparison”. Review these steps before you begin.

You can also compare variable values from different XY data files for the same set of wells using Delta bubbles. Refer to “Delta Bubble Plots” on page 179 for details.

10 - 1 Preparing for Comparison

To compare data sets, first load multiple XY data files. If you compare data sets using the sidebar, you also need to specify the active data file. The comparison uses the active data file for reference values.

10 - 1.1 Active Data Set

When you load multiple files, only one file functions as the active data set. Tecplot RS will display the active data set by default in all plots and will use it to determine which entities and variables appear in the selection lists. When doing comparisons, Tecplot RS uses the active data set as the data set to which it compares the other files.

The Compare Options dialog, accessible by clicking the Options button in the Data Set section of the sidebar, lets you choose the active data set.
If you need more information about a data set before choosing it, see instead the XY page of the Manage Data dialog. The active data set appears highlighted. The Active Data Set box lists a summary of the entity types available.

To change the active data set, simply highlight the file name in the Available Data Sets box. The information in the Active Data Set region of the dialog will update accordingly. When you close the Manage Data dialog, the plot and the sidebar will reflect the new active data set.

If no data file has been loaded previously, the new data file will be the active set, and each subsequent data file will be treated as an inactive data set. You can change the active data set at any time by selecting a different data set in the Available Data Sets region of the Manage Data dialog.

Use the Display As text field in the Manage Data dialog to designate a display name for the active data set. The legend for comparison data displays this name. The legend uses the file name if the Display As field is empty.

10 - 2 Using the Compare Toggle

The simplest approach for comparing data sets is to plot them in a single frame using the Compare toggle in the sidebar. This method is available for the following plot types: XY Variables, XY Entities, RFT Plots, Custom XY Plot or XY Custom Entities.

In order to use this function, you must first have multiple data sets loaded. To load another data set, choose “Load XY Data” from the Project menu. You can click the Manage Data button in the toolbar to customize which data set appears as the active data set. (The active data set will determine which entities and variables you can select for plotting.) In order for the comparison to work, the additional data sets must have matching entity names.
Comparing XY Data

The Data Set portion of the sidebar for XY Variables and XY Custom Plot includes these controls:

The other XY plot types include a similar Data Set portion of the sidebar, without the Show Deltas option.

**10 - 2.1 Data Set Selection for Comparison**

To activate the comparison feature, toggle-on “Compare” in the sidebar. Toggling-on “Compare” will open the Compare Data Sets dialog.

The name of the active data set displays at the top of the dialog, under “Active Data Set”. The remaining loaded data sets are displayed in the Select Files for Comparisons box. Select the file or files that you want to include for comparison from the box.

The active data file displays at the top of the Compare Data Sets dialog. You can change the active data file in the Manage Data dialog (accessible in the toolbar or the Project menu). Refer to Section 4 - 2 “Managing XY Data” for more information on the Manage Data dialog.
Using the Compare Toggle

10 - 2.2 Comparable Entities and Variables

The list of entities and variables displayed in the sidebar depends upon the active data set. You can customize the list using the Filtering dialog (open this dialog with the Filter button in the sidebar). For example, you can limit the list of entities to just the wells (don't include completions, areas, or field data).

To compare entities using the Compare toggle in the sidebar, the selected entity names must match exactly across all files. However, you can define some flexibility with variable names using variable aliases. For example, if the active file uses OPR for oil production rate (typical for Eclipse/SLB files) and a comparison file uses QOP (VIP standard), you can tell Tecplot RS that QOP is an alias for OPR. Aliases are entered using the Variables page in the Plot Options dialog; see Section F - 2 "Variables".

If your data files use different variable names or aliases, you can still compare your data using the XY Freestyle plot; see Comparison Using the XY Freestyle Plot Type.

You can edit the Master Variables List to expand the list of variable aliases.

Comparison data display is not compatible with the Sum or Avg toggle in XY Entities. When the Sum or Avg toggles are selected, comparison data will not display.

10 - 2.3 Data File Order

Use the Order page of the Compare Data Sets dialog to specify the plot order of the data files that you want to compare with the active file (first, highlight the files to compare on the Select page). Use the arrow keys to reorder the files.

The order of the data file assigns it to its corresponding Style Set (specified on the XY Lines page of the Plot Options dialog). By using Style Sets, you can customize the style of the lines, symbols and variables displayed for each data file included in the comparison. Refer to Section 10 - 2.7 "Altering Styles for Comparison Data Sets" for information on using Style Sets.
Comparing XY Data

10 - 2.4 Comparing More Than 99 Data Sets
You can compare as many files as you wish simultaneously; however, the number of comparison style sets is limited to 99 (100 including the active data set). Use the Style page of the Compare Data Sets dialog to specify how to apply styles when comparing 100 or more files.

![Compare Data Sets dialog](image)

You can choose either:

- **Cycle through comparison styles** - repeats the 99 comparison style sets, or
- **Re-use last comparison style** - uses the 99th comparison style for all data files after the 99th.

When comparing files, use the Style Set options on the XY Lines page of the Plot Options dialog to define different colors and/or patterns for the comparison data sets. See also: Altering Styles for Comparison Data Sets.

10 - 2.5 Comparison Legend
Use the Style page of the Compare Data Sets dialog to indicate how to display file names in the legend. You may display any of the following:

- **Variable Name** - The legend will include the variable name at the beginning of the display.
- **Include Display Name or File Name** - The legend will include the file name or the display name after the variable name, separated by a dash `-`. The display name is set on the XY page of Manage Data; (see Section 4 - 1 "Loading XY Data"). The display name is initially the filename unless you have changed it.
- **Include File Extension** - If the File Name is included, then check this toggle to include the file extension in the file name.

By default, the Comparison Legend identifies files by their display name.
Using the Compare Toggle

10 - 2.6 Delta Comparison Methods

When comparing data sets as XY Variables or Custom XY Plots, an additional toggle for delta comparison appears in the Data Set region of the sidebar. When “Delta” is toggled-on, Tecplot RS will display a selected comparison between the active data set and the comparison data set(s). By default, the Delta option displays the difference between the active data set and comparison data set(s).

You can customize the Delta display on the Delta page of the Compare Data Sets dialog.

The Delta page includes the choice of whether to show the active data for reference on your plot (by toggling-on “Show reference data”).

You can choose the manner of comparison between your active data set and comparison data set(s):

- $V_{ref} - V_{comp}$ = Active value minus comparison value (default setting)
- $V_{comp} - V_{ref}$ = Comparison value minus active value

Toggle-on “Normalize by $V_{ref}$” to normalize each delta value by its active value.

If you toggle-on the “Show Magnitude” option on the Delta page, the magnitude (absolute value) of each delta value will display.

If you want to use Time as the independent variable for comparison plots, make sure that both files reference the same starting time.

Once you have chosen the file(s) to compare and completed your changes in the dialog, your plot will show both the active and comparison data sets (if you left “Show reference data” toggled on, on the Delta page of the dialog).
Comparing XY Data

Following is a display of a comparison between two files included in your installation (chelan.unsmry and chelan.hist).

To create this comparison display, follow these steps.

1. Choose “Load XY Data” from the Project menu. Click Add in the Load XY Data dialog to display the Open Files dialog.
2. Navigate to the examples/tecplotrs folder of your Tecplot RS installation folder (by default on Windows platforms, Tecplot RS installs to C:\Program Files\Tecplot\TecRS 2019 R1) and choose “All Files” in the Files of type menu. Click on the chelan.unsmry file, and, while pressing the Ctrl key, click the chelan.hist file. Click the Open button.
3. Click OK in the Load XY Data dialog.
4. Make sure that the chelan.unsmry file is highlighted in the Manage Data dialog that appears and click OK.
5. With OIL-01 highlighted in the Entities list in the sidebar, toggle on “Compare” in the sidebar. In the Compare Data Sets dialog that displays, on the Select page, click on chelan.hist. Click Close.

By default, each data set will display with a different line type (based on your previous settings on the XY page of the Plot Options dialog). See Appendix F: Section F - 3 “XY Lines” for more information on customizing the line types.
10 - 2.7 Altering Styles for Comparison Data Sets

The XY Lines page of the Plot Options dialog allows you to customize the style for each comparison data set. The Plot Options dialog opens automatically when you double-click on the line you wish to customize. Or you can launch it via the Options menu or the icon in the toolbar.

Using the Style Set menu, change the Style Set to “Comp 1”. The “Default” is defined in the active RS Variables file. The factory settings in this file are for short dash lines.

When you chose “Comp 1” for the Style Set, you chose to display the styles for the first comparison data set. This time the factory setting simply changes to a different line style. While this is often sufficient to differentiate the lines, you can make additional changes.

You may often want to keep the default color for both lines for simplicity. However, you can make other changes to set the lines apart. For example:

- Make the line thicker on the active data set and thinner on the comparison set.
- Turn symbol fill on for the active set and off for Comp 1.
- Show only symbols on Comp 1 (toggle-off “Lines” to omit lines), and show only lines on Active (toggle-off “Symbols” to omit symbols).
- Make your symbols squares for one set and diamonds for the other.

Note that the Style Set menu lets you choose from Active and Comp 1 through Comp 99. With these selections you can create 100 unique sets of styles (one for your active data set and up to 99 different comparison data sets).

If you would like to reuse the style settings you created in the Plot Options dialog, save your settings with the Load/Save page of that dialog. Refer to Section F - 1 “Load/Save” for additional information.

1. Specify the order of the comparison data sets on the Orders page of the Comparison Data Sets dialog. Refer to Section 10 - 2.3 “Data File Order” for more information.
Comparing XY Data

10 - 3 Comparison Using the XY Freestyle Plot Type

Use this method if you would like to compare data sets that do not have matching variable or entity names. XY Freestyle plots allow you to compare data within a single frame or across several frames. If the data files that you wish to compare have matching variable or entity names and you would like to plot your comparison in a single frame, refer to Section 10 - 2 “Using the Compare Toggle”.

To compare data sets using XY Freestyle plot type, follow the instructions for creating an XY Freestyle plot in Section 4 - 8 “XY Freestyle”. Switch between the files you wish to compare for each line mapping using the File menu in the sidebar. To compare data sets across multiple frames, switch between frames for each line mapping.

The following example illustrates how to compare the “Cumulative Oil Production Rate” (OPC) over time from two different data files in a single frame. In this example, the observed data file used OPC as the variable name for oil production rate and the simulated data file used CumOilPr as the variable name for oil production rate.

1. Load both XY data sets into Tecplot RS (see Section 4 - 1 “Loading XY Data” on page 53).
2. Change the plot type to XY Freestyle.
3. To set up the first line, make the following changes in the sidebar:
   a. From the File list, choose the first observed data file.
   b. From the Entities list, choose the well or field to compare.
   c. In the Variables region of the sidebar, set “Time” as the X-axis variable and “OPC” as the Y-axis variable.

4. To set up the second mapping, make the following changes in the sidebar:
   a. From the File list, choose the simulated data file.
   b. From the Entities list, choose the well or field to compare.
   c. In the Variables region of the sidebar, set “Time” as the X-axis variable and “CumOilPr” as the Y-axis variable.
5. To change the style of either mapping, double-click on the line and make your changes in the Mapping Style dialog.

If the axis ranges are not identical for each frame, you can adjust the axis ranges. To accomplish this:

1. Click  in the sidebar or double-click on an axis to open the Plot Options dialog.
2. On the XY Axes page, choose OPC from the Variables box.
3. In the Axis Scale region of the dialog, choose “Manual” from the Range menu and adjust the min and max ranges as you wish.
4. Choose “CumOilPr” from the Variables box.
5. Repeat step 3 for CumOilPr.
6. Close the dialog.
History Match

It is often useful to compare history data of a reservoir with multiple simulation runs to determine which simulation best matches the history data. While other comparison methods give good qualitative comparison results, when that is not sufficient, you can use the History Match plot type to compare data sets in a quantitative, visually diverse manner.

You can compare data sets using History Match plots in two ways. In the One Well mode, Tecplot RS shows you how the comparison data for a single well deviates from the history data over time (or as another independent variable changes). In the Multi Well mode, Tecplot RS shows you how the comparison data for a single date deviates from the history data from well to well.

To use the History Match plot type, with XY data loaded, choose History Match from the Plot Type menu in the sidebar or from the Plot Type menu in the menu bar.

The History Match plot type displays three frames at once, showing three different comparisons of the data sets: the raw data, the deviation data, and the deviation distribution.

![History Match Plot Example](image)
History Match

An example of the three frames that display when the History Match plot type is selected. In this example, the red line is a display of the observed data, and the blue and green lines represent simulated data sets.

11 - 1 History Match Plots
The History Match plot type always displays three frames with three specific plots. Legends, when included by controls in the Paper Layout plot type, display in the Deviation Distribution plot frame.

You can adjust the style of the lines displayed, as well as the axes colors and marker styles, by double-clicking on one of the plots to open the XY Lines page of the Plot Options dialog. However, you cannot adjust the scale of the plots in the History Match plot type; the axes scale to fit the data being displayed. By default, the first nine lines displayed on History Match plots use style sets one through nine (ST1 through ST9). Additional lines use style set 9 (ST9) and rotate through comparison style sets.

The legend that displays in the Deviation Distribution frame identifies each data set. You can control how the legend displays the data set names by using the Style page of the Compare Data Sets dialog (accessible by clicking the Options button at the top of the sidebar), or by adjusting the display name itself on the XY page of the Manage Data dialog (accessible by choosing "Manage Data" from the Project menu or clicking the Manage Data button in the toolbar).

11 - 1.1 Raw Data Plot
The Raw Data plot displays a standard comparison of each data set as chosen in the sidebar. For example, in Figure, the Observed data set is displayed as the history data, along with Simulation One and Simulation Three. DATE is selected in the X Var menu of the sidebar, and OPR is selected in the Y VAR menu of the sidebar. (This is a One Well plot. In a Multi Well plot, the X axis always represents the well numbers of the selected wells.)

11 - 1.2 Deviation Data Plot
The Deviation Data plot shows the difference between the history data and each selected comparison data set, for each value of the independent variable. (In the example of Figure, the deviations are displayed by Date. In a Multi Well plot, they are displayed by well number.)

11 - 1.3 Deviation Distribution Plot
The largest frame of the History Match plot type displays the Deviation Distribution of the data. This plots the cumulative percentage of points (shown on the Y-axis) that fall within the deviation range (shown on the X-axis). For example, on the plot shown in Figure, the blue line intersects the red line at about 3%, which means only about 3% of the data points in Simulation One deviate negatively from the history data. The green line, Simulation Two, intersects the yellow deviation band at about 50% and remains inside the deviation band from 50 to 100%, showing that about 50% of the data deviates from the history data within the acceptable range.

11 - 2 History Match Controls
When you choose “History Match” from the Plot Type menu in the sidebar or from the Plot Type menu in the menu bar, the displayed plot type in Tecplot RS will switch to the History Match plot type, and the sidebar will change to include specialized options for customizing your history match set of plots. You may then choose One Well or Multi Well tab to select which mode you wish to use.
With the options in the History Match sidebar, you can customize your plot comparisons in a number of ways.

**File Selection**

Use the controls in the top region of the sidebar to choose which data sets Tecplot RS will analyze and display:

- **History Data** The data set chosen in this menu acts as the active data set to which all other data sets will be compared. Only variables and entities (wells, completions, and so forth) included in the history data set chosen will display in the Data region of the sidebar.
- **Comparison Data** All loaded XY data sets except the data set chosen as the History Data display in the Comparison Data list. This list controls which data set(s) Tecplot RS compares to the history data set. Highlight one or more data sets to compare them to the history data set. You can also control which data sets to include in the **Compare Data Sets** dialog.
- **Options** Use the Options button to open the **Compare Data Sets** dialog, in which you can customize additional aspects of your History Match plot, including the order in which data sets display in the legend and the equations and methods used in calculating the delta or deviation results. For more information about this dialog, refer to Section 10 - 2.1 “Data Set Selection for Comparison”.

**Data Selections**

The group of controls in the Data region of the sidebar control which entities and variables (determined by the data set chosen as the History Data) are displayed and analyzed.

To compare entities and variables between data sets, Tecplot RS reads each data set for entities and variables with matching names. If the data sets use different names for the same entity or variable, you can include additional aliases for these in your RS Variables file, and edit them on the Variables page of the **Plot Options** dialog (accessible by selecting "Plot Options" from the Options menu).

On the One Well page, you can choose the following options:

- **Entity** Choose which entity to display on the History Match plots from the Entity list.
- **X Variable** The variable selected in the X Variable menu will display as the independent
History Match

(X-axis) variable.

- **Y Variable** The variable selected in the Y Variable list will display as the dependent (Y-axis) variable.

On the Multi Well page, you can choose the following options:

- **Wells** Choose the wells to be included on the History Match plots from the Wells list. Hold down Control to toggle the state of the clicked items or Shift to make contiguous selections.
- **Time** Choose the time step for which the History Match plots should be created.
- **Y Var** Choose the variable to be used as the dependent (Y-axis) variable in the History Match plots.

**Calculations**

The choices in the Calculations region of the sidebar control how Tecplot RS calculates the history matching and defines the acceptable range used and displayed on the Deviation Distribution plot and the Deviation Data plot.

- **Deviation band** The deviation band defines the maximum deviation, or error, allowed in each data set compared with the history data. As a measure of error, the deviation band value must be a positive value in the units of the Y-axis variable of the Deviation Data and Deviation Distribution plots. If the “Normalize by Vref” option is chosen on the Delta page of the Compare Data Sets dialog, the deviation band value will be a factor of the normalization. Tecplot RS also saves the deviation band in the project file separately for each Y-axis variable, so you can specify a separate value for each variable.

  The deviation band displays as a background fill on the Deviation Data and Deviation Distribution plots as a visual indicator of how well each of the comparison sets matches the history data.

  In the legend that appears in the Deviation Distribution plot frame, Tecplot RS displays the percentage of data points for each comparison set that fall within the deviation band, along with the standard deviation of each comparison set.

  To turn off the deviation band on the plots and in the legend, type “0” (zero) in the Deviation band field in the sidebar.

- **Normalize** Toggle-on the Normalize switch to normalize the comparison by dividing the difference between each value in the two data sets by the reference (history) data.

  **Shut-down switch** (Available only in One Well mode) The “Ignore shut-down data” switch specifies how the deviation distribution data are computed, to compensate for measurements during which a well (or other entity) was shut down. When this switch is toggled-on, any data points for which both the history data set and the comparison set are zero will be ignored in the distribution calculations. This is targeted for rate variables, to avoid skewing the deviation factor by including matching values from measurements taken while a well was shut down.
History Match Controls

- **Weighting** (Available only in Multi Well mode) When Weighting is toggled-on, the specified variable, typically a cumulative variable such as OPT, is used to determine the importance of each well and is included in the “goodness factor” that indicates how well the simulation data matches the actual data. The weighting factors for each well appear on the Deviation Data plot, and the Deviation Distribution plot emphasizes the most important wells by giving them a greater proportion of the Y axis.

The sum of all weighting factors equals 100% unless one or more wells is not found in the comparison data sets (for example, if some well names differ among the files). If Weighting is toggled-off, each well has an equal contribution to the plot.

The weighting coefficient for a given well is the ratio of the variable value for the well to the maximum value of the variable for all wells; for example, \( W_{well} = \frac{OPT_{well}}{OPT_{max}} \). The sum of the weighting coefficients, \( WT \), is \( WT = \sum W_{well} \) for all wells. The percent contribution for each well is \( P_{well} = 100 \times \frac{W_{well}}{WT} \).
History Match
Part 3 Grid Plots
Loading Grid Data

Tecplot RS has many sophisticated functions for plotting both 2D and 3D representations of a reservoir model. As your first step, load a file containing data that you wish to plot.

Grid data sets generally consist of output from simulation programs. They include the actual grid geometry plus data that describe the subsurface properties, such as porosity, and/or values measured over time, such as oil saturation. You can load up to four different grid files into Tecplot RS at once.

12 - 1 Loading Grid Data

Choose “Load Grid Data” from the Project menu to begin the loading process. Use the File Type menu in the Load Grid Data dialog to specify the type of grid data you wish to load. Tecplot RS supports the following grid file types:

- Eclipse/SLB (Chears)
- VIP Map
- CMG
- Sensor/TETRAD
- UTCHEM
- GRDECL
- RESQML
- APC

CMG-format files can be processed on only Windows machines. However, once the initial processing is complete, the data may be loaded on Linux workstations.

Tecplot RS can also load grid data contained in Virtual Database (VDB) folders. To begin loading data in this format, choose “Load VDB Data” from the Project menu.

After choosing the file or VDB case to be loaded, Tecplot RS displays a dialog to allow you to control the loading process. For more details on loading the supported formats, see the following sections.
Reservoir data files can be quite large, often requiring several gigabytes of disk space. Because the program must read data into the computer memory (RAM) before displaying it, large data files can quickly consume system resources. Data set sizes that cause this process to exceed the available RAM in the computer can adversely affect performance.

For this reason, Tecplot RS allows you to optimize the way Tecplot RS loads the files. For example, the first time you load a grid solution, Tecplot RS will automatically preprocess the grid and create a .rsgrid file that contains a compact form of the grid. The .rsgrid file uses less memory and speeds up the loading process for future loading of the solution. Additional options affect the appearance of the grid or its internal representation. See “Grid Data Loading Options” on page 145 for complete details.

Loading Inactive Cells

Tecplot RS 2009 R2 and later versions include the ability to display inactive cells (cells through which no fluid flows, and/or with no meaningful solution data for variables) along with active cells, in a contrasting display style, and/or with variable values. Tecplot RS automatically determines inactive cell data when loading the grid.

To display the inactive cells, toggle-on “Inactive” in the sidebar. See Section 14 - 1.6 “Inactive Cells” for more information about the options available.

Saturation Variables

The reservoir simulator output defines saturation variables for each cell that sum to 1.0. Often the user will save space in the output file by excluding one of the saturation variables. Tecplot RS interprets the typical simulation cases, and it will automatically calculate and add the missing saturation variable to the internal data set.

12 - 1.1 Loading Eclipse/SLB Data

Tecplot RS reads Eclipse/SLB data (including Chears) from three or more file types, including:

- grid Grid file, containing the grid geometry
- egrid Alternative format for the grid geometry
- init Init file, containing time-independent properties, such as porosity or permeability
- unrst Unified restart file, containing time stepped (recurrent) values such as pressure and oil saturation for all time steps
- Xnnnn Individual restart files, which contain each time step in a separate file.
You may notice that the list of grid files includes files with extensions of .grid, .egrid, and .fgrid. Tecplot RS does not actually support .fgrid files, but they appear in the list because of the way the names are filtered. If you choose an .fgrid file, Tecplot RS will use either a .grid or .egrid file, if available.

In most cases, you need to specify only the grid file. Tecplot RS will automatically find the additional files, provided that the root names match that of the grid file. If both unified and non-unified restart files are available, Tecplot RS will use the unified file.

To begin loading Eclipse or Cears data, choose “Load Grid Data” in the Project menu. In the Open File dialog, choose “Eclipse(SLB)” from the file type menu and select a .grid file to open. The Load Grid Data dialog for Eclipse/SLB data has two pages (Files and Options) like the other grid data dialogs.

Use the Files page of the Load Grid Data dialog to specify the associated file(s) you wish to load, including init, restart, and XY data files. Tecplot RS automatically detects most associated files if they use the same base name as the selected grid file. If any files are not detected because they have different base names, use the browse buttons next to each field to choose the correct file.

The Files page has the following additional options besides specifying the Eclipse data files associated with the grid:

- **Make Active** Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
- **Display name** Enter a name by which the data set will be known within in Tecplot RS. This defaults to the name of the selected grid file, but may be changed.
- **Streamlines** Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slspec format.
- **Survey Wells** Optionally, click the browse button next to the Survey Wells field to specify survey well data to load.

After you have specified the file(s) you wish to load, you can either click OK or switch to the Options page of the Load Grid Data dialog to specify any additional loading preferences. See “Grid Data Loading Options” on page 145 for details.
12 - 1.2 Loading VIP Map Data

In VIP files, the grid and solution data are both stored in files with a .map extension. Tecplot RS supports only Fortran-format binary VIP files. In the case of VIP formats, one .map file contains the grid geometry and static properties. Another .map file, chosen separately, contains the time-dependent variables.

Tecplot RS makes "Date" or "Time" available to the user for use in their plots. However, VIP files contain Date information only. Tecplot RS sets the Time value for each time step as the number of days from the first day in the file.

To load VIP files, choose “Load Grid Data” from the Project menu and choose VIP Map from the file format menu in the Open File dialog. Then select the main VIP .map file, sometimes referred to as the “init” file, containing the grid and static properties. After clicking Open, the Load Grid Data dialog appears, with two pages (Files and Options).

Put the "init" data in the Grid field, and the “recurrent” file in the Solution Data field on the Files page of the Load Grid Data dialog. You can specify the variable used to identify inactive cells on the Options page of the Load Grid Data dialog.

Files

Use the Files page of the Load Grid Data dialog to specify the file(s) you wish to load. You may choose a restart file (which contains the time-based variables) and/or an XY data file.

The Files page has the following additional options besides specifying the additional VIP data files associated with the grid:

- **Make Active** Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
- **Display name** Enter a name by which the data set will be known within Tecplot RS. This defaults to the name of the selected map file, but may be changed.
- **Streamlines** Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slon spec format.
- **Survey Wells** Optionally, click the browse button next to the Survey Wells field to specify survey well data to load.
After you have specified the file(s) you wish to load, you can either click OK or switch to the Options page of the Load Grid Data dialog to specify any additional loading preferences.

**Options**

Use the Options page of the Load Grid Data dialog to specify your preferences for the use of the RSGRID file, Optimization and Inactive Cells.

- **Make Active**
  Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.

- **RSGrid file options**
  The RSGrid file contains the grid geometry in an internal, proprietary format. This format compresses the data and allows more memory efficient data loading. Use the radio buttons to specify whether to:
  - Use the previous settings in the file
  - Overwrite the RSGrid file with the settings in the new dialog
  - Force creation of a new RSGrid file (even if the settings have not changed). This will create an rsgrid file as well, to control the inactive cells in your grid plot.

You can delete the rsgrid file at any time, but Tecplot RS will recreate it the next time you load the file. You can also create RSGrid files externally with the RSPreprocess utility. Refer to Section K - 4 "RSGRID File Format" and Section J - 2 "RSPreprocess" for additional information.

- **Optimization**
  Tecplot RS can perform grid optimization to smooth the grid and remove unnecessary nodes inherent to corner point grids. Choose from three options:
• With “Keep original grid” chosen, Tecplot RS does not perform any smoothing. However, to improve performance, it will still attempt to share duplicate nodes. The Node sharing tolerances define how close values must be for Tecplot RS to consider them a match.

The “Keep original grid” option is intended to preserve the grid provided in the original file. However, since grids often include distortion, Tecplot RS uses tolerances to force node-sharing at logically identical cell nodes. If these nodes fall within the specified tolerances, Tecplot RS eliminates the redundant nodes to reduce memory and speed up rendering. This operation that eliminates nodes is a form of smoothing. Larger tolerances allow greater smoothing. Thus, choosing “Keep original grid” can provide a smooth version of the original grid. It becomes more apparent as you increase the tolerances.

• With “Create corner point grid - Shift” chosen, Tecplot RS joins the face of one cell to the adjacent face in the next higher-numbered plane.
• With “Create corner point grid - Average” chosen, Tecplot RS joins faces, but calculates new Z-values for the corners by averaging the nodes on the joined faces. If you set your simulator to output a smooth corner point grid, these options will have little or no effect on the appearance.

If NNCs (Non-Neighbor Connections) exist in the grid, Tecplot RS will NOT smooth the grid across the NNC plane. Hence, Tecplot RS will preserve faults with specified NNCs.

Smoothing a corner-point grid does NOT change the variable values (pressure, saturations, and so forth). Smoothing affects only the shape of the grid.

In the absence of NNC definitions, smoothing a corner point grid with faults may result in highly distorted cells. In these cases, use the “Keep original grid” selection.

• Tolerances

Although Tecplot RS does not perform smoothing when “Keep original grid” is chosen in the Optimization region of the Options page, to improve performance, it will still attempt to share duplicate nodes. The Tolerances define how close values must be for Tecplot RS to consider them a match. The tolerances only activate when “Keep original grid” is chosen.

Horizontal (XY) and vertical (Z) tolerances are measured separately. In general, a minimum tolerance of around 2% of the average cell size is recommended - this will preserve the original geometry but will help reduce memory requirements and improve display performance. Increasing the tolerance to 10% of the average grid size will further increase performance without significantly changing the geometry.

Applying the smoothing or node sharing calculations can be time consuming, especially for large grids. For this reason, the results of these optimizations are saved in a new grid file with an extension of RSGRID. Once the RSGRID file has been calculated, the program reads from it instead of the original grid file, which greatly reduces file load time.

Tecplot RS also includes a stand-alone executable named RSPreprocess. You can set this program to run at the end of a simulator run to make the more efficient RSGRID file available immediately.

Tecplot RS applies these optimization functions when loading a file. You cannot use these settings to change files once they are loaded.

• Inactive Data
Loading Grid Data

Use the Inactive Cells region of the dialog to specify the criteria to identify inactive cells, and/or load additional inactive cells.

- **Identify Cells as Inactive**
  - Use the Var Name field to specify the variable to use, the menu to specify the comparison criteria, and the Value field to specify the comparison value. If Tecplot RS does not find the specified variable in the init file, it will mark no cells as inactive. It does not consider variables in the recurrent .map file.

Tecplot RS will override any conditions specified here with any existing rsgrid file UNLESS you choose either “Update RSGRID file with these settings” or “Create a new RSGRID file” at the top of the dialog.

### 12 - 1.3 Loading a VDB Case

Tecplot RS includes capability to load virtual databases (VDB), by specifying one or more folders that contain the database of files (or “cases”). This kind of grid data is stored in a database file structure within a folder that ends with a .VDB filename extension. To begin loading a VDB case, choose “Load VDB Data” from the Project menu. Select the case folder inside the top-level VDB folder in the Select VDB Case Folder dialog that appears. (If there is only one case in the VDB, you may also choose the top-level VDB folder.) The Load VDB Data dialog has two pages (Files and Options) with the options described following.

Use the File page of the Load VDB Data dialog to specify the data you wish to load from the VDB case folder you have selected. Tecplot RS automatically locates grid and XY data in the VDB folder. By default, both grid data and complete XY data are loaded.

If the VDB folder contains streamline data, this can be loaded at the same time by toggling on the Load VDB Streamlines checkbox. You cannot load streamlines from the VDB folder and from a separate file at the same time.

The Files page has the following additional options:

- **Make Active** Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
- **Load VDB Streamlines** Toggle-on to load streamlines from the VDB database. (Do not use the Streamlines field lower in the dialog in this case.)
- **XY Data** Indicate which of the XY Data stored in the VDB database you wish to load.
  - **None** - Do not load any XY data, only grid data.
Loading Grid Data

- **Quick** - Reads XY data only for fields, wells, and regions and skips loading completions and network connections.
- **Complete** - Loads all XY data.
- **Display name** - Enter a name by which the data set will be known within Tecplot RS. This defaults to the name of the selected case, but may be changed.
- **Streamlines** - Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slnspec format. (Should not be used if the Load VDB Streamlines option is toggled on.)
- **Survey Wells** - Optionally, click the browse button next to the Survey Wells field to specify survey well data to load.

After you have specified the database you wish to load, you can either click OK or switch to the Options page of the **Load VDB Data** dialog to specify additional loading preferences. See “Grid Data Loading Options” on page 145 for details.

### 12 - 1.4 Loading Sensor Data

Tecplot RS supports the visualization of grid solution data created by the SENSOR® reservoir simulator. To load Sensor grid data into Tecplot RS, choose “Load Grid Data” from the **Project** menu, then choose “Sensor/TETRAD” from the file type menu in the Open File dialog. The filename extension for a SENSOR grid file is .71. Choose a file and click **Open** to display the options that enable Sensor data loading.

The **Load Grid Data** dialog for Sensor data has two pages (Files and Options), like the dialogs for loading other types of grid data. Loading Sensor data requires only the first page of the dialog, but the second page provides additional settings.

On the Files page of the **Load Grid Data** dialog for Sensor data, you can specify an associated XY data file to be loaded at the same time as the grid data. This file has a filename extension of .61 and is automatically selected by Tecplot RS if it exists with the same basename as the grid (.71) file.

The Files page has the following additional options:
- **Make Active** - Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
Loading Grid Data

- **Display name** Enter a name by which the data set will be known within Tecplot RS. This defaults to the name of the selected case, but may be changed.
- **Streamlines** Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slspec format.
- **Survey Wells** Optionally, click the browse button next to the Survey Wells field to specify survey well data to load.

After choosing the Sensor data to load, click OK to load the data, or switch to the Options page in the Load Grid Data dialog to customize loading settings. See "Grid Data Loading Options" on page 145 for details.

12 - 1.5 Loading CMG Data

Tecplot RS can load files created by the CMG (Computer Modeling Group) reservoir simulator, which have the extension .irf, .mrf, .sr3.

CMG-format files are supported only on Windows.

To load CMG grid data into Tecplot RS, choose “Load Grid Data” from the Project menu. Choose CMG from the file type menu in the Open dialog, then choose an .irf, .mrf, .sr3 file and click Open. The Load Grid Data appears, letting you choose what data should be loaded and what units should be used.

The Load Grid Data dialog for CMG data has two pages (Files and Options) similar to the dialog for loading other types of grid data.

On the Files page of the Load Grid Data dialog for CMG data, you can specify the units for the data being loaded and choose to load XY data. Some CMG files do not include rate and ratio variables; if you would like Tecplot RS to calculate these for you while opening the file, toggle on Include derived variables.

Include derived variables is not available for CMG .sr3 files.
The Files page has the following additional options:

- **Make Active** Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
- **Display name** Enter a name by which the data set will be known within Tecplot RS. This defaults to the name of the selected case, but may be changed.
- **Streamlines** Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slnspec format.
- **Survey Wells** Optionally, click the browse button next to the Survey Wells field to specify survey well data to load.

After choosing the CMG data to load, click OK to load the data, or switch to the Options page in the Load Grid Data dialog to customize loading settings. See "Grid Data Loading Options" on page 145 for details.

**12 - 1.6 Loading UTCHEM Data**

Tecplot RS can load files created by the UTCHEM (University of Texas Chemical Flood Simulator). You must choose the file named INPUT.

To load UTCHEM grid data into Tecplot RS, choose "Load Grid Data" from the Project menu. Choose UTCHEM from the file type menu in the Open dialog, then choose an INPUT file and click Open. The Load Grid Data dialog appears, letting you choose what data should be loaded and what units should be used.

The Load Grid Data dialog for UTCHEM data has two pages (Files and Options) similar to the dialog for loading other types of grid data.
On the Files page of the **Load Grid Data** dialog for UTCHEM data, you can edit the solution name, which is initially set to the run name found but may be changed, and choose to load XY data contained in the dataset.

The Files page has the following additional options:

- **Make Active** Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
- **Display name** Enter a name by which the data set will be known within Tecplot RS. This defaults to the name of the selected case, but may be changed.
- **Streamlines** Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slinespec format.
- **Survey Wells** Optionally, click the browse button next to the Survey Wells field to specify survey UTCHEM data to load.

After choosing the UTCHEM data to load, click OK to load the data, or switch to the Options page in the **Load Grid Data** dialog to customize loading settings. See “Grid Data Loading Options” on page 145 for details.

### 12 - 1.7 Loading GRDECL Data

Tecplot RS can load GRDECL data to display grid geometry and static properties. Since data are often distributed in multiple files, and these files may be in separate folders, the dialog gives you the ability to pick and choose the files to be loaded. This is often useful when investigating alternatives prior to running a full simulation.

Tecplot RS does not currently support GRDECL files containing dual porosity models. Additionally, if the GRDECL file contains local grid refinements (LGRs), the inactive cell display is not available. We intend to refine Tecplot RS’s support for GRDECL files in future releases.

To begin loading GRDECL data, choose “Load Grid Data” in the Project menu or the Grid option in the menu bar. In the dialog file type drop-down list, choose “GRDECL grid (*.data; *.grdecl)”
Loading Grid Data

You start by choosing a single file with either a .grdecl or .data filename extension.

- If a .data file is chosen, it is scanned for INCLUDE directives and the dialog will display all the included files that have a .grdecl extension. Since the INCLUDE directive may point to a file with a full path, the additional files may reside in other folders.
- If a .grdecl file is chosen to start, the program will find all the other .grdecl files in the same folder.

The file list is just a starting point. You may remove files from the list by highlighting and deleting them in the Load GRDECL Data dialog. You can also click the Add Files button and browse to and select additional files, including files from other folders.

GRDECL is an ASCII format, which means it is easy to view and change them, but it is less efficient to load and display the data. For this reason, Tecplot RS scans the files and creates additional binary files. The generated .tecinit and .rsinit files hold the solution data, and an .rsgrid file contains the grid geometry.

Tecplot RS attempts to create these files only the first time the GRDECL data is loaded or if it changes. However, it can be difficult to tell what has changed when picking and choosing individual GRDECL files. For this reason, we recommend using a .data file with INCLUDE directives when practical. This makes it possible for Tecplot RS to detect files that have been added, removed, or updated, and avoids unnecessary re-processing when the data is loaded into Tecplot RS.

The options for smoothing the grid geometry can be controlled via the Options tab on the dialog. See "Grid Data Loading Options" on page 145 for details.

12 - 1.8 Loading RESQML Data

Tecplot RS can load IJK grid geometries in the RESQML format (*.epc files and the associated .h5 files). At this time, only the grid geometries are loaded from the RESQML files. However, the associated grid solution data, including well geometries, can be read from Eclipse formatted .init and .unrst files.

When loading the RESQML data, you may choose either an .afi or .epc file. If the .afi file is chosen, it will be searched for an INCLUDE directive that specifies the .epc file containing the grid geometries. This will look something like this.

```
INCLUDE "MyFile.epc" (type="epc" epc_type="geom_and_props")
```

If found, the "MyFile.epc" will be placed in the field for the grid geometry. If the .afi file is not selected, or if it does not contain the required INCLUDE directive, you can instead simply choose the .epc file containing the grid geometry directly.

142
At this time, the grid solution data must come from Eclipse-formatted .init and/or .unrst files. If these files are found in the folder that contained the .afi or .epc file defining the grid geometry, then they will be placed in the dialog. If not found, or if you need to select different solution files, you may use the [...] button to select files manually.

Future releases of RS will provide the option to load solution data from .epc files.

12 - 1.9 Loading APC Data

Tecplot RS reads APC data from 9 file types:

- DSRV1 Cartesian Grid/static array file (*.cn1)
- DSRV1 Corner Point Grid file (*.cpg)
- DSRV1 Time and Well information (*.cn2)
- DSRV1 Time Dependent Data (*.cn3)
- DSRV2 Cartesian Grid/static array file (*.gc1)
- DSRV2 Corner Point Grid file (*.cgcp)
- DSRV2 Time and Well Information (*.gc2)
- DSRV2 Time Dependent Data (*.gc3)
- DSRV2 Grid node displacements (*.gc4)

Tecplot RS APC loader currently does not support the following types of grids:

- Radial coordinates
- Dual Porosity model
- Grid Refinements (That is, grid files may not contain more than one grid)

To load APC data, first select a DSRV1 (*.cn1) file, or a DSRV2 (*.gc1) file.

If a "root.cn1" file is selected, Tecplot RS will look for the following companion files in the same directory:

- "DSRV1 Corner Point Grid file" If root.cpg file is found, a corner point grid will be loaded from this file. If root.cpg file is not found, then a Cartesian grid will be loaded from root.cn1.
- "DSRV1 Time and Well Information" "root.cn2" must exist in the same folder.
- "DSRV1 Time Dependent Data" "root.cn3" must exist in the same folder.

If a "root.gc1" file is selected, Tecplot RS will look for the following companion files in the same directory:
Loading Grid Data

- **"DSRV2 Corner Point Grid file":** If root.cgcp file is found, a corner point grid will be loaded from this file. If root.cgcp file is not found, then a Cartesian grid will be loaded from root.gc1.
- **"DSRV2 Time and Well Information":** "root.gc2" must exist in the same folder
- **"DSRV2 Time Dependent Data":** "root.gc3" must exist in the same folder
- **"DSRV2 Node displacement data":** If "root.gc4" exists, then node displacement data is loaded from this file. **Note:** It is not required that "root.gc4" exists.

**GC4 Note:**

When loading GC4 data, three static variables are created:

- **"GC4 X Displacement", "GC4 Y Displacement", "GC4 Z Displacement"**
  - Although the number of nodes in the GC4 file is \((NX+1)(NY+1)(NZ+1)\), the \((N+1)th\) planes are not read, so each displacement variable has \(NX\times NY\times NZ\) values (i.e., the number of blocks in the grid).

After selecting a *.cn1 or *.gc1 file, Tecplot RS shows the following dialog which displays all companion files found. This information is display only, since companion files must exist in the same folder as the root file and must have the extensions listed above.

The Files page has the following additional options:

- **Make Active** Toggle-on Make Active to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded, and off for subsequent grids.
- **Display name** Enter a name by which the data set will be known within Tecplot RS. This defaults to the name of the selected case, but may be changed.
- **Streamlines** Optionally, click the browse button next to the Streamlines field to specify streamline data in FrontSim .slnspec format.
- **Survey Wells** Optionally, click the browse button next to the Survey Wells field to specify survey UTCHEM data to load.
After you have specified the file(s) you wish to load, you can either click OK or switch to the Options page of the Load Grid Data dialog to specify any additional loading preferences. See Grid Data Loading Options for details.

12 - 1.10 Grid Data Loading Options

The Options page of the Load Grid Data dialog is substantially the same for all formats except VIP.

You can change the following options in this page of the dialog:

- **Make Active** Toggle-on to make this grid the active grid once loaded. It is toggled on by default for the first grid loaded in a session, and off for subsequent grids.

- **RSGrid file settings**
  When a data file is loaded into Tecplot RS for the first time, Tecplot RS builds an RSGrid file derived from the data file. This RSGrid file contains the grid geometry in an internal, proprietary format that compresses the data and allows data loading in a more memory efficient manner. With the radio buttons on this page, you can choose to:
  - Use the previous settings in the file (will apply if this file has been created by previous loading of the data file),
  - Overwrite the RSGrid file with the settings chosen when loaded this time (settings in the Load Grid Data dialog will overwrite old settings), or
  - Force creation of a new RSGrid file (even if settings have not changed).

If you delete the RSGrid file corresponding to a data file, Tecplot RS will recreate it the next time that data file is loaded.
Loading Grid Data

• Optimization
For grids that are not corner point grids, RS can smooth the grid and remove unnecessary
nodes. (Grids that are already corner point grids are not smoothed further.) To exercise this
feature, choose from three options:

• With “Keep original grid” chosen, Tecplot RS only attempts to share duplicate nodes.
The node-sharing tolerances define how close values must be for Tecplot RS to consider
them a match.

The “Keep original grid” option is intended to preserve the grid provided in the original
file. However, since grids often include distortion, Tecplot RS uses tolerances to force
node-sharing at logically identical cell nodes. If these nodes fall within specified
tolerances, Tecplot RS eliminates the redundant nodes to reduce memory and speed up
rendering. This operation that eliminates nodes is a form of smoothing. Larger tolerances
allow greater smoothing. Thus, choosing “Keep original grid” can provide a smooth
version of the original grid. It becomes more apparent as you increase the tolerances.

• With “Create corner point grid - Shift” chosen, Tecplot RS joins the face of one cell to the
adjacent face in the next higher-numbered plane.

• With “Create corner point grid - Average” chosen, Tecplot RS joins faces, but calculates
new Z-values for the corners by averaging the nodes on the joined faces. If you set your
simulator to output a smooth corner point grid, these options will have little or no effect
on the appearance.

If NNCs (Non-Neighbor Connections) exist in the grid, Tecplot RS will not smooth the grid
across the NNC plane. In this way, Tecplot RS will preserve faults with specified NNCs.

In the absence of NNC definitions, smoothing a corner point grid with faults may result in
highly distorted cells. In these cases, use the “Keep original grid” selection.

• Tolerances
Although Tecplot RS does not perform smoothing when “Keep original grid” is chosen
in the Optimization region of the Options page, to improve performance, it will still
attempt to share duplicate nodes. The Tolerances define how close values must be for
Tecplot RS to consider them a match. The tolerances only activate when “Keep original
grid” is chosen.

Horizontal (XY) and vertical (Z) tolerances are measured separately. In general, a
minimum tolerance of around 2% of the average cell size is recommended - this will
preserve the original geometry but will help reduce memory requirements and improve
display performance. Increasing the tolerance to 10% of the average grid size will
further increase performance without significantly changing the geometry.

Applying the smoothing or node-sharing calculations can be time consuming, especially
for large grids. For this reason, the results of these optimizations are saved in a new grid
file with an extension of RSGRID. Once the RSGRID file has been calculated, the
program reads from it instead of from the original grid file, which can greatly reduce file
load time.

Tecplot RS applies all chosen optimizations when loading a file. You cannot use these settings
to change files once they are loaded.
Managing Grid Data

Tecplot RS will let you load up to ten different grid files at once, and you can quickly switch between them or plot them side-by-side for comparison purposes.

To load multiple files, use the same method as to load one file – choose “Load Grid Data” from the Project menu and choose the file containing the data you want to display. Each subsequent time you load data, Tecplot RS will ask you how you would like to handle the additional data with the Manage Data dialog.

Manage Data

To manage your data sets, use the Manage Data dialog. Click the Manage Data button in the toolbar or choose “Manage Data” from the Project menu to launch this dialog. Switch to the Grid page of the dialog to specify the active grid data.

The Grid page of the Manage Data dialog has the following options:

- **Display As** Use the Display As text field to designate a display name for the Active data set. Tecplot RS will use the display name if you have incorporated the file name as part of your Paper Layout. Tecplot RS uses the file name if the Display As field remains empty. (You must click Update to save your changes to the Display As field.)
Loading Grid Data

- Available Data Sets When you load multiple grids, you must also designate which one is the active data set. You can have only one grid active at a time. The active data set will display when you choose a grid plot type.

The Manage Data dialog allows you to control whether the active data set changes when Tecplot RS opens a new file, but you can easily change the active grid after loading the files as well. When you load multiple grids, they will display in the Available Data Sets box. Tecplot RS will highlight the active grid, and a summary showing information about the active grid (number of planes, LGRs, and wells) will display in the Active Data Set box.

To change to a different active data set, highlight that file name in the Available Data Set box. When you click OK and choose the desired plot type, the plot display and dialog options will reflect the data from the newly active grid.

12 - 2.1 Unloading Grid Data

Since grid files can often consume large amounts of system RAM, when you no longer need a grid, it is a good idea to unload it. This releases the system memory that you can use to load another file.

Use the Unload page of the Manage Data dialog to unload data sets. You do not need to unload files prior to exiting Tecplot RS; the data sets unload automatically when you exit.

12 - 2.2 Changing Grid Solution Data

You may load new grid solution data into your project by choosing Project>Change Grid Solution Data. This function is convenient in two situations:

- Changing grid data when the data is stored in a separate file from the grid geometry. Due to this requirement, this feature applies only to some file types. Eclipse (SLB) allows both init and
Managing Grid Data

• Appending streamlines or survey wells to the active grid data set if you didn’t load these when you originally loaded the grid, or want to replace streamlines or add more survey wells. This is available for all file formats.

The Change Grid Solution Data dialog is essentially the same as the Load Grid Data dialog you see when initially loading grid data into Tecplot RS, albeit with some features hidden. The following is the Eclipse (SLB) version of the dialog.

The Options tab is not displayed, since you aren’t changing the grid geometry, and the Make Active checkbox is also hidden because you are, by definition, changing the active grid data set rather than loading a new one. Also, the options for loading XY data are not included. (XY data are not associated with the grid data, so you can always load them separately; see “Loading XY Data” on page 53.)

The solution filenames are pre-filled with the paths to the current grid data solution file(s). Click the [...] browse buttons to choose different files for one or either (or enter the new path directly). Clearing the fields does not unload the data file; see “Unloading Grid Data” on page 148 for instructions on doing this.

Choosing a new streamline file replaces any streamline data already loaded, since only one streamline file may be associated with a grid. However, multiple survey well files may be attached to a single grid by loading them one at a time. Since survey well files are plain text files, you may also concatenate them into a single file and load them all at once.

You may also edit the display name for the current grid data set in this dialog.

12 - 2.3 Swapping Data Files

You can exchange any loaded data file for another by using the Swap Files dialog, accessible from Project>Swap Files. Unlike Changing Grid Solution Data, Swap Files temporarily substitutes one file for another, such that all references to the original file refer instead to the new file. This is particularly useful for plots in the Plot Gallery and for XY Freestyle plots, which are tied to a specific data set. It is also useful
for choosing different files for some kinds of comparison plots without losing track of the original data sets used for the comparison.

The Swap Files dialog shows a list of the files currently active in your project and, to the right of this, a list of corresponding replacement files. Initially, the swap files are listed as “no swap,” indicating that the original file is active. A single scroll bar controls both lists in sync, and highlighting a file in one list also highlights it in the other.

Files you swap in should be basically similar to the original files. That is, in general, they should have the same entity and variable names, grid IJK limits, and spatial dimensions. The swapped-in file will replace the original file in the current session, including in the Plot Gallery and XY Freestyle plots, which refer to specific data sets by name. Differences in variable names can be handled by Aliases. Differences in entity names are not resolved, however, and may result in an empty plot. Also, 3D grid views are calibrated to a specific area, and if a replacement grid is on a different coordinate system, the data may no longer be in that same area and the plot may again appear empty.

To swap in a different file for a designated file, use one of the following techniques. You may swap as many or as few files as you like; you do not need to swap all files.

- **Browse to individual files** - Highlight the data set that you want to replace and click **Browse swap file**. A file browser for the appropriate data type (grid or XY) appears, in the directory of the selected file, with the filename extension filter set the same as the original file. Either may be changed if you wish to load a file from a different directory or of a different type. The selected file appears in the Swap file list after loading.

  If loading a VDB case, click **Browse VDB case** instead. Choose the case folder inside the top-level VDB folder.

- **Files in a different folder** - To handle varying simulator runs where the new results are in a different folder from the current ones, use the Folder button to browse to the new file location, then click Search Names. Files in the selected folder will be swapped in for currently-loaded files if their names match exactly.

- **Files with altered names** - When a new simulator run uses slightly different filenames than the current names, but the new files are in the same folder as the current ones, you can use the Find Pattern and Replace Pattern fields, and the **Search Patterns** button, to perform a search-and-replace operation on the filenames. Each filename in the Current file list is examined and,
Additional Notes on Grid Optimization

if it contains the Find Pattern, that text is replaced with the Replace Pattern. If a file of that name exists in the same folder as the current file, that file is swapped in.

Note that no wildcards ("*" or ") are permitted. Since all matches of the Find Pattern are replaced, be sure to enter enough characters to prevent ambiguity; for example, if you want to change XYZ_March1_2012 to XYZ_March2_2012, searching for 1 and replacing it with 2 will change the year to 2022 as well as the date to 2, causing no files to match; instead, search for 1_ and replace with 2_. Since only files that actually exist will be swapped in, an ambiguous replacement will generally cause the desired files not to be found. In general, make the find and replace strings as specific as possible.

To undo the highlighted swap-in substitution, click **Remove swap file**. The entry in the Swap File list changes back to “no swap.” You can also simply swap the original file back in by browsing to it.

When swapping in new files, Tecplot RS automatically sets the options for you; you do not have the ability to set the options (such as grid smoothing) you set when you originally loaded the file. In general, the same options are used to load the swapped-in file as were used when loading the original file, with the following exceptions:

- If a grid file being swapped in already has a corresponding .rsgrid solution file, it will be used; otherwise, a new one is created using the same smoothing options as the file being replaced.
- If solution data are in files separate from the grid, only the defaults will be loaded (that is, those that match the grid name—the same ones that are selected automatically in the standard grid loading dialog).
- Auxiliary files such as streamlines, faults, or survey wells are loaded if they have the same base name as the swap file and the file being replaced also loaded these data.

If the automatic behaviors are not what you want, after doing the swap you can change the loader settings using the standard loader dialogs.

The selected files are not actually swapped in until you click **OK**. This may take some time depending on the size of the swapped-in files.

**Saving the project after a swap records the swapped-in files. If you want to retain the original project, either choose not to save changes, or save the project under a different name.**

12 - 3 Additional Notes on Grid Optimization

The active grid is always loaded into the computer memory. However, you can choose options that will both smooth the grids and require less RAM. This optimization will also result in greatly improved performance when displaying the grid or changing the view rotation.

The grid cells are shaped like bricks. For corner point grids, eight individual points or nodes (with X-Y-Z coordinates) are required for each brick:
Loading Grid Data

If two cells are adjacent and the nodes match, Tecplot RS will always “share” the nodes so that fewer points are needed. In this example, two bricks require 12 nodes instead of 16:

If the nodes do not coincide, Tecplot RS requires all 16 points:

Tecplot RS gives you the ability to smooth out the surface and force node sharing. This will greatly reduce the number of points required to store and display the model.

Since the smooth grid has fewer exposed cell faces, Tecplot RS requires much less computational effort to render the displayed image.

12 - 4 Load on Demand

Tecplot RS uses a sophisticated load-on-demand algorithm that minimizes memory usage by loading only the grid variables needed to create the current grid plot. It also only loads the data for the required time steps (typically just one time step). Tecplot RS maintains a buffer to read extra variables based on a loader time limit and available memory. When the active plot no longer requires a variable, Tecplot RS stores that variable temporarily in the virtual memory. This helps minimize repeat data transfers when you access files across a network.

12 - 5 Index File (.rsrst)

When you use a file-based loader to load grid data, Tecplot RS reads recurrent variables on demand. When you choose a new time step for display, Tecplot RS will retrieve the data from the file.

To retrieve the data efficiently, Tecplot RS uses a “map” to the start of each time step in the file, which it creates when reading the entire file the first time you open the file.
The data ranges of each variable also serve as important pieces of information. To automatically set up the legend for contour values, it is necessary to know the minimum and maximum values for each variable over all time steps.

The very first time you use a restart file (which contains the time-dependent data), Tecplot RS reads the entire file to find all the time steps and compute all the ranges. It then saves these data in a small file called an Index File. The file has the same root name as the grid file, but with an extension of .rsrst.

If Tecplot RS detects that this file does not exist, or if the Restart file has a newer date than the index file, Tecplot RS will create an index file automatically. The initial load will take longer because Tecplot RS scans the entire file.

Once an up-to-date index file exists, you can load a grid with load-on-demand much faster.

You can also create both the index and the .rsgrid files with the RSPreprocess.exe utility (included in your installation). You can launch this utility automatically at the end of a simulator run. See Section 1.2. "RSPreprocess" for more information.
Loading Grid Data
Basic Grid Plots

You can choose the type of grid display (2D or 3D) in the Plot Type menu, or by using the small menu at the bottom of the sidebar.

2D Grid Plots display one plane (layer) of grid cells at a time. You can choose which plane to plot by specifying both the view (I, J, or K) and the plane index. Radial grids can also display the views at constant R or Theta values.

3D Grid Plots show the entire reservoir grid in an orthogonal or perspective view. The initial orientation of the view is preset, but you can easily rotate, zoom, or translate the view.

13 - 1 2D Grid Plots

To view a 2D plot of a loaded grid file, choose “2D Grid” from the Plot Type menu. The plot will change and the 2D Grid Plot Controls sidebar will appear.

You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words “Plot Controls”). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.
Basic Grid Plots

The sidebar for 2D Grid plots has the options described following.

- **Mesh Layer** This toggle turns on or off the grid mesh.
- **Contour Layer** The Contour toggle controls display of the flooded contours, either as a solid color in each cell or bands of constant color.
- **Connect** When displaying wells, the Connect toggle turns on and off the lines connecting the well nodes.
- **Shade Layer** You can control the Shade only when Contour is toggled-off. Use this toggle to turn on or off the surface shading, making the interior of the grid mesh visible or hidden.
- **Inactive Cells** Toggle-on “Inactive” to display the inactive cells along with the active cells in your grid. If you have not loaded the inactive cells associated with the active grid, Tecplot RS will prompt you load them. See Section “Loading Inactive Cells” for details. See Section 14 - 1.6 “Inactive Cells” for information on how to display solution data on inactive cells.
- **NNCs (2D Grid plots)** Toggle-on this option to make Non-Neighbor Connections (NNCs) visible. Use the Details button to display the NNC dialog.
- **Wells** Toggle-on “Wells” to display any wells in the current plot. The shape of the symbol indicates the type of well (producer, injector, and so forth). The Details button adjacent to Wells brings up the Wells dialog.
- **Bubble Plots** Toggle-on “Bubbles” to show well data represented as bubbles on the well heads.
- **Cell Labels** Toggle-on “Cell Labels” to include cell or well labels in your plot.
- **Time/History** Toggling-on “Time/History” creates a new frame that you can use to display an XY line plot. You can choose to plot value versus time for a single cell in the grid or for a selected well. The current variables chosen in the XY Variables plot type determines the variables shown in the Time/History plots.
- **Depth** If you include RFT data in your current XY data set, you can plot them in a manner similar to the Time/History plots by toggling-on “Depth”. You can choose which variables to display by using the RFT Plots plot type.
- **Statistics** Displays or hides a statistical plot, either a histogram or cross plot (only one of these plots may be visible). Choose Histogram or Cross Plot from the sidebar to choose which plot will be displayed and to set its options; for more details, see Statistical Plots.
- **2D Plane in 3D View** Toggling-on “2D Plane in 3D” will convert the final frame of multi-frame plots to a 3D view. If you are in single-frame mode, it will switch the active frame to a 3D view. The 3D view works well for determining the location of the chosen plane(s) relative to the complete grid.

To plot well data instead of cell data in your Time/History plot, select the well crosshair on the sidebar or hold down the Ctrl key and choose a well head or a cell containing a well.

- **Variables** The Variables box lists each variable that you can use for a contour plot. Time-dependent (dynamic) variables display first, followed by time-independent (static) variables. When you have a variable highlighted, each cell in the grid plot will display filled with a color representing the value of that variable at the chosen time.
• **OWG (Oil/Water/Gas) Saturation Plots** Use the OWG option to create a ternary (red-green-blue) color map to color cells based on their combined saturations.

• **Delta** Choosing “Delta” causes the contour display to reflect the variable value at a selected time, relative to the reference time step.

• **2D Grid Axis Orientation** Two toggles buttons control whether to reverse the X and Y axes. These settings connect to the View plane settings, so you can set reverse toggles for the I plane independently of the K plane.

• **Grid Options** Click this button to bring up a dialog in which you can control many customizations of your grid plot, including loading inactive cells, translating and/or rotating your grid, and more.

• **Expanded List button** Whenever you see the Plus button, next to a list in the sidebar or a dialog, you can click this button to open an expanded version of the list contents. To find an item in the list more easily, you can type letters in the Filter field at the top of the list. Only items that include those letters in that order will appear in the expanded list. For example, to display only items with the word “well” in their name, type “well” into the Filter field.

• **Paging: Animation and Scrolling Controls** The Times region of the sidebar allows you to choose a time step or animate the progression of a time-dependent variable. Use the slider to control time step.

• **Planes** In the Planes region of the sidebar, use the Plane menu to choose logical planes (I, J, or K) to view and the physical plane (YZ, XZ, or XY) or logical plane (JK, IK or IJ) onto which it is projected. For example, choosing J(XZ) will plot only the data at the J-index highlighted in the box, with X as the horizontal axis and depth (Z) on the vertical axis.

When you are working with a radial grid, the list will include R and Theta views. When you make a change, the list of indexes in the box will reflect the new limits for that view (for example, you may have ten J planes but only three K planes).

• **Local Grid Refinement (LGR)** The Local Grid Refinement (LGR) menu and box activate when an LGR intersects the selected plane from the global grid. The menu will show a list of the intersected LGR names. The box will show a list of planes which are part of the LGR selected in the menu.

Where an LGR exists, use the menu to select the LGR and the box to choose its index. In this manner you can switch from the coarse levels of the left-hand box to finer control. Child LGRs appear indented relative to their parent LGR. You can “lock” the relationship between the parent and child LGRs, so that they update each other. To do this, click the Lock button next to the LGR. While the lock is “on”, choosing a parent grid plane will update the plane in the child grid, and changing the plane in a child grid will update the parent grid plane.

By default, changing the plane in a child LGR grid will not update the parent grid plane.
Basic Grid Plots

When multi-reservoir grids are loaded, there is an extra "placeholder" grid with the GLOBAL name, and its dimensions will be N x N x N, where N is the number of reservoirs. In the 2D grid controls, choosing the I, J, or K plane for the GLOBAL grid will actually choose the reservoir number. The LGR list will then be populated with the true grids for that reservoir.

In the 2D Grid plot type, each reservoir is managed independently. This means, for example, that you can't see K plane #5 in two different reservoirs. If this functionality is needed, use Inside View -IJK Slices in the 3D Grid plot type instead.

13 - 2  3D Grid Plots

To view a 3D plot of a grid file, choose "3D Grid" from the Plot Type menu. The display of your plot will change to a 3D view and the Plot Controls sidebar will appear.

You can un-dock the Plot Controls sidebar by dragging its title bar to a new position. To put the Plot Controls back on the side of the workspace, double-click on its title bar (the region that displays the words "Plot Controls"). Or you can drag its title bar to either side of the workspace and let go, and it will snap into place.

The sidebar for 3D Grid plots has the options described following:

- **Mesh Layer** This toggle turns on or off a mesh of lines on your plot.
- **Contour Layer** The “Contour” toggle controls display of flooded contours.
- **Connect** When you have “Wells” toggled-on, this toggle turns on and off the lines connecting the well nodes.
- **Shade Layer** You can use the Shade toggle when you have “Contour” toggled-off. Use it to turn on/off the surface shading, making the interior of the grid mesh visible or hidden.
- **Lighting Layer (3D Grid plots only)** Use this toggle to turn on and off light source shading. When on, shadows make it easier to visualize the shape of the 3D model and mute the colors.
- **Translucency Layer (3D Grid plots only)** With “Translucency” toggled-on, the grid surface becomes translucent, making it possible to see the interior of the model.
- **Inactive Cells** Toggle-on “Inactive” to display the inactive cells along with the active cells in your grid. If you have not loaded the inactive cells, Tecplot RS will prompt you load the inactive cells. See Section “Loading Inactive Cells” for details. See Section 14 - 1.6 “Inactive Cells” to learn how to display solution data on the inactive grid cells.
- **NNCs (2D Grid plots)** Toggle-on “NNCs” to make Non-Neighbor Connections (NNCs) visible. Use the Details button to specify display options in the NNC dialog.
- **Wells** Toggle-on “Wells” to display any wells in the current plot. The shape of the symbol indicates the type of well (producer, injector, and so forth). The Details button adjacent to the Wells option displays the Wells dialog.
- **Bubble Plots** Toggle-on “Bubbles” to show well data represented as bubbles on the well heads.
**Cell Labels** Toggle-on “Labels” to include cell or well labels in the plot.

The Light, Shade, and Translucency toggles are automatically set whenever you choose an option that would activate or deactivate a see-through grid. This includes turning on NNCs, Streamlines, and the Ghost option for inside views.

**Time/History** Toggling-on “Time/history” creates a new frame to display an XY line plot. You can plot value versus time for a single cell in the grid or for a chosen well. If you plot a variable versus time for a selected well, the current selections in the XY Variables plot type determine the variables shown in the Time/History plot. (To plot from a selected well, you must have the corresponding XY data loaded.) If you plot from a cell, Tecplot RS will use the variable currently selected in the 2D or 3D Grid plot to plot the variable versus time.

To plot well data instead of cell data in your Time/History plot, hold down the Ctrl key and select a well head or a cell containing a well.

**Depth** If you have RFT data included in your current XY data set, you can plot these similarly to the Time/history plots by toggling-on “Depth”. Choose which variables to display in the RFT Plots plot type. (Choose “RFT” from the Plot Type menu.)

**Well Path** Creates an XY plot similar to the Time/history and Depth plots by toggling-on “Well Path”. Only available in 3D Plots. Select the cell containing a well to follow the values along the well path. Can be shown in distance along well path or vertical depth.

**Statistics** Displays or hides a statistical plot, either a histogram or cross plot (only one of these plots may be visible). Choose Histogram or Cross Plot sidebar to choose which plot will be displayed and to set its options; for more details, see Statistical Plots.

**Variables** The Variables box lists each variable usable for a contour plot. Time-dependent (dynamic) variables display first, followed by time-independent (static) variables. When you choose a variable, each cell in the grid plot will fill with a color representing the value of that variable at the chosen time.

- **OWG (Oil/Water/Gas) Saturation Plots** Use the OWG option to create a ternary (red-green-blue) color map to color cells based on their combined saturations.
- **Delta** Choosing “Delta” causes the contour display to reflect the variable value at a selected time relative to the reference time step.
- **KSum** Choose “KSum” to display the sum of the variable values in a column (all cells with matching I and J indexes) for all displayed layers.
- **KAvg** Choose “KAvg” to display the average of the variable values in a column (all cells with matching I and J indexes) for all displayed layers.
- **Grid Options** With the Grid Options dialog that opens when you click this button, you can adjust many aspects of the display of your grid plot.
- **Expanded List button** Whenever you see the Plus button, +, next to a list in the sidebar or a dialog, you can click this button to open an expanded version of the list contents. To find an item in the list more easily, you can type letters in the Filter field at the top of the list. Only items that include those letters in that order will appear in the expanded list. For example, to display only items with the word “well” in their name, type “well” into the Filter field.
- **Paging: Animation and Scrolling Controls** The Times region of the sidebar allows you to choose a time step or animate the progression of a time-dependent variable. Use the slider to control time step.
Basic Grid Plots

- **Inside Views** The Inside Views region of the sidebar provides options for displaying the grid solution.

You can store a 3D view (rotation, center, and perspective) and quickly return to it later using the Save and Apply Custom 3D View options on the View menu. See "Custom 3D View" on page 257 for more details.

### 13 - 2.1 3D View Details

Use the 3D View Details dialog (accessed via the View menu) to control a variety of parameters affecting the display of 3D Grid plots.

- **Use Perspective** - Sets Tecplot RS's projection type. If selected, Tecplot RS draws the current frame with perspective projection. If not selected, Tecplot RS draws the current frame with orthographic projection. (Range is 0.1 to 179.9.)
- **Field of View (deg)** - Sets the amount of the plot (in terms of spherical arc) in front of the viewer that may be seen. Zooming in or out of a 3D perspective plot changes this number and the viewer’s position.
- **Maintain Object Size During Field of View Changes** - If selected, Field of View changes result in the viewer’s position being moved so that approximately the same amount of the plane is visible after the change. If not selected, Field of View changes do not change the viewer’s position and result in the entire plot appearing to grow or shrink.
- **View Width** - Sets the amount of the plot (in X-axis units) in front of the viewer that may be seen. Zooming in or out of a 3D orthographic plot changes this number, but not the viewer’s position.
- **Viewer Position** - Change the viewer’s relation to the image by resetting the X, Y, or Z-location, or by changing the view distance.

---

1. With orthographic projection, the shape of the objects is independent of distance. This is sometimes an "unrealistic" view, but it is often used for displaying physical objects when preserving the true lengths is important (such as drafting).
13 - 3 Common Controls

2D and 3D grid plots in Tecplot RS share many powerful features, especially those controlled by the sidebar. You can use the following controls on both 2D Grid Plots and 3D Grid Plots:

- Time Options
- Variable Display Controls
- Grid Options
- Plot Layers (Section 14)

13 - 3.1 Time Options

Use the Time Options dialog to specify a time step increment value and delta display options. To launch the dialog, click the Details button in the Times region of the sidebar, or click the Details button next to the Delta option in the Variables region of the sidebar. This dialog is available for only 2D Grid Plots and 3D Grid Plots.

You can set the Time step Increment value to any integer between 1 and 20. The number chosen dictates the number of time steps that each step of an animation will advance, as well as the number of time steps that the Next (>) and Previous (<) buttons advance the plot. To display the most detailed time animation (the highest number of time steps), enter a time step increment value of "1". To view the animation, use the Play (<<) and Rewind (<<) buttons in the Times region of the sidebar.

The Delta Display region defines the settings used to display delta values on the grid plot (by toggling-on "Delta" in the sidebar). The delta values represent a selected relationship between the solution data at the current time step (set in the Times region of the sidebar) and the solution data at a reference time step (set in the Time Options dialog).

The reference time step, or "Ref Time", is the time step to which Tecplot RS compares each time increment in the delta value formula. This is usually the first time step, but you can choose any time step as the reference time.

Tecplot RS supports several methods of calculating the delta value. Choosing one of the methods from the Formula menu will assign the delta calculation to use that formula.

Methods for calculating the delta value include the following, where \( V_c \) indicates the variable value at the current time and \( V_r \) indicates the variable value at the reference time:

- \( V_c - V_r \) = Variable value at current time minus variable value at reference time (default and previously standard method)
- \( V_r - V_c \) = Variable value at reference time minus variable value at current time
- \( \frac{V_r - V_c}{V_r} \) = Value at reference time minus value at current time, normalized by value at reference time
- \( \frac{V_c - V_r}{V_c} \) = Value at current time minus value at reference time, normalized by value at current time

1. Available values for the reference time step, "Ref Time", depend on your default time variable of either Time or Date (set on the Load/Save page in the Plot Options dialog).
Basic Grid Plots

Toggle-on “Show Magnitudes”, the last option in the Delta Display region of the Time Options dialog, to use the magnitude (absolute value) of each delta value. This option ignores the direction (+ or -) of the delta value, allowing for greater display resolution.

The grid legend displays the range of variable values, as calculated based on selections in the Time Options dialog. When “Show Magnitudes” is toggled-on, a minimum range of zero displays. If you choose an unnormalized range, the legend will range from the minimum range value (either positive or negative) to the maximum value. If you choose a normalized range, the legend will vary between negative one and positive one (-1 to +1).

You can modify the range to any positive or negative values by using the Grid Legend page of the Plot Options dialog.

When time delta is used blank using:

When time delta is used, blanking will be applied based on either the original variable values or delta values depending on this selection. (Default: Original Values)

Settings in the Time Options dialog will display when “Delta” is toggled-on in the sidebar.

13 - 3.2 Variable Display Controls

Depending on the plot type displayed, two or more controls appear in the sidebar next to the list of variable names. In 2D Grid plot mode, the first two controls (OWG, Delta) will display. In 3D Grid plot mode, all four controls (OWG, Delta, KSum, KAvg) display. These selections let you perform specialized computations on the variable values and show the results in the contour display.

You can only use one of the four options—OWG, Delta, KSum, and KAvg—at a time. Choosing one will deselect any other. Tecplot RS may disable an option if the active grid does not have the data needed to support that function.

To learn more about the KSum or KAvg control, refer to Section 17 - 5.1 “KSum” or Section 17 - 5.2 “KAvg”, respectively.

OWG (Oil/Water/Gas) Saturation Plots

Toggle-on “OWG” to display a ternary RGB (Red/Green/Blue) color scheme. The associated saturation variable determines the intensity of each color, where Blue = Water, Red = Gas, and Green = Oil. The legend also changes to a RGB color triangle.

You can change the time steps or animate the plot to see how the relative oil, gas, and water saturations change over time. For example, by observing the predominantly blue regions, you can easily monitor areas with high water saturations.

Tecplot RS automatically chooses variables for Oil, Water, and Gas when possible. If your data set only includes two of these variables, Tecplot RS will automatically calculate the missing variable for you.
If the automatic choices are not suitable, you can choose the variables that represent oil, water, and gas yourself by clicking the [...] button next to the OWG checkbox in the sidebar. The Choose OWG Variables dialog appears.

For each of oil, water, and gas, you can choose a variable using the corresponding menu. Then click OK to save your changes. The plot updates automatically after you click OK.

**Delta**

Instead of showing a variable value at a single time, you can create plots that represent the change in a variable value over time relative to a reference time step. Use the Delta toggle to do this.

When you toggle-on “Delta”, the colors of each cell represent the variable value at the current time value in that cell, relative to a reference time step. If the slider (in the Times region of the sidebar) is at the reference (by default, the initial) time step, the entire grid will display as a solid color, representing the variable value at the minimum time value. As the time slider progresses to sequential values, the plot’s coloration will display changes in the variable value over time.

Tecplot RS will disable the Delta option when the current data set no time-dependent variables. You can use the Delta option with the sample grid data included in your installation (such as chelan.grid). Make sure you have a time-dependent variable selected (with chelan.grid loaded, chose the “PRESSURE” variable), and note the changes on your display as you click the Play (>>) button or other time increment buttons in the Times region of the sidebar.

Refer to Section 13 - 3.1 “Time Options” for instructions on customizing the time dependency calculation settings.

**13 - 3.3 Grid Options**

The Grid Options dialog, accessible by clicking the Grid Options button in the Variables region of the sidebar, controls attributes of the grid display of your plot. You can use the various pages in the Grid Options dialog to customize your grid settings.

Each page of the dialog (except the Inactive Cells page) includes an Apply button. Click the Apply button to apply changes on that page of the dialog to your plot.
Orient/Thicken

Unlike the standard topographical model where the Z-axis represents elevations (increasing upwards), reservoir simulators usually use a Depth value for the Z coordinate (that increases downward). If Tecplot RS displayed this type of grid using a typical 3D orientation, the plot would look upside-down.

Tecplot RS provides two methods for reversing the depth component. By the first option, Tecplot RS maintains all coordinate values and rotates the 3D view so that the Z-axis points down. This maintains the right-handed nature of the coordinate system (often used by the simulator). To use this 3D view rotation, choose Right-handed as the grid orientation.

By the second method, useful for dealing with left-handed coordinate systems, Tecplot RS multiplies all Z values by -1. To use this control, choose the Left-handed grid orientation on the Orient/Thicken page of the dialog.

The two orientations result in different views of your plot; if viewed side-by-side, the same data set with the two different methods would appear as mirror images of each other.

Different grid file types generally use either right or left-handed coordinate systems, and Tecplot RS chooses the most likely orientation when loading a grid file based on the file type and state file settings, in the following order:

1. Tecplot RS will use the orientation specified in the state file, if a state file exists for the file being loaded.
2. If Tecplot RS loads the file by a macro that includes orientation, it will use that setting.
3. Otherwise, Tecplot RS will choose coordinate systems based on file type:
   • Sensor grids load with right-handed coordinates,
   • VIP and VDB grids load with the coordinates specified in their files,
   • .egrid files load with left-handed coordinates unless the optional GRIDUNIT flag indicates otherwise, and

164
**Common Controls**

- .grid files load with right-handed coordinates unless the optional GRIDUNIT flag indicates otherwise.

The **Z-Axis Exaggeration** value exaggerates (or flattens) the vertical scale (typically, Z). Allowable values range from 0 to 100. Use a value of 0 (recommended) to let Tecplot RS automatically compute a pleasing ratio. If you use the grid thickening factor, set the Z-Axis exaggeration to 0, at least initially.

The **Grid Thickening** factor enables you to stretch the Z (vertical) axis on 3D Grid plots by a selected factor, without exaggerating the topology. Especially useful for plots with thin vertical layers and irregular surfaces, this feature stretches the grid between the top and bottom surfaces, to make thin vertical layers more visible while preserving the original slopes.

While applying Z-axis scaling changes only the display, applying the Grid Thickening factor actually changes the Z values in the grid. When you apply thickening (by changing the factor to a number greater than 1), the labels on the displayed Z-axis will change, and probing results will reflect the altered Z values. Any grid equations that use the Z variable will also reflect the “stretched” Z values.

The thickening factor will default to 1 the first time a grid is loaded. Tecplot RS saves the latest factor in the project file, so that a reloaded project remembers and uses the saved factor. Multiple grids in one project may have different thickening factors.

The factor can range from 1 to 1000, where 1 indicates no thickening applied. A factor acts as a multiplier for the total grid thickness. For example, applying a thickening factor of 5 will stretch a grid with an original vertical depth of 200 to an adjusted vertical depth of 1000.

Adding a thickening factor will not thicken streamlines and survey wells (wells loaded from separate files, where those files define the well nodes with XYZ locations) with the grid. These will still display, but they may not appear at the correct depths. Wells included in the original simulation data will stretch properly with the grid.

These settings have no effect on other plot types, and you can use the thickening and exaggeration together. Click **Apply** to implement your changes.

**Inactive Cells**

On the Inactive Cells page of the Grid Options dialog, you can choose whether to load or unload inactive cells in the grid. You can click the Load Inactive Cells button to load the inactive cells if they are not loaded already. When Tecplot RS has inactive cells loaded, the button on this page of the dialog changes to Unload Active Cells. Click this button to immediately unload the inactive cells in your plot.

If, when you click Load Inactive Cells, a message appears that the "Inactive grid file has not yet been solved", you must first instruct Tecplot RS to create the rsgridi file. To do this, reload your grid data, and on the Options page of the Load Grid Data dialog, either choose "Create a new RSGRID file" or toggle-on "Load inactive cells". See Section "Loading Inactive Cells" for details.
Basic Grid Plots

Dual Porosity

When working with dual porosity grids, you can use the Dual Porosity page of the Grid Options dialog to adjust the display of matrix or fracture representations of your grid. To show both the matrix and the fracture grids simultaneously, choose “Show Both.”

When displaying both grids, Tecplot RS overrides the settings in the Multi-Frame Options dialog in favor of the dual view. The two grids appear side-by-side if the paper layout is in landscape mode, or stacked vertically if the paper is in portrait mode.

Displaying both grids also links the view and blanking options between the two grids, regardless of the settings in the Multi-Frame Options dialog. However, layers and NNCs are still linked according to the selections in the Multi-Frame Options dialog. Cell Labels, Streams and Quick Plots appear only on the matrix grid. Finally, variable settings are linked between the frames.

The Well Display option controls how wells are shown when displaying dual porosity grids. You may choose to display only the wells that complete in the displayed grid (first option) or to show all wells regardless of where they complete (second option). If Grid Display is set to Both, each well is shown only in the grid in which it completes (option 1), or in both grids (option 2), according to this setting.

Changing these settings requires Tecplot RS to re-output and re-draw the entire grid. Since this may take some time for large files, these settings are not applied until you explicitly do so by clicking the Apply button.

Translate

You can use the Translate page of the Grid Options dialog to translate your grid to a new location relative to the coordinate system. Choose “Translate to 0,0” to shift the current minimum X and Y coordinates of the grid to the origin, or choose “Enter values” to shift the grid to a new position that you specify.

When “Enter values” is chosen as the translation, the dX, dY, and dZ text boxes become active. You can use these text boxes to indicate the direction in which you wish to shift the grid. These dX, dY, and dZ measurements reference the original grid position as dX = dY = dZ = 0. Tecplot RS reads any values in these text fields as a distance from the original position. (To undo all grid shifts, then, and return to the original grid position, type “0” into each of the three text boxes.)

With the Apply to survey wells control, you can choose whether to include survey wells in the translation. While usually survey wells require translation with the plot, turning this option off may be useful to align your plot and survey wells if the survey wells were input with a different coordinate system.

Click the Apply button to apply the translation to your plot.

1. Refer to Chapter D: “Paper Layout” for information on changing the paper orientation.
Rotate
With the Rotate page of the Grid Options dialog, you can specify a rotation angle, align the edge of the grid with the axis, or use MAPAXES data if included in your data file(s).

- **Enter Angle** With this control chosen, you can type the desired rotation angle (in degrees) and click Apply to rotate your plot by the specified angle.
- **Align w/ axis** Choose this control to align your grid along a north/south orientation.
- **Use MAPAXES** If you want to rotate an Eclipse grid, and your grid file includes MAPAXES data, you can choose this control to determine rotation (and translation if included in the MAPAXES data).

Since, as with translation, the rotation angle measures the angle from the original grid position, you can type “0” into the Rotation angle text box (and click Apply) to return the grid to its original orientation.

Toggle-on “Apply to survey wells” to rotate survey wells along with your plot, and click the Apply button to apply the rotation to your plot.

Scale
With the Scale page of the Grid Options dialog, you can multiply each coordinate by a number to scale that coordinate larger or smaller. This feature can help if you wish to convert your grid from one unit of measurement to another, or to exaggerate one dimension relative to another. (However, the Orient/Thicken controls can exaggerate the vertical dimension more optimally than the scaling controls).

Toggle-on “Apply to survey wells” to scale survey wells along with your plot.
Click the Apply button to apply the scaling to your plot.

13 - 4 More Options
Tecplot RS includes dozens of additional options for customizing the display of your grid plot. The following possibilities that you can investigate with the 3D Grid view of your plot provide an overview of your options.

On the Wells page of the Plot Options dialog, try both the Frame Units and Grid Units settings for text (click the Apply button to see the effects). Each time, zoom in and out on the grid view and watch what happens to the well labels.

On the Orient/Thicken page of the Grid Options dialog, set the Z-Axis Exaggeration Factor to “2” and click Apply. View the results, then try it again using a scale of 0 (zero).

Still on the Orient/Thicken page, set the Grid Thickening Factor to “2” and click Apply.

On the Grid Axes page of the Plot Options dialog, toggle-on “Show 3D Axes” and click Apply.

On the Grids page of the Plot Options dialog, switch the Contours Type to “Continuous Flood”. This causes color to vary between contour levels instead of using a constant color for each cell. Look at several variables and time steps in both 2D and 3D Grid plot types, comparing them to the results you had when “Cell Center Flood” was selected.


See Chapter F: “Plot Options” for more information on all the features accessed with the Plot Options dialog. To learn more about grid thickening, refer to Section F - 7 “Grid Axes”.

On the Grids page of the Plot Options dialog, switch the Contours Type to “Continuous Flood”. This causes color to vary between contour levels instead of using a constant color for each cell. Look at several variables and time steps in both 2D and 3D Grid plot types, comparing them to the results you had when “Cell Center Flood” was selected.


167
13 - 5 Changing Variables in Multi-frame Grid Plots

When working with multi-frame grid plots (see Section 3 - 1 “Using Frames” on page 45), the initial multi-frame plot displays the currently chosen variable in the first frame, and subsequent variables in subsequent frames. You can change the variable chosen for each frame after the multi-frame plot has been created.

To choose a new variable for a specific frame, first make the frame active by clicking anywhere within it. Then, in the sidebar, choose the variable that you wish displayed in that frame. Tecplot RS will update that frame with new values. You can do this for each frame.
Grid Plot Controls

Since we provided the Tecplot RS sidebar with the goal of making plot attribute modifications trivial, the top of the grid plot types' sidebar naturally controls all plot layers, and the rest of the sidebar includes other important controls.

While the basic options available for grid plots are described in Chapter 13: "Basic Grid Plots", this chapter details the plot layers that Tecplot RS allows you to interactively add and subtract in any combination in the sidebar, as well as several other toggle switches included in the grid plot sidebars.

14 - 1 Plot Layers

Tecplot RS includes the following plot layers for grid plots:

- Mesh Layer
- Contour Layer
- Connect - When displaying wells, the Connect toggle turns on and off the lines connecting the well nodes.
- Shade Layer
- Lighting Layer (3D Grid plots only)
- Translucency Layer (3D Grid plots only)
- Inactive Cells
- NNCs (2D Grid plots) (see Inside Views for NNCs on 3D Grid plots)
- Wells
- Bubble Plots
- Cell Labels

Use the toggles in the top region of the sidebar to activate each layer. The Details (...) button next to the Light, Inactive, NNCs (2D Grid plots), Wells, Bubbles and, Cell Labels, toggles launches dialogs that you can use to customize your settings for the corresponding layer. Use the Plot Options dialog (accessed from the Options menu) to change global settings for each of the layers. You must turn on a layer to view its settings.
Grid Plot Controls

14 - 1.1 Mesh Layer
Toggle-on “Mesh” in the sidebar to add a mesh layer to your grid plot.
The mesh plot layer displays the lines connecting neighboring data points within a zone. For I-ordered data, the mesh is a single line connecting all of the points in order of increasing I-index. For IJ-ordered data, the mesh consists of two families of lines connecting adjacent data points of increasing I-index and increasing J-index. For IJK-ordered data, the mesh consists of three families of lines, one connecting points of increasing I-index, one connecting points of increasing J-index, and one connecting points of increasing K-index. For finite element zones, the mesh is a plot of every edge of all of the elements that are defined by the connectivity list for the node points.

To adjust the appearance of the Mesh layer on your plot, use the Grids page of the Plot Options dialog (accessible by double-clicking on your plot or choosing “Plot Options” from the Options menu).

14 - 1.2 Contour Layer
You can use the contour layer to show variation of one variable across all cells. To add a contour layer to your plot, toggle-on “Contour” in the 2D or 3D Grid sidebar.

To change the type of color mapping used in the contour layer, use the Grids and Grid Legend pages of the Plot Options dialog.

14 - 1.3 Shade Layer
Although most commonly used with 3D grid plots, you can also use the shade layer to flood 2D plots with solid colors, or light source shade the exterior of 3D volume plots. In 3D plots, translucency and lighting cause color variation when you have the shade layer turned on. Shading can also help you determine the shape of a plot.

Toggle-on “Shade” to add shading to your 2D or 3D Grid plot.

14 - 1.4 Lighting Layer (3D Grid plots only)
You can enhance the shading of 3D grid plots by using lighting and translucency layers. To activate the Light layer, turn on the Light control in the sidebar.

Tecplot RS calculates the lighting as though the light source appears as a point of light far from the drawing area (so casting nearly parallel beams, as the sun does on the earth).

Once you have turned on the Light layer, you can use the Light Source tool to change the position of the light source relative to your plot. To do this, after turning on the Light layer, click the Light Source tool in the toolbar, and drag in your plot to change the light source position. You can also see the light position change reflected on the 3D orientation axes.
To adjust the effect that the light source has on your plot, click the Details button next to the Light control in the sidebar to open the **Light Source** dialog. In this dialog you can adjust the following settings.

**Lighting** Use these controls to adjust how extremely the light affects your plot.

- **Intensity** Use this control to adjust how brightly the light source "shines" on your plot. A higher intensity value results in a "brighter" appearance. (An intensity of 100% produces maximum contrast between lighted and unlighted areas, and fully lighted areas use the full surface color.)

- **Background Light** With this control, you can adjust the lighting effect applied to your entire plot, regardless the light source position. A higher background light value results a higher amount of light on all areas of your plot. A background light of 100% results in all areas lighted the maximum amount, and areas not lighted by the directional light source use full surface color.

- **Surface Color Contrast** Use this control to adjust the saturation of contour coloring in your plot under the light. A higher value results in more saturated colors. A surface color contrast value of zero results in a white plot before applying lighting effects (the plot will only appear in white and/or shades of gray).

**Specular Highlights** With this control, you can turn on/off the appearance of reflected light on 3D shaded or flooded objects. This affects all surfaces in your plot receiving light from the light source.

- **Intensity** The intensity value controls the amount of specular highlights (that is, the amount of reflected light, which controls the amount of whiteness at the peak of the highlight).

- **Shininess** The shininess value controls how shiny the highlighting is - the size and spread of the highlighting.

**Optimization** A few combinations of lighting type and plot style may result in slower redrawing of plots (especially larger plots). Tecplot RS provides the choice of which lighting method to use in order to avoid slower redraws. These optimizations are on by default. You may want to turn the graphics cache off before turning off these optimizations for plots with large amounts of data. See **Performance Dialog: "Graphics Cache"** for details on caching graphics.

- **Force Gouraud Effects** This control forces gouraud shading under the circumstances described. Gouraud shading achieves smooth lighting by linearly interpolating a color or

### Light Source dialog

- **Intensity (%):** 75
- **Background light (%):** 50
- **Surface color contrast (%):** 100

### Specular highlights

- **Include specular highlights**
- **Intensity (%):** 60
- **Shininess (%):** 40

### Optimization

- **Force gouraud effects when plotting**
- **Light source shaded contours flooded contours**
- **Force gouraud effects when plotting light source shaded oil flooding**

Intensity and background lighting act cumulatively; they can result in colors lightened beyond the base surface color. For example, for high values of both controls, reds may become pink and grays may become white. You may need to experiment with the controls to find the best setting for your plot.

- **Surface Color Contrast** Use this control to adjust the saturation of contour coloring in your plot under the light. A higher value results in more saturated colors. A surface color contrast value of zero results in a white plot before applying lighting effects (the plot will only appear in white and/or shades of gray).
Grid Plot Controls

shade across a polygon. It offers a more continuous and smoother shading than paneled shading, but can result in slower plotting in some cases.

- **Force Paneled Effects** This control forces paneled shading under the described circumstances.

In paneled shading, the color within each cell assigned to each area by shading or contour flooding is tinted by a shade constant across the cell. Tecplot RS bases the shade on the orientation of the cell relative to the light source.

**14 - 1.5 Translucency Layer (3D Grid plots only)**

As noted previously, you can enhance grid plot shading by using lighting and translucency in your 3D grid plot. To make your plot translucent, enabling you to see the interior of the plot, toggle-on the “Trans” toggle in the Layers region of the sidebar.

Tecplot RS automatically sets the Light, Shade, and Translucency controls whenever you choose an option that would activate or deactivate a see-through grid, including the Ghost option for inside views.

**14 - 1.6 Inactive Cells**

To display the inactive cells in the active plot, toggle-on “Inactive” in the sidebar. If you have not loaded the inactive cells associated with the active grid, Tecplot RS will prompt you to load them. See Section “Loading Inactive Cells” for details.

You can use the Inactive Cells dialog to customize the inactive cell display. Click the Details button next to the Inactive toggle to launch the Inactive Cells dialog.

At the top of the dialog, you can choose whether to display the inactive cells as a simple mesh or shade, or whether to display a variable value:

- **No fill (mesh only)** Choose this option to display the inactive cells as a mesh.
- **Solid Shade** Choose this option to fill the inactive cells with a color.
- **Variable - match active** Choose this option to color the inactive cells according to the solution data of the variable used by the active cells. If the inactive cells do not contain a value for that variable, they will display with a value of zero.
- **Variable - independent** Choose this option to color the inactive cells according to solution data of a variable of your choice. If the inactive cells do not contain a value for that variable, they will display with a value of zero. Choose the variable you wish displayed from the Contour variable list.

In the next region of the dialog, you can specify the style of the mesh or shading chosen:

- **Mesh Color** Choose the color of mesh displayed from the Mesh Color menu.
- **Thickness** Enter a thickness value between 0.1 and 2.0 in the Thickness field to specify the width of the mesh lines as a percentage of frame size.
- **Shade Color** Choose a color for inactive cell shading from the Shade Color menu.
When “Variable - Independent” is highlighted in this dialog, the Contour variable list becomes active. Choose a variable from this list to use this solution variable to color the inactive cells accordingly. If the grid data for the inactive cells does not include a value for that variable, the inactive cells will display a value of zero.

A portion of this dialog’s controls are also included on the Grids page of the Plot Options dialog (when “Inactive” is chosen on the left side of that page: see Section F - 5.2 “Inactive Cell Styles”). Changes made in one dialog will be updated in the other dialog.

**14 - 1.7 NNCs (2D Grid plots)**

If your grid model includes Non-Neighbor Connections (NNCs), you can view them as a layer on your 2D Grid plots. (For 3D Grid plots, choose “NNCs” from the drop-down menu in the Inside Views section of the sidebar. See “NNCs” on page 190 for further details.)

In 2D Grid Plots, a heavy line indicates NNCs, marking the upstream and/or downstream faces normal to the view plane. Click the [...] button next to “NNCs” in the sidebar to set the styles for NNC display. You can choose to display the upstream faces, downstream faces, or both. When both types are displayed, the overlap can cause interference, but selecting different colors can help differentiate the two.
Grid Plot Controls

To make NNC faces visible in 3D, Tecplot RS activates see-through grids when NNCs are activated. Use the Grids page of the Plot Options dialog to customize the See-Through styles.

When the See-Through Style is set to “Ghost Gray”, you can use the Light Effect to alter the appearance of the surface. Choose the “Paneled” Light Effect to get a better idea of cell boundaries (especially when the mesh is turned off), or “Smooth” to create a more rounded look. The “Smooth” option may load slowly on very large models.

Only NNCs within a grid display. NNCs between the global grid and LGRs, or those between two LGRs, are not highlighted, although the boundaries are still visible when translucency is on.

When NNCs are displayed, Tecplot RS displays a legend for the NNC variable. You can move or remove this legend by choosing the Paper Layout plot type and moving or deleting the RS_NNCVAR (the legend title) and/or RS_NNCLEGEND (the legend itself) dynamic text items from the layout.

To adjust the legend, switch to the 3D Grid plot type and double-click the legend. The Grid Legend page of the Plot Options dialog appears; click the variable by which the NNCs are colored in the Variables list to modify the NNC legend settings.
14 - 1.8 Wells

Toggle-on “Wells” in the sidebar to display wells in your plot.

Click the Details (...) button to bring up the Wells dialog.

With the options in the Wells dialog, you can limit the wells displayed to a subset of those in the file. This helps when you have so many wells in the reservoir that displaying all of them makes it difficult to see details.

In the top region of the dialog, toggle-on “Show Wells” to display wells on your plot. This toggle matches the Wells toggle in the sidebar. You can also click the Styles button to modify the styles of your wells on the Wells page of the Plot Options dialog.

In the Display region of the Wells dialog, the box contains the list of wells from which you can highlight those you want to include. You can use the Select All button to highlight all wells. Use the Refresh button to apply your changes to the current plot.

Of course, if you have thousands of wells, choosing the ones you want to display from a box may not work efficiently. In this case, use Selection Sets.

To understand the basic concepts of selection sets, and how to create them using filters, read Chapter 7: “Filters, Selection Sets, Groups, Well Patterns, and Branches”.

Within the Wells dialog, you can create new selection sets from the list of highlighted wells AND use existing selection sets to change those highlights.

To create a new selection set (SS), start by highlighting the wells you want to include in the box (in the Display region of the dialog). Assign a name for the set (or use the supplied default), and click the Make SS button.

To use an existing SS to alter your chosen list of wells, highlight the set you want from the box in the lower region of the Wells dialog. Choose a rule to follow for making the changes:

- Add to selections Tecplot RS will highlight each well name from the selection set highlighted in the upper box, without disturbing existing selections.
- Remove from selections Tecplot RS will turn off each well name from the selection set in the upper box, without disturbing other selections.
- Replace selections Tecplot RS will modify all highlights in the upper list so that only the wells in the selection set will be highlighted.

Click Apply to use the selection set to alter the wells selected for display.
Grid Plot Controls

You can also use the pointer to change the highlighted wells. To do this, start by toggling-on “Wells” with the well labels (modify label settings in the Wells page of the Plot Options dialog). This is necessary because you will be selecting the well labels with the pointer, rather than the well symbols.

Switch to the Multi-Select page in the Wells dialog. Use the pointer to pick the wells. You can do this by rubber-banding a box around the ones you want, or by holding down Shift key and clicking individual labels. Just remember it is the labels (text) you want (any other picks will be ignored). As long as you hold down the Shift key, the well labels will accumulate.

Click Apply to use the picked wells to alter the well highlights.

Switch to the Multi-Select page in the Wells dialog. Use the pointer to pick the wells. You can do this by rubber-banding a box around the ones you want, or by holding down Shift key and clicking individual labels. Just remember it is the labels (text) you want (any other picks will be ignored). As long as you hold down the Shift key, the well labels will accumulate.

Click Apply to use the picked wells to alter the well highlights.

At this point, you may wish to create a selection set. Refer to Chapter 7: “Filters, Selection Sets, Groups, Well Patterns, and Branches” for detailed information on selection sets.

14 - 1.9 Cell Labels

For 2D or 3D Grid plots, toggle-on “Cell Labels” to include cell labels on your plot. You can use grid labels to display chosen data for the grid cells. By default, Tecplot RS labels each cell with its I-variable. Click the Details (...) button to launch the Cell Labels dialog, where you can choose another variable.

Use the Skip field in the Cell Labels dialog to thin out cell labels. By default, Tecplot RS uses a skip value of zero. A value of zero designates an auto-skip mode, where Tecplot RS computes the skip value to produce approximately 100 total labels. The auto-skip mode usefully adjusts to grids with different numbers of cells or when switching between 2D and 3D views.

Use the Cell Labels page of the Plot Options dialog to customize the label formatting (Section F- 8 “Cell Labels”).
14 - 1.10 Bubble Plots

Bubble plots provide a way to display data for individual wells on a 2D or 3D grid plot. The well head symbol is replaced by a bubble that represents values for well data at the time defined by the time slider. The values may be historical, simulated, or even delta values computed between the two.

Bubbles are in the form of a pie chart with up to four different slices, one for each variable with each in a different color. Injectors and producers may be defined separately, so up to eight total values may be shown on the plot. Bubbles may also be sized according to a variable or even a sum of multiple variables. In this way, the pie slices display the relative quantities of two or more values, while the bubble size reflects the magnitude of a value.

To create bubble plots, you must have both XY and grid data sets loaded (refer to 4 - 1 “Loading XY Data” and Chapter 12: “Loading Grid Data” for details). Once you have loaded both sets of files, switch to a grid plot type and toggle-on both “Wells” and “Bubbles”. Then use the [...] button next to the Bubbles to bring up this dialog:
Grid Plot Controls

**Prod and Inj**

Note that the array of controls on the upper half of the dialog are divided into two groups for “Prod” (production) and “Inj” (injection) bubbles. Tecplot 360 will create two separate sets of bubbles, and if both are to be shown you will need to limit your selections to variables that fall in the appropriate category. While there is nothing preventing you from selecting injection values in the production group, or vice-versa, if you mix the two you may get two bubbles plotted on top of each other, with the result being a “scrambled” image.

**Variable and Color**

For each bubble value to be shown, choose the variable and color. You may choose the color explicitly or select the “Default” option. This is the same as using the Default symbol color for XY line plots. The Default color is defined in the `rsvariables.txt` file, and can be seen/changed using Plot Options: Variables.

**Multiplier**

Each pie slice value will generally be measured in different units than the next. The Multiplier option can be used to balance or create equivalent units so that the relative size of one pie slice does not completely obscure the other.

Note that the multiplier is used for both the pie relative size and in the label for the pie slice value.

**Show in Pie and Use for Size**

Check the Show in Pie toggle to indicate that you want this variable to be included in the pie chart. You may select up to four variables within a Prod/Inj group to be shown.

The Use for Size toggle indicates that you want to use a variable to control the bubble size. Generally only one size variable will be chosen, but if you choose more than one then the sum of the values will be used to determine the size.

**Bubble Size**

The Use for Size toggle is active only when the bubble sizing is Dynamic, as controlled in these selections:

Choose Dynamic sizing when you want the bubble size to vary according to the values defined by the Use for Size checkbox. When only a single variable is selected in Show in Pie, you will almost always want to choose Dynamic sizing so that you can see changes other than what is reflected in the label. Static sizing will make all bubbles the same size.

When dynamic sizing is in effect, the Range Ring option will plot a hollow circle to represent the maximum bubble size, providing a visual scale for the current size vs. the max value for all wells over all times.

The Scale options include Diameter or Area, and this selection controls how the bubble is sized relative to the maximum size. For example, if the max value of the bubble size values is 1000 and the current value is 500, the bubble could be either half the diameter of the maximum size or half the area of the maximum, depending on this selection.

The Size and Units options control the actual dimensions of the maximum bubble size when Dynamic sizing is in effect, or the Static size if that option is chosen. Size may range from 1 to 20, and this value represents a percentage of either the frame size or the average dimension of the grid. If you choose Grid.
units, the bubbles will get bigger/smaller when you zoom in or out on the view. Frame units will keep the bubble sizes constant relative to the frame. The latter is usually the better option when there are many wells, since you can zoom in and eliminate overlap.

**Labels**

Each pie wedge can be labeled with the value and/or name of the variable being shown. The labeling options are shown here:

As with the bubbles themselves, you can choose sizing units for the labels that will either zoom with the grid or remain fixed relative to the paper/frame.

**Delta Bubble Plots**

Bubbles can also display delta values - the change in a value between one dataset and another. This may be historical data vs. simulated, or the difference between two different simulations.

When the Show Deltas toggle is checked, you will be limited to showing a single variable value, and bubble sizing is automatically switched to dynamic so that the bubble size will reflect the magnitude of the value. The Delta File controls will display the list of loaded XY files from which you can choose the one used to calculate the differences.

Bubbles will be shown in the selected color when the delta value is positive, and in white when the change is negative.

You must also choose a value for the Delta Max, which is the value that scales to the maximum bubble size. Larger deltas will be clamped at that size. A sample use case for this is when any value greater than this max is equal cause for concern, but you want more granularity to see the lesser values.

If you toggle on Normalize, the size of the delta bubbles will represent the magnitude of the difference between the Active Data Set and the comparison data set divided by the value of the Active Data Set.

**Bubble Style Files**

Bubble styles are saved as part of the project file and will be remembered when the project is reopened. You can also save just the bubble styles in a separate file. This makes it easy to share the styles between projects or to create your own custom style to be used as a default starting point for new projects. Use the Save and Load buttons to accomplish this.
14 - 1.11 Stamp Plots

Stamp plots provide a way to compare well production and injection data on a 3D grid plot. This gives a spatial view of these data, allowing the engineer to determine those regions of the reservoir that are performing well or poorly. When stamp plots are shown, each well symbol is replaced by a miniature line plot of the selected property appropriate for the well type at the current time step.

To create stamp plots, you must have both well (XY) and grid data sets loaded (see Section 4 - 1 "Loading XY Data" and Chapter 12: "Loading Grid Data" for details). Switch to the 3D Grid plot type, and turn on the "Wells" toggle. Then use the […] button next to the Stamps option to display this dialog:

![Stamp Plot Options Dialog]

The list of properties comes from the Well data set. You may choose one property for production data, and another for injection data. Which property is shown for the stamp will depend on the status of the well at the time step determined by the slider on the sidebar. So if a well changes from a producer to an injector partway through the simulation, you will see the stamp change to the other property when you move the slider.

You can select from small, medium, or large sizes for the stamp plots. The stamps may be drawn as a simple line or a filled area with the "Use solid fill" toggle. The range for the vertical axis will be set to the min/max values of the displayed property over all times and all wells. This allows you to compare how wells perform relative to each other. For production properties, the color will be according to your settings in plot options. For injection properties, the color will be determined by the well type (red for gas injectors, blue for water or generic injectors).

When the "Time/history" toggle is selected and you Ctrl-click on a well, the XY view is displayed using one of the following options:

- Select "Show enlarged stamp plot" to display a larger view of the XY plot shown in the stamp. This option will display the Time/history plot using the production and injector property selections in the Stamp options dialog so that the XY view is an "enlarged" version of XY plot displayed in the stamp.
Additional Data Views

- Select “Show view defined in XY Variables plot” to display an XY plot using the property settings from the XY Variables plot type. If this option is selected, the Time/history plot may not match the stamp if the properties selected in XY Variables is different that the property selections in the stamp plot dialog.

You can use the “Well Selection...” button to choose which wells, and thus which stamps, are displayed on the plot. The Auto-Apply button, when turned on, will instantly apply your selections to the plots as you make them. If you have a large number of wells, it may be helpful to leave this off and use the Apply Changes button to see the results after making multiple changes.

14 - 2 Additional Data Views

You can quickly incorporate another view of your grid data by using one of the following toggles in the sidebar:

- **Time/History**
- **Depth**
- **Well Path**
- **2D Plane in 3D View**
- **Statistical Plots** in the Analyze menu, give additional methods to view data.

These data views have options to select either a cell or well. The current selection mode is shown in the sidebar. The crosshair containing the box is for cell probing. The crosshair with the well is for the well probing mode.

14 - 2.1 Time/History

When you toggle-on “Time/history” in the sidebar, Tecplot RS reduces the size of the first frame to make room for another frame. The pointer also changes to a small crosshair with a box denoting the pointer is in cell probe mode.
Grid Plot Controls

Use the pointer to choose any cell in the grid. A line plot will fill the new frame. This graph represents the displayed grid variable for the chosen cell over all time steps.

If you change the variable or highlight a different cell, Tecplot RS will update the Time/history frame to reflect the new selections. You can conveniently query values for a selected cell.

If XY data is loaded into a project with the grid solution, then a user can utilize the Time/history plot to XY data in the quick frame. A user can interactively choose the well data they want to view with the well probe. Clicking the cell that contains the well you are interested in is the most reliable way to choose a specific well.
**14 - 2.2 Depth**

The Depth toggle is similar in operation to the Time/History toggle, but the Depth plots show data at various depths. If you have loaded RFT data, you can Control-click a well to see the RFT plot for that well at the time closest to the one selected for the grid display. The sidebar settings for the RFT plot type (accessible by choosing RFT from the Plot Type menu) determine the variables that appear on the Depth plot. If the RFT data has values for multiple times, the Depth plot automatically updates as you change the grid time step.

If you are displaying grid data in 3D, you can also display another type of Depth plot. By clicking a cell (without the Control key) you can get a plot of the cell values versus depth for a column of cells at the IJ location where you clicked. The solution value in this plot is the one shown in the grid in the first frame. If you have chosen delta values, derived (equation values), or KSum/KAvg, the plot also reflects those. Animating or changing the time slider updates the plot at each time step.

For the column of cells plot, depths are computed from the Z coordinate at the center of each cell. If you have applied Grid Thickening, the Z values will be altered from the original. Z values are not changed when simply exaggerating the vertical scale.

**14 - 2.3 Well Path**

The well path toggle is similar in operation to the Time/History and Depth toggles except it is only available in 3D Grid Plots. The Well Path toggle instead follows the value through the distance of the well path.

Probing along the Well Path also has two options for displaying the data. Either by distance from the first node or vertical depth. These options can be changed by selecting the “...” icon next to Well Path.

**14 - 2.4 2D Plane in 3D View**

Use the 2D Plane in 3D View toggle to display a 3D view of your current 2D Grid Plots. The last frame of a multi-frame view always becomes the 3D plane in 3D view, no matter how many plot frames are shown. In single-frame mode, the current 2D view will switch to 3D. It will return to 2D mode when you toggle-off this option.

The toggle provides a 3D view of the 2D plane specified in the Planes region of the sidebar. Use the arrow buttons in the Planes region of the sidebar to scroll through the available planes. This works as an ideal way to view where the currently selected planes in different LGRs sit relative to each other.

**14 - 3 Inside Views**

When using 3D Grid plots, you can use the Inside View region of the sidebar to view the interior cells of your data set. The Inside View settings allow you to view sets of slices (either in IJK Slice, XYZ Slice or Arbitrary Slice), a group of cells or wells (Well Blank) or a user-defined IJK range (IJK Blank).

You can view the interior of your grid data by the following methods:

- **IJK Slice** Use the IJK Slice option to view layers of your data based on selected I, J and K values.
- **XYZ Slice** Use the XYZ Slice option to view slices of your data based on selected X, Y and Z values.
Grid Plot Controls

- **Arbitrary Slice**: Use the Arbitrary Slice option to create your own slice based upon points or wells you identify with clicks of the pointer.
- **IJK Blank**: Use the IJK Blank option to blank regions of your data based upon a range of I, J and K values.
- **Well Blank**: Use the Well Blank option to display just the cells associated with selected wells.
- **Iso-surface**: Use the Iso-surface option to create a surface based upon a user-specified variable (such as Pressure)
- **Grids and LGRs**: View the global grid and/or one or more Local Grid Refinements
- **Faults**: See faults that have been loaded with your data or defined via constraints
- **NNCs**: Display Non-Neighbor Connections (for NNCs in 2D Grid plots, see "NNCs (2D Grid plots)" on page 173)
- **Streamlines**: 

The Show toggle must be activated to view any selections made for an Inside View.

All Inside Views are controlled by the following toggles, which are next to the drop-down menu.

- **Toggle-on Show**: to display the selected Inside View.
- **Toggle-on Ghost**: to display the grid. Use the Grid page of the Plot Options dialog (accessed on the Options menu) to customize the style of the grid in Ghost mode (click the See-Through Styles radio button).
- **Toggle-on Persistent**: (not available in all Inside Views) to continue to display the current view when you change to another Inside View type, allowing you to combine views. This will also be turned off when you toggle-off Show.

### 14 - 3.1 IJK Slice

To incorporate IJK Slices in your plot, use the following procedure:

- Choose IJK Slice from the Inside View menu in the sidebar.
- **Toggle-on “Show”** to incorporate your selections in your plot.
- **Optional**: Choose “Auto-Update” to have your plot updated as you make your selections in the sidebar. Otherwise, you will need to click the Apply button for every change. “Auto-Update” is not recommended for very large grids. Instead, use the Apply button to update your plot after making all of your selections.
• Use the Grid menu to specify whether to apply your plane selections to the Global grid or any Local Grid Refinements (LGRs) included in your data. Child LGRs appear indented relative to their parent LGR in the menu.
• Use the Plane menu and corresponding list to specify the type of plane and number(s) to display. You can choose multiple plane numbers with the Shift and Ctrl keys.
• Click the Apply button to apply your settings (if you did not toggle-on Auto-Update).
• **Optional** Toggle-on “Ghost” to see a transparent view of the boundary of the entire grid. Use the Grids page of the Plot Options dialog to choose Ghost options.

### 14 - 3.2 XYZ Slice

In addition to viewing an IJK Slice, Tecplot RS allows you to view XYZ slices inside your data set. Follow these steps to add an XYZ slice or set of XYZ slices.

- **First**, choose XYZ Slice from the menu in the Inside View region of the sidebar.
- **Next**, toggle-on “Show” to incorporate your selections in your plot.
- Use the X, Y and Z radio buttons to specify the plane on which to include your slice(s). By default, your XYZ slices will display on an X-plane. Choose the Y radio button to switch to a Y-plane.
- Use the # of Slices field to change the number of slice to three.
- Use the sliders to position the your slice(s). The Slice A slider positions the first slice and the Slice B slider move the last slice. Intermediate slices will display at equidistant intervals between Slice A and Slice B.

- **Optional** Toggle-on “Ghost” to see a transparent view of the entire grid. Use the Grids page of the Plot Options dialog to choose Ghost options.

**If you change to another plane after you have created at least one slice, your slice(s) will display repositioned along the new plane.**

- **Optional** When using XYZ slice(s), you can also turn on lighting or translucency for the slice(s), using the Light and Transl toggles available in the Inside Views region of the sidebar. The Light toggle controls light source shading on the slice(s), and the Transl toggle controls surface translucency of the slice(s). The main Lighting and Translucency controls in the sidebar do not affect these controls - you can have these controls on even if the main controls are turned off.

### 14 - 3.3 Arbitrary Slice

Use the Arb Slice option in the Inside Views menu to add a slice unrestricted to an X,Y,Z, I, J or K-plane. You can generate arbitrary slices in any orientation parallel to the Z-axis (that is, vertical). As such, you need to specify only two points to create a plane.

• **Optional**
To create and view an arbitrary slice, use the following procedure:

- Choose Arb Slice from the menu at the top of the Inside View region of the sidebar.

If you plan to position your arbitrary slices according to well locations, toggle-on the Wells layer in the sidebar.

- **Optional** Toggle-on Ghost to see a transparent view of the entire grid. Use the Grids page of the Plot Options dialog to choose Ghost options.
- Define what kind of slices you want to create out of the three options:
  - **Chain** Creates a slice from two selected points. Each additional selected point will add another slice from the end of the previous one until the Stop button is selected or the right mouse button is clicked.
  - **Radial** Creates a slice from two selected points. Each additional selected point will add a slice using the first point as the anchor. This operation continues until the Stop button is selected or the right mouse button is clicked.
  - **Pairs** Creates a slice from two selected points. Each additional selected point will begin the start of another two point pair until the Stop button is selected or the right mouse button is clicked.

- Click the Start button to begin creating your arbitrary slice based on the definition you selected. This will switch the pointer tool into a mode for interactively selecting points.
- Create your slice(s). Click the top surface of the grid (not the sides) to add a point or points for your slice to pass through. Ctrl-click for your slice to pass through the nearest well. Right-click the pointer to end the selection process. You can add a new slice sequence by clicking the Create button again.
- The point(s) and well(s) you have selected will appear in the Slices box. Points will be labeled P1 - Pn, and any wells you have selected will be labeled with their name.
- Use the check boxes next to the points to toggle the selected slice. You can also highlight the slices you want to toggle on or off and select the Turn On or Turn Off button.
Inside Views

- Slices can also be deleted by being highlighted and then selecting the Delete button.
- Optional Toggle-on Clip to end the slice at the cell containing the endpoint. Toggle-off Clip to extend the slice to the edge of the grid.
- Toggle-on Show to incorporate your selections in your plot.

14 - 3.4 IJK Blank

Use the IJK Blank option in the Inside Views region of the sidebar to choose a given I, J and/or K range of planes to include or exclude from your plot.

To perform IJK Blank:

- Choose IJK Blank from the menu at the top of the Inside Views region of the sidebar.
- Toggle-on “Show”. Unless you have already activated Cell Value Blanking or Pick Blanking, you will see your entire plot.
- Optional Toggle-on “Ghost” to include a transparent view of the entire grid.
- Optional Toggle-on “Auto-Update” to view the results as you make your selections.
- Use the Grid menu to define the grid for which you are choosing the IJK ranges.
- Once you have selected the grid to use, you can specify the I, J and K ranges to display using the I, J and K sliders. The sliders on the left-hand side establish the start value to view, and the sliders on the right-hand side establish the end value.
- Optional Toggle-on “Invert” to see the I, J, and K values excluded from the ranges specified by the sliders.
- Click the Apply button to view the results (if you have not selected Auto-Update).

14 - 3.5 Well Blank

Use the Well Blank option in the Inside Views region of the sidebar to display just the cells that include a well path.

To perform Well Blank:

- Optional Toggle-on “Wells” in the sidebar to display well nodes and connections.
- Choose Well Blank from the menu in the Inside Views region of the sidebar. Toggle-on “Show”.
- Optional Toggle-on “Ghost” to show a transparent view of the grid.
- Optional Toggle-on “Auto-Update” to update your plot as you make your selections.
- You can choose the wells to display (using the Shift or Ctrl keys) in the Wells box.
- By default, Tecplot RS displays only the cells that contain a completion. To include cells that the well path intersects (defined as straight lines between completions), toggle-on “Include intersected cells”.

187
Grid Plot Controls

- Click the Apply button to view only the selected well(s) (if you have not selected Auto-
Update).

14 - 3.6 Iso-surface

The Iso-surface menu choice in the Inside Views region of the 3D Grid sidebar gives you the opportunity to include iso-surfaces in your plot.

To include iso-surfaces in your plot:

- Select Iso-Surface from the menu in the Inside Views region of the sidebar and toggle-on “Show”.
- Optional Toggle-on “Ghost” to show a transparent view of the grid.
- Use the Variable menu to specify the iso-surface variable.
- Specify a value of the first iso-surface in the Iso Val 1 box.
- Toggle-on “Iso Val 2” to include a second iso-surface value. Specify a second iso-surface value in the adjacent box.
- Optional When using iso-surfaces, you can also turn on lighting or translucency for the iso-surface(s), using the Light and Transl toggles available in the Inside Views region of the sidebar. The Light toggle controls light source shading on the iso-surface and the Transl toggle controls iso-surface translucency.

The main Lighting and Translucency controls in the sidebar do not affect these controls - you can have these controls on even if the main controls are turned off.

The available data range for the selected variable will display at the bottom of the Inside View region.

14 - 3.7 Grids and LGRs

The Grids/LGRs menu choice in the Inside Views region of the 3D Grid sidebar lets you display the global grid and/or one or more Local Grid Refinements. To view the grid and/or LGRs in your plot:

- Choose “Grids/LGRs” from the menu in the Inside Views region of the sidebar and toggle-on “Show.”
- Optional Toggle-on “Ghost” to show a transparent view of the grid(s).
- Choose one or more grids in the Grids list. The GLOBAL entry represents the global grid; the rest are LGRs. Hold down Shift while clicking to select a contiguous range, or Control-click to toggle individual grids on and off. You may also click “Select All” to display all grids.

The grids appear or disappear immediately as you turn them on or off.

14 - 3.8 Faults

Geological faults are represented inside Tecplot RS as cell faces that will be flooded by the variable value from the cell they are attached to. They can be defined in three ways:

- They can be loaded along with the grid. With the Sensor and VDB simulators, the fault data is included in the grid data file. With CHEARS and Eclipse, the fault data is a separate ASCII file
Inside Views

(with a .faults filename extension) included with the input deck; if it has the same base name as the grid file, it will be loaded automatically. Faults loaded along with the grid will have names or numbers and will be referred to as “named faults.”

- Non-Neighbor Connections (NNCs) included in the grid data can be used to define fault faces. Tecplot RS also has a separate Inside View for NNCs (see “NNCs” on page 190). The difference is that the NNCs view colors the faces based on the value of a specific NNC variable; the Faults view colors them based on the grid variable.
- Faults may be defined by constraints, which define a variable and condition that identifies the fault cells, for example, TRANX <= 0. (The X in the variable name indicates the face used for the fault.) The Define Fault Constraints dialog (shown here) is launched by clicking the Constraints button in the sidebar when the Faults Inside View is active or by choosing Data > Fault Constraints from the menu.

Fault constraints are saved with project files; be sure to save a project file if you wish to save your constraints.

To define a new constraint:

- Highlight the variable in the list, which displays all static variables whose names begin or end with I, J, K, X, Y, or Z. These may be further decorated with + or - to indicate the upper or lower face.
- Choose an operator, such as “<=” for “less than or equal to.
- Click Add.

You may click unwanted constraints in the list and click Remove to remove them.

Regardless of how your constraints are defined or loaded, they appear in the Faults list in the Inside Views section of the sidebar. Named constraints, NNCs, and constraints are all listed and may be toggled on and off independently. Click any listed fault to select only that fault; hold Shift while clicking again to select a range of the listed faults. Hold Control while clicking to toggle individual faults on and off. You may also choose the mesh color and the width.
Grid Plot Controls

14 - 3.9 NNCs

If your grid model includes Non-Neighbor Connections (NNCs), you can view them by choosing NNCs in the drop-down menu of the Inside Views section of the sidebar. (For NNCs in 2D Grid plots, see “NNCs (2D Grid plots)” on page 173.) The Inside Views section of the sidebar then shows controls for choosing which NNCs are displayed and specifying how they will appear.

You can choose to display the upstream faces, downstream faces, or both. When both types are displayed, the overlap can cause interference.

The faces may be flooded with no color (displaying only the mesh), a solid color, or contoured based on a selected NNC variable, if your data includes such variables. You may also choose the mesh color and width.

To make the NNC faces visible, Tecplot RS activates see-through grids when NNCs are displayed. Use the Grids page of the Plot Options dialog (accessible on the Options menu) to customize the See-Through Styles.

When the See-Through Style is set to “Ghost Gray”, you can use the Light Effect to alter the appearance of the surface. Choose the “Paneled” Light Effect to get a better idea of cell boundaries (especially when the mesh is turned off), or “Smooth” to create a more rounded look. The “Smooth” option may render slowly on very large models.
Inside Views

Only NNCs within a grid are displayed. NNCs between the global grid and LGRs, or those between two LGRs, are not highlighted, although the boundaries are still visible when translucency is on.

When NNCs are displayed, Tecplot RS displays a legend for the NNC variable. You can move or remove this legend by choosing the Paper Layout plot type and moving or deleting the RS_NNCVAR (the legend title) and/or RS_NNCEGEND (the legend itself) dynamic text items from the layout.

To adjust the legend, double-click it. The Grid Legend page of the Plot Options dialog appears; click the variable by which the NNCs are colored in the Variables list to modify the NNC legend settings.

Streamlines

Tecplot RS will display streamline data as an Inside View, providing a look at how fluids move through the reservoir model over time.

Streamline data are stored in separate files. Load streamline data on the File(s) page of the Load Grid Data dialog under the Streamlines heading. Tecplot RS will accept streamlines provided by a simulator that output streamline data in the FrontSim .slinespec format.

Tecplot RS displays a streamline legend when streamlines are active. To move or remove this legend, switch to the Paper Layout plot type and move or delete RS_STREAMVAR (the legend title) or RS_STREAMLEGEND (the legend itself).

To adjust the legend, switch to the 3D Grid plot type and double-click the legend. The Grid Legend page of the Plot Options dialog appears; click the variable by which the streamlines are colored in the Variables list to modify the streamline legend settings.

Streamline Options

When streamline data are available, the Streamlines view is enabled in the drop-down menu in the Inside Views section of the sidebar. Use the sidebar to choose which streamlines to include and how to display them.
The controls in the Times section of the sidebar control the streamline time step. Typically, streamline times correspond to the grid times, except at the start; you will usually need to move the time slider to at least the second step to see any streamlines. If you do not have streamline data for every grid time step, the streams are drawn for the time step on or before the time selected by the slider. The Times controls may also be used to display or export an animation of the streamlines.

- **Select By** By default, Tecplot RS sets the Select By option to “All”, so that the plot displays all streamlines. You can change this to limit the displayed streamlines. You can choose the streamlines according to their Source (usually the injector well), Sink (a boundary or producer well), or by individual Pairs.

When you choose a new Select By option, the multi-select list to the right clears and repopulates with the available source, sink, or pair identifiers. You can choose which ones to display by highlighting your choices in the list.

- **Color By** Use this option to control how streams are colored. Your choices include:
  - **Source** Tecplot RS will cycle through eight colors, using a different one for each source or injector well.
  - **Sink** The termination well or boundary will determine the streamline color.
  - **Pair** Tecplot RS will plot each well pair in a different color (cycling through the 8 available colors).
  - **Variable** Multi-colored streams will display according to the variable values assigned to each stream node or segment. If multiple variables are included, you can choose which variable to use from the Variable option menu.

When streamlines are displayed with a variable, Tecplot RS displays a legend for the streamline variable. You can move or remove this legend by choosing the Paper Layout plot type and moving or deleting the RS_STREAMVAR (the legend title) and/or RS_STREAMLEGEND (the legend itself) dynamic text items from the layout.

- **Time of Flight** You can color streamlines according to the “Time of Flight” value associated with each node.

- **Variable** Choose the Variable to use for coloring streamlines.

- **Skip** Use the Skip interval to reduce the number of streamlines displayed. This option helps especially when a data set contains so many streams that plotting all of them makes it impossible to see details. You can use a value between 1 and 100 (Tecplot RS uses a default of 5). Tecplot RS will plot at least one streamline between each selected well pair, regardless of the skip factor.

- **Width** Use the Width menu to adjust the thickness of your streamlines. Set these values as a percentage of frame size.

- **Time of Flight (TOF)** With the slider in the Time of Flight region of the dialog, you can visualize streamlines over time. The slider is scaled over the full range of “Time of Flight” (TOF) values for the chosen streamlines. If you position the slider at an intermediate point, partial streamlines display up to that limit.

- **Log** Sometimes a small percentage of the streamlines have a much longer TOF than the rest. This can skew the TOF range so that most of the progress occurs at the lower end of the scale. In these cases, little difference in shading may occur when coloring by “Time of Flight”, and you often lack the granularity in the scale slider to control the display.
Grid Tools

To remedy this, use the Log Scale option to apply a logarithmic scale over the TOF range. This will impact the color bands used when you color streamlines by “Time of Flight” and will make the scale bar usable for these cases.

14 - 4 Grid Tools

Tecplot RS includes several advanced features for displaying grid data and extracting information from the model. These can be found on the toolbar.

14 - 4.1 Measuring Distance on a 3D Grid

The Measure Distance tool displays the straight-line distance between two points clicked on a 2D or 3D grid in the Tecplot RS status bar. Each pair of clicks sets a start and end point for distance measurement.

14 - 4.2 Probing

The Probe tool allows you to select a location in your plot and view values of one or all variables in that location. You can also view information about the data set while probing. There are two probe tools. One displays the values of all variables at the probed location using a dialog. The other displays the value of only a single variable in the status bar at the bottom of the Tecplot RS window, without a dialog.

Refer to the following chapter, Chapter 15: “Data Probing” to learn more about probing.

14 - 4.3 Streamtraces

Tecplot RS includes the capability to draw streamtraces, which are paths traced by a massless particle placed at an arbitrary location in a steady-state vector field, used to illustrate the nature of the field flow in a particular region of the plot.

Refer to Chapter 16, “Streamtraces” to learn more about streamtraces.
Grid Plot Controls
Data Probing

With the Probe tool in Tecplot RS, you can click a location in your plot and view the values of all loaded variables at that point, as well as other information including its I, J, and K values and face neighbor information.

You can also use the Probe At dialog (accessible by clicking the Probe At button in the Probe dialog) to probe at a location specified as a set of spatial coordinates X, Y, and Z, or as a set of I, J, and K indexes. After specifying the position in the dialog, clicking the Do Probe button activates the probe and the corresponding values appear in the Probe dialog.

If you do not need the values of all loaded variables and are viewing a 2D or 3D grid plot, you can use the Quick Probe tool. This tool displays the I, J, and K indexes of the probed point, along with the value of the contour variable, in the Tecplot RS status bar. This can be more convenient for repeated grid probes.

If Tecplot RS appears to be unloading variables that you want to probe, you may need to adjust your memory threshold. Refer to Performance Dialog: "Load On Demand" for additional information.

15 - 1 Overview: Values Returned by Probing

When you probe with the Probe tool, you can choose whether to probe in either Interpolate mode (by clicking in your plot) or Nearest Point mode (by holding down the Ctrl key while clicking).

In Interpolate mode, Tecplot RS displays the variable values as cell-centered data interpolated from the nearest cell centers at the location of the probe action (on the Cell Center Values page of the Probe dialog). On the Variable Values page of the dialog, probing in the Interpolate mode returns the variable values at the location of the probe interpolated from the node values, which Tecplot RS interpolated from the cell-centered data.

When you use Ctrl-click with the Probe tool (thus using the Nearest Point mode), Tecplot RS returns the value of the variables at the nearest node (not at the exact location of the probe) on the Variable Values page of the dialog, as interpolated from the cell-centered data.

Because of this flexibility given by Tecplot RS, care should be taken when probing. Otherwise one might choose to view variable values smoothed by so much interpolation that their usefulness is lost.
Data Probing

Tecplot RS uses Load On Demand for data probing. Therefore, the only Variable data you will receive are the ones currently on screen. To load other Variables, select the “Load Variables” button at the bottom of the Probe dialog. See 17-1.2 “Loading Variables”.

15 - 2 The Probe Tool: Probing a Grid Plot

To probe your data interactively, click the Probe tool in the toolbar, and then click in your plot to probe in Interpolate mode, which opens a dialog showing the probe information interpolated for that point. Hold down the Ctrl key while clicking at any location to probe in Nearest Point mode, which will obtain probe information for the node nearest to the probe tool.

The following table shows the information returned for each type of probe tool action for grid plots. (All pointer operations use the left button.)

<table>
<thead>
<tr>
<th>Probe Action</th>
<th>Information Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>If the pointer is over a valid cell, the dialog displays the variable values interpolated from all nodes in the cell.</td>
</tr>
<tr>
<td></td>
<td>If multiple cells are candidates:</td>
</tr>
<tr>
<td></td>
<td>2D grid plots - The cell from the highest number zone is used.</td>
</tr>
<tr>
<td></td>
<td>3D grid plots - The closest cell in a zone, slice, iso-surface or streamtrace is selected.</td>
</tr>
<tr>
<td></td>
<td>If multiple cells are candidates, the cell closest to the viewer is used, with priority given to surfaces drawn with mesh, flooded contours or shading.</td>
</tr>
<tr>
<td>Tecplot RS excludes any translucent zone surfaces from probing.</td>
<td></td>
</tr>
<tr>
<td>Ctrl-click</td>
<td>If the pointer is over a valid cell, the field value from the nearest node in the cell is returned.</td>
</tr>
<tr>
<td></td>
<td>If multiple cells are candidates:</td>
</tr>
<tr>
<td></td>
<td>2D grid plots - The cell from the highest number zone is used.</td>
</tr>
<tr>
<td></td>
<td>3D grid plots - The cell closest to the viewer is used. If the pointer is not over any cell, then the field values from nearest data point (as measured in distance on the screen) are returned.</td>
</tr>
<tr>
<td>Shift-Ctrl-click</td>
<td>Return the field values from the nearest point on the screen (ignoring surfaces, zone number or depth of the point).</td>
</tr>
<tr>
<td></td>
<td>This is useful in 3D for probing on data points that are on the back side of a closed surface without having to rotate the object.</td>
</tr>
<tr>
<td></td>
<td>In 2D this is useful for probing on data points for zones that may be underneath other zones because of the order in which they were drawn.</td>
</tr>
<tr>
<td>Alt-click (3D only)</td>
<td>Same as Click except ignores zones in the probed area. (Restricts the probe to return values only for streamtraces, iso-surfaces, or slices.)</td>
</tr>
<tr>
<td>Alt-Ctrl-click</td>
<td>Same as Ctrl-click except ignores zones in the probed area. (Restricts the probe to return values only for streamtraces, iso-surfaces, or slices.)</td>
</tr>
<tr>
<td>Alt-Shift-Ctrl-click</td>
<td>Same as Shift-Ctrl-Click except ignores zones. (Restricts the probe to return values only for streamtraces, iso-surfaces, or slices.)</td>
</tr>
</tbody>
</table>
Tecplot RS displays probe results in the **Probe** dialog, or in the status bar at the bottom of the Tecplot RS window if the quick probe tool is being used.

![Diagram of the Probe dialog](Image)

Interpolation does not work for I-ordered data displayed in a 2D or 3D grid plot; if you probe such data you will always get the error message “Point is outside of data field,” because Tecplot RS cannot interpolate outside the grid. You can, however, use the Nearest Point mode in such situations (the Ctrl-click combinations).

### 15 - 3 Probing by Specifying Coordinates and Indexes

Use the **Probe At** dialog for precise control over probe location, probing using I, J, and K-indexes, or probing inside a 3D volume. You can launch the **Probe At** dialog by clicking **Probe At** in the **Probe** dialog.
Data Probing

15 - 3.1 Probe At Position

To probe at a specified location using coordinates (in Interpolate mode), use the Probe At dialog. (To open this dialog, click Probe At in the Probe dialog.)

The Position page of the Probe At dialog includes the following controls:

• **Enter Coordinates** Type the X, Y, and Z coordinates of the location you wish to probe.
• **Probe Within Volume** If you wish to probe a 3D volume, turn on Probe Within Volume to instruct Tecplot RS to perform the probe at the indicated point. Without this control turned on, a probe of a 3D volume zone from this dialog defaults to return the values at the surface of the zone nearest the user.
• **Do Probe** Click Do Probe to perform the probe. The Probe dialog will display interpolated values for the specified location.

If no cell exists at the coordinates provided, Tecplot RS will return the values of the surface closest to the coordinates along the line-of-sight.

15 - 3.2 Probe at Index

To probe at a specified location using data set indexes (in Nearest Point mode), use the Probe At dialog (you can open this dialog by clicking Probe At in the Probe dialog) and switch to the Index page (shown in this section).

The Index page of the Probe At dialog includes the following options for specifying a point to probe:

• **Mapping/Zone** Choose the desired zone or mapping from the Zone menu. For example, you could choose to probe the active or the inactive cells from this menu. The active cells often appear as a zone labeled “1: MATRX:GLOBAL.”.
• **I, J, K** Type the I, J, and K-indexes of the position that you wish to probe. (For finite element and I-ordered data, you can enter only the I-index. For IJ-ordered data, you can enter both I and J-indexes. For IJK-ordered data, you can enter I, J, and K-indexes.)
• **Do Probe** Click the Do Probe button to perform the probe. The Probe dialog will appear with interpolated values for the location specified on the Index page of the Probe At dialog.

15 - 4 Viewing Probed Data

The Probe dialog displays the values returned by the most recent probing action. The dialog includes four pages, on which you can view different information about the probed location.

• **Variable Values** On this page, Tecplot RS displays values of all variables at the probed location.
Viewing Probed Data

- Zone and Cell Information: This page of the dialog reports characteristics of the probed location, including the location's format, cell points included, and nodes around the probed cell location.
- Cell Center: This page displays the variable values at the center of the probed cell.
- Face Neighbor: On the Face Neighbor page, you can view details of cells around the probed cell.

When using the quick probe tool, the IJK indexes of the probed point are displayed, along with the value of the contour variable, in the Tecplot RS status bar at the bottom of the window. The Probe dialog is not displayed.

If a variable appears in the Probe dialog that Tecplot RS has not loaded, the value for that variable will appear as “Not Loaded”. See “Load On Demand” on page 329 for more information on loading variables not loaded automatically.

15 - 4.1 Variable Values

The Variable Values page lists every variable in the active data set and its value at the probe point. Each variable appears on a single line.

As discussed in Section 15 - 1 “Overview: Values Returned by Probing”, it is important to be careful understanding how Tecplot RS approximates the values on this page. In general, use this page when probing in the Nearest Point mode (by using Ctrl-click).

15 - 4.2 Zone and Cell Information

The Zone and Cell Information page of the dialog lists information about the probed location:

- Format: The format of the data appears as either ordered or as a finite element format (FE-Triangle, FE-Quad, FE-Tetra, or FE-Brick).

For cell-based finite element data, the following information appears.

- Total Points: The total number of points in the data.
- Total Elements: The total number of cells (elements) in the data.
- Element Number: The number of the probed element.
- Nodes 1-4: The nodes defining the corners of the cell (Nodes 5-8 appear for the FE-Brick format).

For ordered data, the following information appears:

- I-Max, J-Max, K-Max: The maximum index values of the data.
- Plane: Tecplot RS displays the type of plane probed. I, J, or K displays the index of the point at the principle data point of the cell containing the probed point. (If the point is probed in Nearest Point mode, with Ctrl-click, the label reads “I, J, or K Index.”.)
- Face Plane: The I, J, or K plane used in the probe.
- Face Indexes: These planes, not listed as face planes, appear in 3D or are the axes in 2D.

15 - 4.3 Cell Center

The Cell Center page of the Probe dialog lists the value of each variable in the data set at the location of the probe as interpolated from the centers of the surrounding cells.
Data Probing

15 - 4.4 Face Neighbor

The Face Neighbor page of the dialog displays the cells that neighbor the probed cell. Tecplot RS considers a cell a neighboring cell if one of its faces shares all nodes in common with the probed cell, or if the data set’s face neighbor data identifies it as a neighbor.

For ordered (IJK or IJK) data, cell numbers are defined by the index value of the first node, according to the following formula:

\[ \text{Index} = i + (j - 1)I_{\text{max}} + (k - 1)I_{\text{max}}J_{\text{max}} \]

In this formula, i, j, and k represent the i, j, and k values for the location of the first node.

Because the number of nodes in each direction is one greater than the number of cells in that direction, no cell exists to correspond with the last point in each row. In this example, no cell exists numbered “3”, yet the first cell in the second row is numbered “4”. As you define face neighbors, it may help you to think of a “ghost cell” at the end of each row (where i = I_{\text{max}}) and at the end of each column in 3D (where j = J_{\text{max}}).

For finite element data, the cells are numbered in the order they appear in the connectivity list. In the following example “7 8 19 11” represents the cell number 2:

```
# Example connectivity list of 3 cells:
2 4 8 19
7 8 19 11
1 2 4 5
```

For more information, you can access the Tecplot 360 Data Format Guide from the Tecplot Web site.

15 - 5 Probing an XY Plot

You can probe XY plots similarly to grid plots, by using the probe tool to obtain interpolated variable values at any given location or exact values from a specified (X, Y) data point. When you probe an XY Variables plot, Tecplot RS displays a vertical or horizontal guide line, depending on whether you are probing along an X- or a Y-axis.

To probe in interpolate mode, click the probe tool in the toolbar and then click in your plot. Tecplot RS interpolates axis variable values of all active mappings that lie along the probe line and displays them.

To probe in Nearest Point mode, click the probe tool and then Ctrl-click in your plot. When you Ctrl-click, Tecplot RS displays the exact X and Y values of the data point closest to the location clicked.

The quick probe tool is not available in XY plots.

15 - 5.1 XY Plot Probing in Interpolate Mode

Tecplot RS uses the Interpolate mode as the standard probe tool mode in XY plots just as for grid plots. For XY plots, you can probe along any of Tecplot RS’s five X-axes, or along any of Tecplot RS’s five Y-axes. By default, probing is performed along the X1 axis.
To activate the **Probe Interpolate** mode, click the **Probe** tool in the toolbar, click in your plot to create an initial probed point, and click the **Probe At** button in the **Probe** dialog that appears. The **Probe At** dialog has the following options:

- **Enter Coordinates** Type the coordinates of the location you wish to probe.

Alternatively, you can press the X or Y keys on the keyboard while moving the pointer over the plot to choose the axis to probe along. You can also press the 1, 2, 3, 4, or 5 keys to select different X or Y-axes.

- **Do Probe** Click the **Do Probe** button to perform the probe. The **Probe** dialog will display with the variable values.

For interpolated values, the **Probe** dialog lists every active mapping and the interpolated value the opposing axis variable for that mapping. The dialog lists the value along the probed axis at the bottom.

In the **Probe** dialog, the probe value displays as dashed (---) if the probe is out of range for the mapping. The probe value is gray (inactive) if the mapping is not using the specific axis which you are probing. For example, if you probe the X1 axis and the mapping uses the X2 axis, a dashed line will display. This can happen in XY Line plots with multiple X or Y-axes.

Tecplot RS displays each mapping value on a single line, with the position of the probe listed as following.

- **X-Value, Y-value** X, Y-value of the nearest data point to the probe position.
- **I, J, or K-Index** I, J or K-index of the nearest data point to the probe position.
- **Map Number and name of the nearest map to the probe position.**
- **Zone Number and name of the nearest zone to the probe position.**
- **I, J, or K-Max** Maximum I, J or K-index of the current zone.
- **X or Y-Axis** X or Y-axis associated with the current map.

### 15 - 5.2 XY Plot Probing in Nearest Point Mode

**Nearest Point** probe mode provides the X and Y values of the data point at the node closest to the probed location, interpolated from the cell-centered data. If a data point is common to multiple mappings, the probe returns information on the highest numbered mapping. For example, if a data point is plotted as part of two mappings, numbered 1 and 2, the probe results are displayed for mapping 2.
To enter the **Probe Nearest Point** mode, click the **Probe** tool in the Toolbar and then Ctrl-click at the desired probe location. Tecplot RS calculates the nearest point to the probe tool, independent of the axis you were probing along.

In **Nearest Point** mode, the **Probe** dialog displays the following information about the nearest data point:

- X-value
- Y-value
- I, J, and/or K-index
- The number and name of the mapping associated with the data point
- The number and name of the zone referenced in the mapping
- The maximum I, J, and K-indexes of the zone
- For XY plots, the X-axis and Y-axis associated with the mapping

### 15 - 6 Probe Variables Dialog

With 2D or 3D grid plots, the Probe dialog initially displays values for the probed cell for all the solution variables shown in the plot. For example, this plot shows two solution variables, **PRESSURE** and **CDEPTH**, and values for these are shown in the Probe dialog. The remaining solution variables are shown as “Not Loaded”.

Often, you will want to see the values of other variables at the probed cell without having to set up additional plots containing these variables. The Probe dialog contains a **Load Variables** button that lets you load additional variables and display them in the Probe dialog, but these values do not refresh after changing time step or view type, or many other operations.
Instead of using the Load Variables button in the Probe dialog in this situation, use open the Probe Variables dialog (Data-Probe Variables) and choose the additional variables to be displayed and loaded in the Probe dialog.

- Click an item with the mouse button (without holding down any keys) to select only that item.
- Hold down the Control key while clicking the mouse button to toggle an item between selected and unselected.
- To select a single contiguous range of items, click the first item in the range normally. Then hold down the Shift key while clicking the last item in the range.
- To select multiple ranges, select the first range by clicking and shift-clicking as just described. Then, to select another range while leaving the first selected, Control-click the first item in the range, then Shift-Control-click the last item in the range. Repeat this for each additional range you wish to select.
- To select all variables, press Control-A (for All).

Selections chosen in the Probe Variables dialog are remembered when you change time steps, select different grid planes, and so on, and are saved and restored with the grid.

When working with a comparison plot, you can probe on any of the data sets, and if a variable of the same name exists in the comparison grid, the Probe dialog also shows values from those data sets.

It is not necessary to select variables already shown in the plot, as these will always appear in the Probe dialog, but it won’t hurt to do so, and it will keep those variables’ values available when probing even if you change the variable(s) shown in the plot.

With large data sets, choosing many variables can noticeably slow some operations, particularly animation. If this becomes problematic, close the Probe dialog when not using it, or reduce the variables displayed to just the ones you are interested in.

### 15 - 7 Editing Data

Using the Adjustor tool, you can probe and edit specific data points. In Adjustor mode, you can actually modify the coordinates of your data with the pointer.

To edit data points, move them with the pointer, using the Adjustor tool (in XY and 2D grid plots only).

\[\text{If you modify a shared variable with the Adjustor tool, Tecplot RS will branch the variable—it will create a separate copy of the variable for the edited version.}\]

In XY and 2D grid plots, you can select and move data points with the Adjustor tool. You can select multiple data points and move them as a group by pressing the Ctrl and Shift keys while clicking the points.

See “Adjustor” on page 32 for more information.
Data Probing
Streamtraces

The addition of a streamtrace, the path traced by a massless particle placed at an arbitrary position in a steady-state vector field, to your 2D or 3D grid plot, can help illustrate the nature of a vector field flow in a particular region of the plot.

16 - 1 Simple Streamtrace Creation

Because streamtraces depend on the vector field, you must define the vector components before creating streamtraces in Tecplot RS. To add streamtraces to your 2D or 3D grid plot, click the Add Streamtrace button in the toolbar to activate the Streamtrace tool. After defining the vector components and clicking OK, click in your plot to create a streamtrace whose path traces through the point clicked.

To add a rake of streamtraces (multiple streamtraces equidistant from each other across a surface), drag in your plot to indicate the width of the rake. To change the number of streamtraces in the created rake, type a number between 1 and 9 before dragging in your plot.

You can also use the Position page of the Streamtrace Details dialog (accessible by choosing “Streamtraces” from the Plot menu) to specify the location of your streamtrace. Click the Create Stream(s) button to create a streamtrace with a path through the designated point.

16 - 1.1 Creating Different Types of Streamtraces

To create streamtraces with a format other than Surface Line, choose a format from the “Create Streamtrace with Format” menu on the Position page of the Streamtrace Details dialog (3D grid plots only).

Tecplot RS supports two main types of streamtraces:

- **Surface line streamtraces (or streamlines)** Surface streamtraces are confined to the surface on which they are placed. They can only be placed on 2D or 3D surfaces. See Section 16 - 2.2 “Lines Page” to customize these surface line streamtraces. When surface streamtraces are placed on a no-slip boundary surface, they will propagate according to the flow field very near the surface.

- **Volume streamtraces** Volume streamtraces can be created in 3D volumes only (IJK-ordered volumes). See Section 16 - 2.3 “Rod/Ribbon Page”. Volume streamtraces include three subcategories:
Streamtraces

- Volume Lines, or volume streamlines
- Volume Ribbons, or streamribbons
- Volume Rods, or streamrods

**Streamtrace Limitations**

Streamtraces will not appear under the following conditions:

- Unorganized data (I-ordered zones)
- Zero-valued vectors (choose different vector components)
- Outside the data (Hold down the Control key while clicking or dragging to place a streamtrace outside the data. If drawing a rake on a concave 3D volume surface, hold down the Shift key to draw the rake outside the data.)
- Inappropriate integration step size. Refer to Section 16.2.6 “Integration Page” for information on integrating streamtraces.

**Streamtrace Details dialog**

To control the aspects of your streamtrace(s), use the Streamtrace Details dialog (accessible by choosing “Streamtraces” from the Plot menu). The attributes set in this dialog affect all streamtraces in the active frame, including those already placed.

To display streamtraces in your plot, toggle-on the Show Streamtraces control at the top of the Streamtrace Details dialog.

In order for streamtraces to appear in your plot, or for changes made in the Streamtrace Details dialog to appear in your plot, you must have “Show Streamtraces” toggled-on at the top of the Streamtrace Details dialog.
16 - 2.1 Position Page

Use the Position page of the Streamtrace Details dialog (accessible by choosing “Streamtraces” from the Plot menu) to add and customize the placement of a streamtrace or streamtrace rake.

The Position page includes the following options:

- **Create Streamtraces with Format**: Choose the format for the next streamtrace from the menu. You can choose from the following formats:
  - **Surface Line**: Two-dimensional and 3D surface streamlines. Surface lines are confined to the surface upon which they are placed. If placed in a 3D volume zone, these streamtraces are not plotted.
  - **Volume Line**: Three-dimensional volume streamline plotted through 3D space. The streamline path is integrated in three dimensions within the 3D volume field.
  - **Volume Ribbon**: Three-dimensional volume streamtrace with a defined thickness that twists in accordance with the local stream-wise vorticity of the vector field: a streamribbon. When you select this option, you should also check the ribbon width on the Rod/Ribbon page of the Streamtrace Details dialog. The width affects all streamtraces, including those already placed. The default width is often too large, but it is automatically calculated based upon the extent of your data. The center of the streamribbon is a 3D volume streamline. The streamribbon rotates about this streamline in accordance with the local vector field. Streamribbons have an orientation at each step.
  - **Volume Rod**: This 3D volume type of streamtrace has a defined thickness and a polygonal cross-section: a streamrod. The cross-section of a streamrod rotates around a volume streamline in accordance with the local stream-wise vorticity. The center of the streamrod is a regular 3D volume streamline. Streamrods have an orientation at each step.

You can also add streamtraces by using the Add Streamtrace tool in the toolbar. See Section 16 - 1 "Simple Streamtrace Creation" on page 205.

The Position page includes the following options:

- **Create Streamtraces with Format**: Choose the format for the next streamtrace from the menu.
  - **Surface Line**: Two-dimensional and 3D surface streamlines. Surface lines are confined to the surface upon which they are placed. If placed in a 3D volume zone, these streamtraces are not plotted.
  - **Volume Line**: Three-dimensional volume streamline plotted through 3D space. The streamline path is integrated in three dimensions within the 3D volume field.
  - **Volume Ribbon**: Three-dimensional volume streamtrace with a defined thickness that twists in accordance with the local stream-wise vorticity of the vector field: a streamribbon. When you select this option, you should also check the ribbon width on the Rod/Ribbon page of the Streamtrace Details dialog. The width affects all streamtraces, including those already placed. The default width is often too large, but it is automatically calculated based upon the extent of your data. The center of the streamribbon is a 3D volume streamline. The streamribbon rotates about this streamline in accordance with the local vector field. Streamribbons have an orientation at each step.
  - **Volume Rod**: This 3D volume type of streamtrace has a defined thickness and a polygonal cross-section: a streamrod. The cross-section of a streamrod rotates around a volume streamline in accordance with the local stream-wise vorticity. The center of the streamrod is a regular 3D volume streamline. Streamrods have an orientation at each step.
Streamtraces

step. As with streamribbons, you should check the rod width on the Rod/Ribbon page of the Streamtrace Details dialog, as well as the number of rod points (three, by default). The number of points indicates the cross-sectional shape of the rod. Three is an equilateral triangle; four, a square; five, a regular pentagon; and so forth. Like the width parameter, the number of points applies to all streamrods, including those already placed.

The number of points indicates the cross-sectional shape of the rod. Three is an equilateral triangle; four, a square; five, a regular pentagon; and so forth. Like the width parameter, the number of points applies to all streamrods, including those already placed.

The following shortcuts enable you to place different kinds of streamtraces with the Streamtrace tool in the toolbar. Type the corresponding key before clicking to place the streamtrace.

- **D** - Switches to streamrods
- **R** - Switches to streamribbons
- **S** - Switches to surface lines
- **V** - Switches to volume lines

- **Direction** Select the stream integration direction from the following options:
  - **Forward** Select for forward integration from the starting point.
  - **Backward** Select for backward integration from the starting point. When the streamlines are calculated backwards, the arrowheads still point in the forward direction.
  - **Both** Select for both forward and backward integration from the starting point. (For streamribbons and streamrods, avoid this option.)

- **Enter IJK Positions** Select to specify the streamtrace starting point (and rake ending positions, if applicable) using the mesh indexes I, J, and K.

- **Enter XYZ Positions** Select to specify the streamtrace starting point (and rake ending positions, if applicable) using the spatial coordinates X, Y, and Z.

- **Zone** (only if Enter IJK Positions is selected) Choose from the menu the zone for which the I, J, (and K) indexes are being specified.

- **Create Rake** Select to identify the starting position as the start of a rake, and to activate the Rake Ending Position fields. A rake is a group of streamtraces. If you are drawing a rake on concave 3D volume surfaces, hold down the Shift key to draw the rake outside of the data.

- **Streamtrace Start Position** Specify the starting position for a single streamtrace, or (if “Create Rake” is selected) the beginning of a rake of streamtraces. There are two or three fields, labeled either X, Y, (and Z) or I, J, (and K). Enter the desired value in each field, or use the up and down arrows to increase or decrease the values.

- **Rake End Position** (Only if Create Rake is selected) Specify the end position for a rake of streamtraces. There are two or three fields, labeled either X, Y, (and Z) or I, J, (and K). Enter the desired value in each field, or use the up and down arrows to increase or decrease the values.

- **Streamtraces per Rake** Type an integer in the text field to specify the number of streamtraces on each rake, where a rake is a group of streamtraces.

- **Create Stream(s)** Click this button to place the streamtrace or rake of streamtraces.

- **1, 2, 3, 4, 5, 6, 7, 8, 9** With the Streamtrace tool selected, enter 1-9 to change the number of streamtraces to add when placing a rake of streamtraces.

- **Number of Streamtraces** (Information only) The number of streamtraces currently placed.

- **Delete Last** Click this button to delete the last streamtrace placed.

- **Delete All** Click this button to delete all streamtraces in the current plot.
Streamtrace Details dialog

16 - 2.2 Lines Page

You can customize the appearance of created surface streamtraces or streamlines on the Lines page of the dialog. Tecplot RS constrains these surface streamtraces to the surface on which you place them. You can only place this type of streamtrace on a 2D or 3D surface.

The Lines page includes the following controls. (You cannot customize streamtraces using the Line page until after drawing at least one surface streamtrace.)

- **Line Color** Choose the color for all streamtraces. To color the streamtraces by the chosen contour variable in the same manner as color flooding, choose Multi colored. (If the contour variable is not currently defined, the Contour Variable dialog appears so that you can define it.) You can use the Multi-color option, for example, to color the streamtraces by the local temperature or by the velocity magnitude. You can also specify RGB coloring.

The following attributes affect only surface and volume streamlines:

- **Line Thickness** Type a value or choose a pre-set value for the streamline thickness (as a percentage of the frame height for 2D lines and as a percentage of the median axis length for 3D surface lines and volume lines), or choose a pre-set value.
- **Arrows** Toggle-on “Show Arrowheads on Lines” to display arrowheads along all streamlines (surface and volume) in the active frame. Volume ribbons and volume rods do not include arrows. You can also control the following attributes of the displayed arrows:
  - **Arrowhead Size** Type a value for the arrowhead size (as a percentage of the frame height), or choose a pre-set value.
  - **Arrowhead Spacing** Type the distance between arrowheads, in Y-frame units. A value of ten percent spaces arrowheads approximately ten percent of the frame height apart from each other along each streamline.
16 - 2.3 Rod/Ribbon Page

The settings on the Rod/Ribbon page of the Streamtrace Details dialog affect only volume ribbons and volume rods. To activate these settings, create at least one volume ribbon or volume rod streamtrace (you can do this on the Position Page of the dialog).

The Rod/Ribbon page includes the following controls:

- **Rod/Ribbon Width** Type a width for the volume ribbons and volume rods. The width is expressed in grid units.
- **Rod Points** Volume rods have a polygonal cross-section; this parameter tells Tecplot RS what that cross-section should be. (Three is an equilateral triangle, four is a square, five is a regular pentagon, and so on.)
- **Show Mesh** Toggle-on to display a mesh.
  - **Mesh Color** Choose a mesh color from the Color Chooser dialog.
  - **Mesh Line Thickness** Choose a line thickness from the menu, or type a number in the text field.
- **Show Contour Flood** Turn on this setting to display contour flooding.
  - **Flood by** Choose the contour group by which to flood.
  - **Details** Use the Details button to open the Contour Details dialog.
- **Show Shade** Turn on this control to display shading.
  - **Shade Color** Choose a shade color from the Color Chooser dialog. Multi-color and RGB coloring are not available (use contour flooding instead).
  - **Use Lighting Effect** Toggle-on to enable the lighting effect menu. From this menu you can choose “Paneled” or “Gouraud” shading.
  - **Use Surface Translucency** Toggle-on to enable the surface translucency text field, in which you can set the surface translucency from one (opaque) to 99 (translucent).

16 - 2.4 Timing Page

Use the Timing page of the Streamtrace Details dialog (accessible by choosing “Streamtraces” from the Plot menu) to control timed markers for streamlines and timed dashes for all types of streamtraces. Tecplot RS draws stream markers at time locations along streamlines. The stream markers display at intervals proportional to the magnitude of the local vector field.
Stream markers are symbols plotted along streamtrace paths to identify the positions of particles at certain times. Figure 16.1 shows a plot with both streamtrace markers and dashes.

**Figure 16.1.** Streamtrace markers (top), dashes (bottom), and both (middle).

The stream markers appear at intervals proportional to the magnitude of the local vector field. You can adjust the spacing between stream markers by specifying the time interval (or delta) between stream markers. Increasing the delta time increases the space between stream markers and vice versa. The actual spacing is the product of the local vector magnitude and the specified delta.

You can also select the shape of your stream marker using the pre-set list of the Shape menu on the Timing page of the Streamtrace Details dialog.
Streamtraces

To place stream markers or dashes along your streamtraces, open the Timing page of the Streamtrace Details dialog (accessible by choosing “Streamtraces” from the Plot menu).

The Timing page includes the following controls:

- **Show Markers** [default = spheres (3D) / circles (2D)] Toggle-on to include stream markers. Stream markers are only available for streamlines (surface and volume). Specify the size, color, and shape of the markers in the fields provided.

- **Show Dashes** Toggle-on to include stream dashes. The lengths of the dashes and the spaces between the dashes are controlled by the value of Delta. Type a value into the dash skip factor to control the number of time deltas are used for the “off” sections of the streamtraces.

- **Time Start** Type the time at which the first marker should be drawn. A start time of zero means that the first marker is drawn at the starting point. A start time of 2.5 means that the first stream marker is drawn 2.5 time units downstream of the starting point.

- **Time Delta** Type the time interval that measures the time between stream markers. The actual distance between markers is the product of this number and the local vector magnitude.

- **Time Anchor** Type the time that a dash is guaranteed to start, provided the start and end time surround the dash.
16 - 2.5 Termination Line Page

A streamtrace termination line appears as a polyline that terminates any streamtraces that cross it. The termination line is useful for stopping streamtraces before they spiral or stall. Figure 16-2 shows the cylinder data with some streamtraces terminated by a 2D streamtrace termination line.

Figure 16-2. A streamtrace termination line drawn through surface streamlines.

Tecplot RS terminates streamtraces whenever any of the following occur:

• Tecplot RS reaches the maximum number of integration steps.
• The streamtrace passes outside the available data.
• The streamtrace reaches a point at which the velocity magnitude is zero.

The Term Line page of the Streamtrace Details dialog controls the existence and appearance of streamtrace termination line(s).

With the Term Line page, you can control the following attributes of the termination line:

• Draw Stream Term Line Click this button to change the pointer tool to create a streamtrace termination tool. Click in your plot to create a polyline that will act as a streamtrace termination line. Double-click in your plot to end the termination line.
Streamtraces

- **Active Termination Line** Toggle-on to activate the termination line and terminate any streamtraces that cross it. Toggle-off this option and redraw the plot to view unterminated streamtraces.
- **Show Termination Line** Toggle-on to display the termination line. Toggle-off this option and redraw the plot to display terminated streamlines, but not the termination line.

You can select a termination line with the Selector or Adjustor tool. This allows you to interactively move the line (with the Selector), modify the line (with the Adjustor), or delete the line (with either tool).

Only one termination line can exist at any one time in a given frame. If you draw a second termination line, Tecplot RS automatically deletes the first one.

**Termination Lines in the Eye Coordinate System**

Tecplot RS draws the streamtrace termination line in the grid coordinate system, which in 2D Grid plots moves with the data as you zoom and translate. In 3D Grid plots, Tecplot RS draws the termination line in what is known as the eye coordinate system. Grid coordinates align with the eye coordinate system, so that the termination line moves with the data as you zoom and translate, but remains fixed when you rotate the plot.

When you rotate a 3D data set after drawing a streamtrace termination line, Tecplot RS may terminate streamtraces previously terminated by the termination line at different places, or not terminated at all if the rotated streamtrace no longer intersects the termination line. **Figure 16-2** shows a 3D volume plot with streamribbons and a streamtrace termination line. This figure illustrates how the termination points vary as you rotate the plot. Notice that the termination line, rendered in the eye coordinate system, remains in place on the screen as the plot is rotated.
Tecplot RS uses an adaptive step-size, trapezoidal integration algorithm to calculate streamtraces. This creates the streamtrace by moving it in a series of small steps from the starting point in the direction of (or in opposition to) the local vector field. Each step is only a fraction of a cell or element. Tecplot RS automatically adjusts the step size based on the local cell shape and vector field variation.

Figure 16-3. Rotating Volume streamtraces with a termination line in the eye coordinate system.
Streamtraces

You can control the streamtrace integration by modifying the following parameters on the Integration page of the Streamtrace Details dialog:

- **Step Size** Type the initial and maximum step size Tecplot RS uses while integrating through the vector field as a decimal fraction of the local cell or element width. A typical value (and the default) is 0.25, which results in four integration steps through each cell or element. The value for Step Size affects the accuracy of the integration. Setting Step Size too small can result in round-off errors, while setting it too large can result in truncation errors and missed cells.

- **Max Steps** Type the maximum number of steps before the streamtrace is terminated. This prevents streamtraces from spinning forever in a vortex, or from wandering into a region where the vector components are very small, very random, or both. If you choose a small Step Size, use a larger Max Steps.

- **Minimum Step Size** The smallest step size for Tecplot RS to use. Setting this too small results in integration problems. Setting this greater than or equal to the Step Size results in a constant step size.

- **Obey Source Zone Blanking** When active, Tecplot RS generates streamtraces for non-blanked regions only. When inactive, it generates streamtraces for both blanked and unblanked regions.

During the integration, Tecplot RS terminates a streamtrace if any of the following conditions occur:

- The maximum number of integration steps (Max Steps) have been taken.
- Any point the streamtrace passes outside the available data.
- The streamtrace reaches a point where the velocity magnitude is zero.
- The streamtrace crosses the stream termination line.

Streamtraces may terminate at a zone boundary even if there is an adjacent zone into which the streamtraces should proceed. This can happen if there is a small gap between the zones.
Working with Grid Data

Tecplot RS loads and references data independently of the active frame or plot type, so that you can view one data set in many different ways. Tecplot RS also includes many ways to view and alter your data sets inside the application.

Changes to the data set(s) within Tecplot RS do not affect the original data file(s). You can, however, save modified data to a file by choosing "Write Data As Formatted Text" from the Data menu. In fact, the Data menu includes several powerful features that we discuss in this section.

Tecplot RS provides several methods for working with your grid data, including:

- Data Spreadsheet
- Grid Equations
- Cell Value Blanking
- Pick Blanking
- Performing Integrations
- KSum, KAvg, and RMap

17 - 1 Data Spreadsheet

You can view loaded grid data in the Data Spreadsheet dialog by choosing "Spreadsheet" from the Data menu. In this dialog, you can temporarily edit data, adjust the formatting of the displayed data, copy the data to your operating system's clipboard, and paste it into another program.
Working with Grid Data

The Data Spreadsheet dialog displays the variables selected in the sidebar. The listed zones represent the main grid and any local grid refinements (LGRs). Some data files may have additional zones. The variable values are listed in the table.

17 - 1.1 Value Location

Values in Tecplot RS may be either cell-centered or nodal. The Data Spreadsheet dialog displays only one of these kinds of variables at a time. You may choose which kind is displayed using the Value Location menu. If you do not see the variable you want, check this menu to make sure it is set correctly.

17 - 1.2 Loading Variables

Only variables that are already loaded are shown in the Data Spreadsheet dialog. If you wish to display additional variables, click Load Variables.

In the Load Variable dialog, choose the zone that contains the variables you wish to load, then the variable to be loaded. You may choose more than one variable by holding Shift (to choose a contiguous range) or Control (to toggle individual variables on or off) while clicking.

Because Tecplot RS uses Load On Demand for variable loading, the Load Variable dialog is necessary to view currently unloaded data.

17 - 1.3 Spreadsheet Formatting

Using the formatting controls at the top of the Data Spreadsheet dialog, you can change the format of the displayed data without changing your data file(s) or the appearance of your plot.

- **Format** Choose a number format from the Format menu in the dialog that best represents the data. You can choose from displaying the data in Integer, Float, Exponent, or Best Float form.
- **Precision** If you have Float or Exponent chosen as the Format, you can specify the number of places displayed to the right of the decimal.
Grid Equations

If some values are too wide to fit in their column, the width of the column may be adjusted by dragging the divider lines in the heading.

17 - 1.4 Editing Spreadsheet Data

To edit any displayed value, double-click it, type the new value, and press Enter. Changes made here are applied only to the plot; they do not affect the underlying data set. If you change the plot type, your changes will be lost.

17 - 2 Grid Equations

In the Grid Equations dialog, you can create new variables from existing grid data. Access this dialog by choosing “Grid Equations” from the Data menu. Alternatively, if your current plot is 2D or 3D grid, you can click the toolbar button.

With grid equations, you can use equations to create new variables from combinations of existing variables in your data set. Tecplot RS includes the new variables in the list of variables available for plotting. If your new variable definition depends on existing time-dependent data, Tecplot RS re-calculates the variables when the time step changes.

![Grid Equations Dialog](image)

Equations are entered and edited in the input line to the left of the Enter and Cancel buttons. You may enter equations by simply typing them using the keyboard. However, the dialog also provides some handy tools to make the job easier.

The variables from the current data set are shown in a list. Double-click one of these to insert it into the equation at the current cursor position. Tecplot RS automatically includes the surrounding curly braces () that are used to identify a variable.

There are also buttons for frequently-used functions. Pressing these will insert the function name followed by parentheses, and place the cursor inside the parentheses so you can easily insert the value or variable that belongs there. If the function requires multiple parameters, one or more commas will also appear inside the parentheses, alerting you to the required inputs.
The remaining buttons are mostly duplicates of what you have on your keyboard. You can use the keyboard and mouse interchangeably when entering equations. Press the Enter key on your keyboard OR click on the Enter button on the dialog to record an equation.

The list at the top of the dialog shows all current equations. To make changes to these, double-click the desired item, or right-click and select Edit. You’ll also use right-click to delete an equation that is no longer needed. The topmost item, shown as [NEW], is a shortcut for starting a new equation. When you double-click this, it inserts the text "{NEWVARn}=" into the editing line. This is a starting point for entering a new equation, but its use is optional—you can simply type what you need.

Tecplot RS stores grid data on disk and loads it only as needed to display plots. The equations in the Grid Equations dialog are applied each time data is loaded. Therefore, calculated variables are available only as long as the equation defining them appears in the Grid Equations dialog. If you remove an equation from the Grid Equations dialog, its result will no longer be available in the variable list. This is different from XY Equations, where equations create a persistent variable that remains in memory during the session.

For a full description of the Tecplot RS equation syntax, see Appendix B: Equation Reference.

17 - 2.1 Testing Grid Equations
After you enter an equation, you can click the Test button to make sure the syntax conforms to Tecplot RS requirements and that the variable names referenced are valid. This test works only if you have grid data loaded and a 2D or 3D Grid view displayed. You must complete the equation by pressing Enter before testing. The dialog displays the test results in a list, noting OK or FAIL for each equation. If an equation fails because of a syntax error, a pop-up dialog will show you where the problem begins.

Grid equations are always saved with a project file, and are automatically applied when you reload the project without any additional action on your part. You can also save or update saved equations in a separate file and reload them later, which you may find useful when sharing equations among projects.

Once you have finished the equation(s), click Close. After the dialog closes, if a grid plot type is active, the new variables will appear in the variables list.

17 - 2.2 Integration
Use the Analyze menu to calculate integrals with Tecplot RS. See Section 19 - 2 “Performing Integrations” for information.
Cell Value Blanking

Cell Value Blanking is a powerful tool that lets you turn on or off individual drawing elements (usually cells) according to the values of selected constraint variables. You can add value blanking to your plot with the Value page of the Cell Blanking dialog (accessible by choosing “Cell Blanking” from the Data menu).

The Value page of the Cell Blanking dialog has the following options:

- **Include Value Blanking** Toggle-on to include value blanking.
- **Constraint** You can define up to six value blanking constraints.
- **Active** Toggle-on “Active” to activate the currently selected constraint.
- **Blank When** For each constraint, set the following parameters:
  - Choose the variable to use for value blanking.
  - Choose the comparison criteria.
- **Apply** Click the Apply button to apply any active blanking constraints to your plot.
- **Auto-Update** Toggle-on “Auto-Update” to add any active blanking constraints to your plot automatically as you set their parameters.

Green highlighting in the value blanking constraint number indicates when a particular constraint is active. This allows a quick profile as to how many constraints are currently active.
17 - 3.1 Blanking in Multi-Frame Plots

With the value blanking feature, you can blank cells either in Frame 1 or in all frames. If you have “Link Inside Views/Blanking” turned off in the Multi-Frame Options dialog, value blanking constraints apply only to Frame 1.

Toggling on “Link Inside Views/Blanking” causes Tecplot RS to apply the value blanking criteria to all frames in your plot.

17 - 4 Pick Blanking

Use the Pick page of the Cell Blanking dialog to interactively remove a cell or group of cells. All functions that allow you to choose visible or unblanked cells will recognize cells blanked by Pick Blanking, including:

- Statistical Plots (to access, choose “Histogram/Cross Plot” in the Analyze menu)
- Performing Integrations (accessible by choosing “Integration” from the Analyze menu)
- Property Modifier (accessible by going to Data > Sim Input > Cells)
- Extract Data by Cell dialog (accessible by going to Data > Extract Cell Data > By Cell)
- KSum and KAvg toggles (3D Grid sidebar)

In general, you must blank the cells before choosing one of these functions, or click the Update / Refresh button in the corresponding dialogs after blanking the cells.
To access the Cell Blanking dialog, use the Data menu or the button in the sidebar. The Pick page has the following options:

- **Include Pick Blanking** Toggle-on "Include Pick Blanking" to activate the pick blanking options and incorporate Pick Blanking into your plot.

- **Blank Individual Cells** Click this button to use the pointer to select individual cells for blanking.

- **Blank Cells in a Rectangle** Click this button to identify and blank a rectangular group of cells. Drag the selector tool in your plot to create the rectangle. Tecplot RS will blank the cells according to the selected criteria that displays below this button in the Pick page.

- **Blank Cells in a Polygon** Click this button to identify and blank a polygonal group of cells. Use the left pointer button to define each corner of the polygon. To complete the polyline when you have created all desired edges, double-click. When defining an irregular boundary using a polyline, you can work clockwise or counterclockwise. You do not need to return to the starting point - Tecplot RS will close the boundary automatically.

Tecplot RS will blank the cells according to the criteria selected below this button on the Pick page.
• **Blank Cells in a Circle** Click this button to identify and blank a circular group of cells. Your first pointer click will identify the center of the circle. Drag the pointer outward to extend the radius of the circle. Tecplot RS will blank the cells according to the criteria selected below this button on the Pick page.

• **Undo Pick Blanking** Click this button to remove all of your pick blanking selections.

• **Cells are inside when** Specify whether to blank cells when “any” corner is within a boundary or when “all” corners are within a boundary. This criteria applies only to rectangular, polygonal, and circular blanking.

• **Blank cells** Specify whether to blank the cells that are “outside” or “inside” of the rectangle, polygon, or circle.

### Notes for rectangular or polygonal pick blanking
When working with rectangular, polygonal, or circular pick blanking, the following guidelines apply:

- The view orientation must be top-down (aerial view), and the cell corners must be in the XYZ coordinate system. This means that in 2D Grid views, the selected view plane must be “K - XY Axes” (“K - IJ Axes” will not work, nor will any of the I or J plane views).

- In 3D Grid views, the view must be rotated to the Aerial view. If you click the button for picking cells in rectangular, polygonal, or circular shapes while in a non-aerial view, Tecplot RS will alert you that you must switch to an aerial view and will give you the option to automatically flip to that view. You can also select the appropriate view using **3D > View Presets > Aerial**.

- When choosing multiple cells for pick blanking, the hole will “drill” through all K-planes in the grid. This feature works for both 2D and 3D Grid plot types.

### 17 - 5 KSum, KAvg, and RMap

#### 17 - 5.1 KSum

When activated, the KSum toggle in the sidebar will cause Tecplot RS to sum all the variable values in a column (all cells with matching I and J indexes). If weighting is enabled in the KSum/KAvg Options dialog, the specified weighting variable is multiplied by the grid variable before being added to the total.

The KSum applies only to the cells visible in the current 3D view. To limit the included layers, use **Inside Views** or **Cell Value Blanking**.

The summed value appears in all cells of that column. Since these data are typically viewed from the top, Tecplot RS will switch to an aerial view. The full 3D Grid plot still exists, and you can view it quickly by using the Reset View button or the view presets under the 3D menu.

Cells in LGRs are summed separately from the parent grids, and if the LGR is not visible at the grid surface, you will need to isolate it using an **Inside Views** selection.
17 - 5.2 **KAvg**

When KAvg is toggled-on in the sidebar, Tecplot RS averages the values according to the averaging method selected in the KSum/KAvg Options dialog. If weighting is enabled, the specified weighting variable is multiplied by the grid variable before being included in the average.

The KAvg applies only to the cells that are visible in the current 3D view. You can limit the included layers using the Inside Views.

17 - 5.3 **RMap**

The Recovery Map is a specialized plot that intends to show the amount of fluids in place at one time relative to a reference time. While the standard application is usually for oil or gas in place, RS will perform the computations on whatever transient property you choose to display. If you are displaying a static property, the displayed recovery map values will always be zero.

For example, the gas recovery would be computed as:

\[
\text{GasRecovery}(\text{cur}) = \frac{\sum_{\text{Layers}} FIPGAS(\text{ref}) - \sum_{\text{Layers}} FIPGAS(\text{cur})}{\sum_{\text{Layers}} FIPGAS(\text{ref})}
\]

'\text{ref}' and '\text{cur}' refer to the reference and current (displayed) time steps, respectively. The reference time is usually the first time step, but can be set to any time using the RMap Options dialog. The current time is controlled by the time slider on the sidebar.

The sum over layers refers to a single i, j location through all K-plane layers. The summation is performed on visible cells only. Any of the inside views and blanking options limit the computations, for example, K planes 1 through 12.

If the denominator is 0, the resulting value will be 0.

The Recovery Map Options dialog also gives control over the contour legend display. The default range is 0 to 1, but there may be circumstances where negative values exist, the Legend Range can be altered to include them. The Legend Range is limited to values between -1 and 1.

17 - 5.4 **KSum/KAvg Options**

The KSum/KAvg Options dialog (accessed with the Details [...] button to the right of the KAvg toggle in the sidebar) allow you to choose the averaging method and also to optionally specify a weighting variable.

**Averaging Methods**

The following averaging methods are available. The current averaging method appears in the plot title.

- Arithmetic Average: \( X_{avg} = \frac{1}{N} \sum_{n=1}^{N} X_n \)
Working with Grid Data

- Geometric Average: \[ X_{avg} = \left( \prod_{n=1}^{N} X_n \right)^{1/N} \]
- Harmonic Average: \[ X_{avg} = \frac{N}{\sum_{k=1}^{N} \frac{1}{X_k}} \]

**Weighting Methods**

You may choose a weighting variable to be applied to the grid variable at each cell before being incorporated into the sum or average.

For KSum, the value of the weighting variable \( W \) is simply multiplied by the grid variable \( V \) before being added to the sum, i.e., \( KSum(VW) \), the sum of \( V \) times \( W \) over active K layers for each active I, J.

For KAvg, the method of weighting varies depending on the type of averaging being used, as follows. For geometric and harmonic averages, where \( V \) is zero or less, a very small number (specifically, 0.000005) is substituted.

- Arithmetic Average: \[ KAvg(V) = \sum_{W} \frac{W}{\sum_{W}} \]
- Geometric Average: \[ KAvg(V) = e^{\sum_{W} \log_e W} \]
- Harmonic Average: \[ KAvg(V) = \frac{\sum_{W} W}{\sum_{W} W/V} \]

**17 - 5.5 Restricting K Values**

Tecplot RS calculates K Averaging and Summing over all visible K cells. You can restrict the K range using any of the following methods:

- Value Blanking - refer to Section 17 - 3 “Cell Value Blanking”.
- Pick Blanking - refer to Section 17 - 4 “Pick Blanking”.
- Inside Views:
  - IJK Slices - refer to Section 14 - 3.1 “IJK Slice”.
  - IJK Blanking - refer to Section 14 - 3.4 “IJK Blank”.
  - Well Blanking - refer to Section 14 - 3.5 “Well Blank”.

226
Comparing Grid Data

As with XY data, Tecplot RS includes tools that allow you to compare grid data sets.

The method you should use to compare data sets depends on the type of plot you wish to create:

- **Using the Compare Toggle**: This powerful option serves as the primary method for comparing data files. It also allows you to create delta plots. With this option, Tecplot RS plots your data sets in two, three, or four separate frames.
  
  You can use the Compare toggle for both 2D Grid Plots and 3D Grid Plots. To use this option, the data sets must use identical variable names, unless you link the variable names with an alias.

- **Creating Delta Files**: A delta file is a file that can be generated by Tecplot RS that stores only the differences between two data sets. This can be loaded with the original data sets so that the differences can be displayed alongside the original using the Compare toggle.

### 18 - 1 Using the Compare Toggle

To compare data sets, first load multiple grid data files, then activate the Compare checkbox in the Data Set section of the sidebar. You can then use the Compare Options dialog to choose which data sets to use in the comparison and to change which is the active (or master) data set.

### 18 - 1.1 Loading Multiple Data Files

Tecplot RS allows you load any number of grid data sets. For each data set, choose “Load Grid Data” from the Project menu (see Section 12 - 1 “Loading Grid Data”). Data sets after the first are inactive until made active by selecting them in the Manage Data dialog (Project > Manage Data). Refer to Section 12 - 2 “Managing Grid Data” for information on managing multiple grid files in Tecplot RS.

After you have loaded the data sets the first time, you might want to save a project file so you can load the data sets in fewer steps in the future. Refer to Chapter 21: “Projects” for additional information.
18 - 1.2 Active Data Set

When you load multiple files, only one file functions as the active data set. Tecplot RS will display the active data set by default in all plots and will use it to determine which entities and variables appear in the selection lists. When doing comparisons, Tecplot RS uses the active data set as the data set to which it compares the other files.

The Compare Options dialog, accessible by clicking the Options button in the Data Set section of the sidebar, lets you choose the active data set.

If “Force unlinked grids to sync” is selected, grid views between datasets are always synchronized when compared regardless of size and extent. If not selected, then RS will automatically synchronize views if it determines that the grids in each data set are similar in terms of size and extent. Normally it is not necessary to select this option.

Note that if you are recording a macro, checking/unchecking this toggle is not recorded.
If you need more information about a data set before choosing it, see instead the Grid page of the Manage Data dialog. The active data set appears highlighted. The Active Data Set box lists a summary of the entity types available.

You can change the active data set at any time by selecting a different data set in the Available Data Sets region of the Manage Data dialog.

Use the Display As text field in the Manage Data dialog to designate a display name for the selected data set. The legend for comparison data displays this name. The legend uses the file name by default.

### 18 - 1.3 Selecting Data Sets for Comparison

To activate the comparison feature, toggle-on “Compare” in the sidebar.
Comparing Grid Data

Then click Options to open the Compare Data Sets dialog and choose the data sets to be compared.

The name of the active data set appears at the top of the dialog, under “Active Data Set,” and may be changed here (as well as in the Manage Data dialog shown previously). The remaining loaded data sets are displayed in the Select Files for Comparisons box. Select the file or files that you want to include for comparison from the box, holding down Shift or Control while clicking the mouse button to select multiple files. If you want to select all files, it’s easiest to click at the top and drag down. A new frame appears for each comparison file selected, plus one master frame for the active data set.

When comparing delta grid data blank using:

When grid delta is used, blanking will be applied based on either the original variable values or delta values depending on this selection. (Default: Original variable values)

The settings in the Multi-Frame Options dialog are ignored in the comparison plot; instead, most frame attributes are linked so that the controls in the sidebar now modify all active frames, when the data sets being compared match closely enough. For example, you can choose the variable being displayed and toggle various plot features, such as mesh and shade, on or off, for all frames. If you zoom or rotate one frame, the others will zoom or rotate at the same time. The same time step is shown in all frames.

18 - 1.4 Comparing Dissimilar Data Sets

The Compare feature works best when the grids being compared have the same dimensions, coordinate systems, time steps, and variable names. However, in the real world, this isn’t always the case.

- If the grid origins or coordinate units are different, the views won’t be linked, and you’ll need to do rotations and zooms on each frame separately.
- If the grid IJK dimensions or number of cells are different, you won't be able to calculate deltas, but you’ll still be able to do side-by-side displays. 2D Grid plots and inside views that reference IJK planes will work up to the limits of the planes in each grid.
- If the exact time step cannot be found in every data set, the closest time step will be selected. The frame title will indicate the time actually used.
Creating Delta Files

Tecplot RS must be able to match variable names to display the correct variable in all comparison frames. However, you can use variable aliases to match variable names from one data set to another. For example, if the active file uses OPR for oil production rate (typical for Eclipse/SLB files) and a comparison file uses QOP (VIP standard), you can tell Tecplot RS that QOP is an alias for OPR. Aliases are entered using the Variables page in the Plot Options dialog; see Section F - 2 “Variables.” You can edit the Master Variables List to expand the list of variable aliases.

18 - 1.5 Delta Comparisons

When “Show Deltas” is toggled-on in the sidebar, Tecplot RS will calculate and display the difference in the value of the selected variable between the active data set and the comparison data set(s). Note the range of values in the color legend in the delta frames will be different from that of the master frame.

18 - 2 Creating Delta Files

An alternative way of comparing grid files is to create a “delta” file; that is, a file of the calculated differences between two solution files. The delta file can then be loaded into Tecplot RS and even displayed alongside the original file using the Compare toggle. This procedure works with Eclipse/Chears grid files, VIP Map grid files, and Sensor Map grid files.

To begin creating a delta file, choose Create Delta Grid File from the Project menu.

In the Create Delta Grid File dialog that appears, you can adjust the settings for your delta grid file, indicate where to save it, and click OK to create the file. The dialog offers the following settings:

- **File Type** Use the File type menu to specify whether to compare a set of Eclipse data files, VIP Map data files, or Sensor Map data files.
- **Formula** Choose one of four formula selections to designate how the delta file is calculated, and toggle-on “Show Magnitude” if you wish to use the magnitudes of the calculations.

The four formula selections by which the delta file is calculated include the following, where \( V_a \) indicates each value in the first data file and \( V_b \) indicates the corresponding value in the second data file:

- \( V_a - V_b \) = Value in Solution File A minus corresponding value in Solution File B (default)
- \( V_b - V_a \) = Value in Solution File B minus corresponding value in Solution File A
- \( \frac{V_a - V_b}{V_b} \) = Value in Solution File B minus corresponding value in Solution File A, normalized by the value in Solution File B
Comparing Grid Data

- \( \frac{(V_v - V_b)}{V_v} \) = Value in Solution File A minus corresponding value in Solution File B, normalized by the value in Solution File A.

Toggle-on “Show Magnitudes” to use the magnitude (absolute value) of the calculation method you chosen. This option ignores the direction (+ or -) of the delta value.

- **Grid** Use the Grid field and browse button to specify the grid file to use. The two solution files must belong either to the same grid or to grids with identical structures (they must have the same LGRs, same dimensions for each grid, and identical inactive cells).

The Grid controls do not appear when you choose “Sensor Map” in the File Type menu, since Sensor Map files include the grid and solution data in the same file. Tecplot RS does not need a separate grid file in this case.

- **Solution Data A** Specify the first solution file to use.

- **Solution Data B** Specify the second solution file to use.

- **Results File** Specify the name of the delta file that Tecplot RS will create, including the complete path. The delta file (Results File) will contain the calculation results of each value in Solution File A and its corresponding value in Solution File B. The variables in the delta file will be the difference values and will be named \( d\text{Variable} \), where \( \text{Variable} \) is the original variable name. For example, if water saturation (SWAT) is present in both solution files, the variable name in the delta file will be \( d\text{SWAT} \). If you plan to compare this file using the Compare sideline checkbox, you should create variable aliases to link these variable names to the originals.

Because variables names are limited to 8 characters in the Eclipse file format, Tecplot RS will truncate variable names that have 8 or more characters to 7 characters when ‘d’ is added. For example, "PRESSURE" becomes "dPRESSUR".

Although the output file is formatted like the input files, it contains only those data fields recognized or needed by Tecplot RS. For this reason, we cannot guarantee that other visualization/post-processing applications will be able to load or display the output file.
Data Analysis

Tecplot RS allows you to analyze your grid data in a variety of ways, including using the Analyze menu. The Analyze menu acts as the portal to access Histograms and Cross Plots analyses, as well as Performing Integrations.

19 - 1 Statistical Plots

Tecplot RS’s statistical plots, histograms and cross plots, graph the distribution of grid data, enabling you to analyze your data in a visually meaningful way. Accessible by choosing Histogram or Cross Plot from the Analyze menu, using the options on the sidebar, or using buttons on the toolbar, both of these analysis methods open a smaller frame next to your grid plot that displays the analysis data. When you display a histogram or cross plot, Tecplot RS will resize the plot frame to add the analysis frame. If you have multiple frames shown, Tecplot RS will resize only Frame 1.

19 - 1.1 Histograms

When you choose the Histogram from the Analyze menu or by clicking the toolbar button, the Quick Stats dialog appears in Histogram mode. You can show or hide the histogram plot using the Show checkbox in the dialog or by using the Quick Stats checkbox in the sidebar. For your convenience, you may also switch between the histogram and cross plot using the radio buttons at the top of the dialog.

The histogram displays the frequency with which different values of the chosen variable occur. You can change the variable used by choosing a different item in the Variables list in the sidebar. The histogram updates automatically whenever you change a setting.
The **Quick Stats** dialog has the following options when in Histogram mode:

- **Limits** You can choose to perform calculations on All Cells in the model, or on only those Visible in the current view.
  When Visible Cells is selected for 3D Grid plots, you can control which cells are included in the analysis via the Inside Views option in the sidebar and also the Cell Blanking options (both Pick and Value Blanking).
  Grids with LGRs use blanking internally. Cells are blanked in the parent grid where they are replaced by the LGR. Keep this in mind when choosing the All vs. Visible option, since it will affect the cell count.
  In 2D Grid plots, the All Cells computations are limited to the single layer being displayed, and Visible Cells can be further limited by Cell Blanking.

- **Binning** Histogram data are grouped into bins, with each bin counting the number of cells that fall into a defined range. The Binning options allow you to control the number and range of the bins.
  With Match Contours on, the bins match the contour levels used in the current plot and the legend shown in the plot frame. Each bar of the histogram that represents the count of the number of cells in that range will also be colored to match the cell color in the main plot. Since you can customize the contour legend for each variable using Plot Options, your histogram bins and coloring may change when you choose a different variable. In addition, the Plot Options controls will allow you to set up log scales, different color maps, and custom ranges on a variable-by-variable basis. If you make a change in Plot Options for the plot legend, that change will also be reflected in the histogram plot.

  Double-click the legend in the plot frame to be taken directly to Plot Options and the options for the legend for the current variable...

If you want different bins for your histogram without changing the contours in the main plot, turn off the “Match Contours” checkbox to activate controls that allow you to set bins manually by specifying both the number of bins and the range covered.

- **Display** These settings control the display of additional information in the histogram frame.
  - **Show Legend** Turns on a legend in the histogram frame showing the bin levels and colors. This is similar to the legend shown in the data frame, except the histogram legend is always drawn vertically.
Stats Choose None, Basic, or Complete. Basic info includes Min, Max, Mean, and Standard Deviation. Complete info adds Median and Quartiles. These data are displayed as text at the top of the analysis frame.

The example histogram shown here uses the Match Contours option for bins and Basic statistics. The Show Legend option is on.

19 - 1.2 Cross Plots

Like histograms, cross plots also graph the distribution of a data set, giving you another method of visualizing the arrangement of your data. In a cross plot, instead of a number of bins distributing the data, the distributed relationship between two, three, or four variables is shown as a scatter plot.

For example, the following plot compares Pressure and Oil Saturation (SOIL) in 6000 cells. With each symbol on the plot representing one of the cells, the display shows that the majority of oil saturation occurs in the cells with a pressure value between 3500 and 3700.

When you choose the Cross Plot function from either the Analyze menu or by clicking the toolbar button, the Quick Stats dialog appears in Cross Plot mode. You can show or hide the cross plot using the Show checkbox in the dialog or by using the Quick Stats checkbox in the sidebar. For your convenience, you may also switch between the histogram and the cross plot using the radio buttons at the top of the dialog.

The cross plot automatically updates when you change the settings in the dialog.

For 2D cross plots only, if the Y axis variable name contains the word DEPTH, then the Y axis will be reversed. For example, if the selected Y axis variable is ‘CDEPTH’, the Y axis will be reversed.
The Quick Stats dialog includes the following options when in Cross Plot mode:

- **Limits** You can choose to perform calculations on All Cells in the model, or on only those Visible in the current view.
  
  When Visible Cells is selected for 3D Grid plots, you can control which cells are included in the analysis via the Inside Views option in the sidebar and also the Cell Blanking options (both Pick and Value Blanking).
  
  In 2D Grid plots, the All Cells computations are limited to the single layer being displayed, and Visible Cells can be further limited by Cell Blanking.

- **Axes** In the Axes section of the dialog, you can choose which variables to compare on the cross plot.
  
  You can choose two variables for a 2D plot, and a third variable when you enable the 3D option.

- **Symbols** In the Symbols section, you can customize the symbols displayed on the cross plot by choosing the symbol color, shape, size, and fill option.
  
  You also have the option to Color by Variable, allowing you compare a third or fourth variable on the plot. When this option is checked, you choose a variable name instead of color, and the symbols will be colored just as contours are shown in the grid plot. A separate legend is displayed in the cross plot frame to indicate the color scale.

In the example cross plot here, four different variables are compared (one on each of three axes and the fourth by color).
Performing Integrations

To analyze your data using integration, choose “Integration” from the Analyze menu or click the button in the toolbar. (Integration cannot be performed when the KSum or KAvg toggle is active.) The Integration dialog appears.

The integration operation sums variable values from the grid cells in the current plot view, determined by the variable value and time step selected on the Tecplot RS sidebar. You may use variables derived from equations and time delta values, as well as variables from your data file. If your plot contains multiple frames, only the values in the first frame are used.

Choosing Cells

Using the Cell Selection radio buttons in the dialog, you can choose to integrate over all visible cells in the current plot or only cells containing completion nodes.

- **Visible cells** - All nodes shown in the current plot. If you are using the 2D grid plot type, you can sum values in a single I, J, or K plane. When displaying the grid in 3D, you can sum all of the cells or use the inside views and/or cell blanking to limit the integration to selected areas of the grid.
- **Cells containing well nodes** - You may choose either all cells containing any well node (both open and closed), or only those containing open well nodes. Integration is further limited to the wells that are selected for display using the [...] button next to the Wells toggle on the sidebar.

Binning Results

If you have chosen to integrate over all visible cells, you may bin the results into groups, similar to binning in histograms. (Results are always binned by the individual wells when integrating over only the cells containing wells, so additional binning is not available in this situation.) Using binning, you could, for example, group the results according to the cell depth or FIP number. When you chose to bin the values,
the results include separate sums for all the cells that fall into each bin, plus, as usual, the total for all visible cells.

To activate binning, toggle on the Bin results checkbox, then choose the binning variable from the list. (Variables calculated from equations are not available for binning.) The dialog displays the range of the selected binning variable and asks you to choose how to determine the bin sizes.

- **Number of bins** - Ranges from 2 to 100. This is generally the simplest option, but you may not get the exact number of bins you requested; Tecplot RS automatically adjust the bin ranges to “nice” values depending on your data (you might, for example, get a range of .2 to .4 for a bin instead of .1733 to 3.3487).
- **Bin interval** - This choose the interval directly and is not adjusted by Tecplot RS.

If your grid contains transient data, the bin variable list also includes TIME or TIME STEP, either of which is handled differently from other variables. When TIME or TIME STEP is selected, Tecplot RS animates through the time steps in the grid data and integrates at each step. This operation may be slow for large grids with many time steps. You won’t see the plot change during the integration, but when integration is complete, the plot displays the final time step.

**19 - 2.3 Applying Volume Values**

You may display additional data with a volume variable applied, expanding the results to include values that reflect the product of the volume variable and the current contour value. Variables commonly used for this function include Pore Volume or Cell Volume.

If the volume of a cell must be computed from other variables (such as DX * DY * DZ), use the Grid Equations dialog (accessible from the Data menu) to solve this value first. Refer to Section 17 - 2 "Grid Equations" for additional information.

**19 - 2.4 Integration Results**

Click the Compute button to perform the integration and display the values computed from the grid cells in the table at the bottom of the dialog. If you change any setting in the Integration dialog or any of the values or settings that have an influence on integration (for example, blanking criteria, variable, or time step), you must click Compute again to display updated results.

The results include:

<table>
<thead>
<tr>
<th># Cells</th>
<th>How many cells were included in the computation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>The sum of the values (of the contour variable displayed in the frame) for all cells included (as determined by the Cell Selection and Binning options)</td>
</tr>
<tr>
<td>Min/Max</td>
<td>The smallest and largest value for the cells in a bin</td>
</tr>
<tr>
<td>Avg</td>
<td>Sum divided by the number of cells</td>
</tr>
<tr>
<td>Product Sum</td>
<td>Sum of all product values (that is, the contour variable value multiplied by the Volume variable value) in each cell</td>
</tr>
<tr>
<td>Volume Sum</td>
<td>Sum of all Volume variable values</td>
</tr>
<tr>
<td>Product Avg</td>
<td>Product Sum (see above) divided by the number of cells</td>
</tr>
<tr>
<td>Weighted Avg</td>
<td>Product Sum divided by Volume Sum</td>
</tr>
</tbody>
</table>

In addition to displaying the results in the dialog, you may click to Save CSV File button to export the results to a comma-separated value file suitable for import to Microsoft Excel and other software.
Data Export

Your Tecplot RS installation allows you to manipulate your data to use for new simulator input with the following routines:

- **Property Modifier** - Use the Property Modifier dialog to create an ASCII file to use as input into reservoir simulation programs to modify grid properties within the simulator.
- **Extract Data by Cell** - Use the Extract Data by Cell dialog to save information about cells to a file (Grid data ONLY). You have the option to save information about all cells, all blanked cells or all visible cells.
- **Extract Data by Well** - Use the Extract Data by Well dialog to save information about a well or group of wells to a file (Grid data ONLY).
- **Well Editor** - Use the Modify Wells dialog to interactively create or modify a well trajectory.

### 20 - 1 Property Modifier

Using the Property Modifier dialog, you can create an ASCII file to use as input into reservoir simulation programs. The dialog allows you to change values of any of the properties in the grid file. You can apply the changes to the entire grid or to a subset of the grid (either according to blanking criteria or by drawing a boundary). Using the Property Modifier dialog will not alter the values in the grid solution files. Instead, the Property Modifier dialog directs Tecplot RS to create a new file that the VIP, Eclipse, or Chears input decks can use.

Open the Property Modifier dialog by choosing Data > Sim Input > Cells.
To use the Property Modifier dialog, perform the following steps:

1. Load and display the grid solution files containing data to be modified. The displayed view (2D or 3D) impacts the cells chosen for inclusion in the file. To limit the output to a single plane, use a 2D view. Use a 3D view to choose cells in multiple planes.

2. In the Property Modifier dialog, specify which cells to apply modifications to: visible cells, blanked cells, cells inside boundary, or cells outside boundary.

3. To apply property modifications to the displayed cells, choose “Visible cells” and do not use Cell Value Blanking, Pick Blanking or Inside Views. Otherwise:
   a. To apply the modifications to visible or blanked cells, specify the blanking criteria in the Cell Blanking dialog (accessed with the button in the toolbar) or any of the Inside Views options.
   b. To apply the modifications using boundary criteria, use the second portion of the dialog to create the boundaries.

4. If you chose either of the boundary options in the Apply Modifications To region of the dialog, use the Boundary Creation region of the dialog to create the boundary. To use boundary criteria for your property modification, you must use an aerial view of your plot. In multi-frame plots, you must also have Frame 1 highlighted.

Use the buttons to create the boundary:

- Insert a rectangular boundary region.
- Insert a circular boundary region
- Insert a polygonal boundary region
- Erase the boundary region

You can use only one boundary region at a time. If you insert a second boundary region, the last one you drew will be erased automatically.
5. After you have created your geometry, specify whether to include cells inside geometry when the boundary encloses all corners, or when the boundary encloses at least one corner. When you apply property modifications according to a boundary, only the visible cells will be used. To apply the property modifications to all cells affected by your boundary, do not use Cell Value Blanking, Pick Blanking or Inside Views.

6. Once you have specified which cells to apply your modifications to, you are ready to make your modifications in the Modifiers region of the dialog.
   a. Use the Property menu to specify the property to modify. The Property variables match the variable list for the currently loaded grid file.
   b. From the Operator menu, you can choose from the operators =, +, -, *, @ (Property to the Value power), & (Value to the Property power), >, or <. The inequality operators > and < force a minimum or maximum value, respectively; any values less than the specified value (or greater than, in the latter case) will be replaced by the provided value. For example, < 1600 replaces any values larger than 1600 with 1600, so that all values are no greater than 1600.
   c. You can type any number as the value. Tecplot RS does not validate this value in any way.

7. After you have specified the property modifications, click the Apply Modifiers to Plot button to apply the changes. If you have the same property (variable) displaying in your grid plot, the plot will reflect the applied change. Click Reset to Original Values to undo the property modification.

8. Use the File Output region of the dialog to write out your property modifications.
   a. Choose the desired output format (Chears, Eclipse, VIP, or INTERSECT) from the Output Format menu.
   b. Click the File button when you are ready to output the data to a file. A Write Text File dialog will appear with a default file name matching the grid file name but with an extension of .txt. If the file already exists, a dialog will prompt you to either overwrite the file or append it. This allows you to output multiple property modifiers into a single file.
   c. Click the Write Equations button to write out the modifiers to the file you specified with the File button. Alternatively, click the Copy Values button to write out the values for the variable chosen in the dialog to the file specified with the File button.

   When you use the Copy Values option, Tecplot RS will output all grid cells for the chosen variable (regardless of blanking and boundary settings).

If you choose to output your property modifications to a file, the output box at the bottom of the Property Modifier dialog will display the name of the file to which Tecplot RS wrote your output and a summary of the output (the summary displays the equations, if you clicked Write Equations, or a message indicating that the values were copied, if you clicked Copy Values).

20 - 1.1 Property Modifier Output

The output file will contain information which identifies:

- The property (variable) being modified
Data Export

- The grid name (if cells are in an LGR)
- The range of cells to be modified
- The operator (for example: equals, add, subtract)
- The value

In general, the output is an equation for modifying the existing properties. The equations are specific to VIP, CHEARS, Eclipse, or INTERSECT, depending on the chosen Output Format. They are not in the format of the Tecplot Data Alter equations. For additional details regarding the file format, refer to the VIP, CHEARS, Eclipse, or INTERSECT user’s manual.

**CHEARS Variable Names**

For some variables, the names in the `.init` and `.unrst` files differ from what CHEARS needs for the property modifier input deck.

Tecplot RS will translate the following variable names when writing equation data to CHEARS format files.

<table>
<thead>
<tr>
<th><code>.init or .unrst</code> name</th>
<th>Output file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>PORVOL</td>
<td>POREVOLUME</td>
</tr>
<tr>
<td>POROS</td>
<td>POROSITY</td>
</tr>
<tr>
<td>TOPDEPTH</td>
<td>TDEPTH</td>
</tr>
<tr>
<td>PERMX</td>
<td>XPERM</td>
</tr>
<tr>
<td>PERMY</td>
<td>YPERM</td>
</tr>
<tr>
<td>PERMZ</td>
<td>ZPERM</td>
</tr>
<tr>
<td>KRREG</td>
<td>KRREGION</td>
</tr>
<tr>
<td>EQLREG</td>
<td>EQUILREGION</td>
</tr>
</tbody>
</table>

**CHEARS File Formats**

Output in CHEARS format by way of the Write Equations button uses the following format when you are modifying data:

```
***** Comment *****
VARNAME
WINDOW I1 I2 J1 J2 K1 K2 (operation) value
(WINDOW line may be repeated)
```

The header indicates the operation performed and the chosen selection method. The next line specifies the variable being modified. Tecplot RS then specifies a WINDOW of cells bounded by I1, I2, J1, J2, K1, and K2 limits. The indicates what to do with the value, and the final number is the user-supplied value. Below is an example of subtracting 0.5 from the POROSITY of the visible cells:

```
***** Output Visible Cells *****
POROSITY
WINDOW 1 4 1 1 1 1 - 0.500000
WINDOW 1 3 2 2 1 1 - 0.500000
WINDOW 1 3 3 3 1 1 - 0.500000
WINDOW 1 1 4 4 1 1 - 0.500000
```

When using Copy Values, the output file uses the following format:

```
***** Comment *****
VARNAME
```
**Property Modifier**

CELLS i1 i2 j1 j2 k1 k2 =
value1 value2 ... valueN

The header indicates the operation performed. The next line specifies the variable being modified. A group of cells is specified using their I/J/K boundaries, followed by, on the next line, the values of these cells. For example:

***** Copy cell values from plot *****
PRESSURE
CELLS 1 24 1 12 1 10 =
0.0000 0.0000 0.0000 ...

**Eclipse File Formats**

When using Write Equations, an Eclipse file will have a format based on the following template:

```
-- Comment
(op)
VARNAME value I1 I2 J1 J2 K1 K2 /
```

That is, a comment indicating the operation and the selection, followed by a line indicating the operation, which is spelled out in Eclipse format (ADD for +, etc.). This is followed by one or more lines indicating the variable name, the value to be applied, and the I/J/K window to be modified. Multiple of this latter kind of line will appear if there are multiple regions being modified based on the selection type. The variable name and value will be repeated on each line in this case. For example:

```
-- Output Visible Cells
ADD
PRESSURE 1.0000 13 18 5 1 1 /
```

For Copy Values, the file format is slightly different:

```
-- Comment
VARNAME
I1 I2 J1 J2 K1 K2 /
```

After the comment, separate lines contain the command BOX, the I/J/K window of the full data set, the variable name, and the values in the individual cells. For example:

```
-- Copy cell values from plot
BOX
I1 I2 J1 J2 K1 K2 /
PRESSURE
0.0000 0.0000 0.0000...
```

**VIP File Formats**

For Write Equations, the VIP file output format adheres to the following syntax:

```
! Comment
VARNAME MOD I1 I2 J1 J2 K1 K2 (operation)value
```

That is, a comment line indicating the operation and the selection, the name of the variable name being modified, the keyword MOD indicating modification, each on its own line. This is followed by one or more lines indicating the I/J/K window to be modified, the operation, and the value. For example:

```
! Output Visible Cells
PRESSURE
MOD
I3 18 5 5 1 1 +1.0000
```

When using Copy Values, the following format is used:
Data Export

! Comment
VOVER VARNAME
I1 I2 J1 J2 K1 K2 EQ
value1 value2 ... valueN

This format includes a comment line, a VOVER command followed by the name of the variable, specifications for the I/J/K window constraining the data, the EQ command, and the values of the cells. For example:

! Copy cell values from plot
VOVER PRESSURE
1 24 1 2 1 10 EQ
0.0000 0.0000 0.0000 ...

Intersect File Formats

INTERSECT output is in two parts. The first part defines the cells to be modified using the IJK indices. The GLOBAL grid is assumed, but if the cells are part of an LGR, its name is also included.

# Comment
CellSelectionFamily "quinaultlgr_Fam1" {
    Cells = [
        (4 1 1) (5 1 1) (6 1 1) (7 1 1) (8 1 1) (9 1 1) (10 1 1) (4 2 1)
        ('B_INJ' 6 1 1) ('B_INJ' 3 2 1) ('B_INJ' 4 2 1) ('B_INJ' 5 2 1)
    ]
    SelectionNames = ['quinaultlgr_Sel1']
}

Comments are designated by the # symbol.

Once the cell selection is defined, there will be one or more property modifiers as follows:

CellPropertyEdit "quinaultlgr_Prop1" {
    Family        Name                      Property                  Expression
    "quinaultlgr_Fam1" "quinaultlgr_Sel1" "PRESSURE" "PRESSURE +
    2000"
}

INTERSECT does not support copying individual values from an altered plot.

20 - 2 Extract Data by Cell

The Extract Data by Cell dialog enables you to extract a range of cells from your grid plot for export into another file or format (this option is not available for XY plots). Open the dialog by going to Data > Extract Cell Data > By Cell.
20 - 2.1 CSV Extractions by Cell

The Extract Data by Cell dialog has various options based on the selected format. When “CSV” displays as the format, the following controls display:

- **Variables**
  The Variables box lists all of the variables available in the grid. Tecplot RS highlights the first variable by default. Use the Ctrl and Shift keys to highlight a set of variables to include in the output file.

- **Time steps**
  The Time steps box lists all of the time steps available in the grid. Tecplot RS highlights the first available time step by default. Use the Ctrl and Shift keys to highlight a set of time steps.

- **Visible/All Cells**
  The selectable options at the bottom region of the dialog specify whether to save visible cells or all cells. The latter is available only when saving cell values (see next option). The Inside Views region of the sidebar controls the settings for visible cells. You may also use Cell Value Blanking and Pick Blanking to exclude cells from export.

- **Cell Values/KSum/KAvg**
  Choose to save the actual cell values, or KSum or KAvg. The latter are available in only 3D Grid plots and always save the sum or average of visible cells (the Visible/All Cells setting is not used). The output for KSum or KAvg always encompasses the full range of I and J values available in your data. KSum and KAvg output is provided for all grids (global and LGRs) plus all selected variables and time steps.

  When saving “Cell Values” for dual porosity grids:
  - If “Show Matrix Grid” is selected in the “Dual Poros” tab, then matrix grid cells will be exported.
  - If “Show Fracture Grid” is selected, the fracture grid cells will be exported.
  - If “Show Both” is selected, then both matrix and fracture cells will be exported.

  The CSV file will contain an addition column after the LRG column. The value in this column will be “MATRIX” or “FRACTURE”. The CSV file will contain all matrix grid cells, followed by all fracture grid cells.

- **Save CSV**
  Click the Save button to save the data to a csv file. Tecplot RS outputs the data delimited in a column format. For each group of data, one header line indicates the name of the data in each column of output. The static data (ordered by LGR) will appear in the file first. The static data will be followed by all time-dependent data, output by time step, then LGR.

The time format (date or time) listed in the Time steps box is determined by the setting on the Load/Save page of the Plot Options dialog. Refer to Section F - 1.2 “Miscellaneous Settings” for additional information.
20 - 2.2 Sector Data Extractions by Cell

You can also choose to output a continuous IJK range of cells, known as a “sector” of data. For example, the group of cells 1-5 in the I-dimension, cells 2-4 in the J-dimension, and cells 2-3 in the K direction could define a sector of data. To output a three-dimensional group of cells like this, choose “Sector Data” from the Format menu in the Extract Data By Cell dialog, and related options will appear in the dialog.

A "sector" of data represents a continuous, three-dimensional grouping of cells. You can define and extract a sector of data in the Extract Data By Cell dialog after choosing "Sector Data" as the data format to extract.

When you choose “Sector Data” from the Format menu, the Variables and Time steps options remain the same as for CSV extraction, but additional controls appear beneath.

• **File Type**
  Choose from Chears, Eclipse, or VIP as the file type of the sector data output file. The output formats match the Property Modifier File Output formats.

• **Grid**
  From the Grid menu, choose the grid from which to pull the data. By default, Tecplot RS will choose the GLOBAL grid.

• **I-Index Start** and **I-Index End**
  In the Start and End boxes to the right of the I-Index label, indicate the range of cells in the I dimension to extract.

• **J-Index Start** and **J-Index End**
  In the Start and End boxes to the right of the J-Index label, indicate the range of cells in the J dimension to extract.

• **K-Index Start** and **K-Index End**
  In the Start and End boxes to the right of the K-Index label, indicate the range of cells in the K dimension to extract.

• **Save Sector Data**
  Click Save to save the sector data to a file of the type chosen (Chears, Eclipse, or VIP).
20 - 3 Extract Data by Well

Use the Extract Data by Well dialog (accessible by going to Data > Extract Cell Data > By Well) to save information about a well or group of wells to a file (Grid data ONLY).

The Extract Data by Well dialog has the following controls:

- **Cell Options radio controls** Specify whether to save completion (connection) nodes only or completion nodes and intersected cells.
  - **Intersected cells** When chosen, the output file will include completion node and intersected cell information.
  - **Completion cells** When chosen, the output file will include only completion nodes.
- **Wells list** The Wells box lists all of the wells in the grid. All of the available wells are highlighted by default. Use the Ctrl and Shift keys to highlight a subset of the available wells. Click the button in the upper-right corner to launch an expanded, searchable entity list.
- **Variables list** The Variables box lists all of the variables available in the grid. By default, the first variable is selected. Use the Ctrl and Shift keys to highlight a subset of variables to be included in the output file.
- **Time steps list** The Time steps box lists all of the time steps available in the grid. The first time step is highlighted by default. Use the Ctrl and Shift keys to highlight a subset of time steps.
- **Save CSV** Click this button to save the data to a csv file. Tecplot RS outputs the data comma-delimited in column format. The data will be output in one group, ordered by time step. This function does not treat static variable data differently than time-dependent data; if you choose a static variable and multiple time steps, the output file will repeat static values for each time step.

The available variables in this dialog do not include derived (equation) variables. If these are needed, you can instead use Extract Data by Cell with the following settings:

- From the sidebar, activate Inside Views - Well Blanking and choose the desired wells.
- Toggle the “Include Intersected Cells” checkbox to determine whether or not these cells are included in the display and the output file.
- In the Extract Data By Cell dialog, choose Visible Cells and proceed with the export.
The CSV file created by Extract Data By Well includes the well name. You may want to load the CSV file into Excel and sort the data by well name. If your well names begin with a number, you may also need to first click on that column and indicate that the data should be formatted as text (not numeric).

**20 - 4 Well Editor**

You can use the Well Editor dialog (accessible by selecting Data > Sim Input > Wells) to interactively create or modify a well trajectory and output the I, J, K indexes of the cells with completions. The dialog becomes available when at least one grid file is loaded and a grid plot type (2D or 3D) is active.

The Well Editor dialog allows you to create new well trajectories, or modify existing well paths for your simulator input.

To create a new well trajectory:

1. Click the Add Well button to add a well to the Wells list. Right-click the well name and select Rename then type a well name.
2. Edit the I, J, and K indexes of any highlighted node, along with the Grid assignments for existing Well Nodes by double-clicking the value of the column and either typing a value or using the arrows. Click Apply to update the Well Nodes list with the modified values. Alternatively, have Auto-Update checked to automatically update the plot without the Apply button.

The modified well trajectory will appear as a diverging red line from the original well line.

3. You can also add new nodes to the list by clicking the Add Node button. This adds a duplicate node of the last node in the list. Modify the values of the highlighted node and click the Apply button to save your edits to the Well Nodes list.
Nodes can also be added via the Probe to Add Nodes button and the Add Series of Nodes button. The Add Series of Nodes will create a series of nodes for an existing well.

The well trajectories do not modify the wells themselves. Instead, Tecplot RS draws a red 3D polyline on the plot to show the new well trajectory. Turn on Translucency in the sidebar to see the line.

4. Once you have completed your desired changes, selecting Close will update the dataset with your survey wells. Wells not yet added to the dataset will be bolded in the Well list.

5. If you would like to include the well trajectory in your simulator input, highlight the wells you would like exported, then click the Output button to write the data to a file.

20 - 4.1 Add Node Series
Clicking the “Add Series of Nodes” button opens the Add Node Series dialog. This creates a series of nodes increasing or decreasing in a certain I, J or K direction. The initial node location defaults to the smallest, active IJK position.

Enter the desired start position in either XYZ or IJK coordinates. Alternatively, probe for the initial node location. Select orientation (the I, J or K axis to increment along) and choose the direction (increasing or decreasing). Finally input the number of node intervals. For your benefit, the maximum number of intervals is shown at the top of the dialog.

When ready, select the Add Well button to add the Well Series as a set of new nodes for the selected well.

20 - 4.2 Well Data Output
The output is saved in Eclipse format. Here is an example:

```plaintext
WELSPECS
  'GAS-05' 1* 23 2 1* 'GAS' /
/ 
COMPDAT
  'GAS-05' 23 2 2 2 'OPEN' 2* 0.708 1* 0.0 1* 'Z' /
  'GAS-05' 23 2 3 3 'OPEN' 2* 0.708 1* 0.0 1* 'Z' /
/ 
```

The WELSPECS section includes the following well parameters:

- Well name
- Name of Well group (the default is used)
- I location of well head
- J location of well head

The well trajectories do not modify the wells themselves. Instead, Tecplot RS draws a red 3D polyline on the plot to show the new well trajectory. Turn on Translucency in the sidebar to see the line.
Data Export

- Reference depth for bottom hole pressure (the default is used)
- Preferred phase for the well

The COMPDAT section includes the following completion parameters:

- Well name
- I location of the completion
- J location of the completion
- Minimum K value of completion(s)
- Maximum K value of completion(s)
- Open/shut flag
- Saturation table number for connection relative permeabilities (the default is used)
- Transmissibility factor for the connection (the default is used)
- Well bore diameter (always written as 0.708)
- Effective Kh (the default is used)
- Skin factor (always written as 0.0)
- D-factor (the default is used)
- Direction in which the well penetrates the grid block (always written as Z)

The "GLOBAL" grid in Tecplot RS will be called "COARSE" in the output file. All other grid names will be output as they are named in Tecplot RS.
Part 4 Project Files, Templates, Gallery
Projects

Using a project file can help you with several goals. When you work with multiple data files, such as comparing numerous history match runs to observed data, it is useful to load and unload all associated files simultaneously. A project file can do this. When you work with the same data file on multiple occasions, a project file can help you return to visualize the data file the way you did previously. In case you work with a large data file that might cause Tecplot RS to crash, saving a project file will ease the pain of crashing, since you will usually lose less work. Trivial in size but large in power, project files can help speed the workflow of most users.

A Project file consists of a list of data files (with their file paths for simultaneous loading), saved plot styles, and paper layout settings. The Project file is a tagged text file (XML) so that you can edit it manually if you wish, while remaining usually small in size. All these factors allow you to use a Project file to return to a set of data files with the “look” you have established for them.

21 - 1 Creating a New Project File

When you launch Tecplot RS, you are automatically working with a new, empty project. You can immediately start loading data into the project, and Tecplot RS will prompt you to save the project to a file when you exit the application.

You can also create a new project by choosing “New Project” from the Project menu. If you had already loaded data or adjust settings in Tecplot RS (thus working in an unsaved project), Tecplot RS will ask you if you want to save that project before switching to a new project.

The project file includes any file that you currently have open, including Custom files, Style files, and Paper Layout Template files (.rscx, .rsstyx, and .rslayx, respectively). The project file will also include the paths to the solution files associated with any active grid file. Refer to Chapter K: “Tecplot RS Files” for information on the file types.

21 - 2 Saving a Project File

To save the condition of your current project, choose “Save Project” from the Project menu. If you have not previously saved the current project, Tecplot RS will prompt you to specify a location in which to save it. Otherwise, the current settings will automatically update the current project file.
Projects

To save the condition of your current project to a new file, choose “Save Project As” from the Project menu. Tecplot RS will prompt you to specify the location to save the project. The saved file will become your current project file in Tecplot RS.

You can save project files to any location; Tecplot RS does not require them to reside in the same location as your data files.

21 - 3 Opening Existing Project Files

To open an existing (that is, previously saved) project file, choose “Open Project” from the Project menu. Tecplot RS also remembers up to ten recently accessed project files and adds them to the Project menu.

Tecplot RS will unload your currently loaded data files (the data files associated with your current project) before loading the files in the new project.

You can also open a project file by dragging it onto the Tecplot RS icon or onto the Tecplot RS workspace.

You can open a project from the command line by typing “tecplotrs” followed by the name of the project file (including the extension, .rsprj). For example, to open the project myproject.rsprj from the command line, type the following in the command line and press Enter:

tecplotrs myproject.rsprj

21 - 4 Project File Contents

When you save a project, that project will include:

- The list of all open files, including identifiers for which ones are active.
- Embedded versions of the Paper Layout, Plot Options, and Custom Options files. Refer to Chapter D: “Paper Layout”, Chapter F: “Plot Options”, and Section 5 - 5 “Custom Plot Options Dialog” (respectively) for details.
- All defined selection sets (refer to Section 7 - 2 “Selection Sets” for details).
- Grid and XY Equations (refer to Section 17 - 2 “Grid Equations” and Section “XY Equations” for details).
- Display options (for example, show wells and 2D view type).
- All XY Freestyle plot definitions (refer to Section 4 - 8 “XY Freestyle” for details).
- Multi-frame settings (refer to Multi-Frame Options for details).
- Select comparison data sets and comparison options (refer to Chapter 10: “Comparing XY Data” for details).
- Your Template folder and 10 most recently used templates in the project (refer to Section 22 - 2 “Templates” for details).
- Plot descriptions that you have saved to the Gallery (see Section 22 - 3 “Plot Gallery”).
- The Custom 3D View, if any (see Section 22 - 1 “Custom 3D View”).
- The last plot type view.

While your project file has the style data embedded, you can always change styles with the interface (independent of the data in your project file), and you can save your project again to save the changes.
Viewing Project Files

The project file uses an XML format, a logically tagged file. It is not necessary for you to edit this file manually; however, if you wish, you can view the file in a variety of XML browsers, including Internet Explorer. In order for the browser to properly recognize it as an XML file, however, you may need to rename the project file with a .xml extension instead of the normal .rsprj extension.

If you use the XML browser in Internet Explorer, Windows may require you to "Allow Blocked Content". This allows you to take advantage of some browser capabilities, such as collapsing subcategories, that make navigating XML files easier.
Saving and Reusing Views and Plots

As you work with your project data in Tecplot RS, you may find it useful to be able to save an interesting plot or view so that you can quickly return to it later. You can do this in three different ways:

- **Custom 3D View** - Stores the current 3D view (rotation, center, and perspective) as the main 3D view of your project. Later, you can easily return to this view. This view is stored in and saved with your Tecplot RS project file.

- **Templates** - Define plot settings that you can apply to any data set, not just the current one. Settings included in templates include plot type, paper layout, multi-frame settings, variable selections, and layer toggles. Templates are saved in files on your computer and are not associated with any particular data set or project.

- **Plot Gallery** - Stores plot settings that apply to a particular data set. This includes everything stored in a template, plus data-dependent options such as entities, time steps, and view (pan, zoom, rotate). The only settings not saved in the Gallery are the settings in Plot Options (which apply to all plots in the project). Gallery plots are stored in and saved with your Tecplot RS project file.

### 22 - 1 Custom 3D View

When the active frame contains a 3D plot, you can choose Save Custom 3D View from the View menu to store that plot’s rotation, center, and perspective. (Only the 3D view is saved; other plot characteristics, such as the data set and style, are not saved.) Later, you can return to this view by choosing Apply Custom 3D View, or by clicking the Reset View button on the toolbar. The custom 3D view is stored in and saved with your project file.

The keyboard shortcut for Save Custom 3D View is Control-3.

Only one custom 3D view can be saved per project. If you save a custom 3D view when one already exists in your project, the one being saved replaces the previously-saved one.
22 - 2 Templates

Templates store data-independent plot settings and can be applied to data sets other than the one used to create them. We suggest you create a folder specifically for storing your templates. This folder does not need to be the same location as your project file or data files. Having a single folder containing all your templates usually works well, since templates are designed as “generic” in nature, for use with multiple different projects.

You can change the location of the Template Folder at any time by choosing “Choose Folder” from the Templates menu. This launches the Manage Data dialog with the Templates page open.

To change the Template Folder, click the Browse button and choose a new folder, or type the location into the text field. Tecplot RS scans the specified folder for files with the template extension (.rstmpl) and lists file names of any templates it finds in the Template Files box.

22 - 2.1 Saving Template Files

Once you create plot settings that you want to save as a template, choose “Save Template” from the Templates menu. The Save Template dialog shows the folder currently chosen for template files associated with this project. Any template files you create will be saved in this folder. You can change the folder by clicking the Browse button.

Type a descriptive file name for your template file in the Template File Name text field. If you wish, you can type a description of the plot you are saving in the Description field.

Keep lines short and press Enter for each new line. This will make the description easier to read when it appears in the dialog that lets you choose to apply a template.

Click OK, and Tecplot RS will save the template file. Tecplot RS automatically adds the file name extension .rstmpl.
22 - 2.2 Applying Template Files

Once you have saved a template file, you can apply it by choosing “Apply” from the Templates menu, and choosing the template to which you wish changes to be applied. Tecplot RS remembers the last 10 template files that have been applied. If you do not see the desired template file in the list, choose "More" after “Apply” in the Templates menu to launch the Templates dialog.

The Templates dialog displays a list of all the template files that Tecplot RS found in the current template folder. You can change the template folder by clicking the Browse button.

To apply one of the templates, choose it in the list and click the Apply button.

Since the template defines the plot type, applying a template may change the sidebar as well as the view. It can also change the paper size and orientation, since the template also stores this information.

Templates record the variables to be displayed in each frame. It is possible that the variables in use when the template was created may not exist in the current data set. Tecplot RS checks variable aliases and attempts to find a match. If it does not find one, it uses reasonable defaults.

The template file does not include other data set-dependent items. For example, a 3D Grid plot's template will save the fact that you are viewing IJK slices with the ghost turned on, but the choice of which IJK slices to view is saved in the grid state file. Other data set-dependent items not included in the template file include the current time step and any Inside View options.

22 - 2.3 Template File Contents

Template files are XML files that include information needed to re-create a particular plot. This information includes:

- The current plot type (XY Variables, XY Entities, 3D Grid, or another plot type).
- The current Paper Layout design.
- Multi-frame options.
- Global plot settings, such as the state of many options in the sidebar.
- Individual frame settings, such as the variables chosen for display in each frame.

Tecplot RS organizes each template in a separate file, in XML format. Using an XML editor or text editor, you can view and edit the template manually. However, it is much easier (and safer) to make changes using the Tecplot RS interface.
22 - 2.4 Managing Template Files

Use the Templates page of the Manage Data dialog (accessible by clicking the Manage Data button in the toolbar or from the Project menu), to change the folder from which to load template files. The Template Files region of the dialog displays all of the files housed within the folder listed in the Template Folder field.

22 - 3 Plot Gallery

The Plot Gallery allows you to create a collection of plots. Plots saved in the Plot Gallery are not images, but snapshots of the settings you used to create the plot. Virtually everything about the plot is saved except for the settings in the Plot Options, which are shared by all plots in the project. (The XY Freestyle plot type has its own settings for individual line styles, and so can be useful when you don't want to change the line styles in all Gallery plots using Plot Options.) When you re-display a plot from the Plot Gallery, it restores the sidebar and all other settings dialogs to the state they were in when you added the plot to the Plot Gallery.

In general, any number of plots may be stored in the Plot Gallery, and there is no limitation on the number of plots of each type that can be stored. However, the Plot Gallery currently does not support the History Match or Flow Tables plot types, cell label options, inactive grid display options, pick blanking sections. Polyline geometries are not currently saved.

The Plot Gallery is part of your Tecplot RS project. Plots saved in the Plot Gallery are saved when you save a project, so if you do not save a project file, your Plot Gallery will be lost.

Gallery plots work on the data sets loaded with the project. If those files change, for example with a new simulator run, the Gallery plots will reflect the new data when the project is next opened.

22 - 3.1 Saving a Plot

To save a plot in the Plot Gallery, choose Save from the Gallery menu and specify a name for the plot. Each plot must have a unique name; if you specify the name of a plot already in the Gallery, you will be asked if you wish to replace the existing plot with that name.

The name you specify here is not a file name, so it can contain characters that are not legal in filenames. Commas, quotes, asterisks, spaces, and other special characters may be used (up to 80 characters total); however, both slashes and backslashes will be replaced with vertical bars.

You may also save a Gallery plot using the Plot Gallery dialog (see following).
### 22 - 3.2 Managing the Gallery

The Plot Gallery dialog is opened by choosing `Manage` from the `Gallery` menu. The main section of this dialog contains a list of all saved Gallery plots organized by plot type. You can expand or collapse a plot type, showing or hiding the saved plots of that type, by clicking the small triangle next to the plot type. All plot types can be expanded or collapsed at once by clicking the up/down buttons at the top of the dialog.

You can select multiple plots for batch exporting by holding down the Control or Shift key while clicking. Click a plot type to select all gallery plots of that type.

After selecting one or more plots, you may take the following actions using the buttons on the right side of the dialog:

- **Display** - Displays the plot. (Only available if one plot is selected.) You may also double-click a plot to display it. The Gallery menu has a list of the most recently-used plots from the Gallery for easy access.
- **Export** - Exports the selected plot(s) as image(s). If you have selected only one plot, you are asked to name the resulting image file. If you have selected multiple plots, you are asked to choose a folder (or create a new one). The exported plots will be placed in this folder and named according to their name in the Plot Gallery, with the appropriate image filename extension added. (Note that characters that are invalid in filenames will be removed.)
- **Export Setup** - Chooses the file format and options for the exported image (see Exporting a Single Image). If you do not set up your export, PNG file(s) with default settings are created.
- **Print** - Prints the plot (see Printing Your Plot).
- **Delete** - Deletes all selected Gallery plots.
- **Select All** - Selects all plots in the Gallery.

You may also save a new plot to the Gallery by clicking the `Save` button (this is the same as choosing `Gallery>Save`).

The Plot Gallery dialog may be left open while you work with Tecplot RS.

### 22 - 3.3 Moving Gallery Plots Between Projects

Since Gallery plots are stored in the project file, moving them between projects requires some finesse. If the second project uses data files that are very similar in structure to the first project (in particular, the same variables), only with different file names, you may find `Project>Swap Files` useful to load different data files into the project containing the Gallery plots you wish to use. The project may then be saved under a different name for later use with the swapped-in files. For more information, “Swapping Data Files” on page 149.

It may also be feasible to simply make a copy of the first project file and change the names of the data files it loads using a text editor. The copied project will have all the same project settings as the original, including its Gallery.

In other situations, you can create a template from a Gallery plot in one project, apply it to data loaded in a second project, and then save it as a Gallery plot in that project. Because templates do not store all plot...
options, some additional work will be needed to fully recreate the plot in the second project, but applying the template will give you a significant head start.
Part 5 Advanced Topics
Batch Processing

You can run Tecplot RS without displaying any graphics on your screen. This method, called batch processing, can save time when you want to process multiple data sets into plots to print or export.

23 - 1 Batch Processing Overview

These guidelines govern the use of batch processing in Tecplot RS:

- Use a macro to give Tecplot RS instructions to work with data through batch processing. Create the macro first and save it to the bin folder of your Tecplot RS installation.
- To run a macro in batch processing mode, use the command line to navigate to the bin folder of your installation. Then type tecplotrs -b macro.mcr, where macro.mcr is the name of the macro you want Tecplot RS to run.
- You can use Tecplot RS in batch mode only on your local machine.

For in-depth instructions and explanations, see the following sections.

23 - 2 Batch Processing Setup

To prepare for batch processing, follow these basic steps:

1. Create a macro file to control the batch processing. You can do this either by choosing “Record Macro” from the Macro menu and recording from within a Tecplot RS session, or by using an ASCII text editor. See Chapter 24: “Macros: Task Automation” for more information.
2. Create project files for the macros to use, as necessary.
3. Prepare data files.
4. Debug the macro file by running Tecplot RS while not in batch mode.

Macros should work with future releases if they begin with a blank project file. Refer to the Tecplot 360 Scripting Guide for more information.

To use batch processing, you must run at least one macro. When you launch Tecplot RS in batch mode, it requires that you provide the name of a macro file to execute. The minimal command to launch Tecplot RS in batch mode is as follows:

```
tecplotrs -b macrofile.mcr
```

The `-b` flag instructs Tecplot RS to run in batch mode, and the `macrofile` tells Tecplot RS the name of the macro file to execute. Refer to Command Line Options for more details and options.

In order to run Tecplot RS in batch mode, you should first navigate to the `bin` folder of your Tecplot RS installation. You can run batch processing without navigating by including the full path (in quotation marks) of `tecplotrs` and `macrofile.mcr`.

### 23 - 3 Batch Processing Using a Project File

Combining project files with batch processing is both powerful and flexible. It is also the recommended method. With project files you can organize a plot with a plot type, a template, and style settings. The project file manages data sets, and you can alter it easily, either from the command line or within a macro that loads the project file, to load whichever data sets you want to use. Then load the project in Tecplot RS using the command:

```
tecplotrs -b batch.rsprj
```

### 23 - 4 Batch Processing Diagnostics

Each time Tecplot RS is run in batch mode it creates a file named `batch.log` in the folder in which Tecplot RS was started. (You can name this file differently by defining an environment variable called `BATCHLOGFILE`. If the name given in the `BATCHLOGFILE` environment variable is a relative path, the directory name where Tecplot RS was started is prefixed.) Tecplot RS sends a running commentary on actions performed in Tecplot RS, as well as warning and error messages, to the `batch.log` file.
Macros: Task Automation

To make common plot tasks and repetitive actions simple, Tecplot RS includes the ability to record sets of commands and play them back with the click of a button. Tecplot RS records the command sets in the Tecplot scripting language, in units of macros. You can record and play macros from within Tecplot RS, or you can use text editing software to edit an existing macro or write your own and then load it into Tecplot RS.

Macros can save you time by performing repetitive operations or time-consuming operations for you. For example, if you have daily data simulations and want to create a plot each day to view the simulation, you can record a macro that opens a project file with customized plot settings, loads data, manipulates the plot, and exports an image of the simulation. Then each day you only need to place the simulation data where the macro is assigned to look for it (with the same name), run the macro, and view the exported image!

This section discusses recording, editing, and playing macros from within Tecplot RS. Refer to Chapter 26: "Macro Commands Summary" for a list of all the commands used for functions specific to the RS Manager.

24 - 1 Creating a Macro

To record a macro in Tecplot RS, start the Macro Recorder, accessible in the Macro menu, and then perform the sequence of actions you wish to record. After recording your macro, if you wish, you can edit your macro file with an ASCII text editor to remove redundant operations, compress repetitive actions into loops, or otherwise modify the macro.

To operate the Macro Recorder, do the following:

1. Choose “Record Macro” from the Macro menu.
2. Specify a file name and location to save your macro in the Write Macro File dialog and click Save in that dialog (macros automatically use the file extension .mcr).
3. An Information dialog appears to let you know that Auto-redraw will not work during macro recording. Click OK.
4. Tecplot RS is now recording the macro. Execute the actions you wish to record. (The Macro Recorder dialog remains open during the recording session).
5. When you have completed the actions you wish to record, click the Stop Recording button in the Macro Recorder dialog.

To redraw your plot while recording and see the result of your plot selections, click the Redraw button in the sidebar.

While recording macros, you can use the buttons in the Macro Recorder to add specific commands to your macro. These buttons insert the following:

- **Insert “Pause”** Clicking this button adds a “pause” command to the macro. When you play a macro including a pause command, Tecplot RS displays a message box when it reaches the pause command, and waits for you to click OK before continuing to process the macro. If you include several different plots or plot views in your macro, you may find it useful to insert a pause in the sequence. Click the Insert Pause button, and add a comment or label in the provided dialog. Then, when you replay the macro, the sequence will pause at this point, allowing you to view the results.

- **Insert “Graphics Off”** Adds a “graphics off” command to the macro. When you play a macro containing a “graphics off” command, Tecplot RS stops displaying graphics in the workspace from the “graphics off” command until a “graphics on” command is encountered.

- **Insert “Graphics On”** Adds a “graphics on” command to the macro.

- **Insert Raw Command** Opens a dialog in which you can enter any valid Tecplot macro command. For example, you can add “$!LOOP 10" at the start of a section you want to repeat 10 times, then "$!ENDLOOP" at the end. See the Tecplot 360 Scripting Guide for information on the Tecplot macro language.

- **Stop Recording** Click this button to stop recording when you have completed the sequence of actions you wish to include in your macro.

To make your macro as compatible as possible with other versions of Tecplot RS, begin recording with a blank project and default formatting.

When creating a macro, be sure to think about the state of your project when you begin recording. For example, you may wish to begin with a blank project and default formatting to create a macro that will run without first loading data. On the other hand, if you wish to create a macro that operates on whatever data you have loaded at the time, you may wish to load example data before beginning to record your macro.

To use a macro to precisely duplicate the plot you had when you recorded it, Tecplot RS must be in the exact same state when you run the macro as it was when you began recording it. To accomplish this, start with an blank project for both recording and replaying a macro to start with all default settings except plot type (you can specify the plot type in your macro).

To begin with all default formatting and the default plot type, restart Tecplot RS before recording and replaying your macro.
There are a number of ways to play a created macro. The most straightforward is to choose "Play Macro" from the Macro menu. In the Play Macro dialog that appears, browse to the macro file (.mcr) that you wish to play, and click the Open button.

The last ten macros you played are listed in the Macro menu, giving you a second way to play frequently-used macros.

On Windows operating systems, you can also launch Tecplot RS and run a macro by dragging the macro file (with the extension .mcr) onto the Tecplot RS icon.

**Command Line**

You can also launch Tecplot RS from the command line and tell it to play a macro by including the name of the macro file on the command line, like this:

```
tecplotrs mymacro.mcr
```

To play a macro this way, first navigate to the folder containing the macro or include the path to the macro in the command.

You can also run the macro in batch mode using the -b flag. The complete command for accomplishing this on a Windows operating system follows this form:

```
tecplotrs -b <macro filename>
```

For example:

```
tecplotrs -b MyMacro.mcr
```

This command syntax will also work on Linux platforms.

**Easy Macros**

The Easy Macros window, which you can open from the Macro menu, lets you quickly play a macro file from a folder you have chosen. The Easy Macros window will stay open while you use Tecplot RS, giving you an easy way to integrate your macros into your workflow.

You may encounter errors in macro playback if you include "pick" operations when recording a macro. A "pick" operation includes any instance of selecting an object by clicking it (such as text or a geometry).
Macros: Task Automation

- Click **Browse** to choose the folder.
- If you add more macros to the folder while Tecplot RS is running, click **Refresh** to see them in the list.
- Click **Run** to play the selected macro, or simply double-click the macro in the list.

Manage Data

The Macros tab of the Manage Data dialog lets you choose the default directory where the Easy Macros window will look for macros. The directory can be set for each project.

In this dialog, click Browse to set the Easy Macros directory, or type a path directly. The Macro Files list shows all the macro files found in the selected directory.

24 - 3  Writing and Editing a Macro

While using the **Macro Recorder** is the easiest way to create macros, you can also use a text editor to either write your macro manually or edit a created macro. This can be useful for automating the same action several times in one macro (for example, to load several data files with numerically incremental names, like simulation1.unsmry, simulation2.unsmry, and simulation3.unsmry).

When writing or editing a macro file, you can add macro commands by enclosing them in a unit called a macro function: define the command(s) in the macro function, and then call the macro function. Use this form to define a macro function:

```
$!MACROFUNCTION
  NAME = functionname
  .
  .
$!ENDMACROFUNCTION
```
Between \$!MACROFUNCTION and \$!ENDMACROFUNCTION, you can include any legal macro command (except \$!MACROFUNCTION you cannot define another macro command inside a definition).

For example, the following macro function turns on the Contour zone layer, turns off the Mesh zone layer, sets the contour plot type to Both Lines and Flood for zones 1, 2 and 3, then chooses gray scale color mapping:

\$!MACROFUNCTION
NAME = "graycontour"
RETAIN = Yes
$!FIELDLAYERS SHOWCONTOUR = YES
$!FIELDLAYERS SHOWMESH = NO
$!FIELDMAP [1-3] CONTOUR{CONTOURTYPE = BOTHLINESANDFLOOD}
$!COLORMAP 1 CONTOURCOLORMAP = GRAYSCALE
$!REDRAW
$!ENDMACROFUNCTION

The RETAIN parameter tells Tecplot RS to retain the macro function definition for use in subsequent macro calls in one Tecplot RS session. This allows you to define and call a macro function once, and then call that function in any other macro after playing this macro in your Tecplot RS session.

Use the \$!RUNMACROFUNCTION macro command to call your macro function. For example, to call the "graycontour" macro function defined above, use the following macro command:

\$!RUNMACROFUNCTION "graycontour"

You can use the \$!RUNMACROFUNCTION command within other macro functions; calls may be nested up to ten deep.

To access parameters from within a macro function use "|n|", where \(n\) is the parameter number (do not include the double quotes). For example, the following function uses two parameters for the assignments to SHOWCONTOUR and SHOWMESH:

\$!MACROFUNCTION
NAME = "AssignContourAndMesh"
$!FIELDLAYERS SHOWCONTOUR = |1|
$!FIELDLAYERS SHOWMESH = |2|
$!ENDMACROFUNCTION

\$!RUNMACROFUNCTION "AssignContourAndMesh" (YES,NO)

### 24 - 4 Working with Macros: Going Farther

If you use macros for only recording and playing, you do not need to understand or even look at the command structure. However, to tap into the full power of macros, you can learn to manipulate the files, cut and paste, modify, and even create files with macros.

#### 24 - 4.1 Exploring Basic Macro Structure

Remember the very first XY plot you created in Chapter 4: "Basic XY Plots"? The macro commands for creating that plot look like this:

```
#INC 1100
$!VarSet [MFBO] = 'C:\Program Files\TEC_RS_2019'
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'LOADDATAFILE FTYPE=ECLUNSMRY FRAME="C:\Program Files\Tecplot\TecRS 2019\Examples\Tecplot RS\chelan.unsmry" APPENDRULE=NONE'
```

271
Macros: Task Automation

$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'SETACTIVEXydata set FNAME="C:\Program Files\Tecplot\TecRS 2019 R1\Examples\Tecplot RS\chelan.unsmry"'
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'PLOTXY TYPE=XYVARIABLES'
$!REDRAWALL
$!RemoveVar |MFBD|

Even without understanding the macro structure, you can probably recognize that these commands load a file and then specify the XY Variables plot type, which are the steps you took to create that first plot.

The best way to learn macro command structure is record while you are working and then look at the results. Also, refer to the command guides. Your command file will usually contain a combination of "native" Tecplot commands and those specific to Tecplot RS. For the former, refer to the Tecplot 360 Scripting Guide (downloadable at the Tecplot Web site). For the syntax for commands unique to Tecplot RS, see Chapter 26: "Macro Commands Summary" of this manual. Tecplot RS macros always begin with:

$!ADDONCOMMAND ADDONID = 'Tecplot RS'

Refer to Chapter 26: "Macro Commands Summary" for a complete list of the Tecplot RS macro commands.

24 - 4.2 Understanding Basic Macro Structure

All Tecplot RS macro commands are embedded in the Tecplot scripting language's ADDONCOMMAND macro:

$!ADDONCOMMAND
ADDONID = <string>
COMMAND = <string>
...

The first string (<string>) identifies the Tecplot add-on that will receive the command. Set this to "Tecplot RS". The second string contains all of the information that Tecplot RS needs to process the command.

In the tables that follow this section, parameter values will be identified by the type enclosed in angle brackets < >. Do not include the brackets when you type a command.

The type of commands include:

<integer> Integer value, which does not include decimal points. The allowable range will depend on the specific command.
<double> Real number, with or without decimal points. The allowable range will depend on the specific command.
<boolean> TRUE or FALSE (can be shortened to T or F)
<string> Character strings, enclosed in double quotes.
<option> Options specific to the particular command. Allowable values will appear in the Notes column.

The COMMAND strings must be contained on a single line in your macro command file, even if they appear on multiple lines in the tables.
24 - 5  Macro Debugger

Use the **Macro Debugger**, accessed via **Macro>View/Debug Macros**, to step through and debug a macro file. This dialog allows you to add and delete breakpoints, view and set watch variables, and view the call stack.

The **Macro Debugger** displays the text of the currently loaded macro file at the top of the dialog in the Macro Source area. The black arrow marks the line about to be executed; it moves to the next command after the current command is executed. Below this is a second area (Expanded View) showing the complete command about to be executed, as many macro commands are lengthy and may not be readable in their entirety in the Macro Source area.

Because Tecplot RS began life as a Tecplot 360 add-on, many of its macro commands appear as `$!ADDONCOMMAND` in the macro debugger. You will need to view them in the Expanded View to see what they actually do.

The Macro Debugger has the following buttons in its toolbar:

- **Load a Macro file** - Loads a macro file using the **Open Macro** dialog, in which you can specify which macro file to load. Tecplot macro files typically have the extension `.mcr`. Once you have loaded a macro file, it stays loaded in the Macro Debugger until you load a different one.
- **Continue** - Plays the macro without stopping after each step, until the macro finishes or the Macro Debugger encounters a breakpoint.
- **Step buttons** - These three related buttons help you step through your macro line by line, pausing after each instruction has been processed. Checking the values of variables after each step is very helpful in finding and fixing problems. These buttons have slightly different functions, described below.
Macros: Task Automation

- **Step Into** - Executes the current macro command. When a `$RUNMACROFUNCTION` command is encountered, the Macro Viewer steps into the called function, so it too can be executed line by line.
- **Step Over** - Executes the current macro command. When a `$RUNMACROFUNCTION` command is encountered, the entire function is processed as a single operation, instead of allowing you to step through it line by line. This is useful for functions that you have already verified to be working correctly and/or do not wish to step through, especially long ones.
- **Step Out** - Executes the rest of the current function at full speed, rather than line by line, until the end of the function ($ENDMACROFUNCTION) is encountered, then resumes single-stepping at the line after the `$RUNMACROFUNCTION` instruction that called the function. This is useful when you have verified that a function is working correctly, and don’t need to continue stepping through it (especially in functions with loops) or have accidentally stepped into a function you don’t want to step through.
- **Reset** - Stops the running macro, if any, and resets the macro to start running at the beginning again.

If your macro relies on Tecplot RS being in a particular state when it starts processing, make sure Tecplot RS is in this state before you click Reset. Otherwise, the results of the macro may not be what you expect.

A convenient way to handle state with macro resets is to save your plot in the Plot Gallery before beginning debugging, then restore that plot if you need to reset.

The Macro Debugger has the following three areas at the bottom of the dialog. Watch Variables and Breakpoints share the same space; use the provided tabs to switch between them.

- **Watch Variables** - Displays the values of selected macro variables as you step through the code, and allows you to add and remove variables to be watched. See Watching Variables.
- **Breakpoints** - Displays the breakpoints set in your macro and allows you to delete any or all of them easily. See Using Breakpoints.
- **Call Stack** - Displays all function calls currently executing. When one function calls another, which calls another, and so on, this area displays the name of all these functions in the order they were called. The name main represents the top-level script (instructions outside of any functions).

### 24 - 5.1 Watching Variables

The Watch Variable panel at the bottom of the Macro Debugger allow you to set variables to be displayed while your macro runs. You can add a variable to be watched by choosing it from the pop-up menu here. To stop a variable from being watched, click it in the list of watched variables, then click the delete (trash) icon.

### 24 - 5.2 Using Breakpoints

A breakpoint is a point in your code where you wish to pause execution, usually just before some macro instructions you are having trouble with. Using the Continue button, your macro runs at full speed until it
reaches a breakpoint. You can then inspect variables or the call stack and see the next several lines to be executed, then step through the macro a line at a time using the appropriate Step buttons in the toolbar to see how they behave.

Breakpoints are shown as red discs to the left of each line of code in the Macro Source field. To set a breakpoint at a particular line of your macro, click to the left of that line. A red disc appears next to that line to indicate that execution will pause just before that line is executed. You can remove the breakpoint by clicking again.

The Breakpoints area at the bottom of the Macro Debugger dialog display information about where each breakpoint is set: the function it's in ("main" if it's outside a function), its line number, and the macro command. You can delete breakpoints from this area by selecting them and clicking Delete Selected Breakpoints. (This is the fastest way to delete all breakpoints.)
List of Macro Commands

ANIMATE 281
ANIMATESETUP 281
ARBSLICES 301
BLANKING 295
BUBBLEOPTIONS 295
CLEARALLSLICES 302
CMGSETUP 283
COMPARELEGENDFORMAT 314
COMPARESETUP 314
COMPLETIONSETUP 315
EXTRACTCELLEDATA 283
GALLERYDELETE 284
GALLERYDISPLAY 284
GALLERYSAVE 285
GRID_DISPLAYNAME 296
GRIDEQUATIONS 296
GRIDOPTIONS 297
GRIDTRANSFORM 298
IJKBLANKING 302
List of Macro Commands

IJKSLICES 302
INSIDEFAULTS 303
INSIDELGRS 303
INSIDENNCS 299
INTEGRATE 299
ISOSURFACES 303
LOADCUSTOMPLOT 285
LOADFLOWTABLE 285
LOADGRIDDATA 285
LOADGRIDDELTA 286
LOADGRIDINACTIVECELL 287
LOADGRIDNNCS 287
LOADGRIDSMOOTHING 287
LOADGRIDTRANSFORM 286
LOADPAPERLAYOUT 288
LOADPLOTSTYLE 288
LOADTEMPLATE 322
LOADXYDATA 288
MAKEUSERGROUPS 313
MAKEWELLPATTERNS 314
MULTIFRAMEOPTIONS 305
NNCOPTIONS 300
PAPERLAYOUT 305
PERFORMANCE 306
PERIODICPRODUCTIONRATES 289
PLOTFLOWTABLE 294
PLOTGRID 300
PLOTOPTIONS_AXIS 306
PLOTOPTIONS_CELL_LABELS 306
PLOTOPTIONS_GRID 307
PLOTOPTIONS_GRIDAXES 307
PLOTOPTIONS_INACTIVEGRID 308
PLOTOPTIONS_LABELS 308
PLOTOPTIONS_MISC 309
PLOTOPTIONS_SCALING 309
PLOTOPTIONS_WELL_LABELS 310
PLOTOPTIONS_WELL_OPTIONS 310
PLOTOPTIONS_WELLSYMBOLS 310
PLOTOPTIONS_XY 311
PLOTXY 316
PROMPTFORFOLDER 289
RESETVIEW 300
RFTSETUP 316
RSVFILE 312
SAVEPAPERLAYOUT 290
SAVEPLOTSTYLE 290
SAVEPROJECTFILE 290
SAVETEMPLATE 322
SELECTIONSET_DELETE 312
SELECTIONSET_RENAME 313
SELECTIONSET_SAVE 312
SETACTIVEGRID 291
SETACTIVEXYDATASET 291
SETASDEFAULT CUSTOMOPTIONS 291
SETASDEFAULT PAPERLAYOUT 292
SETASDEFAULT PLOTOPTIONS 292
SOLVEPTIME 317
STAMPOPTIONS 322
STREAMLINEOPTIONS 317
SWAPGRIDFILE 293
SWAPXYFILE 293
TEMPLATEFOLDER 323
List of Macro Commands

UNLOADFLOWTABLE 293
UNLOADGRIDFILE 293
UNLOADXYDATASET 294
UPDATE3DVIEW 301
UPDATEOPTIONS 312
UPDATESTREAMLINES 318
UPDATESTYLES 318
WELBLANKING 304
WELLOPTIONS 301
XY_DISPLAYNAME 319
XYANIMATE 282
XYANIMATESETUP 282
XCUSTOMSETUP 318
XYENTITIESSETUP 319
XYEQUATIONS 319
XYFILTERING 320
XYFREESTYLESETUP 320
XYSORTING 321
XYSUBSETSETUP 321
XYVARIABLESETUP 321
XYZSLICES 304
Macro Commands Summary

26 - 1 Animation Macros

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "ANIMATE"

Description: Animates grid plots. Set animation parameters using the ANIMATESETUP command.

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "ANIMATESETUP [optional parameters]"

Description: Sets up the parameters for playing and recording in grid plot animations. The same parameters are used for recording and playing, although some parameters are ignored when not recording.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&lt;string&gt;</td>
<td>none</td>
<td>Name of the animation file. Ignored when not recording.</td>
</tr>
<tr>
<td>FTYPE</td>
<td>&lt;option&gt;</td>
<td>AVI</td>
<td>Type of animation file to create – AVI, RP, PS, FLASH, WMF, or PRINTER. Ignored when not recording.</td>
</tr>
<tr>
<td>SPEED</td>
<td>&lt;double&gt;</td>
<td>1.0</td>
<td>Animation speed. Applies only to output formats that recognize frame speed.</td>
</tr>
</tbody>
</table>
**Syntax:**

```bash
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "XYANIMATE"
```

**Description:** Starts the animation of XY plots. Set animation options using the `XYANIMATESETUP` command.

---

**Syntax:**

```bash
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "XYANIMATESETUP [optional parameters]"
```

**Description:** Sets up the parameters for playing and recording in XY plot animations. The same parameters are used for recording and playing, although some parameters are ignored when not recording.

### Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>= &lt;option&gt;</td>
<td>none</td>
<td>Type of XY plot to be animated – XYVARIABLES, XYENTITIES, or CUSTOM</td>
</tr>
</tbody>
</table>

### Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>none</td>
<td>Name of the animation file; ignored when not recording.</td>
</tr>
<tr>
<td>FTYPE</td>
<td>= &lt;option&gt;</td>
<td>AVI</td>
<td>Type of animation file to create – AVI, PR, PS, FLASH, WMF, or PRINTER. Ignored when not recording.</td>
</tr>
<tr>
<td>SPEED</td>
<td>= &lt;double&gt;</td>
<td>1.0</td>
<td>Animation speed. Applies only to output formats that recognize frame speed.</td>
</tr>
</tbody>
</table>
26 - 2 File Loading and Saving

These macros handle loading and saving of XY, grid, streamline data files and specialized files.

**CMGSETUP**

**Syntax:**

```addoncommand```
ADDONID = "TECPLOT RS"
COMMAND = "CMGSETUP \[required parameters\]"
```

**Description:**

Sets options for loading CMG data, currently only units. These option must be specified before any data files are loaded and apply globally to all files opened in a session.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNITS</td>
<td>= &lt;string&gt;</td>
<td>UNIT_SI, UNIT_FIELD, UNIT_LAB, UNIT_MODSI, UNIT_CHEARS, UNIT_GEMSI, UNIT_GEMFIELD, UNIT_STARSLAB</td>
<td></td>
</tr>
</tbody>
</table>

**Antialias**

**Syntax:**

```addoncommand```
ADDONID = "TECPLOT RS"
COMMAND = "CMGSETUP \[required parameters\]"
```

**Description:**

Performs antialiasing to improve quality – TRUE or FALSE.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>USEMULTIPLE</td>
<td>= &lt;boolean&gt;</td>
<td>FALSE</td>
<td>Applies only to AVI files. Set to FALSE to create an AVI file compatible with most players. Set to TRUE to create an AVI file with the highest quality images.</td>
</tr>
<tr>
<td>COLORTABLES</td>
<td>= &lt;boolean&gt;</td>
<td>FALSE</td>
<td></td>
</tr>
<tr>
<td>ANTI_ALIAS</td>
<td>= &lt;boolean&gt;</td>
<td>FALSE</td>
<td>Perform antialiasing to improve quality – TRUE or FALSE.</td>
</tr>
<tr>
<td>SUPERSAMPLEFACTOR</td>
<td>= &lt;integer&gt;</td>
<td>3</td>
<td>Anti aliasing super sampling factor.</td>
</tr>
<tr>
<td>WIDTH</td>
<td>= &lt;integer&gt;</td>
<td>300</td>
<td>Sets the width of the output frame. Ignored when not recording.</td>
</tr>
<tr>
<td>STARTSELECT</td>
<td>= &lt;integer&gt;</td>
<td>1</td>
<td>Starting entity or variable number (depending on the plot type). This uses a 1-based index from the list of available entities or variables after any filtering has been applied.</td>
</tr>
<tr>
<td>STOPSELECT</td>
<td>= &lt;integer&gt;</td>
<td>2</td>
<td>Final entity or variable index.</td>
</tr>
<tr>
<td>RECORD</td>
<td>= &lt;boolean&gt;</td>
<td>FALSE</td>
<td>Set to TRUE to record this animation.</td>
</tr>
</tbody>
</table>

**EXTRACTCELLDATA**

**Syntax:**

```addoncommand```
ADDONID = "TECPLOT RS"
COMMAND = "EXTRACTCELLDATA \[optional parameters\]"
```

**Description:**

Save the data from a group of cells to file.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRAME</td>
<td>= &lt;string&gt;</td>
<td>File name to save</td>
<td></td>
</tr>
<tr>
<td>CELLELECTION</td>
<td>= &lt;string&gt;</td>
<td>VISIBLE</td>
<td>VISIBILE, BLANKED, ALL, WELL or COMPLETION</td>
</tr>
</tbody>
</table>

283
### Syntax:

```bash
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "GALLERYDELETE NAME=<string>"
```

### Description:
This command deletes a plot from the Gallery.

### Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>= &lt;string&gt;</td>
<td>Name of Gallery plot to be deleted.</td>
</tr>
</tbody>
</table>

### Syntax:

```bash
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "GALLERYDISPLAY NAME=<string>"
```
### GALLERYSAVE

**Description:** This command displays a plot from the Gallery.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td><code>&lt;string&gt;</code></td>
<td>Name of Gallery plot to be displayed.</td>
</tr>
</tbody>
</table>

**Syntax:**

```$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "GALLERYSAVE NAME=<string>"
```

### LOADCUSTOMPLOT

**Description:** This command saves a plot to the Gallery.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td><code>&lt;string&gt;</code></td>
<td>Name by which current plot will be known in the Gallery.</td>
</tr>
</tbody>
</table>

**Syntax:**

```$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "LOADCUSTOMPLOT FNAME=<string>"
```

### LOADFLOWTABLE

**Description:** This command allows you to load a *.flot file containing custom plot data.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td><code>&lt;string&gt;</code></td>
<td>File name of flow table to load.</td>
</tr>
</tbody>
</table>

**Syntax:**

```$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "LOADFLOWTABLE FNAME=<string>"
```

### LOADGRIDDATA

**Description:** This command allows you to load a Chears *.rsc file containing custom plot data.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td><code>&lt;string&gt;</code></td>
<td>File name of grid data to load.</td>
</tr>
</tbody>
</table>

**Syntax:**

```$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "LOADGRIDDATA FNAME=<string>"
```
**LOADGRIDDELTA**

Syntax:

```
$/ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'LOADGRIDDELTA [optional parameters]'
```

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file containing the grid geometry.</td>
</tr>
<tr>
<td>SOLUTIONFILE</td>
<td>= &lt;string&gt;</td>
<td>Name of file containing solution file. Can</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be repeated when multiple files are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>required. For VDB files, use the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOLUTIONFILE parameter to specify the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>case name.</td>
</tr>
<tr>
<td>APPENDRULE</td>
<td>= &lt;boolean&gt;</td>
<td>Indicates whether data are appended to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>existing grid (TRUE) or a new grid is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>being loaded (FALSE).</td>
</tr>
</tbody>
</table>

**LOADGRIDTRANSFORM**

Syntax:

```
$/ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'LOADGRIDTRANSFORM [optional parameters]'
```

Description: This command is used to set the grid transformation values, including coordinate conversion, rotation, and translation.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONVERTX</td>
<td>= &lt;value&gt;</td>
<td>Value by which to scale the X coordinate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default = 1).</td>
</tr>
<tr>
<td>CONVERTY</td>
<td>= &lt;value&gt;</td>
<td>Value by which to scale the Y coordinate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default = 1).</td>
</tr>
<tr>
<td>CONVERTZ</td>
<td>= &lt;value&gt;</td>
<td>Value by which to scale the Z coordinate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default = 1).</td>
</tr>
<tr>
<td>DELTAX</td>
<td>= &lt;value&gt;</td>
<td>Value by which to shift the X coordinate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default = 0).</td>
</tr>
<tr>
<td>DELTAY</td>
<td>= &lt;value&gt;</td>
<td>Value by which to shift the Y coordinate</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(default = 0).</td>
</tr>
</tbody>
</table>

286
LOADGRIDSMOOTHING

Syntax:
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'LOADGRIDSMOOTHING [optional parameters]'  

Description:
This command is used to set the grid smoothing parameters.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CENTERX</td>
<td>&lt;double&gt;</td>
<td>X coordinate of the center to which to rotate the grid.</td>
</tr>
<tr>
<td>CENTERY</td>
<td>&lt;double&gt;</td>
<td>Y coordinate of the center to which to rotate the grid.</td>
</tr>
<tr>
<td>ROTATECOS</td>
<td>&lt;double&gt;</td>
<td>Cosine value of the angle of rotation.</td>
</tr>
<tr>
<td>ROTATETAN</td>
<td>&lt;double&gt;</td>
<td>Tangent value of the angle of rotation.</td>
</tr>
</tbody>
</table>

LOADGRIDNNCS

Syntax:
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'LOADGRIDNNCS [optional parameters]'  

Description:
This command is used to set the grid smoothing parameters.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SolverGridRule</td>
<td>&lt;option&gt;</td>
<td>Controls whether to re-process the RSGRID file, if it exists. - NEVER, CONDITIONAL (if options are different) or ALWAYS</td>
</tr>
<tr>
<td>CornerPoint</td>
<td>&lt;options&gt;</td>
<td>Create corner point options - ORIGINAL, SHIFT, or AVERAGE.</td>
</tr>
<tr>
<td>XYTolerance</td>
<td>&lt;double&gt;</td>
<td>Tolerance for XY dimensions. NOTE: You must also set ZTOLERANCE when setting X YTOLERANCE.</td>
</tr>
<tr>
<td>ZTolerance</td>
<td>&lt;double&gt;</td>
<td>Tolerance for Z dimensions. NOTE: You must also set X YTOLERANCE when setting Z TOLERANCE.</td>
</tr>
</tbody>
</table>

LOADGRIDINACTIVECELL

Syntax:
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'LOADGRIDINACTIVECELL INACTIVECELLCONDITION= "<string>" '  

Description:
This command is used to specify the variable used to identify inactive cells for VIP grid data files.
LOADPAPERLAYOUT

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INACTIVECELLCONDITION</td>
<td>=&lt;string&gt;</td>
<td>A string containing the inactive cell condition. The string should consist of a variable name, one of the allowed operators, and a floating point value. The allowed comparison operators are &gt;, &lt;, and &lt;=. The string should be surrounded in double quotation marks.</td>
</tr>
</tbody>
</table>

**Example:** In this example, cells with a KID value less than zero will be treated as inactive cells.

```plaintext
$!ADDONCOMMAND
  ADDONID = 'Tecplot RS'
  COMMAND = 'LOADGRIDINACTIVECELL INACTIVECELLCONDITION="KID<0.0"'
```

LOADPAPERLAYOUT

**Syntax:**

```plaintext
$!ADDONCOMMAND
  ADDONID = 'TECPLOT RS'
  COMMAND = 'LOADPAPERLAYOUT FNAME=<string>
```

**Description:** Loads a saved paper layout template.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file to load.</td>
</tr>
</tbody>
</table>

LOADPLOTSTYLE

**Syntax:**

```plaintext
$!ADDONCOMMAND
  ADDONID = 'TECPLOT RS'
  COMMAND = 'LOADPLOTSTYLE FNAME=<string>
```

**Description:** Loads plot styles.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file to load.</td>
</tr>
</tbody>
</table>

LOADXYDATA

**Syntax:**

```plaintext
$!ADDONCOMMAND
  ADDONID = 'TECPLOT RS'
  COMMAND = 'LOADXYDATA'
```

**Description:** Macro command for loading XY data, survey wells, or streamline files.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file.</td>
</tr>
</tbody>
</table>
PERIODICPRODUCTIONRATES

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTYPE</td>
<td>= &lt;option&gt;</td>
<td>Type of file: ECLFRFT, FRONTSIM, CHEARCSV, CHEARSHIST, INTERSECTHIST, VDP, XYMULTILIST, PROJECT, VDB, CMG, VDPOBSERVED, OR GENERICASCII</td>
</tr>
<tr>
<td>CASE</td>
<td>= &lt;string&gt;</td>
<td>For VDB files only. Name of the case to load.</td>
</tr>
</tbody>
</table>

Parameter Syntax Notes:

- **APPENDRULE** = <option> - Indicates action taken for appending RFT data. Options are PROMPT, NONE, APPENDFR, or AUTO. AUTO is used to automatically append the RFT file to the UNSMRY file.
- **STREAMLINEFILE** = <string> - Name of file. Indicates streamline file to add.
- **LOADERIVEDVARS** = <boolean> - Whether to calculate rates and ratios when loading CMG data files missing these variables.
- **QUICK** = <boolean> - For VDB data, reads only fields, wells, and regions and skips loading completions and network connections.

PERIODICPRODUCTIONRATES

Syntax:

```$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "PERIODICPRODUCTIONRATES [required parameters]"
```

Description: Performs periodic production rate calculations on the active XY dataset and saves the results to the specified CSV file.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>File name to save.</td>
</tr>
<tr>
<td>ENTITYFILTER</td>
<td>= &lt;option&gt;</td>
<td>Name of the entity type. Must be one of WELLS, FIELD, AREAS, REGIONS, UNERGROUPS</td>
</tr>
<tr>
<td>ENTITIES</td>
<td>= &lt;string,string,...&gt;</td>
<td>Comma-separated list of entity names.</td>
</tr>
<tr>
<td>VARIABLE</td>
<td>= &lt;string,string,...&gt;</td>
<td>Comma-separated list of variable names.</td>
</tr>
<tr>
<td>PERIOD</td>
<td>= &lt;option&gt;</td>
<td>Time period. Must be one of WEEKLY, BIWEEKLY, MONTHLY, QUARTERLY, ANNUALLY</td>
</tr>
</tbody>
</table>

Parameter Syntax Notes:

- **VARNAME** = <string> - Receives the selected folder.

PROMPTFORFOLDER

Syntax:

```$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "PROMPTFORFOLDER VARNAME=<macrovar>"
```

Description: Displays a dialog where the user can browse for a folder. The selected folder is placed in <macrovar>. If the user cancels the dialog and no folder is selected, then no changes are made to <macrovar>.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARNAME</td>
<td>= &lt;string&gt;</td>
<td>Receives the selected folder</td>
</tr>
</tbody>
</table>
Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPTION</td>
<td>= &lt;string&gt;</td>
<td>Dialog caption for the folder selection dialog.</td>
</tr>
<tr>
<td>DEFAULTFOLDER</td>
<td>= &lt;string&gt;</td>
<td>The dialog's working directory will be set to this directory. Must be the name of a folder, not a file. An ending file separator character is optional.</td>
</tr>
</tbody>
</table>

Example:

```plaintext
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = "PROMPTFORFOLDER VARNAME='UserSelectedFolder' CAPTION='Select a folder',
DEFAULTFOLDER='c:\my-data-files'"
```

The result of the command above will be placed in the Tecplot macro variable `UserSelectedFolder`!

---

SAVEPAPERLAYOUT

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SAVEPAPERLAYOUT FNAME=<string>'
```

**Description:** Save a paper layout template.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file to save.</td>
</tr>
</tbody>
</table>

---

SAVEPLOTSTYLE

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SAVEPLOTSTYLE FNAME=<string>'
```

**Description:** Save plot styles.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file to save.</td>
</tr>
</tbody>
</table>

---

SAVEPROJECTFILE

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SAVEPROJECTFILE FNAME=<string>'
```

**Description:** This command is used to save the current files in a project file whose file name is defined by FNAME.
**SETACTIVEGRID**

**Required Parameter:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&lt;string&gt;</td>
<td>Name of the active grid file (Include full path.)</td>
</tr>
</tbody>
</table>

**Syntax:**

```$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SETACTIVEGRID FNAME=<string>'
```

**Description:** When multiple grid files have been loaded, this command determines which one is active.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&lt;string&gt;</td>
<td>Name of the active grid file (Include full path.)</td>
</tr>
</tbody>
</table>

**SETACTIVEXYDATASET**

**Syntax:**

```$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SETACTIVEXYDATASET FNAME=<string>'
```

**Description:** When multiple XY data sets have been loaded, this command determines which one is active.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&lt;string&gt;</td>
<td>Name of the active XY data set (Include full path.)</td>
</tr>
</tbody>
</table>

**SETASDEFAULT CUSTOMOPTIONS**

**Syntax:**

```$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SETASDEFAULT CUSTOMOPTIONS=<boolans>'
```

**Description:** When set to TRUE, the currently loaded .rsc file will be loaded every time Tecplot RS is launched.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUSTOMOPTIONS</td>
<td>&lt;boolans&gt;</td>
<td>Available values = TRUE or FALSE.</td>
</tr>
</tbody>
</table>
### SETASDEFAULT PAPERLAYOUT

**Syntax:**

```python
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SETASDEFAULT PAPERLAYOUT=boolean'
```

**Description:** When set to TRUE, the currently loaded paper layout will be loaded every time Tecplot RS is launched.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAPERLAYOUT</td>
<td>&lt;boolean&gt;</td>
<td>Available values = TRUE or FALSE</td>
</tr>
</tbody>
</table>

### SETASDEFAULT PLOTOPTIONS

**Syntax:**

```python
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'PLOTOPTIONS=boolean'
```

**Description:** When set to TRUE, the currently loaded .rsstyx file will be loaded every time Tecplot RS is launched.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLOTOPTIONS</td>
<td>&lt;boolean&gt;</td>
<td>Available values = TRUE or FALSE</td>
</tr>
</tbody>
</table>

### STAMPOPTIONS

**Syntax:**

```python
$!ADDONCOMMAND
ADDONID = 'TECPLOT_RS'
COMMAND = 'STAMPOPTIONS [optional parameters]'
```

**Description:** Set options for showing stamps in 3D grid plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARNAMEA</td>
<td>&lt;string&gt;</td>
<td>Property used for production wells</td>
</tr>
<tr>
<td>VARNAMEB</td>
<td>&lt;string&gt;</td>
<td>Property used for injection wells</td>
</tr>
<tr>
<td>SYMBOLFILL</td>
<td>&lt;bool&gt;</td>
<td>Use solid fill option</td>
</tr>
<tr>
<td>SIZE</td>
<td>&lt;integer&gt;</td>
<td>1, 2, or 3 for small/medium/large</td>
</tr>
<tr>
<td>SHOW</td>
<td>&lt;bool&gt;</td>
<td>Show stamps option</td>
</tr>
<tr>
<td>QUICKXY</td>
<td>&lt;option&gt;</td>
<td>Set to ENLARGED to show enlarged stamp plots, or XYVARIABLES to use the view defined in the XY Variables plot. (default: XYVARIABLES)</td>
</tr>
</tbody>
</table>
### SWAPGRIDFILE

**Syntax:**

```bash
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SWAPGRIDFILE FNAME=<string> ID=<integer>'
```

**Description:** Swaps in a new grid file, substituting it for an already-loaded file. See Section 12.2.3, “Swapping Data Files” on page 149.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Pathname of the grid data file to be swapped in.</td>
</tr>
<tr>
<td>ID</td>
<td>= &lt;integer&gt;</td>
<td>Number, starting at 0, of the file in the list that will be swapped out and substituted with the new file.</td>
</tr>
</tbody>
</table>

### SWAPXYFILE

**Syntax:**

```bash
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SWAPXYFILE FNAME=<string> ID=<integer>'
```

**Description:** Swaps in a new XY file, substituting it for an already-loaded file. See Section 12.2.3, “Swapping Data Files” on page 149.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Pathname of the XY data file to be swapped in.</td>
</tr>
<tr>
<td>ID</td>
<td>= &lt;integer&gt;</td>
<td>Number, starting at 0, of the file in the list that will be swapped out and substituted with the new file.</td>
</tr>
</tbody>
</table>

### UNLOADFLOWTABLE

**Syntax:**

```bash
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'UNLOADFLOWTABLE ID = <integer>'
```

**Description:** This command allows you to unload a selected *flow* table from memory. To read the flow table again, it must be reloaded.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>= &lt;integer&gt;</td>
<td>Flow table number to unload.</td>
</tr>
</tbody>
</table>

### UNLOADGRIDFILE

**Syntax:**

```bash
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'UNLOADGRIDFILE'
```

293
UNLOADXYDATASET

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "UNLOADGRDFILE FNAME=<string>"

Description: Unloads the specified Grid file.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file (fully pathed) to unload.</td>
</tr>
</tbody>
</table>

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "UNLOADXYDATASET FNAME=<string>"

Description: Unloads specified XY data set.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file (fully pathed) to unload.</td>
</tr>
</tbody>
</table>

26 - 3 Flow Tables

PLOTFLOWTABLE

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "PLOTFLOWTABLE"

Description: Set up options for plotting flow tables. You must call this command one or more times before plotting a flow table.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>= &lt;integer&gt;</td>
<td>Flow table number to plot. Before using the PLOT macro command, you must at least set the flow table number with this command.</td>
</tr>
</tbody>
</table>

MULTIPARAM = <string, string, string,...>
The first <string> parameter indicates the name of the code name independent variable to plot, such as WGR. The other <string> parameters are the values of the variable to plot.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINGLEPARAM</td>
<td>= &lt;string, string, ...&gt;</td>
<td>One or more pairs of strings. The first &lt;string&gt; parameter indicates the name of the code independent variable to set, such as WGR. The next &lt;string&gt; parameter indicates the setting for that variable.</td>
</tr>
</tbody>
</table>

294
See also:

LOADFLOWTABLE ......................................................... p.285
UNLOADFLOWTABLE ..................................................... p.293

26 - 4 Grid Plot Macros

See Also: Section 26 - 2 "File Loading and Saving" and Section 26 - 5 "Inside Views"

---

BLANKING

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT_RS"
COMMAND = "BLANKING [optional parameters]"

Description: Set options for user-defined Cell Value Blanking criteria.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCLUDE</td>
<td>=&lt;boolean&gt;</td>
<td>Turn cell value blanking on or off. TRUE=on.</td>
</tr>
<tr>
<td>CONSTRAINT</td>
<td>=&lt;integer&gt;</td>
<td>The constraint number (1-6)</td>
</tr>
<tr>
<td>ACTIVES</td>
<td>=&lt;boolean&gt;</td>
<td>Controls whether the current constraint is active or not.</td>
</tr>
<tr>
<td>VARA</td>
<td>=&lt;integer&gt;</td>
<td>Variable number used to establish blanking criterion.</td>
</tr>
<tr>
<td>CONSTRAINTOP2MODE</td>
<td>=&lt;option&gt;</td>
<td>Mode for constraint comparison: USEVAR or USECONSTANT.</td>
</tr>
<tr>
<td>VARB</td>
<td>=&lt;integer&gt;</td>
<td>The variable number used in the comparison. Only available if CONSTRAINTOP2MODE = USEVAR.</td>
</tr>
<tr>
<td>VALUECUTOFF</td>
<td>=&lt;double&gt;</td>
<td>The value used for comparison. Only available if CONSTRAINTOP2MODE = USECONSTANT.</td>
</tr>
<tr>
<td>RELOP</td>
<td>=&lt;option&gt;</td>
<td>Relative operator for comparison: LESSTHAN, GREATERTHAN, LESSTHANOREQUAL, GREATERTHANOREQUAL, EQUALTO, or NOTEQUALTO.</td>
</tr>
</tbody>
</table>

---

BUBBLEOPTIONS

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT_RS"
COMMAND = "BUBBLEOPTIONS [optional parameters]"

Description: Set options for bubbles in grid plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOWBUBBLES</td>
<td>=&lt;boolean&gt;</td>
<td>Master switch for drawing bubbles on/off.</td>
</tr>
<tr>
<td>BUBBLENUMBER</td>
<td>=&lt;integer&gt;</td>
<td>The pie slice for which the following options are being set (1-8).</td>
</tr>
<tr>
<td>BUBBLEVAR</td>
<td>=&lt;option&gt;</td>
<td>Variable name to be assigned to the pie slice designated by BUBBLENUMBER.</td>
</tr>
<tr>
<td>COLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Color to be used for the pie slice designated by BUBBLENUMBER. The standard color names, plus DEFAULT.</td>
</tr>
</tbody>
</table>
GRID_DISPLAYNAME

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCLUDE</td>
<td>= &lt;boolean&gt;</td>
<td>Whether to show the pie slice indicated by BUBBLENUMBER.</td>
</tr>
<tr>
<td>BUBBLESIZE</td>
<td>= &lt;boolean&gt;</td>
<td>Whether to use the BUBBLEVAR assigned to the current BUBBLENUMBER to control the size of the bubble.</td>
</tr>
<tr>
<td>MULTIPLIER</td>
<td>= &lt;double&gt;</td>
<td>Multiplier for the bubble value shown in the BUBBLENUMBER size.</td>
</tr>
<tr>
<td>FIXEDSIZE</td>
<td>= &lt;boolean&gt;</td>
<td>Whether the bubbles are a fixed size (true) or dynamic (false).</td>
</tr>
<tr>
<td>UNITS</td>
<td>= &lt;option&gt;</td>
<td>Whether bubble size is expressed in PAPERUNITS or GridUNITS.</td>
</tr>
<tr>
<td>SYMBOLIZE</td>
<td>= &lt;index&gt;</td>
<td>Maximum size of the bubbles (1 to 10), in the specified UNITS.</td>
</tr>
<tr>
<td>RANGE</td>
<td>= &lt;boolean&gt;</td>
<td>Toggle for showing range bubbles when bubble sizing is dynamic (FIXEDSIZE is false).</td>
</tr>
<tr>
<td>SCALE</td>
<td>= &lt;option&gt;</td>
<td>Bubble size is determined by DIAMETER or AREA.</td>
</tr>
<tr>
<td>FONTCOLOR</td>
<td>= &lt;double&gt;</td>
<td>The color of the bubble labels.</td>
</tr>
<tr>
<td>FONTUNITS</td>
<td>= &lt;option&gt;</td>
<td>Units used for sizing the bubble labels. FRAME, GRID, or POINT.</td>
</tr>
<tr>
<td>FONT</td>
<td>= &lt;double&gt;</td>
<td>The font used for bubble labels.</td>
</tr>
<tr>
<td>LABELS</td>
<td>= &lt;boolean&gt;</td>
<td>Toggle for including the bubble value label.</td>
</tr>
<tr>
<td>VARIABLE</td>
<td>= &lt;boolean&gt;</td>
<td>Toggle for including the bubble variable name label.</td>
</tr>
<tr>
<td>SIZE</td>
<td>= &lt;integer&gt;</td>
<td>Size for the bubble labels.</td>
</tr>
<tr>
<td>DECIMALS</td>
<td>= &lt;integer&gt;</td>
<td>Selects the number of decimals to display on bubble value labels. Actually selects the option in the dialog, so 0 = &quot;best&quot; and 1-5 translate to 0-4 decimal places.</td>
</tr>
<tr>
<td>DELTA</td>
<td>= &lt;boolean&gt;</td>
<td>Toggle for turning on/off delta bubble values.</td>
</tr>
<tr>
<td>NORMALIZE</td>
<td>= &lt;boolean&gt;</td>
<td>Toggle for normalizing delta values.</td>
</tr>
<tr>
<td>MAX</td>
<td>= &lt;double&gt;</td>
<td>Maximum value to be used when sizing delta bubbles.</td>
</tr>
<tr>
<td>DELTASIZEREFERENCE</td>
<td>= &lt;integer&gt;</td>
<td>Index to the loaded data file that is used to compute delta bubble values.</td>
</tr>
</tbody>
</table>

Parameter Syntax Notes

Syntax:
```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "GRID_DISPLAYNAME"
FNAME = "<string>" NAME = "<string>"
```

Description: Specifies the label to identify the file in legends and paper layouts.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>= &lt;string&gt;</td>
<td>Name of file.</td>
</tr>
<tr>
<td>NAME</td>
<td>= &lt;string&gt;</td>
<td>Name to display when file FNAME is in use.</td>
</tr>
</tbody>
</table>

GRID_EQUATIONS

Syntax:
```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "GRID_EQUATIONS"
EQUATIONLIST = "<string, string, ...>
```

Description: Defines one or more equations to be used to create new grid variables.

296
**GRIDOPTIONS**

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUATIONLIST</td>
<td>&lt;string_list&gt;</td>
<td>List of equations defining new variables to be solved from existing values.</td>
</tr>
</tbody>
</table>

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "GRIDOPTIONS [optional parameters]"
```

**Description:** Sets up the options for creating grid plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARIABLE</td>
<td>=&lt;string&gt;</td>
<td>The name of the variable to plot.</td>
</tr>
<tr>
<td>VACTIVETVAR</td>
<td>=&lt;string&gt;</td>
<td>The name of the variable to plot on the active cells. Requires the FILLSTYLE parameter for inactive grid cells (PLOTOPTIONS_INACTIVEGRID) to be set to VARIABLE.</td>
</tr>
<tr>
<td>TIMESSTEP</td>
<td>=&lt;integer&gt;</td>
<td>The time step (1-based) to display.</td>
</tr>
<tr>
<td>DELTA</td>
<td>=&lt;boolean&gt;</td>
<td>Show delta option – TRUE or FALSE.</td>
</tr>
<tr>
<td>DELTABLANKING</td>
<td>=&lt;option&gt;</td>
<td>Set to ORIGINAL to blank using original variable values, or DELTA to blank using delta values.</td>
</tr>
<tr>
<td>PLANES</td>
<td>=&lt;option&gt;</td>
<td>View plane for 2D plots – I, J, K, X, Y, Z, R or THETA.</td>
</tr>
<tr>
<td>GLOBALINDEX</td>
<td>=&lt;integer&gt;</td>
<td>Index of plane in global grid, for 2D plots.</td>
</tr>
<tr>
<td>DUALVIEW</td>
<td>=&lt;option&gt;</td>
<td>For dual porosity grids. Controls which grid to show. Option = MATRIX, FRACTURE or BOTH.</td>
</tr>
<tr>
<td>DUALWELLS</td>
<td>=&lt;option&gt;</td>
<td>For dual porosity grids. Controls whether to display only wells that complete in the current grid (MATCH) or all wells (BOTH). Option = BOTH or MATCH.</td>
</tr>
<tr>
<td>LGR</td>
<td>=&lt;string&gt;/&lt;string&gt;</td>
<td>LGR selection for 2D plots. The first &lt;string&gt; is the LGR name, the second &lt;string&gt; is the LGR plane index.</td>
</tr>
<tr>
<td>LOADINACTIVE</td>
<td>=&lt;boolean&gt;</td>
<td>FALSE to unload inactive cells (default), TRUE to load inactive cells.</td>
</tr>
<tr>
<td>OWNVARIABLES</td>
<td>=&lt;string&gt;, &lt;string&gt;, &lt;string&gt;</td>
<td>Define the three variables used for Oil/Water/Gas (OWG) plots, in that order.</td>
</tr>
<tr>
<td>SHOWMESH</td>
<td>=&lt;boolean&gt;</td>
<td>Show grid mesh – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWWELLS</td>
<td>=&lt;boolean&gt;</td>
<td>Show wells – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWCELLLABELS</td>
<td>=&lt;boolean&gt;</td>
<td>Show cell labels – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHANNICKS</td>
<td>=&lt;boolean&gt;</td>
<td>Show NNCs – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWSTREAMS</td>
<td>=&lt;boolean&gt;</td>
<td>Show streamlines – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWKSUM</td>
<td>=&lt;boolean&gt;</td>
<td>Show K-Sum values – TRUE or FALSE.</td>
</tr>
</tbody>
</table>

**Parameter Syntax Notes**

- **EQUATIONLIST**
  - Syntax: `<string, string, ...>`
  - Description: List of equations defining new variables to be solved from existing values.

**Optional Parameters**

- **VARIABLE**
  - Syntax: `<string>`
  - Description: The name of the variable to plot.

- **VACTIVETVAR**
  - Syntax: `<string>`
  - Description: The name of the variable to plot on the active cells. Requires the FILLSTYLE parameter for inactive grid cells (PLOTOPTIONS_INACTIVEGRID) to be set to VARIABLE.

- **TIMESSTEP**
  - Syntax: `<integer>`
  - Description: The time step (1-based) to display.

- **DELTA**
  - Syntax: `<boolean>`
  - Description: Show delta option – TRUE or FALSE.

- **DELTABLANKING**
  - Syntax: `<option>`
  - Description: Set to ORIGINAL to blank using original variable values, or DELTA to blank using delta values.

- **PLANES**
  - Syntax: `<option>`
  - Description: View plane for 2D plots – I, J, K, X, Y, Z, R or THETA.

- **GLOBALINDEX**
  - Syntax: `<integer>`
  - Description: Index of plane in global grid, for 2D plots.

- **DUALVIEW**
  - Syntax: `<option>`
  - Description: For dual porosity grids. Controls which grid to show. Option = MATRIX, FRACTURE or BOTH.

- **DUALWELLS**
  - Syntax: `<option>`
  - Description: For dual porosity grids. Controls whether to display only wells that complete in the current grid (MATCH) or all wells (BOTH). Option = BOTH or MATCH.

- **LGR**
  - Syntax: `<string>/<string>`
  - Description: LGR selection for 2D plots. The first <string> is the LGR name, the second <string> is the LGR plane index.

- **LOADINACTIVE**
  - Syntax: `<boolean>`
  - Description: FALSE to unload inactive cells (default), TRUE to load inactive cells.

- **OWNVARIABLES**
  - Syntax: `<string>, <string>, <string>`
  - Description: Define the three variables used for Oil/Water/Gas (OWG) plots, in that order.

- **SHOWMESH**
  - Syntax: `<boolean>`
  - Description: Show grid mesh – TRUE or FALSE.

- **SHOWWELLS**
  - Syntax: `<boolean>`
  - Description: Show wells – TRUE or FALSE.

- **SHOWCELLLABELS**
  - Syntax: `<boolean>`
  - Description: Show cell labels – TRUE or FALSE.

- **SHANNICKS**
  - Syntax: `<boolean>`
  - Description: Show NNCs – TRUE or FALSE.

- **SHOWSTREAMS**
  - Syntax: `<boolean>`
  - Description: Show streamlines – TRUE or FALSE.

- **SHOWKSUM**
  - Syntax: `<boolean>`
  - Description: Show K-Sum values – TRUE or FALSE.

297
GRIDTRANSFORM

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'GRIDTRANSFORM [optional parameters]'* 

Description: Controls the customization of various attributes of grid plots. Refer to Grid Options to learn more about the controls.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRIDORIENTATION</td>
<td>=&lt;option&gt;</td>
<td>Grid orientation. LEFT or RIGHT</td>
</tr>
<tr>
<td>ZAXISMULTIPLIER</td>
<td>=&lt;double&gt;</td>
<td>Multiplier for the Z-axis. Accepts values from 0.0 to 100.0 inclusive, where 0 indicates automatic factor computation.</td>
</tr>
<tr>
<td>GRIDTHICKENING</td>
<td>=&lt;double&gt;</td>
<td>Defines factor by which Tecplot RS thickens grid, stretching the Z-axis values without distorting surface. Accepts values from 1.0 to 100.0 inclusive.</td>
</tr>
<tr>
<td>INSIDEVIEW LIGHTING</td>
<td>=&lt;boolean&gt;</td>
<td>Defines whether to display light source shading for the chosen inside view entity (XYZ slice or iso-surfaces only) - TRUE or FALSE.</td>
</tr>
<tr>
<td>INSIDEVIEW TRANSLUCENCY</td>
<td>=&lt;boolean&gt;</td>
<td>Defines whether to display surface translucency for the chosen inside view entity (XYZ slice or iso-surfaces only) - TRUE or FALSE.</td>
</tr>
<tr>
<td>CONVERTX</td>
<td>=&lt;double&gt;</td>
<td>Value by which to scale the X coordinate (default = 1).</td>
</tr>
<tr>
<td>CONVERTY</td>
<td>=&lt;double&gt;</td>
<td>Value by which to scale the Y coordinate (default = 1).</td>
</tr>
<tr>
<td>CONVERTZ</td>
<td>=&lt;double&gt;</td>
<td>Value by which to scale the Z coordinate (default = 1).</td>
</tr>
<tr>
<td>DELTAZ</td>
<td>=&lt;double&gt;</td>
<td>Value by which to shift the Z coordinate (default = 0).</td>
</tr>
<tr>
<td>DELTAY</td>
<td>=&lt;double&gt;</td>
<td>Value by which to shift the Y coordinate (default = 0).</td>
</tr>
<tr>
<td>DELTAX</td>
<td>=&lt;double&gt;</td>
<td>Value by which to shift the X coordinate (default = 0).</td>
</tr>
<tr>
<td>ANGLE</td>
<td>=&lt;double&gt;</td>
<td>Angle by which to rotate the grid, in degrees (default = 0).</td>
</tr>
</tbody>
</table>

Parameter Syntax Notes

GRIDORIENTATION = <option> Grid orientation. LEFT or RIGHT
ZAXISMULTIPLIER = <double> Multiplier for the Z-axis. Accepts values from 0.0 to 100.0 inclusive, where 0 indicates automatic factor computation.
GRIDTHICKENING = <double> Defines factor by which Tecplot RS thickens grid, stretching the Z-axis values without distorting surface. Accepts values from 1.0 to 100.0 inclusive.
INSIDEVIEW LIGHTING = <boolean> Defines whether to display light source shading for the chosen inside view entity (XYZ slice or iso-surfaces only) - TRUE or FALSE.
INSIDEVIEW TRANSLUCENCY = <boolean> Defines whether to display surface translucency for the chosen inside view entity (XYZ slice or iso-surfaces only) - TRUE or FALSE.
CONVERTX = <double> Value by which to scale the X coordinate (default = 1).
CONVERTY = <double> Value by which to scale the Y coordinate (default = 1).
CONVERTZ = <double> Value by which to scale the Z coordinate (default = 1).
DELTARADIUS = <double> Value by which to shift the radius (default = 0).
DELTADISPLACEMENT = <double> Value by which to shift the displacement (default = 0).
DELTACENTER = <double> Value by which to shift the center (default = 0).
DELTADIRECTION = <double> Value by which to shift the direction (default = 0).
DELTATYPE = <string> Defines option for computing delta values. Allowed options are: VC-VR (Default), VR-VC, (VC-VR)/VC, (VR-VC)/VR.
DELTAMAGNITUDE = <boolean> Defines whether to use delta magnitudes – TRUE or FALSE.
DELTATYPE = <string> Defines option for computing delta values. Allowed options are: VC-VR (Default), VR-VC, (VC-VR)/VC, (VR-VC)/VR.
LOADINACTIVE = <boolean> Defines whether to load inactive cells. TRUE to load cells, FALSE to unload.
### INSIDENNCS

#### Syntax:

```
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'INSIDENNCS [optional parameters]' 
```

#### Description:

Controls the display of the NNC inside view.

#### Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW</td>
<td>&lt;boolean&gt;</td>
<td>Turns the 3D NNC inside view on or off.</td>
</tr>
<tr>
<td>PERSIST</td>
<td>&lt;boolean&gt;</td>
<td>Turns on or off the persistence of the NNC inside view (allowing other inside views to be seen simultaneously).</td>
</tr>
</tbody>
</table>

### INTEGRATE

#### Syntax:

```
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'INTEGRATION [required parameters] [optional parameters]' 
```

#### Description:

Performs integration and outputs the results to a CSV file.

#### Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>&lt;string&gt;</td>
<td>Fully-qualified pathname of output CSV file.</td>
</tr>
<tr>
<td>SELECTBY</td>
<td>&lt;option&gt;</td>
<td>Cell selection option: VISIBLE, OPENNODE, CLOSEDNODE.</td>
</tr>
</tbody>
</table>

#### Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARA</td>
<td>&lt;string&gt;</td>
<td>Variable name for volume multiplier. Omit if not using volume multipliers.</td>
</tr>
<tr>
<td>VARB</td>
<td>&lt;string&gt;</td>
<td>Variable name for binning. Omit if not binning values. Use “TIME” or “TIME STEP” to bin by time.</td>
</tr>
<tr>
<td>VALUE1</td>
<td>&lt;integer&gt;</td>
<td>Controls the number of bins. Omit or set to 0 when using bin interval or when binning by time.</td>
</tr>
<tr>
<td>VALUE2</td>
<td>&lt;integer&gt;</td>
<td>Controls the bin interval. Omit or set to 0 when using number of bins or when binning by time.</td>
</tr>
</tbody>
</table>

#### Examples:

```
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INTEGRATE SELECTBY=VISIBLE VARB="SOIL" VALUE2=0.1
NAME="C:\MyFile_T1\VSOIL_RS01.csv"
```

```
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INTEGRATE SELECTBY=OPENNODE VARB="TIME STEP" NAME="C:\MyFile_T10\VSOIL.csv"
```

```
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INTEGRATE SELECTBY=VISIBLE VARA="POROS" VARB="CDEPTH" VALUE1=5 VALUE2=0
NAME="C:\MyFile_sample.csv"
```
**NNOPTIONS**

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "NNOPTIONS [optional parameters]"
```

**Description:** Sets up the options for displaying NNCs in Grid plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NNCVALUENUM</td>
<td>=&lt;integer&gt;</td>
<td>The variable index for flooding NNC faces.</td>
</tr>
<tr>
<td>SHOWNCS</td>
<td>=&lt;boolean&gt;</td>
<td>Show NNC option – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWGRIDMESH</td>
<td>=&lt;boolean&gt;</td>
<td>Show mesh on main grid – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWNNCMESH</td>
<td>=&lt;boolean&gt;</td>
<td>Show mesh on NNC grid – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWGRIDFILL</td>
<td>=&lt;boolean&gt;</td>
<td>Fill mesh on main grid – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWNCFILL</td>
<td>=&lt;boolean&gt;</td>
<td>Fill mesh on NNC grid – TRUE or FALSE.</td>
</tr>
<tr>
<td>TRANSLUCENCY</td>
<td>=&lt;integer&gt;</td>
<td>Translucency as a percentage.</td>
</tr>
<tr>
<td>NNCFACES</td>
<td>=&lt;option&gt;</td>
<td>NNC faces to display – UPSTREAM, DOWNSTREAM, BOTH.</td>
</tr>
<tr>
<td>FILLSTYLE</td>
<td>=&lt;option&gt;</td>
<td>Fill style for grid - NONE, SHADE, or VARIABLE.</td>
</tr>
<tr>
<td>LIGHTEFFECT</td>
<td>=&lt;boolean&gt;</td>
<td>Option for shading - SMOOTH or PANELED.</td>
</tr>
<tr>
<td>COLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>When FILLSTYLE is SHADE, this is the shade color used.</td>
</tr>
<tr>
<td>UPCODECOLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Color of grid on upstream faces.</td>
</tr>
<tr>
<td>DOWNCOLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Color of grid on downstream faces.</td>
</tr>
<tr>
<td>MESHCOLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Grid color for main grid.</td>
</tr>
<tr>
<td>MHC Thickness</td>
<td>=&lt;double&gt;</td>
<td>Thickness of mesh on NNC grids.</td>
</tr>
<tr>
<td>GRIDTHICKNESS</td>
<td>=&lt;double&gt;</td>
<td>Thickness of mesh on main grid.</td>
</tr>
</tbody>
</table>

**Parameter Syntax Notes**

- **TYPE** = <option>
  - When FILLSTYLE is SHADE, this is the shade color used.
  - Grid color for main grid.

---

**PLOTGRID**

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PLOTGRID TYPE=<option>"
```

**Description:** This command draws a 2D or 3D Grid plot. Precede the command with the GRIDOPTIONS command to set the desired options.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>=&lt;option&gt;</td>
<td>Type of plot to draw - TWOD or THREE.</td>
</tr>
</tbody>
</table>

---

**RESETVIEW**

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "RESETVIEW"
```

**Description:** Resets the grid plot to the default scale and orientation.

300
UPDATE3DVIEW

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "UPDATE3DVIEW"

Description: Redraw the plot after making changes to the 3D Inside Views (IJK slices, well blanking, and other affected entities). See also Section 26 - 5 “Inside Views” on page 301.

WELLOPTIONS

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "WELLOPTIONS [optional parameters]"

Description: Defines the well display options on grid plots.

Required Parameter:

Optional Parameter:

ARBSLICES

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "ARBSLICES [optional parameters]"

Description: Set options for displaying Inside Views in 3D Grid plots using Arbitrary Slices.

Optional Parameters:
CLEARALLSLICES

Syntax:
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "CLEARALLSLICES"

Description:
Clears all slice planes that were previously selected using IJKSLICES.

IJKBLANKING

Syntax:
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "IJKBLANKING [optional parameters]"

Description:
Set options for displaying Inside Views in 3D Grid plots using IJK Blanking.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW</td>
<td>$!BOOLEAN</td>
<td>Show IJK Blanked slices – TRUE or FALSE</td>
</tr>
<tr>
<td>INVERT</td>
<td>$!BOOLEAN</td>
<td>Option to invert blanking status – TRUE or FALSE</td>
</tr>
<tr>
<td>PLANES</td>
<td>$!NAME, $!Imin, $!Imax, $!Jmin, $!Jmax, $!Kmin, $!Kmax</td>
<td>Planes to be shown in slices. First string is the name of the local grid refinement (or GLOBAL for the main grid). This must be followed by six values which represent the min and Max range for the I, J, and K planes, respectively. All items must be enclosed in double quotes.</td>
</tr>
</tbody>
</table>

IJKSLICES

Syntax:
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "IJKSLICES [optional parameters]"

Description:
Set options for displaying Inside Views using IJK Slices in 3D Grid plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW</td>
<td>$!BOOLEAN</td>
<td>Show IJK Slices – TRUE or FALSE</td>
</tr>
</tbody>
</table>
INSIDEFAULTS

Syntax:

```plaintext
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INSIDEFAULTS SHOW=F'

$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INSIDEFAULTS PERSISTENT=T'

$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INSIDEFAULTS SELECT="CONSTRAINT:TRANX<=0", "Fault2", "NNCs: Upstream"
```

Description:
Set options for displaying Inside Views of faults in 3D Grid plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT</td>
<td>&lt;string,string,...&gt;</td>
<td>Selects one or more named faults, defined constraints, and/or NNCs, which must be specified as displayed in the Tecplot RS sidebar (see example syntax above).</td>
</tr>
<tr>
<td>SHOW</td>
<td>&lt;boolean&gt;</td>
<td>Show faults – TRUE or FALSE</td>
</tr>
<tr>
<td>PERSISTENT</td>
<td>&lt;boolean&gt;</td>
<td>If TRUE, the Faults Inside View will remain visible when switching to other Inside Views.</td>
</tr>
</tbody>
</table>

INSIDELGRS

Syntax:

```plaintext
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'INSIDELGRS [optional parameters]'
```

Description:
Set options for displaying Inside Views of Local Grid Refinements in 3D Grid plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW</td>
<td>&lt;boolean&gt;</td>
<td>Show LGRs – TRUE or FALSE</td>
</tr>
<tr>
<td>LGR</td>
<td>&lt;string,string,...&gt;</td>
<td>LGRs to be shown. GLOBAL refers to the global grid.</td>
</tr>
</tbody>
</table>

ISOSURFACES

Syntax:

```plaintext
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'ISOSURFACES [optional parameters]'
```

Description:
Set options for displaying Inside Views in 3D Grid plots using Iso-surfaces.
Optional Parameters:

### WELLBLANKING

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW</td>
<td>&lt;boolean&gt;</td>
<td>Show iso-surfaces – TRUE or FALSE</td>
</tr>
<tr>
<td>VARIABLE</td>
<td>&lt;string&gt;</td>
<td>Specify the variable that defines the iso-surface</td>
</tr>
<tr>
<td>COUNT</td>
<td>&lt;integer&gt;</td>
<td>Specify the number of iso-surfaces (1 or 2)</td>
</tr>
<tr>
<td>VALUES1</td>
<td>&lt;variable&gt;</td>
<td>Sets value for first iso-surface</td>
</tr>
<tr>
<td>VALUES2</td>
<td>&lt;variable&gt;</td>
<td>Sets value for second iso-surface</td>
</tr>
</tbody>
</table>

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "WELLBLANKING [optional parameters]"*
```

**Description:** Set options for displaying Inside Views in 3D grid plots using Well Blanking.

### XYZSLICES

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Default</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHOW</td>
<td>&lt;boolean&gt;</td>
<td>OFF</td>
<td>Show XYZ Slices – TRUE or FALSE</td>
</tr>
<tr>
<td>XYZ</td>
<td>&lt;parameter&gt;</td>
<td>X</td>
<td>Slice plane – X, Y, or Z</td>
</tr>
<tr>
<td>PLANES</td>
<td>&lt;integer&gt;</td>
<td>1</td>
<td>Number of planes to display</td>
</tr>
<tr>
<td>MAX</td>
<td>&lt;integer&gt;</td>
<td>25</td>
<td>Relative position of front plane, expressed as a percentage from 0 to 100</td>
</tr>
<tr>
<td>MIN</td>
<td>&lt;integer&gt;</td>
<td>75</td>
<td>Relative position of back plane, expressed as a percentage from 0 to 100</td>
</tr>
</tbody>
</table>

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "XYZSLICES [optional parameters]"*
```

**Description:** Set options for displaying Inside Views in 3D Grid plots using XYZ Slices.
## Multi-Frame Macros

### MULTIFRAMEOPTIONS

**Syntax:**

```
$/ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "MULTIFRAMEOPTIONS [optional parameters]"
```

**Description:** Set multiple frame options.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRAMEMODE</td>
<td>=&lt;option&gt;</td>
<td>Frame mode - SINGLE or MULTI</td>
</tr>
<tr>
<td>LINKVIEWS</td>
<td>=&lt;boolean&gt;</td>
<td>Link frame views - TRUE or FALSE</td>
</tr>
<tr>
<td>LINKBLANKING</td>
<td>=&lt;boolean&gt;</td>
<td>Link frames for cell value blanking, pick blanking and inside views - TRUE or FALSE</td>
</tr>
<tr>
<td>LINKLAYERS</td>
<td>=&lt;boolean&gt;</td>
<td>Link layer toggles on frames - TRUE or FALSE</td>
</tr>
<tr>
<td>LINKWELLS</td>
<td>=&lt;boolean&gt;</td>
<td>Link well display on frames - TRUE or FALSE</td>
</tr>
<tr>
<td>NUMROWS</td>
<td>=&lt;integer&gt;</td>
<td>Number of rows of frames (for multi-frame mode).</td>
</tr>
<tr>
<td>NUMCOLUMNS</td>
<td>=&lt;integer&gt;</td>
<td>Number of columns of frames.</td>
</tr>
</tbody>
</table>

### Paper Layout

When you design a paper layout template, you can do several operations outside of the RS Manager dialog, particularly those associated with creating text. Please refer to the Tecplot 360 Scripting Guide for details about those macro commands. See also: Section 26 - 2 "File Loading and Saving".

### PAPERLAYOUT

**Syntax:**

```
$/ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PAPERLAYOUT [optional parameters]"
```

**Description:** Set options from the paper layout dialog.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLORNUM</td>
<td>=&lt;integer&gt;</td>
<td>Integer between 0 and 63, corresponding to Tecplot standard colors</td>
</tr>
<tr>
<td>DESIGNMODE</td>
<td>=&lt;boolean&gt;</td>
<td>TRUE or FALSE. When editing the paper templates, you must surround the commands with the ON and OFF modes to indicate that commands are being applied to the paper layout template rather than the plot frame.</td>
</tr>
<tr>
<td>DYNAMICTEXT</td>
<td>=&lt;string&gt;</td>
<td>Adds dynamic text to the active frame</td>
</tr>
<tr>
<td>FOOTERHEIGHT</td>
<td>=&lt;integer&gt;</td>
<td>If a footer is included, the height as a percentage of paper height.</td>
</tr>
<tr>
<td>FOOTERWIDTH</td>
<td>=&lt;integer&gt;</td>
<td>If a footer is included, the width as a percentage of paper width.</td>
</tr>
<tr>
<td>HEADERHEIGHT</td>
<td>=&lt;integer&gt;</td>
<td>If a header is included, the height as a percentage of paper height.</td>
</tr>
<tr>
<td>HEADERWIDTH</td>
<td>=&lt;integer&gt;</td>
<td>If a header is included, the width as a percentage of paper width.</td>
</tr>
</tbody>
</table>
PERFORMANCE

26 - 8 Performance

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PERFORMANCE [optional parameters]"

Description: This command allows you to set options affecting Tecplot RS performance.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAGENUMBER</td>
<td>&lt;=integer&gt;</td>
<td>Sets the starting page number.</td>
</tr>
<tr>
<td>PAPERORIENTATION</td>
<td>&lt;=string&gt;</td>
<td>LANDSCAPE or PORTRAIT</td>
</tr>
<tr>
<td>SHOWFOOTER</td>
<td>&lt;=boolean&gt;</td>
<td>Include a footer frame - TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWHEADER</td>
<td>&lt;=boolean&gt;</td>
<td>Include a header frame – TRUE or FALSE.</td>
</tr>
<tr>
<td>SHOWPAPER</td>
<td>&lt;=boolean&gt;</td>
<td>Set paper display in the Tecplot RS workspace.</td>
</tr>
<tr>
<td>SIZE</td>
<td>&lt;=string&gt;</td>
<td>LETTER, DOUBLE, A4, A3, CUSTOM1 or CUSTOM2.</td>
</tr>
</tbody>
</table>

26 - 9 Plot Options

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PLOTOPTIONS_AXIS [optional parameters]"

Description: Set options for plotting axes on XY plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAJORINTERVALMARKERS</td>
<td>&lt;=option&gt;</td>
<td>Major interval markers. SOLID, TICKS, DOTTED, or PRECISE.</td>
</tr>
<tr>
<td>MINORINTERVALMARKERS</td>
<td>&lt;=option&gt;</td>
<td>Minor interval markers. SOLID, TICKS, DOTTED, or PRECISE.</td>
</tr>
<tr>
<td>COLOR</td>
<td>&lt;=COLOROPTION&gt;</td>
<td>Any of the standard colors listed in Section 26 - 12.</td>
</tr>
</tbody>
</table>

Syntax:
## PLOTOPTIONS_GRID

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT_RS'
COMMAND = "PLOTOPTIONS_CELL_LABELS [optional parameters]"
```

**Description:** Set options for labeling cells on grid plots

### Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLOR</td>
<td>&lt;COLOROPTION&gt;</td>
<td>Label color. Any of the standard colors listed in Section 26 - 12.</td>
</tr>
<tr>
<td>SIZE</td>
<td>&lt;double&gt;</td>
<td>Size of cell labels, expressed as a percentage of frame size.</td>
</tr>
<tr>
<td>BOX</td>
<td>&lt;boolean&gt;</td>
<td>Include box around label.</td>
</tr>
<tr>
<td>FONT</td>
<td>&lt;FONTOPTION&gt;</td>
<td>Label font. Any of the allowable fonts specified in Section 26 - 12.</td>
</tr>
</tbody>
</table>

## PLOTOPTIONS_GRIDAXES

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT_RS'
COMMAND = "PLOTOPTIONS_GRIDAXES [optional parameters]"
```

**Description:** Set options for plotting grids.

### Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Permitted Values</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MESHCOLOR</td>
<td>&lt;COLOROPTION&gt;</td>
<td>Any of the colors listed in Section 26 - 12, plus MULTI.</td>
<td>Mesh color.</td>
</tr>
<tr>
<td>GRIDTHICKNESS</td>
<td>&lt;double&gt;</td>
<td>Thickness of grid mesh.</td>
<td></td>
</tr>
<tr>
<td>CONTOURLINEWIDTH</td>
<td>&lt;double&gt;</td>
<td>0.1 to 2.0</td>
<td>Contour line width.</td>
</tr>
<tr>
<td>CONTOURLINEWIDTH</td>
<td>&lt;COLOROPTION&gt;</td>
<td>Standard Tecplot RS colors plus MULTI (which maps to the contour variable).</td>
<td></td>
</tr>
<tr>
<td>SHOWCONTOURLABELS</td>
<td>&lt;boolean&gt;</td>
<td>TRUE or FALSE</td>
<td></td>
</tr>
<tr>
<td>CONTOURLABELCOLOR</td>
<td>&lt;COLOROPTION&gt;</td>
<td>Standard Tecplot RS colors.</td>
<td></td>
</tr>
<tr>
<td>FONT</td>
<td>&lt;FONTOPTION&gt;</td>
<td>Standard fonts.</td>
<td></td>
</tr>
<tr>
<td>CONTOURLABELSIZES</td>
<td>&lt;integer&gt;</td>
<td>0.1 to 5.0</td>
<td></td>
</tr>
<tr>
<td>SHOWXYZ</td>
<td>&lt;boolean&gt;</td>
<td>Show the axes on 3D plots</td>
<td></td>
</tr>
<tr>
<td>SHIMMYZ</td>
<td>&lt;boolean&gt;</td>
<td>Show the mesh on 3D plots</td>
<td></td>
</tr>
<tr>
<td>LIGHTEFFECT</td>
<td>&lt;option&gt;</td>
<td>PANELED or SMOOTH</td>
<td>Lightning effect.</td>
</tr>
<tr>
<td>TRANSLUCENCY</td>
<td>&lt;integer&gt;</td>
<td>1 to 100%</td>
<td>See-through grid transparency.</td>
</tr>
<tr>
<td>SHOWGRIDFILL</td>
<td>&lt;option&gt;</td>
<td>FILLGRAY, GHOSTCOLOR, or NONE</td>
<td>Fill style for see-through grids</td>
</tr>
</tbody>
</table>

## Syntax:

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT_RS'
COMMAND = "PLOTOPTIONS_CELL_LABELS"
```
### PLOTOPTIONS_INACTIVEGRID

**COMMAND** = "PLOTOPTIONS_GRIDAXES [optional parameters]"

**Description:** Set options for plotting axes on grid plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Label color. Any of the standard colors listed in Section 26-12.</td>
</tr>
<tr>
<td>FONT</td>
<td>=&lt;FONTOPTION&gt;</td>
<td>Label font.</td>
</tr>
<tr>
<td>LINECOLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Axis line color. Any of the standard colors listed in Section 26-12.</td>
</tr>
<tr>
<td>SHOWXYZ</td>
<td>=&lt;boolean&gt;</td>
<td>Turns on or off the axes display in 3D plots.</td>
</tr>
<tr>
<td>SIZE</td>
<td>=&lt;double&gt;</td>
<td>Label size, ranging from 0.1 to 5.0.</td>
</tr>
</tbody>
</table>

### PLOTOPTIONS_INACTIVEGRID

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PLOTOPTIONS_INACTIVEGRID [optional parameters]"
```

**Description:** Set options to define the inactive grid cells' style. No defaults apply.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILLSTYLE</td>
<td>=&lt;string&gt;</td>
<td>Accepts values of SHADE, MESHONLY, MATCH, or VARIABLE to control the fill style of displayed inactive cells.</td>
</tr>
<tr>
<td>MESHCOLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Controls the mesh color of inactive cells.</td>
</tr>
<tr>
<td>COLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Controls the fill (shade) color of inactive cells. Applies only when FILLSTYLE is set to SHADE.</td>
</tr>
<tr>
<td>GRIDTHICKNESS</td>
<td>=&lt;double&gt;</td>
<td>Controls the thickness of each line of the mesh as a percentage of the frame size. Acceptable values range from 0.1 to 2.0.</td>
</tr>
</tbody>
</table>

### PLOTOPTIONS_LABELS

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PLOTOPTIONS_LABELS [optional parameters]"
```

**Description:** Set label options.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FONT</td>
<td>=&lt;FONTOPTION&gt;</td>
<td>Any of the allowable fonts specified in Section 26-14.</td>
</tr>
<tr>
<td>SIZE</td>
<td>=&lt;double&gt;</td>
<td>Size as a percentage of frame. If the value does not match one of the preset values on the Plot Options dialog it converts to the nearest preset value.</td>
</tr>
<tr>
<td>COLOR</td>
<td>=&lt;COLOROPTION&gt;</td>
<td>Any of the standard colors listed in Section 26-12.</td>
</tr>
</tbody>
</table>
**PLOTOPTIONS_MISC**

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "PLOTOPTIONS_MISC [optional parameters]"
```

**Description:** Set time variable and animation options.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMEUNITS</td>
<td>= TIME, DATE</td>
<td>Set the time variable to either TIME or DATE</td>
</tr>
<tr>
<td>ANIMATIONDELAY</td>
<td>= &lt;integer&gt;</td>
<td>Specify the animation delay (pause between time steps)</td>
</tr>
<tr>
<td>USEFORMATDATE</td>
<td>= &lt;boolean&gt;</td>
<td>Specify whether to use decimal year as date format</td>
</tr>
<tr>
<td>USEFORMATTIME</td>
<td>= &lt;boolean&gt;</td>
<td>Specify whether to use decimal day as time format</td>
</tr>
<tr>
<td>DATEFORMAT</td>
<td>= &lt;string&gt;</td>
<td>Specify a Tecplot RS date format string. For example, &quot;mmm-dd-yyyy&quot;. By default, &quot;mm/dd/yy&quot;.</td>
</tr>
<tr>
<td>TIMEFORMAT</td>
<td>= &lt;string&gt;</td>
<td>Specify a Tecplot RS time format string. For example, &quot;[d] hh:mm:ss&quot;. By default, &quot;[d] hh:mm&quot;.</td>
</tr>
</tbody>
</table>

**Parameter Syntax Notes**

- **VARIABLE** = <string>  
  Name of the variable to apply the following settings to. You can use the long or short name, but it must match exactly (excluding upper- or lowercase).

- **INTERVAL** = <integer>  
  Assigns the interval between major markers on X or Y axis. Must follow the VARIABLE parameter, although does not have to follow immediately. Range includes values zero (0) and greater.

- **MINORCOUNT** = <integer>  
  Assigns the number of minor markers displayed between major markers. As the INTERVAL parameter, MINORCOUNT will be associated with the preceding VARIABLE parameter. Acceptable values range from zero (0) to one hundred (100).

- **USEGLOBALSETTINGS** = <boolean>  
  TRUE to set parameter for all variables.

- **RANGE** = <option>  
  Scaling range. FRAME, DATASET, or MANUAL.

- **MIN** = <double>  
  Valid only if RANGE=FRAME. If the value does not match one of the preset values on the Frame Options dialog, it converts to the nearest preset value. Use 0 for Log scale.

- **MAX** = <double>  
  Valid only if RANGE=FRAME. If the value does not match one of the preset values on the Frame Options dialog, it converts to the nearest preset value. Use 0 for Log scale.

- **SCALE** = <double>  
  If the value does not match one of the preset values on the Frame Options dialog, it converts to the nearest preset value. Use 0 for Log scale.

- **OVERRIDE** = <boolean>  
  TRUE to declare a new string for the units display.

- **UNITS** = <string>  
  Character string to be used for displaying units.

- **CUTOFFLOW** = <boolean>  
  TRUE to cutoff contours below a set value.
PLOTOPTIONS_WELL_LABELS

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PLOTOPTIONS_WELL_LABELS [optional parameters]"
```

**Description:** Set options for labeling wells on grid plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCLUDE</td>
<td>&lt;boolean&gt;</td>
<td>Include well names.</td>
</tr>
<tr>
<td>COLOR</td>
<td>&lt;COLOROPTION&gt;</td>
<td>Label color. Any of the standard colors listed in Section 26 - 12.</td>
</tr>
<tr>
<td>SIZE</td>
<td>&lt;double&gt;</td>
<td>Size of well labels.</td>
</tr>
<tr>
<td>UNITS</td>
<td>&lt;option&gt;</td>
<td>Units for label size. GRID or FRAME</td>
</tr>
<tr>
<td>FONT</td>
<td>&lt;FONTOPTION&gt;</td>
<td>Label font. Any of the allowable fonts specified in Section 26 - 12.</td>
</tr>
<tr>
<td>WELLHEADOFFSET</td>
<td>&lt;integer&gt;</td>
<td>Offset value.</td>
</tr>
<tr>
<td>WELLHEADPOS</td>
<td>&lt;option&gt;</td>
<td>Position option (1 – 4)</td>
</tr>
<tr>
<td>WELLMULTIFRAME</td>
<td>&lt;option&gt;</td>
<td>Options for displaying wells in multi frames: ONEFRAME or ALLFRAMES</td>
</tr>
<tr>
<td>WELLDISPLAY2D</td>
<td>&lt;option&gt;</td>
<td>Display option for wells in 2D views: ALL, CURRENTPLANE, or NODESONLY</td>
</tr>
</tbody>
</table>

PLOTOPTIONS_WELL_OPTIONS

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "PLOTOPTIONS_WELL_OPTIONS [optional parameters]"
```

**Description:** Set options for general well display on grid plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>WELLHEADOFFSET</td>
<td>&lt;integer&gt;</td>
<td>Offset value.</td>
</tr>
<tr>
<td>WELLHEADPOS</td>
<td>&lt;option&gt;</td>
<td>Position option (1 – 4)</td>
</tr>
<tr>
<td>WELLMULTIFRAME</td>
<td>&lt;option&gt;</td>
<td>Options for displaying wells in multi frames: ONEFRAME or ALLFRAMES</td>
</tr>
<tr>
<td>WELLDISPLAY2D</td>
<td>&lt;option&gt;</td>
<td>Display option for wells in 2D views: ALL, CURRENTPLANE, or NODESONLY</td>
</tr>
</tbody>
</table>

PLOTOPTIONS_WELLSYMBOLS

**Syntax:**

```plaintext
```

310
PLOTOPTIONS_XY

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "PLOTOPTIONS_WELLSYMBOLS [optional parameters]"

Description: Set options for plotting wells and bubbles.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>=&lt;option&gt;</td>
<td>Well type: PRODUCER, INJECTOR, WATERINJECTOR, GASINJECTOR, SHUTIN, OPENNODE, or CLOSEDNODE</td>
</tr>
<tr>
<td>SYMBOLS</td>
<td>=&lt;option&gt;</td>
<td>Well symbol: DEFAULT, SQUARE, CIRCLE, DIAMOND, DELTA, GRADIENT, LEFTTRI, RIGHTTRI, SPHERE, CUBE, or OCTAHEDRON</td>
</tr>
<tr>
<td>COLOR</td>
<td>=&lt;COLOROPTIONS&gt;</td>
<td>Well color: Any of the standard colors listed in Section 26 - 12</td>
</tr>
<tr>
<td>SIZE</td>
<td>=&lt;double&gt;</td>
<td>Size (in percent)</td>
</tr>
</tbody>
</table>

PLOTOPTIONS_XY

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "PLOTOPTIONS_XY [optional parameters]"

Description: Set options for XY plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>STYLESET</td>
<td>=&lt;styleset&gt;</td>
<td>Which of 20 style sets all following parameters will be applied to. Options are ACTIVE or COMP1 through COMP99</td>
</tr>
<tr>
<td>VARIABLE</td>
<td>=&lt;string&gt;</td>
<td>Name of the variable to apply the following settings to. You can use the long or short name, but it must match exactly.</td>
</tr>
<tr>
<td>USEGLOBALSETTING</td>
<td>=&lt;boolean&gt;</td>
<td>TRUE to set parameter for all variables.</td>
</tr>
<tr>
<td>SHOWNLINES</td>
<td>=&lt;boolean&gt;</td>
<td>Show lines.</td>
</tr>
<tr>
<td>LINECOLOR</td>
<td>=&lt;COLORDESCRIPTION&gt;</td>
<td>Line color. Any of the standard colors listed in Section 26 - 12 plus DEFAULT.</td>
</tr>
<tr>
<td>LINEPATTERN</td>
<td>=&lt;option&gt;</td>
<td>Line pattern: DEFAULT, SOLID, SHORTDASH, DASHDOT, DOTTED, LONGDASH, or DASHDOTDOT.</td>
</tr>
<tr>
<td>LINEPATTERNLENGTH</td>
<td>=&lt;double&gt;</td>
<td>Line pattern as a percent. If the value does not match one of the preset values on the Plot Options dialog, it converts to the nearest preset value.</td>
</tr>
<tr>
<td>LINETHICKNESS</td>
<td>=&lt;double&gt;</td>
<td>Line thickness as a percent. If the value does not match one of the preset values on the Plot Options dialog, it converts to the nearest preset value.</td>
</tr>
<tr>
<td>SHOWSYMBOLS</td>
<td>=&lt;boolean&gt;</td>
<td>TRUE to show all symbols.</td>
</tr>
<tr>
<td>SYMBOLFILL</td>
<td>=&lt;boolean&gt;</td>
<td>TRUE to fill all symbols.</td>
</tr>
<tr>
<td>SYMBOLCOLOR</td>
<td>=&lt;COLORDESCRIPTION&gt;</td>
<td>Symbol color. Any of the standard colors listed in Section 26 - 12 plus DEFAULT and MATCH.</td>
</tr>
<tr>
<td>SYMBOLSHAPE</td>
<td>=&lt;option&gt;</td>
<td>Symbol shape: DEFAULT, SQUARE, CIRCLE, DIAMOND, DELTA, GRADIENT, LEFTTRI, RIGHTTRI, CHARACTER</td>
</tr>
<tr>
<td>SYMBOLSPACING</td>
<td>=&lt;option&gt;</td>
<td>Symbol spacing: ALL, I2, I4, I6, I8, I10, D1, D2, D3, D4, D5.</td>
</tr>
<tr>
<td>SYMBOLCHAR</td>
<td>=&lt;string&gt;</td>
<td>Symbol character if SYMBOLSHAPE=CHARACTER.</td>
</tr>
<tr>
<td>SYMBOLSIZE</td>
<td>=&lt;double&gt;</td>
<td>Symbol size. If the value does not match one of the preset values on the Plot Options dialog, it converts to the nearest preset value.</td>
</tr>
</tbody>
</table>
RSVFILE

Syntax:
```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "RSVFILE TYPE=<rsvtype>"
```

Description: Chooses the RS Variables file to be used for variable renaming and aliasing and for colors and line and symbol styles used in plots.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>&lt;rsvtype&gt;</td>
<td>Chooses the file that will be used. Supported types are USER (rsvariables.txt), ECLIPSE, CHARS, VIP, SENSOR, and CMG. The simulator-specific files are named e.g. rsvariables_chears.txt.</td>
</tr>
</tbody>
</table>

UPDATEOPTIONS

Syntax:
```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "UPDATEOPTIONS"
```

Description: Update the plot after changes in Plot Options or Bubble Options dialog.

26 - 10 Selection Sets

See also: Section 26 - 2 “File Loading and Saving”.

SELECTIONSET_SAVE

Syntax:
```
$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "SELECTIONSET_SAVE ENTITY=<list> NAME=<string>"
```

Description: This command saves or edits a selection set.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTITY</td>
<td>&lt;string, string, ...&gt;</td>
<td>One or more paired entity names and entity numbers, the entity number should be zero in most cases. If the entity represents a well layer or completion, the value should be the completion number. If the entity is from an RFT file, the number represents the time step for that well name.</td>
</tr>
<tr>
<td>NAME</td>
<td>&lt;=string&gt;</td>
<td>The name to be assigned to the selection set.</td>
</tr>
</tbody>
</table>

SELECTIONSET_DELETE

Syntax:
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SELECTIONSET_RENAME NAME=<string>'

Description: This command renames an existing selection set. Two names must be provided – the original name and the new name.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>=&lt;string&gt;</td>
<td>The new name of the selection set.</td>
</tr>
</tbody>
</table>

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'MAKEUSERGROUPS
SUMVARS = "<string>"
AVGVARS = "<string>"
NEWVARS = "<string>"
SELECTIONSETS = "<string>"
ACTIVE = <boolean>

Description: This command creates a user group from one or more existing selection sets.

Required Parameters:

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVE</td>
<td>=&lt;boolean&gt;</td>
<td>Controls whether the group creation affects only the active data set (TRUE) or all loaded data sets (FALSE). Defaults to TRUE.</td>
</tr>
</tbody>
</table>

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SELECTIONSET_DELETE NAME=<string>'

Description: This command deletes an existing selection set.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>=&lt;string&gt;</td>
<td>The name to be assigned to the selection set.</td>
</tr>
</tbody>
</table>

Syntax:
MAKEWELL PATTERNS

Syntax:

$!ADDONCOMMAND ADDONID = "TECPLOT RS"
COMMAND = "MAKEWELL PATTERNS"
SUMVARS = "<string>", "<string>", "<string>", ...
NEWVARS = "<string>", "<string>", "<string>", ...
SELECTIONSETS = "<string>", "<string>"

Description: This command creates a user group from one or more existing selection sets.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUMVARS</td>
<td>= &quot;&lt;string&gt;&quot;</td>
<td>List the cumulative variables which show the accumulated production for each time step</td>
</tr>
<tr>
<td>NEWVARS</td>
<td>= &quot;&lt;string&gt;&quot;</td>
<td>List the variables that you wish Tecplot RS to calculate.</td>
</tr>
<tr>
<td>SELECTIONSETS</td>
<td>= &quot;&lt;string&gt;&quot;</td>
<td>List the existing selection sets you wish Tecplot RS to use.</td>
</tr>
</tbody>
</table>

26 - 11 XY Plot

These commands are used to make selections for and initiate XY plots, including XY ENTITIES, XY VARIABLES, XY CUSTOM, RFT, and COMPLETION PROFILES. See also Section 26 - 2 "File Loading and Saving".

COMPARELEGENDFORMAT

Syntax:

$!ADDONCOMMAND ADDONID = "TECPLOT RS"
COMMAND = "COMPARELEGENDFORMAT [optional parameters]"

Description: Controls how comparison file names appear in the legend.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCLUDEVARNAME</td>
<td>= &lt;boolean&gt;</td>
<td>If TRUE, the variable name is included (Default: TRUE)</td>
</tr>
<tr>
<td>INCLUDEFILENAME</td>
<td>= &lt;boolean&gt;</td>
<td>If TRUE, the file name or display name is included (Default: TRUE)</td>
</tr>
<tr>
<td>FILENAMEFORMAT</td>
<td>= &lt;option&gt;</td>
<td>If INCLUDEFILENAME is TRUE, option for filename format. May be DISPLAYNAME, or FILEBASENAME. (Default: DISPLAYNAME)</td>
</tr>
<tr>
<td>INCLUDEFILETEXT</td>
<td>= &lt;boolean&gt;</td>
<td>If INCLUDEFILENAME is TRUE, and FILENAMEFORMAT=FILENAME, set to TRUE to include the file extension in the filename. Default: TRUE. Ignored if INCLUDEFILENAME is FALSE, or FILENAMEFORMAT is DISPLAYNAME.</td>
</tr>
</tbody>
</table>

COMPARESETUP

Syntax:
COMPLETIONSETUP

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "COMPLETIONSETUP [optional parameters]"

Description:
If the comparison toggle is turned on for a plot, use this command to choose the comparison data sets and options for displaying them.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
</table>
| COMPAREDATASET | +<string, string, ...> | Specify one or more file names. Order of files determines how they will appear in legend. Files must be loaded first. If a filename is listed more than once, the duplicates will be ignored. For example: COMPAREDATASET 'f1.hist' 'f2.hist' is equivalent to COMPAREDATASET 'f1.hist'
|             |              | If a filename is the active filename, it will be ignored since the active file cannot be a comparison file. For example: COMPAREDATASET 'f1.hist' 'f1.usmry' is equivalent to COMPAREDATASET 'f1.hist' if 'f1.usmry' is the active file. |
| SHOWREFERENCE | +<boolean>   | Controls whether the reference data are shown when the Delta option is turned on. |
| STYLESET    | +<option>    | Option for handling comparison style set when more files are compared than there are available stylesets— CYCLE or REPEAT |
| DELTATYPE   | +<string>    | Defines option for computing delta values. Allowed options are: VC-VR (Default)
|             |              | VR-VC |
|             |              | VC represents Vref, the active value, and VR represents Vcomp, the comparison value(s). |
| NORMALIZE   | +<boolean>   | Defines whether to normalize the delta values by Vref— TRUE or FALSE |
| DELTAMAGNITUDE | +<boolean> | Defines whether to use delta magnitudes— TRUE or FALSE |

Parameter Syntax Notes

- WELL = <string>
  Name of layered well to plot.
- TIMES = +<integer>
  Time to plot (one-based index).
- SHOWPERCENTAGES = +<boolean>
  Show/hide percentages.
- COMPLETIONLABELS = +<option>
  Possible values: NONE, DEPTH, KPLANE.

Macros created prior to the release of Tecplot RS 2009 do not contain the DELTATYPE, NORMALIZE, and DELTAMAGNITUDE parameters. For compatibility, Tecplot RS assumes these values:
- DELTATYPE = VR-VC
- NORMALIZE = FALSE
- DELTAMAGNITUDE = FALSE

COMPLETIONSETUP

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "COMPLETIONSETUP [optional parameters]"

Description:
Sets parameters for completion profiles.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MELL</td>
<td>+&lt;string&gt;</td>
<td>Name of layered well to plot.</td>
</tr>
<tr>
<td>TIMES</td>
<td>+&lt;integer&gt;</td>
<td>Time to plot (one-based index).</td>
</tr>
<tr>
<td>SHOWPERCENTAGES</td>
<td>+&lt;boolean&gt;</td>
<td>Show/hide percentages.</td>
</tr>
<tr>
<td>COMPLETIONLABELS</td>
<td>+&lt;option&gt;</td>
<td>Possible values: NONE, DEPTH, KPLANE.</td>
</tr>
</tbody>
</table>
PLOTXY

Example:

```plaintext
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'COMPLETIONSETUP XAXIS1="OPR","GPR","LGR"'
```

This command will assign variables OPR, GPR, and LGR to be plotted on the X1 axis.

---

PLOTXY

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'PLOTXY TYPE=<<<<<<<plottype>>>>'  
```

**Description:** This command draws an XY plot of the specified type. Before using this command, you should call the `SETUP` command for the associated plot type. For example, before doing an XY ENTITIES plot, specify the variables and entities to plot with one or more `XYENTITIESSETUP` commands.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPE</td>
<td>= &lt;options&gt;</td>
<td>Type of plot to draw. Must be XYENTITIES, XYVARIABLES, XYSUBSETS, XYFREESTYLE, RFT, CUSTOM, CUSTOMENTITIES or COMPLETION</td>
</tr>
</tbody>
</table>

In general, the steps to create the XY Freestyle plots (XYFREESTYLE) are NOT recorded in the macro. The only things recorded are the plot type and page number. For this reason, we strongly recommend macro recording be turned off during creation of the XY Freestyle plots.

---

RFTSETUP

**Syntax:**

```plaintext
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'RFTSETUP [optional parameters]'  
```

**Description:** Set parameter options for RFT plots.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTITY</td>
<td>= &lt;string, string&gt;</td>
<td>Paired entity name and entity number. The entity number represents the time step for that well name.</td>
</tr>
<tr>
<td>XAXIS</td>
<td>= &lt;string&gt;</td>
<td>X-axis variable name.</td>
</tr>
<tr>
<td>YAXIS</td>
<td>= &lt;string&gt;</td>
<td>Y-axis variable name.</td>
</tr>
</tbody>
</table>
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "SOLVEPTIME VARIABLE="GPR" APPLYTODIFFILES=T"

Description:
Finds the time production started, creating a new variable called PTIME that stores the

time relative to the start of production for each entity.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARIABLE</td>
<td>=&lt;string&gt;</td>
<td>Variable that becomes non-zero when a well or other entity begins production (usually OPR or GPR)</td>
</tr>
</tbody>
</table>

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLYTODIFFILES</td>
<td>=&lt;boolean&gt;</td>
<td>If TRUE, PTIME will be calculated for all open files. If FALSE, it is calculated only for the current file. Default: FALSE</td>
</tr>
</tbody>
</table>

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS SELECTBY=SOURCE"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS COLORBY=SINK"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS VARIABLE="SWAT"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS SKIP=4"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS LINETHICKNESS=0.4"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS TIMEPERCENT=60"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS LOSSCALE=T"

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "STREAMLINEOPTIONS SELECTSTREAMS="1"

Description:
Options for controlling the appearance of streamlines in 3D plots.
Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECTBY</td>
<td>&lt;=option&gt;</td>
<td>ALL, SOURCE, SINK, PAIR</td>
</tr>
<tr>
<td>COLORBY</td>
<td>&lt;=option&gt;</td>
<td>SOURCE, SINK, PAIR, VARIABLE, TOF</td>
</tr>
<tr>
<td>VARIABLE</td>
<td>&lt;=string&gt;</td>
<td>Variable name for COLORBY option</td>
</tr>
<tr>
<td>SKIP</td>
<td>&lt;=integer&gt;</td>
<td>1 to 100. Skip interval for thinning the number of streams to display</td>
</tr>
<tr>
<td>TEMPERCENT</td>
<td>&lt;=integer&gt;</td>
<td>0 to 100. Slider position for TOF display</td>
</tr>
<tr>
<td>LOGSCALE</td>
<td>&lt;=boolean&gt;</td>
<td>TRUE or FALSE. Determines whether TOF is scaled logarithmically</td>
</tr>
<tr>
<td>PERSISTENT</td>
<td>&lt;=boolean&gt;</td>
<td>If TRUE, causes streamlines to continue to be displayed when another Inside View is selected.</td>
</tr>
<tr>
<td>SELECTSTREAMS</td>
<td>&lt;=string&gt;</td>
<td>Identifiers for streams to plot. Allowable values depend on SELECTBY option.</td>
</tr>
</tbody>
</table>

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "UPDATESTREAMLINES"

Description: Update the plot after changes via STREAMLINEOPTIONS.

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "UPDATESTYLES"

Description: Force updating of plot styles.

Syntax:

$!ADDONCOMMAND
ADDONID = "TECPLOT RS"
COMMAND = "XYCUSTOMSETUP [optional parameters]"

Description: Set options for XY CUSTOM plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTITY</td>
<td>=&lt;string&gt;,&lt;string&gt;</td>
<td>Paired entity name and entity number. The entity number should be zero in most cases. If the entity represents a well layer or completion, the value should be the completion number. If the entity is from an RFT file, the number represents the time step for that well name.</td>
</tr>
</tbody>
</table>
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "XY_DISPLAYNAME" FNAME= "<string>" NAME= "<string>"

**Description:** Specifies the label to identify the file in legends and paper layouts. This is especially useful when working with comparison plots.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&lt;string&gt;</td>
<td>File name.</td>
</tr>
<tr>
<td>NAME</td>
<td>&lt;string&gt;</td>
<td>Name to display when file FNAME is in use.</td>
</tr>
</tbody>
</table>

---

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "XYENTITIESSETUP" [optional parameters]"

**Description:** Sets options for the XY ENTITIES plot.

**Optional Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTITY</td>
<td>&quot;&lt;name1&gt;&quot;;&lt;&quot;number1&quot;&gt;;&quot;&lt;name2&gt;&quot;;&lt;&quot;number2&quot;&gt;...</td>
<td>One or more paired entity names and entity numbers. The entity number should be zero in most cases. If the entity represents a well layer or completion, the value should be the completion number. If the entity is from an RFT file, the number represents the time step for that well name.</td>
</tr>
<tr>
<td>YAXIS</td>
<td>&lt;string&gt;</td>
<td>Y-axis variable.</td>
</tr>
<tr>
<td>XAXIS</td>
<td>&lt;string&gt;</td>
<td>X-axis variable.</td>
</tr>
<tr>
<td>SUM</td>
<td>&lt;boolean&gt;</td>
<td>Sum option.</td>
</tr>
<tr>
<td>AVERAGE</td>
<td>&lt;boolean&gt;</td>
<td>Average option.</td>
</tr>
</tbody>
</table>

---

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = "XYEQUATIONS" EQUATIONLIST=<string,string,...> APPLY=<option>"

**Description:** Defines one or more equations to be used to create new XY variables.
XYFILTERING

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUATIONLIST</td>
<td>= &lt;string, string, ... &gt;</td>
<td>List of equations</td>
</tr>
<tr>
<td>APPLY</td>
<td>= &lt;option&gt;</td>
<td>Entity type on which equations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>are to be applied (can be</td>
</tr>
<tr>
<td></td>
<td></td>
<td>repeated) - WELLS, COMPLETIONS,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FIELD, AREAS, REGIONS, FLOWSTAT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>QUALITYDATA, RFTDATA,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GATHERSTAT, AQUIFER, BLOCKDATA,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USERGROUPS, OTHER.</td>
</tr>
<tr>
<td>ERRORIGNORE</td>
<td>= &lt;boolean&gt;</td>
<td>If NO (the default), Tecplot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RS displays an error message</td>
</tr>
<tr>
<td></td>
<td></td>
<td>when a division by zero occurs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and does not create any new</td>
</tr>
<tr>
<td></td>
<td></td>
<td>variables. If YES, the affected</td>
</tr>
<tr>
<td></td>
<td></td>
<td>data value will be set to 0 (</td>
</tr>
<tr>
<td></td>
<td></td>
<td>when the number being divided</td>
</tr>
<tr>
<td></td>
<td></td>
<td>is zero) or -999999 (when the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>dividend is nonzero).</td>
</tr>
</tbody>
</table>

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLYTOALLFILES</td>
<td>= &lt;boolean&gt;</td>
<td>Default is FALSE.</td>
</tr>
</tbody>
</table>

Example:

```
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'XYEQUATIONS EQUATIONLIST="{wpr}={wpr}/2" APPLYTOALLFILES=T APPLY=WELLS
APPLY=FIELD'
```

XYFILTERING

Syntax:

```
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'XYFILTERING [optional parameters]'  
```

Description: Set filtering options for XY plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TYPEFILTER</td>
<td>= &lt;option, option, ... &gt;</td>
<td>Type filter - can select more</td>
</tr>
<tr>
<td></td>
<td></td>
<td>than one: WELLS, COMPLETIONS,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FIELD, AREAS, REGIONS, FLOWSTAT,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>QUALITYDATA, RFTDATA,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GATHERSTAT, AQUIFER, BLOCKDATA,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USERGROUPS, NODES,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONNECTIONS, CONNLIST, or OTHER.</td>
</tr>
<tr>
<td>ENTITYFILTER</td>
<td>= &lt;string, string&gt;</td>
<td>If further filtering is desired,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>this lists the entities (paired</td>
</tr>
<tr>
<td></td>
<td></td>
<td>entity name and entity number).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The entity number should be zero</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in most cases. If the entity</td>
</tr>
<tr>
<td></td>
<td></td>
<td>represents a well layer, the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>value represents the completion</td>
</tr>
<tr>
<td></td>
<td></td>
<td>number. If the entity is from an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RFT file, the number represents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the time step for that well name.</td>
</tr>
</tbody>
</table>

XYFREESTYLESETUP

Syntax:

```
$!ADDONCOMMAND
ADDONID = 'Tecplot RS'
COMMAND = 'XYFREESTYLESETUP PAGENUMBER = <integer>'
```

Description: Specifies the page number for the XY Freestyle plot.
XYSORTING

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAGENUMBER</td>
<td>&lt;integer&gt;</td>
<td>Specify the page number for the XY Freestyle plot.</td>
</tr>
</tbody>
</table>

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'XYSORTING [optional parameters]'  

Description: Set sorting options for entities in XY plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SORTTYPE</td>
<td>&lt;option&gt;</td>
<td>Sort type – BYNAME, BYTYPE, or BYVARIABLE.</td>
</tr>
<tr>
<td>SORTDIR</td>
<td>&lt;option&gt;</td>
<td>Sort direction - ASCENDING or DESCENDING</td>
</tr>
<tr>
<td>SORTVARIABLE</td>
<td>&lt;string&gt;</td>
<td>If sort type is by variable, the variable name on which sorting is performed.</td>
</tr>
</tbody>
</table>

Parameter Syntax Notes:

- ENTITY = <string>  Entity Name.
- XAXIS = <string>  Name of the variable assigned to the X-Axis.
- YAXIS = <string>  Name of the variable assigned to the Y-Axis.
- SUM = <boolean>  Set to True to sum the variable across all entities being plotted.
- AVERAGE = <boolean>  Set to True to display the average value for all selected entities.

XYSUBSETSETUP

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'XYSUBSETSETUP [optional parameters]'  

Description: Set options for XY Subset plots.

Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTITY</td>
<td>&lt;string&gt;</td>
<td>Entity Name.</td>
</tr>
<tr>
<td>XAXIS</td>
<td>&lt;string&gt;</td>
<td>Name of the variable assigned to the X-Axis.</td>
</tr>
<tr>
<td>YAXIS</td>
<td>&lt;string&gt;</td>
<td>Name of the variable assigned to the Y-Axis.</td>
</tr>
<tr>
<td>SUM</td>
<td>&lt;boolean&gt;</td>
<td>Set to True to sum the variable across all entities being plotted.</td>
</tr>
<tr>
<td>AVERAGE</td>
<td>&lt;boolean&gt;</td>
<td>Set to True to display the average value for all selected entities.</td>
</tr>
</tbody>
</table>

Parameter Syntax Notes:

XYVARIABLESSETUP

Syntax:

$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'XYVARIABLESSETUP [optional parameters]'  

Description: Set parameter options for XY VARIABLES plot.
Optional Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTITY</td>
<td>&lt;string,string&gt;</td>
<td>Paired entity name and entity number. The entity number will be zero in most cases. If the entity represents a well layer or completion, the value should be the completion number. If the entity is from an RFT file, the number represents the time step for that well name.</td>
</tr>
<tr>
<td>XAXIS</td>
<td>&lt;string&gt;</td>
<td>X-axis variable name.</td>
</tr>
<tr>
<td>YAXIS1</td>
<td>&lt;string,string,...&gt;</td>
<td>Y1-axis variable name(s).</td>
</tr>
<tr>
<td>YAXIS2</td>
<td>&lt;string,string,...&gt;</td>
<td>Y2-axis variable name(s).</td>
</tr>
<tr>
<td>YAXIS3</td>
<td>&lt;string,string,...&gt;</td>
<td>Y3-axis variable name(s).</td>
</tr>
<tr>
<td>YAXIS4</td>
<td>&lt;string,string,...&gt;</td>
<td>Y4-axis variable name(s).</td>
</tr>
<tr>
<td>YAXIS5</td>
<td>&lt;string,string,...&gt;</td>
<td>Y5-axis variable name(s).</td>
</tr>
<tr>
<td>COMPARE</td>
<td>&lt;boolean&gt;</td>
<td>Compare data sets.</td>
</tr>
<tr>
<td>DELTA</td>
<td>&lt;boolean&gt;</td>
<td>Show delta. Ignored if COMPARE=FALSE.</td>
</tr>
</tbody>
</table>

**SAVE TEMPLATE**

26 - 11.1 Template Macros

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'SAVE TEMPLATE FNAME= "<string>" '
```

**Description:** This command allows you to save a template to a file. Note, if you wish to save the template file in a folder other than your default template folder, call TEMPLATEFOLDER first to specify the folder location.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&quot;&lt;string&gt;&quot;</td>
<td>File name to use.</td>
</tr>
</tbody>
</table>

**LOAD TEMPLATE**

**Syntax:**

```
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'LOAD TEMPLATE FNAME= "<string>" '
```

**Description:** This command allows you to load a template file. Note, if you wish to load a template that is not in your default template folder, call TEMPLATEFOLDER first to specify the location of the folder containing the template.

**Required Parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FNAME</td>
<td>&quot;&lt;string&gt;&quot;</td>
<td>File name to load.</td>
</tr>
</tbody>
</table>
Syntax:

```
$!ADDONCOMMAND
ADDONID = 'TECPLOT RS'
COMMAND = 'TEMPLATEFOLDER NAME= "<string>"'
```

Description: This command allows you to specify the name of the template folder.

Required Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td><em>&quot;&lt;string&gt;&quot;</em></td>
<td>Template folder</td>
</tr>
</tbody>
</table>

### 26 - 12 Standard Options

#### <COLOROPTION>

The standard set of colors that can be specified in macro commands include:

- BLACK
- BLUE
- BROWN
- CREAM
- CYAN
- GOLD
- GRAY
- GREEN
- INDIGO
- LILAC
- LIME
- MAROON
- NAVY
- OLIVE
- ORANGE
- PINK
- PURPLE
- RED
- ROSE
- SAPPHIRE
- SILVER
- SKY
- TEAL
- VIOLET
- WHITE
- YELLOW

#### <FONTOPTION>

The fonts that can be specified in macro commands include:

- COURIER
- COURIERBOLD
- HELVETICA
- HELVETICABOLD
- TIMES
- TIMESBOLD
26 - 13 Deprecations

The following commands have been deprecated in Tecplot RS. Tecplot RS ignores deprecated commands, so that if the command occurs in an old macro, the macro is not disrupted.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Syntax</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>USE_RSMANAGERSETTING</td>
<td>bool</td>
<td>Was used to designate whether the Plot Options dialog controlled settings that could be adjusted by selecting &quot;Assign Axis Variables&quot; from the Plot menu. FALSE ignored the settings in the Plot Options dialog in favor of settings made in a now-obsolete Tecplot 360 dialog.</td>
</tr>
</tbody>
</table>
Customization

This section describes how you can use the Preferences dialog in the Options menu or, more technically, edit your configuration file, to customize aspects of your Tecplot RS sessions.

27 - 1 Performance Dialog

In the Performance dialog you can adjust the methods of Tecplot RS's image rendering and calculation. This can help optimize your workflow, especially when working with large data sets.

Use the Rendering page of the Performance dialog (accessed from the Options menu) to adjust the Plot Approximation, Graphics Cache, and Image Export Options. Use the Miscellaneous page of the Performance dialog (accessible from the Options menu) to adjust Data I/O, Load On Demand, Variable Derivation, and Status Information.
27 - 1.1 Rendering

The Rendering page of the Performance dialog has the following options:

- **Use Auto Redraw** When selected, Tecplot RS will automatically redraw the plot whenever style or data changes. Some users prefer to turn this option off while setting multiple style settings and then click the Redraw All button in the toolbar to see the updated plot.

  To interrupt an auto-redraw, click your pointer or press any key.

- **Subdivide all volume cells (to resolve saddle point issues)** Turn on this control to eliminate holes in iso-surfaces near saddle points. When turned on, all cells are subdivided for the purpose of contouring, slicing, and isosurface generation. This layout property applies to all frames and iso-surfaces.

- **Plot Approximation**
- **Graphics Cache**
- **High Quality Font Usage**
- **Image Export Options**

### Plot Approximation

- **Approximate Plots for Better Speed** When selected, Tecplot RS builds an approximate representation of the plot. The following settings control the degree of detail of the approximation:
  - **Automatic** (Default) When the number of data points exceeds the point threshold, Tecplot RS will render the approximate plot for style, data, and interactive view changes, followed immediately by the full plot. This option provides for good interactive performance with the final plot always displayed in the full representation.
  - **Non-Active Frames Always Approximated** When only one frame exists, this option acts the same as the automatic mode. When the plot contains multiple frames, Tecplot RS sets the active frame to automatic mode while approximating the other frames.
  - **All Frames Always Approximated** When the number of data points exceeds the point threshold, Tecplot RS renders the approximate plot in all frames. To see the full representation, click the Redraw All button in the toolbar.

- **Point Threshold for Automatic Approximation** This value controls when Tecplot RS will consider using approximate plots. The optimal value to use depends highly on the computer’s hardware capabilities.

- **Approximate Plot as % of Full Plot** This value controls the percentage of geometric detail represented by the approximate plot. The larger the percentage the more closely the approximation represents the original plot. However, the interactive performance is reduced. This number should be adjusted until there is a balance between good interactive performance and sufficient detail. Typically, the percentage should be set to be less than or equal to 50. If values larger than 50% are needed to provide sufficient detail, consider not using approximate plots.

### Graphics Cache

Tecplot RS uses OpenGL to render plots. OpenGL provides the ability to cache graphic instructions for rendering and can re-render the cached graphics much faster. This increases speed for interactive
manipulation of a plot. However, this performance potential comes at the cost of using more memory. If
the memory need is too high, the overall performance could be less.

Use one of the following Graphics Cache modes to optimize your computer’s performance:

- **Cache All Graphics** (Default) When selected, Tecplot RS assumes that there is enough
  memory to generate the graphics cache. If this is valid, Tecplot RS's rendering performance will
  be optimal for interactive manipulation of plots.

- **Cache Only Lightweight Graphics Objects** Lightweight objects include approximate plots
  and some other minor items, but do not include full plots. This is a good setting for memory
  constrained problems. Consider using this option in conjunction with the “Plot
  Approximation” mode set to “All Frames Always Approximated”.

- **Do Not Cache Graphics** Consider using this option when memory constraints are very
  limited. If you intend to interact with the plot, also consider setting the “Plot Approximation”
  mode set to “All Frames Always Approximated”.

In order to optimize animation, graphics caching is temporarily disabled during
animations that include zones, line mappings, time, or blanking elements. Graphics
 caching is not altered during animations that include slices, streamtraces, or iso-
surfaces.

**High Quality Font Usage**

Tecplot RS supports high quality TrueType font usage. Windows platforms include the TrueType fonts
used by Tecplot RS. On the Linux platforms, the fonts have to be obtained and installed.

Tecplot RS has three high quality font modes:

- **When Possible** (Default setting for Windows) Tecplot RS uses any of its TrueType fonts that
  are available for any size text. This produces the best rendering quality; however, performance
  is slower for large amounts of text.

- **For Large Characters Only** Tecplot RS uses the TrueType fonts for large characters only. Small
  characters will use Tecplot RS’s built-in stroke fonts. This is a good blend of quality and
  performance.

- **Never** Tecplot RS never uses TrueType fonts. This is the default mode for platforms other than
  Windows and Linux 32 bit operating systems.

**Image Export Options**

Some graphics cards’ hardware does not support off-screen rendering (needed for exporting images). In
addition, most graphic hardware produces images off-screen slower than on-screen.

To accommodate a variety of graphic hardware Tecplot RS provides two image export modes:

- **Safe (Render Image Off-Screen)** (Default) Tecplot RS will render all exported images off-
  screen. This allows creation of images not bound by the physical size and state of the Tecplot
  RS drawing area.

- **Fast (Use On-Screen Image)** Tecplot RS will grab the pixels from the physical Tecplot RS
  drawing area. Any rendering damage, such as occluding windows or partially drawn images
  will become part of the exported image. In addition, the image size is bound by the physical
  size of the Tecplot RS drawing area.
**Best Practices For Rendering Performance**

The factory settings in the Performance dialog are designed for moderately sized data and occasionally may need to be adjusted to optimize Tecplot RS’s rendering performance.

There are many combinations of Plot Approximation and Graphics Cache modes. However, two combinations meet most user’s needs:

- **When visualizing moderate to large size data sets:**
  - Toggle-on “Plot Approximation”
  - When using one frame, set the Plot Approximation mode to “Automatic” (Default).
  - When using multiple frames, set the Plot Approximation mode to “Non-Active Frames Always Approximated”.
  - Set the Graphics Cache mode to Cache All Graphics.

- **When visualizing large to very large size data:**
  - Set the Graphics Cache mode to “Cache only Lightweight Graphics Objects”.
  - For ordered data, setting the Plot Approximation mode to “All Frames Always Approximated” can be helpful.
  - For finite element data, toggle-off “Plot Approximation” to reduce up-front load time. However, this setting may result in unacceptably slow view changes (rotation, translation, zooming, etc.).

The size of the data isn’t the only factor when rendering in Tecplot RS. If your plot includes slices or iso-surfaces, you may also need to adjust your plot approximation mode and graphics cache settings.

With either case, adjust the “Approximate Plot as% of Full Plot” value to give an acceptable balance between interactive performance and plot detail.

**27 - 1.2 Miscellaneous**

The Miscellaneous page of the Performance dialog has the following controls:
Performance Dialog

Data I/O

Use Memory Mapped I/O When toggled-on, Tecplot RS will use system-level memory mapping functions to map Tecplot RS variables directly over block data in a binary data file. The advantage of mapping variable data is that Tecplot RS will only load the variable when it is first used. In addition, the mapped variable data can be shared between other Tecplot RS sessions running on the same machine. Memory mapped I/O is most useful when there is a large number of data points to load from a file and they are not all being used by Tecplot RS at the same time. Only variable data that is in a binary block format can be memory mapped.

Load On Demand

With load-on-demand activated, Tecplot RS generates plots faster and using less memory by only loading data that is needed for the plot. If changes to the plot style require additional variables to be loaded, Tecplot RS will automatically load them, and if necessary, unload variables that are no longer used. Tecplot RS’s ability to automatically load and unload variables on demand allows you to examine data that is much larger than the physical or virtual memory of your computer.

For large data sets, Tecplot RS will load only the zones and variables currently in use. However, for small data sets, Tecplot RS may load some other zones and variables for you (based on the Memory Threshold).

• Unload Strategy Use the Unload Strategy menu to specify how to manage unloading variables and other load-on-demand resources.
  • Auto Unload This strategy attempts to keep Tecplot RS’s memory use within the defined Min and Max Memory Thresholds. Tecplot RS uses these values to determine when and how much it should unload. This is the best option for exploring data as Tecplot RS only unloads if and when the memory threshold has been exceeded.
  • Minimize Memory Use This strategy is used if more aggressive unloading of variables and other load-on-demand resources is required. This option is best suited for animating through a very large number of time steps, where each time step consumes a significant part of the computer’s available physical and virtual memory.
  • Never Unload This strategy disables the unloading capability of load-on-demand while still preserving the ability to load variables on demand.

Most users should select either ”Auto Unload” or ”Minimize Memory Use” for best results.

• Memory Threshold (%) [Auto Unload ONLY] When Tecplot RS uses at least the maximum percentage of the available physical and virtual memory, it will attempt to unload variables and other load-on-demand resources until the available physical and virtual memory is at or below the specified minimum percentage.

Variable Derivation

When Tecplot RS needs to create a nodal variable from a cell centered variable, it uses a prescribed derivation method. Tecplot RS provides two such derivation methods: fast and accurate.

• Fast (Linear) When selected, Tecplot RS uses simple averaging to derive a nodal variable from a cell centered one.
• Accurate (Laplacian) When selected, Tecplot RS uses Laplacian interpolation to derive a nodal variable from a cell centered variable.
**Customization**

**Status Information**

Since the display of the status line in the Tecplot RS workspace requires memory usage, you can adjust the Status Line settings in this dialog to optimize your Tecplot RS experience. Use the following controls in the Status Information region of the Performance dialog to customize what Tecplot RS displays in the status line:

- **Show Status Line** Toggle this option on/off to control the display of status messages.
  
  If you are remotely displaying Tecplot RS on an X terminal, updating the status line can slow down processing. If this is the case, toggle-off the Show Status Line option.

- **Show Continuous State Messages** Toggle-on this option to receive context sensitive commentary in the Status Line.

- **Show Continuous Running Coordinates** Toggle-on this option to display the pointer's coordinates in the status line.

- **Show Tool Tips** Use this option to turn the display of tool tips on or off.

**27 - 2 Configuration Files**

A Tecplot configuration file is a special type of Tecplot macro file that Tecplot RS reads on start up. Use customized configuration files to override any or all of Tecplot RS’s factory default settings.

**27 - 2.1 Loading Configuration Files in Tecplot RS**

Tecplot RS looks for configuration files (named `tecplot.cfg`) in one of three places: the current working directory, the user’s home directory, and the Tecplot RS installation folder. Tecplot RS looks for the configuration file (in the respective order listed above) and uses the first configuration file found.

If you want to force Tecplot RS to load a specific configuration file (instead of one of the standard files named above), you can use the `-c` command line option when starting Tecplot RS.

System administrators can use the `tecplot.cfg` file in the Tecplot RS installation folder to set system-wide defaults, then others on the system can copy the system configuration file to their own installation folders and make any desired changes. Tecplot RS will use the settings in your local configuration file instead of the settings in the system configuration file.

A configuration file needs to include only those options for which you want to override defaults.

Tecplot RS on Linux platforms has a second type of configuration file: an X11 resource file (app-defaults file) that controls the appearance of the Tecplot RS application and its dialogs. Most users do not need to concern themselves with this file; nothing in the resource file has any effect on the plots you create with Tecplot RS, either on screen or on paper. However, if you are an experienced Linux and X11 user, you may want to modify some of the resources to improve the appearance of Tecplot RS’s windows and dialogs on your display. Section 27 - 3 “Interface Configuration (Linux)” explains how to do this.
27 - 2.2 Configuration File Creation

The simplest way to customize a configuration file is to edit settings in the default tecplot.cfg file present in your Tecplot RS installation folder.

27 - 2.3 Editing the Configuration File

You are not limited to customizing only those settings that appear in the default configuration file. Most settings that can be modified by the $Field, $LineMap, or $Interface macro commands can be changed in the configuration file directly. You can use the $Limits macro command in the configuration file only.

The simplest way to do this is to create and save a project or macro with the settings you want, and then copy and paste the appropriate commands from your project (.rsprj) or macro (.mcr) file into your configuration file. See the Tecplot 360 Scripting Guide (accessible on the Tecplot Web site) for complete details on macro commands.

SetValue Commands

SetValue Commands are macro commands used to specify the value of a given plot attribute. You can add SetValue commands to your tecplot.cfg file to override any of Tecplot RS’s default settings. For example, suppose you want your 2D axes to appear cyan. You can add this preference to your configuration file as follows:

1. Using the Tecplot RS interface, create a 2D plot with cyan axes while either recording your steps as a macro, or saving the result as a Tecplot RS project.
2. Open the resulting macro or project with a text editor, and scan for the lines that set the 2D axis colors. The following example shows the commands that specify the X- and Y-axis details in a 2D grid plot with cyan axes:

   `$TWODAXIS XDETAIL{RANGEMIN = -3}
   `$TWODAXIS XDETAIL{RANGEMAX = 15}
   `$TWODAXIS XDETAIL{GRIDLINES{SHOW=YES}}
   `$TWODAXIS XDETAIL{GRIDLINES{COLOR = CYAN}}
   `$TWODAXIS YDETAIL{GRIDLINES{SHOW = YES}}
   `$TWODAXIS YDETAIL{GRIDLINES{COLOR = CYAN}}
   `$TWODAXIS XDETAIL{GRIDLINES{COLOR = CYAN}}
   `$TWODAXIS YDETAIL{GRIDLINES{COLOR = CYAN}}

3. Discard everything but the lines that actually set the color:

   `$TWODAXIS YDETAIL{GRIDLINES{COLOR = CYAN}}
   `$TWODAXIS YDETAIL{GRIDLINES{COLOR = CYAN}}

4. Paste the resulting lines into your configuration file.

Plot Default Setting - FIELDMAP and LINEMAP

You can include a single $FIELDMAP command to set plot defaults. You cannot specify the zone in the configuration file, and the command is not effective for values set dynamically by Tecplot RS, such as Mesh Color. In the example below, the default contour type is Flood, scatter symbol shape is Delta, and scatter size is 1.8.

`$FIELDMAP CONTOUR{CONTOURTYPE = FLOOD}
`$FIELDMAP SCATTER{SYMBOLSHAPE{GEOMSHAPE = DEL}}
`$FIELDMAP SCATTER{FRAMESIZE = 1.8}`
Customization

In the same way as above, you can add a single $!LINEMAP command for line mapping defaults. In the example below, XY and Polar Line mappings will have a dashed line pattern, and symbols will be filled circles.

$!LINEMAP LINES{LINEPATTERN = DASHED}
$!LINEMAP LINES{LINEPATTERN = SOLID}
$!LINEMAP LINES{LINEPATTERN = SOLID}
$!LINEMAP LINES{LINEPATTERN = SOLID}
$!LINEMAP LINES{LINEPATTERN = SOLID}
$!LINEMAP SYMBOLS{SYMBOLSHAPE{GEOMSHAPE = CIRCLE}}
$!LINEMAP SYMBOLS{SYMBOLSHAPE{GEOMSHAPE = CIRCLE}}
$!LINEMAP SYMBOLS{SYMBOLSHAPE{GEOMSHAPE = CIRCLE}}
$!LINEMAP SYMBOLS{SYMBOLSHAPE{GEOMSHAPE = CIRCLE}}
$!LINEMAP SYMBOLS{SYMBOLSHAPE{GEOMSHAPE = CIRCLE}}

Override Automatic View > Fit Everything

When loading a plot, Tecplot RS automatically fits all 3D surfaces, data points, text, and geometries to the frame. To revert to the old Tecplot RS behavior, add the following line to your tecplot.cfg file:

$!FrameSetup Initial3DScale = 0.7

Interface Configuration

The many members of the $!INTERFACE macro help you configure Tecplot RS’s user interface and graphics drawing capabilities. Although some of these commands can be executed in any Tecplot RS macro, the best place to put these is in the Tecplot RS configuration file: tecplot.cfg. Below are a few examples. Refer to the Tecplot 360 Scripting Guide for a complete listing.

General Interface Configuration Options

$!INTERFACE followed by:

- MOUSEACTIONS {MIDDLEBUTTON {SIMPLEDRAG=ZOOMDATA}} Specify the action of the middle pointer button dragging. The Tecplot 360 Scripting Guide (available on the Tecplot Web site) lists several other options for the middle and right pointer buttons. Tecplot RS can execute these commands only from the configuration file.
- UNIXHELPBROWSERCMD = string Specify the default browser for viewing the Help files (Linux platforms only). This command can only be executed from the Tecplot RS configuration file.
- SHOWWAITDIALOGS = (YES, NO) Disable the launch and display of all Wait dialogs by setting this to NO. (Wait dialogs are launched during long operations and give you the ability to cancel the operation.) This is useful on some Linux systems where transient dialogs do not drop properly, leaving a gray box that obscures part of Tecplot RS’s drawing area.
- USESTROKEFONTSFOR3DTEXT = (YES, NO) If set to YES, Tecplot RS draws all 3D text in the work area using internal stroke fonts. If set to NO, the native True Type fonts will be used instead. This option has no effect on Linux platforms.
- USESTROKEFONTSFORTDTEXT = (YES, NO) If set to YES, Tecplot RS draws all 3D text in the work area using internal stroke fonts. 3D text consists of ASCII scatter symbols and node and cell labels when the active plot type is 3D Grid. For 3D text, this setting overrides the setting of USESTROKEFONTSFOR3DTEXT. If set to NO, Tecplot RS uses the native True Type fonts instead. This option has no effect on Linux platforms.

OpenGL-Specific Configuration Options

Several options are available to further tune Tecplot RS to operate with the OpenGL capabilities of your platform. To assign values to these parameters you must use the $!INTERFACE OPENGLCONFIG command. The Tecplot 360 Scripting Guide includes a complete list of these options.

$!INTERFACE OPENGLCONFIG followed by:
• \{ALLOWHWACCELERATION = (YES, NO)} In some cases, bugs in OpenGL drivers cause problems in Tecplot RS. In these situations, Tecplot RS will typically behave better if this option is set to NO. However, Tecplot RS will also run slower.

• \{SCREENRENDERING \{DOEXTRADRAWFORLASTPIXEL = (YES, NO)} Some OpenGL implementations use an optimization for line drawing that omits the last pixel in the line. Set this to YES to change all line drawing to force the last pixel to be drawn. This setting applies only to drawing on the screen.

• \{SCREENRENDERING \{STIPPLEALLLINES = (ALL, CRITICAL, NONE)} Set to ALL to make all lines drawn using stippling. Set to CRITICAL to use stippling for stroke and user-defined fonts. Set to NONE to disable stippling. This setting applies only to drawing on the screen.

• \{IMAGERENDERING \{DOEXTRADRAWFORLASTPIXEL = (YES, NO)} Some OpenGL implementations use an optimization for line drawing that omits the last pixel in the line. Set this to YES to change all line drawing to force the last pixel to be drawn. This setting applies only to exporting images from Tecplot RS.

• \{IMAGERENDERING \{STIPPLEALLLINES = (ALL, CRITICAL, NONE)} Set to ALL to make all lines drawn using stippling. Set to CRITICAL to use stippling for stroke and user-defined fonts. Set to NONE to disable stippling. This setting applies to exporting images from Tecplot RS.

27 - 2.4 Default File Name Extensions
You can also change the default extensions for file names in file input-output dialogs in the configuration file. To change these settings, use the $\!\text{FNAMEFILTER}$ sub-command in the $\!\text{FILECONFIG}$ macro command.

\$\!\text{FILECONFIG \ FNAMEFILTER}$ followed by:

- $\text{COLORMAPFILE} = \text{<string>}$ Specifies the default extension for color map files.
- $\text{INPUTDATAFILE} = \text{<string>}$ Specifies the default extension for input data files.
- $\text{OUTPUTASCIIADATAFILE} = \text{<string>}$ Specifies the default extension for ASCII output files.
- $\text{OUTPUTBINARYDATAFILE} = \text{<string>}$ Specifies the default extension for binary output files.
- $\text{STYLEFILE} = \text{<string>}$ Specifies the default extension for stylesheet files.
- $\text{MACROFILE} = \text{<string>}$ Specifies the default extension for macro files.
- $\text{EQUATIONFILE} = \text{<string>}$ Specifies the default extension for equation files.

For example, to change the default extension for input data files to be .tbl use:

\$\!\text{FILECONFIG \ FNAMEFILTER \ \{INPUTDATAFILE = "*.tbl" \} \}$

27 - 2.5 Default Temporary Directory
Tecplot RS writes out a number of temporary files. To customize where Tecplot RS places these files, add the following macro command to the tecplot.cfg file:

\$\!\text{FILECONFIG \ TEMPFILEPATH = "tempfilepath" \}$

where tempfilepath represents the new path. The default path is system dependent.

27 - 3 Interface Configuration (Linux)
On Linux platforms, the style of the graphical user interface for Tecplot RS is configured, for the most part, by a resource file called TecplotRS, which resides in the app-defaults folder below the Tecplot RS installation folder. If you edit this file, the changes will affect all users. Alternatively, if you want the changes to apply only to your own execution of Tecplot RS, you can add entries to a file called .Xdefaults, which resides in your own $HOME directory. If the file .Xdefaults does not already exist in your home directory, you can create one.
Customization

27 - 3.1 Default Size of Tecplot RS

The resource lines that affect the default Tecplot RS process window size are:

*Tecplot.main_dialog.width: 900
*Tecplot.main_dialog.height: 720

Changing either the value 900 or the value 720 will change the default size of the Tecplot RS process window.

27 - 4 Custom Character and Symbol Definition

When Tecplot RS launches, it reads the font file (tecplot.fnt). This file contains information that defines the appearance of text characters on the screen. Tecplot RS defines and draws characters on the screen as a set of straight lines called strokes. These stroked characters approximate the appearance of characters for the screen.

The font file is an ASCII file. You can modify the shape, size, and resolution of existing stroke font characters or add completely new ones. In PostScript print files, text characters are generated using PostScript defined fonts, not the stroked fonts. If you are using the Windows version of Tecplot RS and the Windows print drivers are active, then all text except text using the User-Defined fonts is serviced by the Windows printer driver. However, the text characters in bitmap export files are in stroked fonts (since they are generated from the screen). The inter-character spacing in all output files is determined by the character-width definitions in the font file. When using PostScript print files or the Windows print drivers, changing the font commands affects only the character shape for User-Defined fonts and the character spacing for all fonts.

The Font File is structured as follows:

```
#FF 4
CharCellHeight
Stroke command set for Helvetica Font
Stroke command set for Greek Font
Stroke command set for Math Font
Stroke command set for User-Defined Font
Stroke command set for Times Font
Stroke command set for Times Italic Font
Stroke command set for Courier Font
```

The file type and version are on the first line ("FF" refers to Font File). CharCellHeight is the interline spacing (the height of a capital M plus some vertical space) in the units of a two-dimensional coordinate system used to define the stroke-font characters. The baseline of the characters is at zero. Before Tecplot RS uses the character definitions, they are normalized by the character cell height.

Following the character cell height, there are seven sets of stroke commands, one set for each font as shown above. Each stroke command set consists of definitions for the characters in the font. Each font has a base set of 96 characters (character indexes 32 to 127). Some fonts also include an extended set of characters (character indexes 160 to 255). The extended characters are needed to complete the character sets for most of the common European languages.

All seven stroke command sets must be present, and each must have at least one character defined. Each stroke command set begins with the definition for a space (character index 32). After that, characters within a stroke command set can be defined in any order. If a character is not defined in the Font File, it is drawn as a blank.
Each character in a stroke command set is defined as follows:

<table>
<thead>
<tr>
<th>CharIndex</th>
<th>NumCommands</th>
<th>CharWidth</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CommandN</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CharIndex is the character index that ranges from 32 to 127 and 160 to 255 for each font (see “Custom Characters” on page 365 for the matching of the character index to the English, Greek, Math, and standard User-Defined font characters). NumCommands is the number of stroke commands defining the character that follows. CharWidth is the character width, which determines the spacing of the characters.

A command may exist in one of the following forms:

- m x y.
- d x y.
- mr dx dy.
- dr dx dy.

Where:

- A command that begins with an m is a move command.
- A command that begins with a d is a draw command.
- Commands mr and dr are relative move and relative draw commands.
- The x and y are the absolute coordinates within the character cell.
- The dx and dy are the relative coordinates with respect to the previous location (increments from the position attained by the previous command).
- All coordinates are specified as integers.
Customization

Figure 27-4 shows an example of a character cell and the commands used to define the lowercase letter "y". The height of the character cell is 48.

Figure 27-5 shows a symbol being defined. Symbols should be centered about (0, 0) so that they are centered about the point they mark. The font file included with Tecplot RS contains many User-Defined font stroke commands. Most of these are for creating extra plotting symbols, accessible when you use the Symbol Type "Other", enter an ASCII character, and specify the User-Defined font.

Figure 27-5. Defining a user-defined plotting symbol.
Part 6 Appendixes
Glossary

The following table defines terms used frequently in the Tecplot RS User's Manual for your reference and convenience. A general understanding of these concepts will help you understand Tecplot RS.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Grid</td>
<td>2D Grid Plots are plots with two dimensions that display one plane (layer) of grid cells at a time. You can choose which planes to plot by specifying both the view (( I ), ( J ), or ( K )) and the plane index. Radial grids also have the option of displaying the views at constant ( R ) or ( \Theta ) values.</td>
</tr>
<tr>
<td>3D Grid</td>
<td>3D Grid Plots show the entire reservoir grid in three dimensions, in an orthogonal or perspective view. The initial orientation of the view is preset, but the view is easily rotated, zoomed, or translated interactively.</td>
</tr>
<tr>
<td>Active Data Set</td>
<td>When you load multiple files, only one of the files is considered to be the active data set. The active data set displays by default in all plots and determines which entities and variables appear in the selection lists. It is also the data set to which the others are compared. The active data set displays highlighted in the Manage Data dialog.</td>
</tr>
<tr>
<td>Anchor Point</td>
<td>The fixed point of an object on the plot (such as a specific corner of an inserted geometry).</td>
</tr>
<tr>
<td>Antialiasing</td>
<td>The process of removing or reducing the jagged distortions in curves and diagonal lines.</td>
</tr>
<tr>
<td>Arbitrary Slice</td>
<td>An arbitrary slice cuts through the 3D Grid along any plane. The slice can span the grid or be clipped to selected cells.</td>
</tr>
<tr>
<td>ASCII Text File</td>
<td>A text file composed of code representing English characters as numbers, where each letter is assigned a number from 0 to 127.</td>
</tr>
<tr>
<td>Blanking</td>
<td>A feature of Tecplot RS that excludes certain cells and points from a plot. Tecplot RS includes two types of blanking: Cell Value Blanking and Pick blanking.</td>
</tr>
<tr>
<td>Branches</td>
<td>For a multi-lateral well, branches are the extensions of the well that branch off from the main well stem. Branches are usually made of multiple segments.</td>
</tr>
<tr>
<td>Cell</td>
<td>The space containing one increment of each index of ( IJK ) or ( IJK )-ordered data.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cell Value Blanking</td>
<td>A method of value blanking that enables turning on or off individual drawing elements (usually cells) according to the values of selected constraint variables.</td>
</tr>
<tr>
<td>Cell-Centered Values</td>
<td>Values located at the center of the cell (assumed to be the centroid).</td>
</tr>
<tr>
<td>Color Map</td>
<td>A color spectrum used to plot contour flooding and multi-colored objects.</td>
</tr>
<tr>
<td>Completion</td>
<td>A node along a well path where a reservoir fluid is produced or injected. The nodes are defined at cell centers.</td>
</tr>
<tr>
<td>Completion Profile</td>
<td>A horizontal bar chart that provides the contribution of each completion, usually for a production variable.</td>
</tr>
<tr>
<td>Configuration File</td>
<td>A file containing initial Tecplot RS defaults.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>The line segments that connect completions to form the well path.</td>
</tr>
<tr>
<td>Continuous Contour Flood-</td>
<td>A type of color display representing a variable in which Tecplot RS assigns a color to each point in a mesh, based on the contour variable and color map. Tecplot RS fills each face with colors interpolated between the corner nodes, resulting in a smooth variation of color over the surface.</td>
</tr>
<tr>
<td>Contour</td>
<td>A field plot type that plots iso-valued lines, or color flooding based on the values of a specified variable.</td>
</tr>
<tr>
<td>Coordinate</td>
<td>Any of a set of numbers used in specifying the location of a point on a plot.</td>
</tr>
<tr>
<td>Data File</td>
<td>A file that contains data used for plotting in Tecplot RS.</td>
</tr>
<tr>
<td>Data Point</td>
<td>A location with X, Y, and Z coordinates at which field variables are defined.</td>
</tr>
<tr>
<td>Data Set</td>
<td>A set of data for one or more entities or grids.</td>
</tr>
<tr>
<td>Delta File</td>
<td>A delta file contains the difference values between two different solution files with the same grid.</td>
</tr>
<tr>
<td>Dependent</td>
<td>An axis mode requiring the axes to maintain a fixed ratio to one another.</td>
</tr>
<tr>
<td>Depth</td>
<td>For image export, the number of bits stored per pixel.</td>
</tr>
<tr>
<td>Derived Object</td>
<td>A graphic object visible in the plot and created from data; for example, an iso-surface, a slice, or a streamtrace.</td>
</tr>
<tr>
<td>Dynamic Text</td>
<td>Special placeholders added to text that change with the data or display environment to give a description of the data or display environment.</td>
</tr>
<tr>
<td>Entity</td>
<td>A data structure such as well completion, group, region and field. Each entity may have its own set of variables.</td>
</tr>
<tr>
<td>Error Bars</td>
<td>An XY line setting in which a second dependent variable (error) can appear in a plot to show the accuracy range of the first dependent variable.</td>
</tr>
<tr>
<td>Filtering</td>
<td>The filtering option allows you to select entities based on criteria such as entity type, name or variable value. When filtering is in use, only the entities that meet the criteria in the Filtering dialog will be available for your plot.</td>
</tr>
<tr>
<td>Flow Tables</td>
<td>Flow tables contain an N-dimensional array of bottom hole pressure (BHP) values plotted for N-independent variables. Flow table plots are created from one or more Chears .flt files.</td>
</tr>
<tr>
<td><strong>Font Modifier</strong></td>
<td>The modifier used to embed Greek, Math, or User-Defined characters in a text box.</td>
</tr>
<tr>
<td><strong>Frame</strong></td>
<td>Area within the workspace in which you can create sketches and plots.</td>
</tr>
<tr>
<td><strong>Frame Coordinate System</strong></td>
<td>Coordinate system fixed to the frame that does not change when the plot is zoomed, translated, or rotated.</td>
</tr>
<tr>
<td><strong>Ghost</strong></td>
<td>The Ghost switch allows you to see a transparent view of the entire grid. Use the Grids page of the Plot Options dialog to select Ghost options.</td>
</tr>
<tr>
<td><strong>Gouraud Shading</strong></td>
<td>Shading used to achieve smooth lighting on low-polygon surfaces by linearly interpolating a color or shade across a polygon.</td>
</tr>
<tr>
<td><strong>Grid Area</strong></td>
<td>One or more rectangular regions defined and bounded by the grid axes.</td>
</tr>
<tr>
<td><strong>Grid Axes</strong></td>
<td>An axis option which displays the coordinates of the grid along the various spatial dimensions.</td>
</tr>
<tr>
<td><strong>Grid Coordinate System</strong></td>
<td>A coordinate system that consists of two dimensions of physical coordinates aligned with the coordinate system and used by the plot axes.</td>
</tr>
<tr>
<td><strong>Gridline</strong></td>
<td>A set of lines drawn from one or more axes that extend from the markers on an axis across the grid area.</td>
</tr>
<tr>
<td><strong>Grid Point</strong></td>
<td>In 2D, the intersection of gridlines.</td>
</tr>
<tr>
<td><strong>IJK Blanking</strong></td>
<td>IJK Blanking is an inside view option for 3D Grid plots. It allows you to remove range of I, J and/or K values from your plot.</td>
</tr>
<tr>
<td><strong>I-Ordered</strong></td>
<td>A type of data point ordering in which each point is listed one at a time (that is, by one index). Used mainly in XY plots. In 2D or 3D, this type of data point ordering is sometimes called irregular, and is only useful for scatter plots, or for interpolating and triangulating into 2D or 3D surfaces, or 3D volumes.</td>
</tr>
<tr>
<td><strong>IJ-Ordered</strong></td>
<td>A type of data point ordering in which the points are arranged in an array used for 2D and 3D surface plotting.</td>
</tr>
<tr>
<td><strong>IJK Blanking</strong></td>
<td>A feature to include or exclude portions of an IJK-ordered zone based on index range.</td>
</tr>
<tr>
<td><strong>IJK-Ordered</strong></td>
<td>A type of data ordering where the points are arranged in a 3D array. Used for 3D volume plotting as well as 2D and 3D surface plotting.</td>
</tr>
<tr>
<td><strong>IJK Slice</strong></td>
<td>IJK Slice is an inside view option for 3D Grid plots. The IJK Slice option allows you to plot a range of indexes for a given plane (for example, the I plane) and then plots the entire range of values in the other two directions (for example, the J and K planes).</td>
</tr>
<tr>
<td><strong>Image Format</strong></td>
<td>Any of the raster or bit-mapped graphic formats supported by Tecplot RS.</td>
</tr>
<tr>
<td><strong>Independent</strong></td>
<td>An axis mode allowing each axis to have a range not affected by the ranges of any other axis or axes.</td>
</tr>
<tr>
<td><strong>Inside Views</strong></td>
<td>The Inside Views options are available in the 3D Grid plot sidebar. They allow you to quickly display subsets of your grid data.</td>
</tr>
<tr>
<td><strong>Internal Macro Variable</strong></td>
<td>A read-only macro variable which allows access to certain key values in Tecplot RS. For example, $NUMVARS gives the number of variables.</td>
</tr>
<tr>
<td><strong>Interpolate</strong></td>
<td>To assign new values for the variables at data points in one zone based on the data point values in another zone (or set of zones).</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Interpolate Mode</td>
<td>When probing is activated using a single click, Tecplot RS returns a value linearly interpolated from all nodes in the cell.</td>
</tr>
<tr>
<td>I-Plane</td>
<td>In an ordered zone, the connected surface of all points with a constant I index. In reality, I-planes can be cylinders, spheres, or any other shape.</td>
</tr>
<tr>
<td>Irregular Data</td>
<td>Points which contain no order, or at least no order which can be easily converted to IJK or IJK-ordering.</td>
</tr>
<tr>
<td>Iso-surface</td>
<td>An inside view option for 3D Grid plots. It allows you to create one or two surfaces of a given variable. Each surface represents a constant value for the variable.</td>
</tr>
<tr>
<td>J-Plane</td>
<td>In an ordered zone, the connected surface of all points with a constant J index. In reality, J-planes can be cylinders, spheres, or any other shape.</td>
</tr>
<tr>
<td>K-Plane</td>
<td>In an ordered zone, the connected surface of all points with a constant K index. In reality, J-planes can be cylinders, spheres, or any other shape.</td>
</tr>
<tr>
<td>Line Map</td>
<td>A set of points where one variable is assigned to an independent axis and another is assigned to a dependent axis. You can define many line maps for an XY plot.</td>
</tr>
<tr>
<td>Macro</td>
<td>A file containing a list of instructions, called macro commands, which can duplicate virtually any action performed in Tecplot software.</td>
</tr>
<tr>
<td>Macro Command</td>
<td>An instruction given to Tecplot RS in a macro file. Macro commands always start with a dollar sign and then an exclamation mark. For example, $!Redraw refreshes a plot view.</td>
</tr>
<tr>
<td>Macro File</td>
<td>A file which contains a series of macro commands. Macro files are run from the command line, or by choosing “Play Macro” from the Macro menu.</td>
</tr>
<tr>
<td>Macro Function</td>
<td>A self-contained macro sub-routine.</td>
</tr>
<tr>
<td>Macro Variable</td>
<td>A holding place for numeric values in a macro file. There are two types of macro variables: user-defined (you set and retrieve the value), or internal (Tecplot RS sets the value and you can retrieve it).</td>
</tr>
<tr>
<td>Menu bar</td>
<td>The top bar of the Tecplot RS workspace that contains all menu items for selection.</td>
</tr>
<tr>
<td>Mesh</td>
<td>A 2D or 3D plot layer which plots connections between data points.</td>
</tr>
<tr>
<td>Multi-Colored</td>
<td>Any Tecplot RS object colored by the value of the contour variable. Multi-colored objects may include mesh, scatter symbols, vectors, contour lines, and streamtraces.</td>
</tr>
<tr>
<td>Nearest Point Mode</td>
<td>When probing is activated by a Ctrl-click, Tecplot RS returns the value of the nearest point, which can be an interpolation.</td>
</tr>
<tr>
<td>Number Format</td>
<td>The style of numbers to display for a data or axis label; exponent, integer, float, and so on.</td>
</tr>
<tr>
<td>OpenGL</td>
<td>A graphics library for high-end 3D graphics. It commonly takes advantage of hardware acceleration for 3D rendering.</td>
</tr>
<tr>
<td>Ordered Data</td>
<td>A type of data point organization which consists of a parameterized series of points. Tecplot RS recognizes seven types of ordered data: I, J, K, IJ, JK, IK, and IJK-ordered. I, J, and IJK-ordered are the most common.</td>
</tr>
<tr>
<td>Paper Layout</td>
<td>The Paper Layout functions let you define a “template” for your plots. This template controls a variety of items needed to create a professional, finished presentation plot, including: paper size, headers &amp; footers, and titles.</td>
</tr>
<tr>
<td>Pick</td>
<td>Select an item in the plot area by clicking on it with the pointer tool.</td>
</tr>
<tr>
<td>Pick Blanking</td>
<td>Pick Blanking allows you to interactively remove a cell or group of cells from your plot.</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Plot Type</td>
<td>Determines the type of plot (and plot settings) displayed in the Tecplot RS workspace, as well as the accompanying sidebar type. Tecplot RS plot types include various XY plot types, 2D and 3D grid plot types, and several specialty plot types.</td>
</tr>
<tr>
<td>Polyline</td>
<td>A continuous line composed of one or more line segments.</td>
</tr>
<tr>
<td>Probe</td>
<td>To obtain variable values by specified position in a plot by clicking on that point in the data region.</td>
</tr>
<tr>
<td>Project File</td>
<td>A specialized macro file with the extension .rsprj that preserves a plot created within Tecplot RS, thus enabling the loading and unloading of a set of files simultaneously. When the project file is opened, it restores Tecplot RS to the state it was in when the project file was saved. The project file can include any of the following file types: Custom files, Style files, and Paper Layout Template files (.rsc, .rsstyx, and .rslayx, respectively). The project file will also include the solution files associated with any active grid file. The file includes a section with instructions for recreating XY Freestyle plot types.</td>
</tr>
<tr>
<td>Property Modifier</td>
<td>Use the Property Modifier function to create an ASCII file to use as input into reservoir simulation programs to modify properties within the simulator.</td>
</tr>
<tr>
<td>Push</td>
<td>Send selected geometries or text behind other plot elements.</td>
</tr>
<tr>
<td>2D Plane in 3D View</td>
<td>2D Plane in 3D View plots allow you to display a 3D view of your current 2D Grid Plots.</td>
</tr>
<tr>
<td>Depth</td>
<td>A Depth plot adds an RFT plot next to your current grid plot. The values displayed in the RFT plot depend on the selected cell in the grid plot. To alter the RFT plot settings, switch your plot type to XY Variables.</td>
</tr>
<tr>
<td>Time/History</td>
<td>An Time/History plot adds an XY Variable plot next to your current grid plot. The values displayed in the XY plot depend on the selected cell or well and time in the grid plot.</td>
</tr>
<tr>
<td>Rake</td>
<td>A specified line from which two or more streamtraces are generated.</td>
</tr>
<tr>
<td>Selection Set</td>
<td>Selection sets are user-defined groups of entities that are used for filtering purposes. They can also be used to create a User Group.</td>
</tr>
<tr>
<td>Shading</td>
<td>A 2D or 3D grid plot layer which plots solid color or colors with lighting effect over the cells of the data.</td>
</tr>
<tr>
<td>Sidebar</td>
<td>The bar of plot settings accessible at all times without opening a dialog (except when turned off in the View menu).</td>
</tr>
<tr>
<td>Slice</td>
<td>A set of data created by the intersection of a plane with 3D data.</td>
</tr>
<tr>
<td>Sort</td>
<td>A measurement from one to two of the amount of work Tecplot RS should do to resolve hidden-surface problems during 3D sorting, such as for image export. Chosing “2” will increase the time required for each redraw and will generate messages about the number of cells with a potential conflict.</td>
</tr>
<tr>
<td>Status Line</td>
<td>The bar located at the bottom of the Tecplot RS workspace which provides hover help for tools, and includes a progress bar for lengthy calculations.</td>
</tr>
<tr>
<td>Style Set</td>
<td>When comparing files, use the Style Set options on the XY Lines page of the Plot Options dialog to define different colors and/or patterns for the comparison data sets.</td>
</tr>
</tbody>
</table>
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Supersampling Factor</strong></td>
<td>When antialiasing an image for export, the factor Tecplot RS uses when creating an intermediate image that it then resizes down to the final image size. The larger the value, the smoother the resulting image, at the cost of speed. Values of more than 3 are seldom necessary.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>The bar of tools that appears by default at the top of the Tecplot RS workspace. These tools follow the main workflow steps typical of Tecplot RS users.</td>
</tr>
<tr>
<td><strong>Transient Data</strong></td>
<td>Data that has a time component in addition to one or more spatial component(s).</td>
</tr>
<tr>
<td><strong>Translucency</strong></td>
<td>A property allowing you to see through an object to areas within or beyond it.</td>
</tr>
<tr>
<td><strong>Unordered or Unorganized Data</strong></td>
<td>(See Irregular Data.)</td>
</tr>
<tr>
<td><strong>User Group</strong></td>
<td>A user group is a user created entity where the variable values are calculated from two or more wells. The wells are specified by a Selection Set.</td>
</tr>
<tr>
<td><strong>Variable</strong></td>
<td>One of the values defined at every data point in a data set or data file.</td>
</tr>
<tr>
<td><strong>Well Blanking</strong></td>
<td>Well Blanking allows you to display only the cells that include a well path.</td>
</tr>
<tr>
<td><strong>Workspace</strong></td>
<td>The portion of your screen in which you can create Tecplot RS frames and work with data. This includes but is not limited to the region covered by the displayed paper.</td>
</tr>
<tr>
<td><strong>XY Custom Entities</strong></td>
<td>The XY Custom Entities plot type allows you to plot multiple entities on the same plot with a user-specified x and y-axis variable.</td>
</tr>
<tr>
<td><strong>XY-Dependent</strong></td>
<td>A 3D axis mode in which X and Y are fixed (dependent), and Z varies freely in ratio (independently).</td>
</tr>
<tr>
<td><strong>XY Entities</strong></td>
<td>XY Entity plots depict an entity or group of entities plotted for single XY axes variable pair.</td>
</tr>
<tr>
<td><strong>XY Freestyle</strong></td>
<td>XY Freestyle plots allow you to manually specify the components of your plot.</td>
</tr>
<tr>
<td><strong>XY Subsets</strong></td>
<td>XY Subset plots allow you to view all of the components of a single well, user group or branch at one time (for a single variable).</td>
</tr>
<tr>
<td><strong>XY Variables</strong></td>
<td>XY variable plots depict a single X-axis (independent) variable with up to five Y-axis (dependent) variables. Tecplot RS applies the axis variable selections to all entities.</td>
</tr>
</tbody>
</table>
Equation Reference

Tecplot RS allows you to use equations to create new variables in both XY and Grid data. The equation syntax is identical for both and is documented here. The dialog you use to enter and edit equations contains buttons to help enter equations, or you can simply type the equation if you are familiar with the syntax. For more information on the two types of equations, see:

- Chapter 8: “XY Equations”
- Section 17-2 “Grid Equations”

B - 1 Equation Syntax

Equations take the form of an assignment of a value to a variable. The variable in which the value will be stored is stated first, followed by an = sign, followed by an expression. The expression to the right of the = sign may be a mix of operations (addition, subtraction, etc.) and calls to built-in functions. For example:

\[ \text{GOR} = \frac{\text{GPR}}{\text{OPR}} \]

This equation defines a new variable named GOR as the ratio between the gas production rate and the oil production rate.

You can also include constants in your calculations:

\[ \text{ACT} = 100.0 \times \frac{\text{WPR}}{\left(\text{WPR} + \text{OPR}\right)} \]

Note the use of parentheses in this example to force the \( \text{WPR} + \text{OPR} \) portion of the equation to be evaluated before the division.

If the variable specified to hold the result already exists in the loaded data set, Tecplot RS uses the equation to modify that variable. If the variable does not already exist, Tecplot RS uses the equation to create a new variable as a function of existing variable(s) or value(s).

As shown, variable names must be enclosed in braces: \{...\}. They are not case-sensitive. You can include any number of spaces within the equation, but do not include any spaces between the letters of built-in function names or inside variable names.
B - 1.1 Specifying Grid Names in Equations
For any Grid equation, one or more grid names may be optionally specified before the equation. If one or
more grid names are provided, the equation will be applied only to the indicated grids. If no grid names
are provided, the equation will be applied to all grids.

The grid name(s) are specified in a comma separated list enclosed in angle brackets followed by a single
colon, followed by the equation:

\(<\text{GRID NAME}, \text{ANOTHER_GRID_NAME}\>...: \text{equation}\)

The grid name syntax must be placed before the equation, as follows:

Examples:
Apply the equation \(\{\text{MY VAR}\}=\{\text{WCT}\}+1\) only to the grid "B_INJ":
\(<\text{B_INJ}>\{\text{MY VAR}\}=\{\text{WCT}\}+1\)

Apply the equation \(\{\text{MY VAR}\}=\{\text{WCT}\}+1\) only to the grids "B_INJ" and "C_INJ":
\(<\text{B_INJ, C_INJ}>\{\text{MY VAR}\}=\{\text{WCT}\}+1\)

Apply the equation \(\{\text{MY VAR}\}=\{\text{WCT}\}+1\) to all grids (this is the default if no grid names are specified):
\(\{\text{MY VAR}\}=\{\text{WCT}\}+1\)

Syntax notes:
• Spaces are ignored. \(<\text{B_INJ}, \text{C_INJ}>\{\text{WCT}\}+1\) is equivalent to \(<\text{B_INJ} , \text{C_INJ} > : \{\text{WCT}\}+1\)
• Grid names are not case sensitive: "B_INJ" is equivalent to "B_inj"
• This syntax is not valid for XY equations, and will show a syntax error if it is used in a XY
equation.
• If a grid name is specified, the equation will be applied to both the matrix and fracture grid (if
it exists) for that name.
• If the grid name contains a left or right curly brace ( { } ), this syntax is not supported for that
grid. For example, specifying a grid with the name "B_INJ{1}" would cause a syntax error due
to the curly braces in the name.
• If a new variable is created, the equation will be applied to the specified grid. The variable will
exist in all other grids but its value will be 0.

B - 2 Operations
In an equation, the following symbols represent mathematical operations between two numbers, which
may be specified as literal numbers, variables, or sub-expressions:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division. Division by 0 results in 0 if the value being divided is zero, or -999999 otherwise (this behavior can be disabled for XY Equations).</td>
</tr>
<tr>
<td>**</td>
<td>Exponentiation</td>
</tr>
</tbody>
</table>

346
Mathematical Functions

The `-` symbol may also be used with a single number to negate it. For example, `- {DEPTH}` negates the value `DEPTH`.

Binary operators have the following precedence:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>**</code></td>
<td>Highest precedence</td>
</tr>
<tr>
<td><code>*</code>, <code>/</code></td>
<td></td>
</tr>
<tr>
<td><code>+</code>, <code>-</code></td>
<td>Lowest precedence</td>
</tr>
</tbody>
</table>

Tecplot RS evaluates operators from left to right within a precedence level. Parentheses may be used to force a desired order of evaluation, with the expressions in the innermost set of parentheses evaluated first.

B - 3 Mathematical Functions

Tecplot RS supports the following mathematical functions (except where noted, all require a single argument). Trigonometric functions require values in units of radians.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIN</td>
<td>Sine (angle must be specified in radians)</td>
</tr>
<tr>
<td>COS</td>
<td>Cosine (angle must be specified in radians)</td>
</tr>
<tr>
<td>TAN</td>
<td>Tangent (angle must be specified in radians)</td>
</tr>
<tr>
<td>ABS</td>
<td>Absolute value</td>
</tr>
<tr>
<td>ASIN</td>
<td>Arcsine (result is given in radians)</td>
</tr>
<tr>
<td>ACOS</td>
<td>Arccosine (result is given in radians)</td>
</tr>
<tr>
<td>ATAN</td>
<td>Arctangent (result is given in radians)</td>
</tr>
<tr>
<td>ATAN2(A, B)</td>
<td>Arctangent of A/B (result is given in radians)</td>
</tr>
<tr>
<td>SQRT</td>
<td>Returns the positive square root</td>
</tr>
<tr>
<td>LOG</td>
<td>Natural logarithm (base e)</td>
</tr>
<tr>
<td>LOG10</td>
<td>Logarithm base 10</td>
</tr>
<tr>
<td>EXP</td>
<td>Exponentiation (base e): <code>EXP(V1)=e**(V1)</code></td>
</tr>
<tr>
<td>MIN(A, B)</td>
<td>Minimum of A or B</td>
</tr>
<tr>
<td>MAX(A, B)</td>
<td>Maximum of A or B</td>
</tr>
<tr>
<td>SIGN</td>
<td>Returns -1 if argument is negative, +1 otherwise</td>
</tr>
<tr>
<td>ROUND</td>
<td>Round off to the nearest integer</td>
</tr>
<tr>
<td>TRUNC</td>
<td>Remove fraction part of a value</td>
</tr>
</tbody>
</table>

To call an intrinsic function, place its argument within parentheses. For example, to set `V4` to the arctangent of `V1`, use:

```
{V4} = ATAN({V1})
```
B - 4 Conditional Expressions

Conditional expressions may be written using the IF function.

\[ \text{IF}(P, T, F) \]

If the predicate expression \( P \) is true (has a non-zero value), returns the value of expression \( T \); otherwise returns the value of expression \( F \). Both \( T \) and \( F \) are fully evaluated regardless of the value of \( P \); there is no “short-circuiting.”

The predicate expression may include comparison and Boolean operators, as summarized in the following table.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>Equal To</td>
<td>( A = \text{IF}(B==2.0, 3, 4) ) assigns to variable ( A ): 3 if ( B ) equals 2.0, otherwise 4</td>
</tr>
<tr>
<td>!=</td>
<td>Not Equal To</td>
<td>( A = \text{IF}(B \neq C, 1, 2) ) assigns to variable ( A ): 1 if ( B ) does not equal ( C ), otherwise 2</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater Than</td>
<td>( A = \text{IF}(B &gt; 1.0, 4, 5) ) assigns to variable ( A ): 4 if ( B ) is greater than 1.0, otherwise 5</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater Than or Equal To</td>
<td>( A = \text{IF}(B \geq C, 4, 5) ) assigns to variable ( A ): 4 if ( B ) is greater than or equal to ( C ), otherwise 5</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less Than</td>
<td>( A = \text{IF}(B &lt; C, 4, 5) ) assigns to variable ( A ): 4 if ( B ) is less than ( C ), otherwise 5</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less Than or Equal To</td>
<td>( A = \text{IF}(B &lt; C, 4, 5) ) assigns to variable ( A ): 4 if ( B ) is less than or equal to ( C ), otherwise 5</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>Logical AND</td>
<td>( A = \text{IF}(B &lt; C \text{ and } B &gt; 3, 8, 9) ) assigns to variable ( A ): 8 if ( B ) is less than ( C ) AND ( B ) is greater than 3, otherwise 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Comparison operators are valid only within the first argument of an IF function. They may not be used elsewhere in an expression. For example, \( (A < B) > 1 \) is invalid. Instead, use \( A < \text{IF}(B > 1, 3, 1) \) or similar.

Python-style operator chaining (such as \( A < B < C \)) is not supported. Although this construction is syntactically valid, it will not produce the expected result. Use \( A < \text{IF}(B < C, 2, 3) \) instead.

\&\& has a higher precedence than (will be evaluated before) ||. When in doubt, use parentheses.

B - 5 Derivative and Difference Functions

You can use a derivative function in the same manner as other intrinsic functions. Tecplot RS can calculate derivative and difference functions with respect to the following variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>( x, y, z )</td>
<td>variable assigned to the x-axis, y-axis or z-axis, respectively*</td>
</tr>
<tr>
<td>( i, j, k )</td>
<td>index range (XY data only)</td>
</tr>
</tbody>
</table>

Table B - 1: Derivative and Difference Function Variables

* If you have multiple x-axes or y-axes in an XY line plot, the variables assigned to the x and y-axis in the first available mapping will be used.
To notate a first or second-order derivative or difference functions, use the following applicable function call:

<table>
<thead>
<tr>
<th>Type</th>
<th>Function Call</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Order</td>
<td>ddx, ddy, ddz</td>
</tr>
<tr>
<td>Second Order</td>
<td>dx2, dy2, dz2</td>
</tr>
<tr>
<td>Second-Order (cross derivatives)</td>
<td>dxy, dyz, dxz</td>
</tr>
</tbody>
</table>

Tecplot RS uses the derivative function ddx to calculate \( \frac{dx}{x^2} \), dx2 calculates \( \frac{d^2x}{dx^2} \), and dxy calculates \( \frac{d^2y}{dx^2} \).

The difference functions ddi, di2, and so forth, calculate centered differences of their argument with respect to the indexes I and J based on the indexes of the point. For example:

\[
\text{ddi}(V) = \frac{V_{i+1} - V_{i-1}}{2}
\]

### B - 5.1 Boundary Values

Boundary values for first-derivative and difference functions (ddx, ddy, ddz, ddi, dj, and ddk) of ordered zones are evaluated by one of two methods: simple (default) or complex.

- For simple boundary conditions, the boundary derivative is determined by the one-sided first derivative at the boundary. This is the same as assuming that the first derivative is constant across the boundary (i.e., the second derivative is equal to zero).
- For complex boundary conditions, the boundary derivative is extrapolated linearly from the derivatives at neighboring interior points. This is the same as assuming that the second derivative is constant across the boundary (i.e., the first derivative varies linearly across the boundary).

The \$INTERFACE parameter in the configuration file tecplot.cfg selects the method to use:

\$INTERFACE DATA {DERIVATIVEBOUNDARY=SIMPLE}

Change the parameter SIMPLE to COMPLEX to use the complex boundary condition.

### B - 6 Index Specification

For XY data only, you can specify indexes by following a variable reference with parentheses. Indexes can be absolute or an offset from the current index.

Index offsets are specified by using the appropriate index “i,” “j” or “k” followed by a “+” or “-” and then an integer constant. Any integer offsets may be used. If the offset moves beyond the end of the zone, the
Equation Reference

boundary value is used. For example, \((V3)(1+2)\) uses the value \((V3)(IMAX)\) when \(I=IMax-1\) and \(I=IMax\). \((V3)(1-2)\) uses the value of \((V3)(1)\) when \(I=1\) or \(I=2\).

Absolute indexes are specified by using a positive integer constant only. For example, \((V3)(2)\) references \((V3)\) at index 2, regardless of the current 1 index.

If the indexes are not specified, the current index values are used.

**B - 6.1 Index Restriction**

You can override a specified index restriction on an equation by equation basis. To specify restrictions for a single equation add the colon character (:) at the end of the equation followed by one or more of the following:

<table>
<thead>
<tr>
<th>Restrictor</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;I=start[,end[,skip]]&gt;</td>
<td>Restrict the I-range.</td>
</tr>
<tr>
<td>&lt;J=start[,end[,skip]]&gt;</td>
<td>Restrict the J-range.</td>
</tr>
<tr>
<td>&lt;K=start[,end[,skip]]&gt;</td>
<td>Restrict the K-range.</td>
</tr>
<tr>
<td>&lt;D=datatype&gt;</td>
<td>Set the data type for the variable on the left hand side. This only applies if a new variable is being created.</td>
</tr>
</tbody>
</table>

The following example adds one to a variable \(V\) for every other \(I\)-index. Note that zero represents the maximum index.

\((V)=(V)+1:<I=1,0,2)\)

The next example creates a new variable of type Byte:

\((NewV)=X-Y:<D=Byte)\)

**B - 7 Macros and Equations**

Tecplot RS allows you to put your equations in macros. In fact, we sometimes refer to a macro with just equations as an equation file. An equation in a macro file is specified using the \((!ALTERDATA)\) command. Equation files may also include comment lines and must start with the comment \#MC 1410, like other macro files. If you are performing complex operations on your data, and/or the operations are repeated frequently, equation files can be very helpful.

You can create equation files from scratch using an ASCII text editor, or you can create your equations interactively by using the Grid Equations dialog or the XY Equations dialog and then saving the resulting equations. Use \(eqn\) as the standard file name extension for equation files.

For example, you might define an equation to compute the magnitude of a 3D vector. In the Grid Equations dialog, it would have the following form:

\(Mag = \sqrt{U^2 + V^2 + W^2}\)

In a macro file, it would have the following form:

\#MC 1410
\(\$!ALTERDATA\)
\(EQUATION = "Mag = \sqrt{U^2 + V^2 + W^2}"\)

The interactive form of the equation must be enclosed in double quotes and supplied as a value to the EQUATION parameter of the \$(!ALTERDATA)\) macro command.

To read an equation file, click Load in the XY Equations or Grid Equations dialog. In the Data Equations dialog, navigate to and choose an equation file that contains a set of equations that you wish to apply to your data. Tecplot RS will add the equations in the equation file to the list of equations in the dialog.
In the XY Equations dialog, Tecplot RS applies all equations to your data when you click the Apply button. In the Grid Equations dialog, Tecplot RS applies all equations when you click OK.

Tecplot RS can calculate equations in equation files somewhat differently depending on whether it receives the equation within an Equations dialog or by running the equation file as a macro. When loaded into an Equations dialog, equations that do not contain index restrictions use the current index restrictions shown in the dialog. When processed as a macro file, the equations apply to all data points. To include index restrictions, you must include them in the equation file as part of the $!ALTERDATA command. Refer to the Tecplot 360 Scripting Guide (available on the Tecplot Web site) for more information on working with the $!ALTERDATA command.

### B - 8 Equation Examples

This section includes various equation examples. You can use or refer to them to gain experience writing equations.

The following equation sets the value of a variable called Density to 205. A new variable is created if a variable called density does not exist.

\[ \text{Density} = 205 \]

In the next equation, the values for \( Y \) (the variable assigned to the Y-axis) are replaced by the negative of the square of the values of \( X \) (the variable assigned to the X-axis):

\[ Y = -(X)^2 \]

The following equation replaces the values of \( V3 \) with the values of \( V2 \) rounded off to the nearest integer. A new variable is created if there are only two variables currently in the data set.

\[ V3 = \text{round}(V2) \]

In the following equation, the values of the fourth variable in the data set are replaced by the log (base 10) of the values of the third variable.

\[ V4 = \log_{10}(V3) \]

Suppose that the third and fourth variables are the X and Y-components of velocity and that there are currently a total of five variables. The following examples create a new variable \( V6 \) that is the magnitude of the components of velocity.

\[ V6 = \sqrt{(V3)^2 + (V4)^2} \]

You can also accomplish the above operation with the following equation (assuming you have already defined the vector components for the active frame):

\[ V6 = \sqrt{(U)^2 + (V)^2} \]

The following equation sets the value of a variable named diff to the truncated value of a variable named depth subtracted from the existing value of depth:

\[ \text{diff} = \text{depth} - \text{trunc}((\text{depth})) \]

In the next equation, \( C \) (the contour variable) is set to the absolute value of \( S \) (the scatter-sizing variable), assuming both \( C \) and \( S \) are defined.

\[ C = \text{abs}(S) \]

In the following example, a new variable is created (assuming that only seven variables initially existed in the data file). The value for \( V8 \) (the new variable) is calculated from a function of the existing variables:

\[ V8 = \sqrt{((V1)^2 + (V2)^2 + (V3)^2) / (287.0 * (V4)^2 + (V6)^2)} \]

The following equation replaces any value of a variable called TIME that is below 5.0 with 5.0. In other words, the values of TIME are replaced with the maximum of the current value of TIME and 5.0.

\[ \text{TIME} = \max(\text{TIME}, 5.0) \]

351
The following equation creates variable V4 which has values of X at points where X<0; at other points, it has a value of zero (this does not affect any values of X):

\[ \text{(V4)} = \text{min}(X, 0) \]

Another example using intrinsic functions is shown below:

\[ \text{(V8)} = 55.0 \times \text{SIN}(\text{(V3)} \times 3.14/180.0) + \text{LOG}(\text{(V6)}^{2/3}/(\text{(V6)}+1.0)) \]

You can also reference the I and J indices in an XY equation. For example, if you wanted to cut out a section of your plot using value blanking, you could create a new variable that is a function of the I and J-indexes. Then, by using value-blanking, you could remove certain cells where the value of the value-blanking variable was less than or equal to the value blanking cut-off value.

Here is an example for calculating a value-blanking variable that is zero in a block of cells from I=10 to 30, and is equal to one in the other cells:

\[ \text{(V3)} = \text{min}((\text{max}(I,30)-\text{min}(I,10)-20),1) \]

The following equation replaces the values of V3 with the average of the values of V3 at the four adjacent data points:

\[ \text{(V3)} = (\text{(V3)}[(I+1),(J)]+(\text{(V3)}[(I-1),(J)]+(\text{(V3)}[(I),(J+1)]+(\text{(V3)}[(I),(J-1)]))/4 \]

The following equation sets the values of a variable called TEMP to the product of the values of a variable called T measured in four places: in zone 1 at two index values before the current data point, in the current zone at an absolute index of three, in zone 4 at the current data point, and in the current zone at the current data point.

\[ \text{(TEMP)} = (T)[1](I-2) \times (T)(3) \times (T)[4] \times (T) \]
When Tecplot RS opens, it loads an RS Variables file: a user-modifiable ASCII text file that allows you to customize how Tecplot RS displays variables, labels, and lines in plots.

More specifically, the RS Variables file:

- Defines the default variables list in Custom Plot Options Dialog and Plot Options.
- Allows variables to be renamed for display in Tecplot RS. Most simulators use very short variable names, such as “GOR.” These can be renamed to less cryptic names like “Gas/Oil Ratio” when displayed on a plot.
- Defines variable aliases; that is, different names for a single variable that can be used in comparison plots.
- Specifies plot options for color, symbol, pattern, and so on, for each variable or entity, controlling the default styles used for plots (unless overridden in Plot Options).

You can also use an RS Variables file to control the default order that variables appear in the list. You might, for example, put the most frequently encountered variables at the top, or sort names alphabetically.
RS Variables Files

or group similar variables together. You can choose to keep the list of variables short, making it easy to find a single item, or expand it to include every solution value that you could potentially encounter in your work. Several other options are available for controlling the master variables list on the Variables page of the Plot Options dialog. These include sorting the list alphabetically and limiting the variables in the list to those loaded from a file or derived.

RS Variables files do not limit the variables that can be loaded and displayed in Tecplot RS—that is, variables can be used even if they don't appear in the active RS Variables file. Review Variables to learn how to interactively update the master variables list and save the resulting file.

File Location

When Tecplot RS is first installed, a selection of RS Variables templates for various simulators is installed with it. Unless you copy your own RS Variables file named rsvariables.txt into the installation directory, you are prompted to choose a template RS Variables file from among the ones found in the Tecplot RS installation folder. If you also mark the Set as Default checkbox, the chosen file becomes the designated RS Variables file for future Tecplot RS sessions.

If you use multiple simulators, you can change the active RS Variables file using the Choose button in the RSVariables section of the Variables tab of the Plot Options, or by using a macro (see RSVFILE).

We have provided RS Variables templates for the various supported simulators:

- rsvariables_cheers.txt CHEARS (Chevron) naming conventions
- rsvariables_cmg.txt CMG naming conventions
- rsvariables_eclipse.txt Eclipse naming conventions
- rsvariables_sensor.txt Sensor naming conventions
- rsvariables_vip.txt Landmark VIP naming conventions

Consider these files starting points—copy and customize them to suit your needs. They are most easily edited in the Variables tab of the Plot Options dialog, but they may also be edited using a text editor. An additional copy of each template is provided in the factorydefaults folder in the Tecplot RS installation folder, if you need an unmodified copy. The copies in factorydefaults have helpful comments that will help you make the changes you want to make.

Tecplot RS searches for RS Variables files in the following places, in this order:

1. The folder defined by the RS_USER environment variable. Tecplot RS does not define this environment variable automatically; you can set it up if you want to direct Tecplot RS to the location of RS Variables files that you wish to use. It's a convenient way of specifying a place where files are located that define user-specific options. State files (.rsgs and .rsxs) files will also be placed in the folder by default, so use a folder for which you have write/create permissions.
2. The home or startup folder. For Windows, this is the "Start In" folder in the shortcut used to launch Tecplot RS, also referred to as the Working Directory.
3. The Tecplot RS installation folder.

If you want to set up a set of standards used by everyone in the company, you might want to put it in the installation folder and/or distribute copies to everyone who has a Tecplot RS installation on their
computer. Alternatively, each user can have their own personal set of options by creating the `RS_USER` environment variable and placing the file in the referenced directory.

Choose "About Tecplot RS" from the Help menu to view the current value of the `RS_USER` environment variable along with the path for the RS Variables file in use.

### Editing RS Variables Files

The easiest way to edit a RS Variables file is by using the Master Variables List. See Master Variables List for more information. You can also edit an RS Variables file separately from Tecplot RS; it is an ASCII text file that can be viewed and edited using any text editor, such as Notepad, WordPad, or vi. To edit the file, first exit Tecplot RS, since Tecplot RS will only read changes to the file when launching.

The required format is:

```
long name, short name, line color, line pattern, symbol color, symbol shape, alias1, alias2, alias3
```

When editing the file, use the following standards:

- Use one line per variable.
- All items must be separated by commas.
- Long variable names can include spaces, but spaces are ignored or “squeezed out” of all other items.
- The short variable names should exactly match those used in the data files (whether from the simulator or your files containing observed data).
- Comments (lines beginning with a “#”) will be ignored. Note that when you modify an RS Variables file from inside Tecplot RS, comments will be lost, so this feature is best suited for templates that will be edited by hand before being used with Tecplot RS.
- The file header lists the colors, patterns, and shapes that can be used.
- At a minimum, you must include both Long Name and Short Name. Long Name is the long variable name as it should appear on plots. Short Name is the acronym variable name as it is found in the file output by the simulator (OPR, WPC, SWAT and so on).
- Alias1 through Alias3 are optional. They are alternative names, or aliases, for the same variable. They can be used for different simulators (for example, Eclipse versus VIP), or names such as those found in user-created ASCII files.

The first few lines of the file (after header lines) are shown here:

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Line Color</th>
<th>Line Type</th>
<th>Symbol Color</th>
<th>Symbol Shape</th>
<th>Variable Alias</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gas Prod Rate, GPR</td>
<td>Red, Solid, Red, Square, QGP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Water Prod Rate, WPR</td>
<td>Blue, Solid, Blue, Diamond, QWP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oil Prod Rate, OPR</td>
<td>Green, Solid, Green, Delta, QGP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The top line is not included in the file. It is displayed here for informational purposes. The first two items in a row are the long variable name followed by the short name (typically used by the simulator). The next four values define the default settings for colors, line patterns, and symbol shapes. The last value is a variable alias. You can include up to three variable aliases (comma-separated).

Include any variable names unique to grid data. In Options > Plot Options > Grid Legend you can manually assign range limits to grid variables in the Axis Scale region of the page.
A set of unique entries, called "Entity ", are defined in RS Variables files to provide default line and symbol styles for plots that display multiple entities, such as XY Entities plot.
Paper Layout

The Paper Layout mode lets you design a layout for your plots. The layout controls a variety of items to create a professional, finished presentation plot, including:

- Paper size, color, and orientation
- Titles identifying the entity, variable, and so forth.
- Page number, date, or time
- Legends
- Orientation axes showing view rotation
- User-defined text and images (company name and/or logo, address, project, any additional text or image elements)
- Areas for headers and footers
- Color, size, font, location, and orientation of all the above

Your installation includes a default layout. You can also define and save your own layouts. Tecplot RS stores paper layouts in named files with an extension of .rslayx. You can create a single file and instruct Tecplot RS to use it as the default layout for each plot. Alternatively, you can create multiple layouts and choose which layout to use for a particular plot type. This approach works well with macros, since you can automatically load a new paper layout prior to any sequence of plots.
Creating a Paper Layout

From the menu bar, choose “Paper Layout” from the Plot Type menu. Your current plots will disappear and the sidebar will change to reflect the options for Paper Layout.

The Paper Layout Sidebar is divided into 4 primary sections:

- **Paper**
- **Frames**
- **Adding Text**
- **Saving the Paper Layout**

## 1.1 Paper

Use the Paper region of the sidebar to specify the paper orientation, size and color. The Paper region of the sidebar has the follow controls:

- **Show Paper** Use the Show Paper toggle to include or remove the paper display from your plot. The paper display allows you to see how your plot(s) will appear on printed paper.
- **Color** Use the color button to change the paper background color. The paper background color will not be included in any print-outs.
- **Size** Use the Size menu to specify the paper size.
- **Orientation** Use the Orientation menu to specify the paper orientation (choose Portrait or Landscape).

## 1.2 Frames

Use the Frames region of the sidebar to customize the Header and Footer and the plot Frame Style in your paper layout.

### Header and Footer

Two toggles control whether to include header and footer frames.

The header and footer are separate frames from the frame containing the plot. The header and footer can contain only text or geometries. You may find header and footer frames especially useful when you work with multi-frame plots, since text in these frames will not be repeated in each of the plot frames. For example, the footer frame can be used to create a title block that includes the company name, date, and page number.

Toggling-on “Show” for the header or footer in the sidebar will activate the text fields for defining the height and width. These values define the amount of space allocated for the header or footer frame, as a percentage of the paper height and width.
For example, a header with a 10% height and a footer with a 5% height will leave 85% of the paper available for plots:

<table>
<thead>
<tr>
<th>Header area</th>
<th>Plot area</th>
<th>Footer area</th>
</tr>
</thead>
</table>

The header and footer are not limited to the top or bottom of the page. By swapping the height and width values, you can place the header on the left edge of the page:

<table>
<thead>
<tr>
<th>Header area</th>
<th>Plot area</th>
<th>Footer area</th>
</tr>
</thead>
</table>

The space used by header and footer frames (if selected) will reduce the area available for the plot frames. Sizes in the range of 5 to 10% will generally produce pleasing arrangements.

While in paper layout mode, only a single plot frame displays even if you wish to design a layout for multi-frame plots. If you apply a layout to a multi-frame plot, Tecplot RS will size the frames to fit within the area covered by the single plot frame shown in paper layout mode.

**Frame Style**

Click any of the Style buttons to launch the Frame Options dialog, which allows you to customize color and border options for each frame.

Use this dialog to choose whether or not to include a border, to choose the border thickness, and to choose a background color, if any.

The dialog indicates the frame that you are editing. Any changes you make will be reflected immediately. You can change the frame (Plot, Header, or Footer) you are working on by clicking one of the three Style buttons on the sidebar or by clicking on the frame.

See Section 3 - 1 “Using Frames” for additional information on working with frames in Tecplot RS.

**D - 1.3 Saving the Paper Layout**

To use your paper layout settings on other plots, save your settings to a file. This allows you to maintain different settings for different scenarios. Click the Load button in the Paper Layout sidebar to load paper layout settings. You have the option either to load an existing paper layout file (*.rslay, *.rslayx) or to load
Paper Layout

Paper layout settings embedded in a project file (*.rspr). Refer to Chapter 21: “Projects” for additional information about project files.

Older versions of Tecplot RS stored paper layouts in files with names ending in .rslay. You can still load these in today’s Tecplot RS, but they won’t appear in the Open File dialog initially. Choose the file type "RS Paper Layout: Pre-7.5 format (*.rslay)" to make them visible.

After making changes to the paper layout, if the paper layout file is already open, use the Save button to save your changes. Otherwise, use the Save As button to assign a file name and save the design. The file will have an extension of .rslay. Toggle-on “Load at startup” before saving the file to have Tecplot RS load that layout every time it launches.

If you would like to associate your paper layout file with a set of XY and/or grid files, we recommend creating a project file. To create a project file, choose “Save Project” from the Project menu. Refer to Chapter 21: “Projects” for additional information.

D - 2 Multi-frame Paper Layout

The paper layout can be applied to a single frame layout or a multi-frame layout. Refer to Section 3 - 1 “Using Frames” for a description of creating multi-frame plots, as well as an example of using a multi-frame paper layout.

D - 3 Modifying your Paper Layout

You can modify your paper layout at any time by returning to paper layout mode and saving the layout file. Alternatively, you can dynamically update many of the attributes of your paper layout by choosing the Update Styles button in the sidebar. The Update Styles button will modify the active paper layout if you make any style changes (for example, re-positioning or re-sizing a legend). However, Tecplot RS will not update the paper layout when you add or delete items. To make any permanent additions or deletions (including text strings), you must switch to paper layout mode and make your changes.

D - 4 Adding Text

You can add three types of text to your paper layout:

- **Static text** As the name suggests, static text does not change. Static text might include your company’s name, address, and telephone number. Refer to Title Options for additional information.

- **Dynamic text** Dynamic text changes according to the situation. For example, you can insert the date. Tecplot RS also uses dynamic text to label the variable name and entity name, to identify each plot.

- **Placeholder text** This type of text is used for legends and the orientation axis. The placeholder text will determine the position and style of these items, but the actual object will be displayed only when appropriate. For example, the orientation axis will be shown only on 3D grid plots, and the bubble legend only on bubble plots. The placeholder text is used only to mark the position on the paper layout; on the actual plot, the legend or orientation axis will be shown.

To add text to the paper layout:

1. Click the Text tool button in the toolbar, or choose “Text” from the Insert menu.
2. Click anywhere in a frame to set the location of the text.
3. Use the **Text Details** dialog that appears to type and modify text and formatting.

To add dynamic text and placeholder text to the paper layout:

1. Make sure the frame in which you want to add the text is active. (Click the frame border to activate the frame if necessary.)
2. Click the desired dynamic text or placeholder in the Dynamic Text list box in the sidebar.
3. Click the Add Text button. The text appears in the middle of the frame.
4. Double-click the text to open the Text Details dialog, then modify styles and options.
5. Click and drag the placeholder text to the desired location on the frame.

**Legends**

To include legends in your plot frame, use one of the following five specialized placeholder text strings.

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS_LEGEND</td>
<td>Primary legend for grid or XY plots. Always appears on the main plot; will be included in each plot frame of both XY and grid plots if included on the paper layout.</td>
</tr>
<tr>
<td>RS_NNCLegend</td>
<td>Shown when non-neighbor connections (NNCs) are visible in grid plots</td>
</tr>
<tr>
<td>RS_STREAMLegend</td>
<td>Shown with streamlines in grid plots</td>
</tr>
<tr>
<td>RS_BUBBLELegend</td>
<td>Shown with bubbles in grid plots</td>
</tr>
<tr>
<td>RS_INACTIVELegend</td>
<td>Shown when an inactive grid mesh is shown in color in grid plots</td>
</tr>
</tbody>
</table>

The position of the placeholder text determines the position of the legend. The text styles assigned to the placeholder text will be applied to the text in the displayed legend.

**D - 4.1 Text Details**

The Text Details dialog allows you to control the style of the text. For placeholder text for legends, the styles assigned to the text will be applied to the legend that appears in its place. Font, style, and color
settings are used for legend labels, anchor and position settings control the legend placement, and text box options will control whether a box is drawn around the legend itself.

The **Text Details** dialog includes the following controls:

- **Text Field** For static text, enter the text you wish to create in the top text field. For dynamic and placeholder text, do not modify the text displayed here.
- **Font** Choose a font for the text from the Font menu.
- **Size** Use the Size control to adjust the sizing of your text or legend label. You can choose whether to control your font size in points or in frame percent (“Frame %”). If you choose to use points, the font will always appear as that size. If you choose frame percent, Tecplot RS will resize the font when the frame is resized, so that the font always appears as a ratio to the frame size.
- **Color** To modify the color of the text, click on the Color button and choose a color in the Color Chooser dialog.
- **Line Spacing** To adjust the spacing between lines of text, type or adjust the number displayed in the Line Spacing control. Applies only to multi-line static text.
- **Angle (deg)** You can adjust the orientation of the text with the Angle control. Tecplot RS measures the angle in degrees counter-clockwise from the horizontal axis: zero degrees indicates horizontal text; 90 degrees indicates vertical text. You can type an angle in degrees or choose a common angle in the Angle menu.
  
  Note that this applies only to static or dynamic text. For placeholder text (legends and the orientation axis), leave this at 0. Instead, you can choose a horizontal or vertical contour legend alignment on a variable-by-variable basis in Plot Options.
- **Position By** Ignore this field. Both text and legends are always positioned relative to the frame.
• **Text Box** Click the Text Box button to open the Text Box dialog, where you can control the appearance of a box around the text or legend and choose a background (fill) color if desired. You can also choose a margin; although you can enter larger values, Tecplot RS limits margins to 5%.

• **Anchor** To adjust the relationship of the entered text to the point clicked, click the Anchor button.

For legends, this should generally match the part of the frame where the anchor is positioned (for example, a corner); it will determine which direction the legend grows, and you will want the legend to grow toward the center of the frame.

### D - 4.2 Embedded Characters

You can embed Greek, Math, and User-defined characters into static text by enclosing the characters in text formatting tags. The text formatting tags and their effects include the following (format tags can appear in upper or lower case):

- `<b>...</b>` Bold
- `<i>...</i>` Italics
- `<verbatim>...</verbatim>` Verbatim (display text exactly as written)
- `<sub>...</sub>` Subscripts
- `<sup>...</sup>` Superscripts
- `<greek>...</greek>` Greek font
- `<math>...</math>` Math font
- `<userdef>...</userdef>` User-defined font
- `<helvetica>...</helvetica>` Helvetica font
- `<times>...</times>` Times font
- `<courier>...</courier>` Courier font

Embedded special characters display correctly only in texts of English font; they have no effect in text created in Greek, Math, or User-defined fonts.

To insert a tag into text literally, precede the first angle bracket with a backslash (\). To insert a backslash in the text, just type two backslashes (\\). In ASCII input files, the number of backslashes must be doubled (two to precede a special character, four to create a backslash) because the Preplot program also requires a backslash to escape special characters.

### D - 4.3 Superscripts and Subscripts

As described previously, you can produce subscripts or superscripts by enclosing any characters with `<sub>...</sub>` or `<sup>...</sup>`, respectively. Tecplot RS has only one level of superscripts and subscripts; expressions requiring additional levels, such as $\alpha^2$, must be created by hand using multiple Tecplot RS text strings. If you alternate subscripts and superscripts, Tecplot RS positions the superscript directly above the subscript. Thus, the string `<sub>a</sub><sup>b</sup><sub>c</sub>` produces $a^b_c$. To produce...
consecutive superscripts, enclose all superscript characters in a single pair of tags. The string \texttt{\textsuperscript{(a+b)}<}\textsuperscript{2}\texttt{\textsuperscript{1/2}} produces \(x^{(a+b)}\)² in your plot.

**D - 4.4 European Characters**

Tecplot RS supports the ISO-Latin1 character encodings. Characters in the ordinal range from 160-255 are now available, providing support for most of the major European languages. Custom Characters shows the characters supported by Tecplot RS. Note that the two right-hand columns represent the extended European characters. Text formatting tags for Greek, Math, or User-defined characters work only with characters in the range 32-126 and is not available for the extended European characters.

If your keyboard is configured to produce European characters, then the European characters should appear and print automatically with no additional setup.

If your keyboard is not configured to produce a specific European character you can generate it by including the sequence \texttt{\textbackslash nnn} in your text where \texttt{nnn} is from the character index table found in Custom Characters. For example, if your keyboard will not generate the é and you want to show the word “latté,” enter: latté\textbackslash 233
D - 4.5  Custom Characters

You can create symbols, characters, and even custom fonts for use in Tecplot RS.

D - 4.6  Dynamic Text

The Paper Layout sidebar includes the most commonly used dynamic text items in the Dynamic Text region. This provides a simple shortcut for adding these items. The following items are categorized as Dynamic Text, meaning text that will change to reflect either what is currently being displayed or the state (date and time) when the plot was created.

- RS_FILENAME
- RS_FRAMETITLE

1. If you entered text in the Display As box on either the XY or Grid page of the Manage Data dialog, this text will appear in your paper layout (instead of the file name). Refer to Section 4 - 1 "Loading XY Data" or Section 12 - 2 "Managing Grid Data", respectively, for additional information.
D - 4.7 Smart Labels

The dynamic text options contain items that can duplicate each other. Understanding how each item works will prevent confusion.

- RS_ENTITY and RS_VARIABLE will always label the entity and variable, respectively. In grid plots, RS_ENTITY will list the time stamp for time-dependent variables, and plane number for 2D Grid plots.
- RS_FRAMETITLE will sometimes be the same as RS_ENTITY, and other times it will match RS_VARIABLE. The same is true for RS_PLOTTITLE, except it will use the alternate selection as the frame title.

Basically, RS_ENTITY and RS_VARIABLE are locked to always display exactly the text they are named for. RS_FRAMETITLE and RS_PLOTTITLE are "smart" options that adjust to reflect what makes the most sense according to the plot type.

This makes it easier to create a "generic" layout that can be used in all plot types, especially with multiple frames. For example, when you create XY Variables plots with multiple frames, each frame shows the same variables but a different entity. You might put the variable names in the header frame just once, but add the entity names to each frame. However, in the XY Entities plots, the entity name remains the same for all frames, and the variables change.

If you created layouts with RS_ENTITY and RS_VARIABLE dynamic text items, you would need to create a separate layout for each plot type. However, by using RS_PLOTTITLE for the label that goes in the header frame, and RS_FRAMETITLE for the heading that changes with each frame, you would leave it up to Tecplot RS to decide the most appropriate item to label in each.

The sample paper layouts included in your installation use the smart labels and are a great place to start.

D - 4.8 Page Number

One of the dynamic text items is the page number. A text field in the Paper Layout sidebar allows you to input or reset the starting page number. You can also reset this value in the Auto-Export dialog.
Adding Geometries

D - 4.9 Title Options
Tecplot RS gives you the ability to choose between displaying the short or long version of all variable (property) names. Click the Title Options button in the Paper Layout sidebar to specify when and whether to use long variable names in the following locations:

- Axis Titles
- XY Legends
- RS_FRAMETITLE
- RS_PLOTTITLE
- RS_VARIABLE
- RS_NNCVAR
- RS_STREAMVAR

You can also choose whether to include the file extension when displaying RS_FILENAME in frames or legends.

D - 4.10 Dynamic Text in XY Freestyle Plots
When working with XY Freestyle plots, the value of some of the dynamic text variables depends on the plot contents. Tecplot RS determines the variable values according to the following rules:

For RS_FRAMETITLE and legends:
- If multiple XY files are open, AND all maps on a single frame use the same file, then:
  - RS_FRAMENAME = the file name
  - Legend contents = the variable and entity names
- Else, if all maps in the frame reference the same entity, then:
  - RS_FRAMENAME = the entity name.
  - Legend contents = the variable name.
- Else, if all maps reference the same variable name, then:
  - RS_FRAMENAME = the variable name.
  - Legend contents = the entity name.
- Else
  - RS_FRAMENAME is blank
  - Legend contents = the variable and entity names

For all cases listed here, if the plot includes multiple loaded files, the legend also shows the file name.

- RS_PLOTTITLE - RS_PLOTTITLE is blank.
- RS_ENTITY - If all maps reference the same entity, the RS_ENTITY shows the entity name. Otherwise, it is blank.
- RS_VARIABLE - If all maps in a frame use the same variable, the RS_VARIABLE shows the variable name. Otherwise it is blank.

D - 5 Adding Geometries
You can enhance a plot using Tecplot RS's drawing tools. Tecplot RS provides simple tools for creating polylines, squares, rectangles, circles, and ellipses in your paper layout. Tecplot RS geometries are line drawings and images. Images are discussed in Section D - 6 "Adding Images".

367
To create a geometry, draw it in a frame using the appropriate tool accessible in the **Insert** menu.

### D - 5.1 Polyline

To add a polyline to your paper, first choose “Polyline” from the **Insert** menu to active the Polyline tool. To draw the polyline, click at the desired beginning point of the first line segment, move the pointer (without dragging) to the desired end point of the first line segment, and click again. Move the pointer to the next end point, click, and so on. After placing the last segment, double-click on the final end point, or right-click.

To draw a horizontal or vertical line segment, type the **H** or **V** keys, respectively, while drawing the segment. After you place the segment’s end point, the horizontal or vertical restriction ends. To lift the horizontal or vertical line segment restriction without placing the end point, type **A** on your keyboard. You can draw unconnected line segments in a single polyline; press **U** on your keyboard to “lift the pen.” You can then move the pointer to the start of the next line segment. Refer to the following table for each key command.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Allow translation of polyline segments in all directions.</td>
</tr>
<tr>
<td>H</td>
<td>Restrict translation of current polyline segment to horizontal.</td>
</tr>
<tr>
<td>U</td>
<td>Pen up, while drawing polyline.</td>
</tr>
<tr>
<td>V</td>
<td>Restrict translation of current polyline segment to vertical.</td>
</tr>
</tbody>
</table>

Table D - 4: Keyboard Shortcuts for Polylines

### D - 5.2 Circle

To add a circle to your paper, choose “Circle” from the **Insert** menu. Then click at the desired center point of the circle, drag the pointer until the circle is the desired radius, and release.

### D - 5.3 Ellipse

To add an ellipse to your paper, choose “Ellipse” from the **Insert** menu, click at the desired center point of the ellipse, drag the pointer until the ellipse is the desired size and shape, and release.

### D - 5.4 Square

To add a square to your paper, start by choosing “Square” from the **Insert** menu. Drag the pointer away from the anchor point of the square, which Tecplot RS chooses as either the lower left-hand corner or the upper right corner of the square. Drag to the right of the anchor to create a square with the anchor at lower left; drag the pointer to the left to create a square with the anchor at upper right. Release when the square is the desired size.

### D - 5.5 Rectangle

To add a rectangle to your paper, choose “Rectangle” from the **Insert** menu to activate the Rectangle tool. Then drag the pointer until the rectangle is the desired size and shape. In contrast to squares, rectangles can grow in any direction.

### D - 5.6 3D Polyline

A 3D polyline may be used to display boundaries or structures in a 3D Grid plot. While it is not possible to create a 3D polyline geometry inside Tecplot RS, one can be imported using the Tecplot Data Loader (Project>Tecplot Data> Read Tecplot Text/Geometry File).
Adding Geometries

A 3D polyline file should only be imported after the 3D Grid plot is established. 3D polylines are transitory: they will be removed when the plot type is changed from 3D Grid.

The complete format of the Tecplot *.dat Data File for 3D polylines is defined in the Tecplot 360 EX Data Format Guide. The key elements of this format required by Tecplot RS to import a 3D polyline are the following:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>GEOMETRY</td>
<td>Required keyword to begin a geometry specification.</td>
</tr>
<tr>
<td>CS=GRID3D</td>
<td>This geometry is specified in the 3D grid coordinate system. The 3D polyline must be specified in the same units as the reservoir grid.</td>
</tr>
<tr>
<td>T=LINE</td>
<td>This geometry is a polyline.</td>
</tr>
<tr>
<td>X, Y, Z</td>
<td>Specifies the X-origin, Y-origin, and Z-origin of the polyline in grid units.</td>
</tr>
<tr>
<td>L</td>
<td>Line type. (SOLID, DASHED, DASHDOT, DOTTED, LONGDASH, DASHDOTDOT)</td>
</tr>
<tr>
<td>C</td>
<td>Line color (BLACK, RED, GREEN, BLUE, CYAN, YELLOW, PURPLE, WHITE)</td>
</tr>
<tr>
<td>LT</td>
<td>Line thickness relative to the frame size. A value of 0.4 is reasonable.</td>
</tr>
<tr>
<td>DT</td>
<td>Data type: SINGLE or DOUBLE precision.</td>
</tr>
</tbody>
</table>

The following example provides additional information about the 3D polyline definition. It describes two offset polylines, one red and one blue.

```plaintext
GEOMETRY CS=GRID3D, T=LINE, X=0, Y=0, Z=0, C=RED, L=SOLID, LT=0.4, DT=SINGLE
1
GEOMETRY CS=GRID3D, T=LINE, X=0, Y=0, Z=0, C=BLUE, L=SOLID, LT=0.4, DT=SINGLE
1
```

<table>
<thead>
<tr>
<th>Entry</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>GEOMETRY</td>
<td>Required keyword to begin a geometry specification.</td>
</tr>
<tr>
<td>CS=GRID3D</td>
<td>This geometry is specified in the 3D grid coordinate system. The 3D polyline must be specified in the same units as the reservoir grid.</td>
</tr>
<tr>
<td>T=LINE</td>
<td>This geometry is a polyline.</td>
</tr>
<tr>
<td>X, Y, Z</td>
<td>Specifies the X-origin, Y-origin, and Z-origin of the polyline in grid units.</td>
</tr>
<tr>
<td>L</td>
<td>Line type. (SOLID, DASHED, DASHDOT, DOTTED, LONGDASH, DASHDOTDOT)</td>
</tr>
<tr>
<td>C</td>
<td>Line color (BLACK, RED, GREEN, BLUE, CYAN, YELLOW, PURPLE, WHITE)</td>
</tr>
<tr>
<td>LT</td>
<td>Line thickness relative to the frame size. A value of 0.4 is reasonable.</td>
</tr>
<tr>
<td>DT</td>
<td>Data type: SINGLE or DOUBLE precision.</td>
</tr>
</tbody>
</table>

The following example provides additional information about the 3D polyline definition. It describes two offset polylines, one red and one blue.

```plaintext
GEOMETRY CS=GRID3D, T=LINE, X=0, Y=0, Z=0, C=RED, L=SOLID, LT=0.4, DT=SINGLE
1
    #Number of polylines based on the above geometry record
5
    #Number of points in the first polyline
3725. 5795. 9615.  #X, Y, Z coordinates of point 1 in polyline 1
657. 3185. 9080.  #X, Y, Z coordinates of point 2 in polyline 1
1565. 2755. 9240. #X, Y, Z coordinates of point 3 in polyline 1
5010. 4620. 9840. #X, Y, Z coordinates of point 4 in polyline 1
3725. 5795. 9615.  #X, Y, Z coordinates of point 5 in polyline 1
1
GEOMETRY CS=GRID3D, T=LINE, X=0, Y=0, Z=0, C=BLUE, L=SOLID, LT=0.4, DT=SINGLE
1
    #Number of polylines based on the above geometry record
5
    #Number of points in the first polyline
3725. 5795. 9575.
657. 3185. 9480.
1565. 2755. 9200.
5010. 4620. 9800.
3725. 5795. 9575.
```
D - 5.7 Geometry Details

Use the Geometry Details dialog to specify attributes of polylines, circles, ellipses, squares and rectangles. To access the Geometry Details dialog, double-click on the geometry object itself.

The following options are available:

- **Line Color** - Select a color for the geometry from the Select Color dialog.
- **Line Pattern** - Select the desired pattern (Solid, Dashed, Dotted, LongDash, or DashDotDot).
- **Pattern Length (%)** - Specify the length of the line pattern as a percentage of the frame width.
- **Line Thickness (%)** - Specify the thickness of the line as a percentage of the frame width.
- **Fill With Color** - Toggle-on to fill a circle, ellipse, square, rectangle or line segment polygon. Then select a color for the geometry fill from the Select Color dialog.
- **Coordinate System** - Specify the coordinate system for the geometry (Frame or Grid).
  - **Frame** - The geometry is always displayed at constant size when you zoom in or out of the plot.
  - **Grid** - The geometry resizes with the data grid.
- **Positioning** - Enter the X and Y-coordinates of the anchor position of the geometry (in frame units if the coordinate system is frame; in grid units if the coordinate system is grid) and its size. The fields for doing this vary depending on the type of geometry.
- **Clipping** - Clipping refers to displaying only that portion of an object that falls within a specified clipping region of the plot. If you have specified your geometry position in the Frame coordinate system, the geometry will be clipped to the frame—any portion of the geometry that falls outside the frame is not displayed. If you have specified the Grid coordinate system, you can choose to clip your geometry to the frame or the viewport.
- **Draw Order** - Geometries can be drawn either before the data, or after the data. If a geometry is drawn before the data, the plot layers, such as mesh, contour lines, etc. will be drawn on top of the geometry. If a geometry is drawn after the data, the geometry will be drawn last, obscuring the data.
- **Attach to Zone/Map** - Toggle-on “Attach to Zone/Map” to attach the geometry to a particular zone or mapping by entering the number of the zone or mapping. Geometries that are attached to an inactive or non-existent zone are not displayed.
- **Show in All “Like” Frames** - Toggle-on this option to display the geometry in all frames sharing the active frame’s dataset.
- **Macro Function** - In the text field, specify the name of the macro function that you wish to link to a particular geometry.

The following fields are specific to particular geometry types:
• **Polyline Arrowhead** - These options control the appearance of an arrowhead on a drawn polyline.
  - **Attachment** - Choose the end or ends of the polyline by selecting the appropriate check boxes.
  - **Style** - Plain, filled or hollow arrowhead.
  - **Size (%)** - Specify the size of the arrowhead, as a percentage of frame height.
  - **Angle** - Specify the angle the arrowhead makes with the polyline. You can either enter a value (in degrees) in the text field, or choose a preset value from the drop-down.

• **Circle** - Controls the radius and precision of approximation of the circle:
  - **Radius** - Set the radius of the circle (in coordinate system units, **Frame** or **Grid**).
  - **Number of Sides** - Enter the number of polylines used to approximate the circle.

• **Ellipse** - Controls the shape and precision of approximation of the ellipse, as follows:
  - **Horizontal Axis** - Set the horizontal axis of the ellipse (in coordinate system units, **Frame** or **Grid**).
  - **Vertical Axis** - Set the vertical axis of the ellipse (in coordinate system units - **Frame** or **Grid**).
  - **Number of Sides** - Enter the number of polylines used to approximate the ellipse.

• **Square** - Controls the size of the square, as follows:
  - **Size** - Set the size of the square (in coordinate system units, **Frame** or **Grid**).

• **Rectangle** - Controls the size and shape of the rectangle, as follows:
  - **Width** - Set the width of the rectangle (in coordinate system units, **Frame** or **Grid**).
  - **Height** - Set the height of the rectangle (in coordinate system units, **Frame** or **Grid**).

---

**Adding Images**

You can also add BMP, JPEG, or PNG images to your paper, for example a logo or a backdrop. To add an image to the paper, choose “Image” from the **Insert** menu and browse to the desired image file.

You cannot save images in data files or in a project. When you save a project or data file, any images in the plot are not saved.
Printing and Exporting

Once you have created your plot, use this section to learn how to share it!

Tecplot RS includes many methods of sharing your created plots with others. You can choose from several different ways to save, print, or export your plot, so that you can select the method most appropriate for your intended audience. The following table summarizes each option and its uses.

<table>
<thead>
<tr>
<th>Method</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Your Plot</td>
<td>Prints a display of your plot.</td>
</tr>
<tr>
<td>Exporting a Single Image</td>
<td>Different formats give flexibility between size and accuracy.</td>
</tr>
<tr>
<td>• EPS Export</td>
<td>Easily transmitted electronically. Users must have software capable of reading the selected format.</td>
</tr>
<tr>
<td>• JPEG Export</td>
<td>Tecplot RS's EPS (Encapsulated PostScript) export format concatenates several PostScript files, resulting in a set of images that can resemble an animation sequence.</td>
</tr>
<tr>
<td>• PNG Export</td>
<td></td>
</tr>
<tr>
<td>• TIFF Export</td>
<td></td>
</tr>
<tr>
<td>• WMF Export</td>
<td></td>
</tr>
<tr>
<td>Exporting an Animation or Group of Images</td>
<td>Ideal for displaying multiple plots, especially those that represent time-stepped animations. Great for adding to Web pages or transmitting electronically. Requires that the user has a viewer capable of reading the specific format.</td>
</tr>
<tr>
<td>• Flash</td>
<td></td>
</tr>
<tr>
<td>• AVI</td>
<td></td>
</tr>
<tr>
<td>• Raster Metafile</td>
<td></td>
</tr>
<tr>
<td>Saving a Tecplot Product File</td>
<td>Can be shared with others who have access to Tecplot 360 or Tecplot Focus but not Tecplot RS. Gives limited ability to modify the plot (for example, in grid plots you can change the rotation or variable, but not the time step). Similar to a single-view option.</td>
</tr>
<tr>
<td>• Layout File</td>
<td></td>
</tr>
<tr>
<td>Movie File Creation with Macros</td>
<td>Creates an animation using macro commands.</td>
</tr>
</tbody>
</table>

To utilize these output options, use one of two workflows, depending on whether you wish to produce a single page or an automated series of pages.

To use the simplest method of electronic export, choose "Copy Plot to Clipboard" from the Edit menu. You can then paste your plot into other applications.
E - 1 Printing Your Plot

Technically, printing your plot involves sending the plot image to an output device, print spooler, or file. Typically a printer represents the output device, but you could also print to a plotter, film recorder, file or typesetting machine (for example, you could print your plot to a PDF). Use this option generally if you do not wish to use the output in another program.

To print a plot, choose “Print” from the Project menu. Tecplot RS supports the standard printer drivers for Windows operating systems.

Type Ctrl-P to access the Print dialog quickly.

The Print dialog includes the following options:

- **Print Setup** Click the Print Setup button to open your platform’s Print dialog and set up a printer, including choosing a different printer or adjusting such settings as the colors used and the paper orientation.

- **Send Output to File** (Linux) Generates a disk file of the output rather than sending it to a printer. (This feature is in the Print Setup dialog in the Windows version of Tecplot RS.)

- **Copies** (Linux) Indicates how many copies of the printout to make. (This feature is in the Print Setup dialog in the Windows version of Tecplot RS.)

- **Render Options** Use the Render Options in the Print dialog to control the appearance of your printed plots. In the Windows version of Tecplot RS, these appear in the main Print dialog. In the Linux version of Tecplot RS, a Render Options button appears instead, leading to a separate Print Options dialog where these options may be set.

  - **Color** Check the Color control for color output; uncheck this box for monochrome output.

  - **Render Type** Choose “Vector” to create print output using the drawing commands of the printer. The printer renders the plot, yielding higher resolution, but the printer cannot render some plot options, such as translucency, contour flooding with Gouraud shading, or contour flooding using continuous color distribution.

  Choose “Image” to create print output using an image from Tecplot RS. Tecplot RS does the rendering at the specified resolution, usually less than the printer’s resolution. However, in this case, Tecplot RS can render all plot options.

  - **Force Extra Sorting for all 3D Frames** This option becomes available when you have chosen the Vector option. Checking this box will cause Tecplot RS to use extra sorting in all 3D frames. When printing 3D plots in a vector graphics format, Tecplot RS must sort the objects so that it can draw those farthest from the screen first and those closest to the screen last. By default, Tecplot RS uses a quick sorting algorithm. This method works quickly, but sometimes operates less accurately and fails to detect problems, such as intersecting objects. If you choose Extra Sorting, Tecplot RS uses a slower, more accurate approach that detects problems.
Exporting a Single Image

- Resolution (dpi) When you have the Image option selected, you can access this control. Type the resolution in dpi in the text field to set the print resolution. Larger resolutions may result in an out-of-memory condition, or produce very large files. Smaller resolutions may yield less attractive output images.

E - 2 Exporting a Single Image

To output a single image of your plot, especially for use in other electronic programs, choose “Export” from the Project menu to create a single-frame graphics file (EPS, JPEG, PNG, TIFF, WMF). Each file type provides different advantages and has its own configuration options.

- EPS Export Vector or image graphics in a special type of PostScript file designed for inclusion in other applications.
- JPEG Export JPEG files are very small for their resolution and quite common on the internet, but they do involve some loss of image quality that may affect certain plot images.
- PNG Export Also common on the internet, PNG images have a high image quality but larger file size than JPEG.
- TIFF Export Image in Tagged Image File Format.
- WMF Export Vector graphics to import into various Windows applications.

Each of these formats allows you to set the options for creating the exported file each time you export. If you usually use the same settings, you may set default export options by choosing “Export Options” from the Options menu.

You have the same options when exporting images using the Plot Gallery by clicking the “Export Options” button in the dialog; the selected options apply to all images exported in that operation.

Performance Tips

If exporting is taking an unusually long time, or you get an error message saying that the image cannot be exported, the most likely cause is that the image width you are trying to export is too large. Selecting a smaller image width may speed up the export process.

For an image export size of Length x Width, the file size for an uncompressed true color image is approximately Length x Width x 3. Memory requirements to export such an image can be up to twice this size.

For 256 color images, the maximum file size is approximately Length x Width, but is usually less since all 256 color image files are compressed. However, the memory requirements for exporting are the same as they are for a true color uncompressed image.

Anti-aliasing can dramatically increase the memory requirements during image generation. This is because a larger image is rendered first and then super-sampled to render to the final image. A smaller super-sample allows for faster rendering time. See Section E - 5 “Antialiasing Images”.

Exporting Images with a Specific DPI

You can customize the DPI of your exported image. To do this, first set the width of the frame to the size of the image that you wish to export, using the Edit Active Frame dialog (accessible by selecting “Edit Active Frame” from the Frame menu). Next, when exporting in an image format (BMP, JPEG, or another image format), multiply the frame width (in inches) by the desired DPI, and use that number to define your exported image dimension (enter the number in the Enter Width field of the Export dialog).

For example, to export a 4 inch by 6 inch image at 300 DPI, set the frame dimensions to 4 inches by 6 inches, and then when exporting, select the Enter Width option in the Export dialog and enter a width of 1200 (4 times 300).
E - 2.1 EPS Export

An Encapsulated PostScript file (EPS) is a PostScript file with additional commands that another program can use to determine the size of your plot. After you import your EPS file into another program, you can position it and usually resize it before printing.

If you try to send an EPS directly to a printer, the printer may not position it correctly on the paper. Use Tecplot RS’s Print dialog to send files directly to a printer.

For some applications, if you import an EPS file and print to a non-PostScript printer, it prints only the preview image. On Windows platforms, you must specify that the printer is a PS printer, or you will get a printout of the preview image.

The Export dialog for EPS format has the following options:

- **Color** Use the check box to choose between color and gray-scale EPS output.
- **Render Type** Choose the Render Type as vector PS commands or a PS image in the file. Vector commands generally result in a smaller file, but a PS image is required to accurately represent translucency or smooth color gradations.

  If you choose Vector Render Type, you can also specify:

  - **Extra Precision** Specify the number of decimal places to include in the size and position parameters in the resulting vector-based EPS output. Larger values create more accurate plots but larger file sizes.
  - **Force Extra Sorting for All 3D Frames** Use this check box to order extra sorting in all 3D frames. When printing 3D plots in a vector graphics format, Tecplot RS must sort the objects so that it can draw those farthest from the screen first and those closest to the screen last. By default, Tecplot RS uses a quick sorting algorithm. This method works quickly, but sometimes operates less accurately and fails to detect problems, such as intersecting objects. If you choose Extra Sorting, Tecplot RS uses a slower, more accurate approach that detects problems.

If you choose Image Render Type, you can also specify:

- **Resolution** Type the resolution of the image in dots per inch. Larger values create more accurate plots but larger file sizes.
- **Region** Choose to export only the active frame, or the smallest rectangle containing all frames, or everything shown in the workspace.
- **EPS Preview Type** Tecplot RS provides the following options for the preview image:
Exporting a Single Image

- **None** No preview image information is included. This is good for importing into applications that do not use preview image information.
- **TIFF** Include a monochrome or gray-scale TIFF preview image. (Color preview images are not available.) This is the most common preview image format. You can specify an image depth for the preview image in the Depth menu. TIFF image depth options are described in Section E - 2.4 “TIFF Export”. (This preview image depth is separate from the depth of the actual image for EPS files generated with Render Type Image. Tecplot RS determines the actual image depth.)
- **EPSIV2** Include a monochrome (one bit per pixel) Encapsulated PostScript Version 2 preview image. This is also a common preview image type in EPS files.
- **FrameMaker** Include a monochrome preview image compatible with older versions of Adobe® FrameMaker®. This preview image type is rarely necessary.

When using Render Type Image, these preview image width and height values are separate from the size of the actual EPS image. The actual EPS image size is determined by the Resolution setting.

### E - 2.2 JPEG Export

JPEG (Joint Photographic Experts Group) is an image format, and thus accurately represent plots with translucency and smooth color gradations. However, JPEG is a highly compressible, “lossy” format, and can result in poor image quality for some types of images. The advantage of JPEG is very small file sizes and near universal acceptance on the internet. JPEG supports different qualities of compression, and Tecplot RS allows you to control the image quality (and thus, inversely, the file size).

When you choose the JPEG format in the Export dialog, you have the following options:

- **Region** Choose to export only the active frame, or the smallest rectangle containing all frames, or everything shown in the workspace.
- **Use Width of Image on Screen** Choose this option to generate an image file the same size as the current plot on the screen. This option is required if you use on-screen image rendering in the Display Performance dialog. See Section 27 - 1 “Performance Dialog” for details.
- **Enter Width** Choose this option to specify a width (in pixels) for the generated image. A larger width increases the quality of your image. However, the greater the width you specify, the longer it will take to export the image and the larger the exported file. This option is not available if you have chosen to use onscreen image rendering.

When using Render Type Image, these preview image width and height values are separate from the size of the actual EPS image. The actual EPS image size is determined by the Resolution setting.
Printing and Exporting

- **Antialiasing** Select this option to remove “jagged edges” from the image. See Section E - 5, "Antialiasing Images" for details.
- **Supersample Factor** Control the amount of antialiasing used in the image. See Section E - 5, "Antialiasing Images" for details.
- **Encoding** Choose an encoding method for the JPEG file:
  - **Standard** Creates a JPEG which downloads one line at a time, starting at the top line.
  - **Progressive** Creates a JPEG image that can be displayed with a “fade in” effect in a browser. This is sometimes useful when viewing the JPEG in a browser with a slow connection, since it allows an approximation of the JPEG to be drawn immediately, and the browser does not have to wait for the entire image to download.

Given the same Quality level, **Standard** encoded JPEG files look better than equivalent **Progressive** encoded JPEG files. However, they have a larger file size.

- **Quality** Select the quality of JPEG image. Higher quality settings produce larger files and better looking export images. Lower quality settings produce smaller files. For best results, use a quality setting of 75 or higher.

### E - 2.3 PNG Export

PNG (Portable Network Graphics) is an image format, and thus accurately represent plots with translucency and smooth color gradations.

When you select PNG in the Export dialog, you have the following options:

- **Region** Choose to export only the active frame, or the smallest rectangle containing all frames, or everything shown in the workspace.
- **Use Width of Image on Screen** Choose this option to generate an image file the same size as the current plot on the screen. You can only use this option if you use on-screen image rendering in the Display Performance dialog. See Section 27 - 1 "Performance Dialog" for details.
- **Enter Width** Choose this control to specify a width (in pixels) for the generated image. A larger width increases the quality of your image. The greater the width you specify, the longer it will take to export the image and the larger the exported file. You cannot choose this option if you have chosen to use on-screen image rendering.
- **Antialiasing** Select this option to smooth jagged edges in the image. See Section E - 5, "Antialiasing Images" for details.
- **Supersample Factor** Control the amount of antialiasing used in the image. See Section E - 5, "Antialiasing Images" for details.
• **Convert to 256 Colors** Select this option to generate an image with only 256 colors (down from a possible 16 million colors). Tecplot RS selects the best color match. The image will have a greatly reduced file size, but poor image quality may result if your plot includes many colors, transparency, smooth color gradations, or antialiasing.

**E - 2.4 TIFF Export**

TIFF (Tagged Image File Format) is an image format, and thus accurately represent plots with translucency and smooth color gradations. Tecplot RS generates both color and gray-scale TIFF images.

When you select TIFF in the Export dialog, you have the following options:

- **Color** Choose between color and grayscale TIFF output.
- **Region** Choose to export the active frame, all frames, or everything shown in the workspace.
- **Use Width of Image on Screen** Choose this option to create an image file the size of the current plot on the screen. You have to use this option if you choose on-screen image rendering in the Display Performance dialog. See Section 27.1 “Performance Dialog” for details.
- **Enter Width** Choose this option to specify a width (in pixels) for the generated image. A larger width increases the quality of your image, but exporting will take longer and result in a larger file. You cannot choose this option if you have chosen to use on-screen image rendering.
- **Antialiasing** Choose this option to smooth jagged edges in the image. See Section E - 5 “Antialiasing Images” for details.
- **Supersample Factor** Control the amount of antialiasing used in the image. See Section E - 5 “Antialiasing Images” for details.
- **Convert to 256 Colors** Select this option to generate an image with only 256 colors (rather than a possible 16 million colors). Tecplot RS chooses best color matches. This control will greatly reduce file size, but may decrease image quality if your plot includes many colors, translucency, smooth color gradations, or antialiasing.
- **Depth** For grayscale images, this specifies the number of shades of gray by how many bits of gray-scale information is used per pixel. The larger the number of bits per pixel, the larger the resulting file. Choose one of these options:
  - **On/Off** One bit per pixel using an on/off strategy. All background pixels are made white (on), and all foreground pixels, black (off). This setting creates small files and is good for images with lots of background, such as line plots and contour lines.
  - **1 Bit/Pixel** One bit per pixel using gray scale values of pixels to determine black or white. Those pixels that are more than 50 percent gray are black; the rest are white. This setting creates very small files that might be useful for a rough draft or a preview image.
• 4 Bit/Pixel Four bits per pixel result in sixteen levels of gray scale. This setting results in small image files with a fair number of gray levels; it works well for preview images.
• 8 Bit/Pixel Eight bits per pixel result in 256 levels of gray. This setting represents images most fully, but can result in large file sizes.

E - 2.5 WMF Export

WMF (Windows Metafile) is a vector graphics format and thus can be easily resized by the importing application. WMF files can be imported into many applications. As a vector format, WMF cannot accurately represent plots with translucency or smooth color gradations. Choosing WMF from the Export Format menu displays WMF options (as shown below).

You can choose from the following options:
• Region Choose to export only the active frame, or the smallest rectangle containing all frames.
• Color Toggle-on for color WMF output. Toggle-off for gray-scale.
• Force Extra Sorting for All 3D Frames Use this check box to instruct Tecplot RS to use extra sorting in all 3D frames. When printing 3D plots in a vector graphics format, Tecplot RS must sort the objects so that it can draw those farthest from the screen first and those closest to the screen last. By default, Tecplot RS uses a quick sorting algorithm. This method works quickly, but sometimes operates less accurately and fails to detect problems, such as intersecting objects. If you choose Extra Sorting, Tecplot RS uses a slower, more accurate approach that detects problems.

The Export dialog controls all image exports, but you can access additional animation export options from the Times region of the sidebar. See the following section for details.

E - 3 Exporting an Animation or Group of Images

You can export an animation of your plot by using the Export button in the Times region of the sidebar for various plot types.

When you are viewing the plot type XY Variables, XY Entities, Custom XY Plots, 2D Grid Plots, or 3D Grid Plots, the sidebar includes a Times region with media buttons resembling DVD controls. In grid plots, these buttons control moving through multiple time steps, while in XY plots, they control cycling through successive variables or entities. These controls include:
• Next and Previous buttons to step through one page at a time,
• A Play button to review an entire series of plots in sequence,
• A Reverse button to review the series of plots in reverse sequence,
• A Stop button to stop an animation progression, and
• An Export button that opens a dialog to export an animation.

To export an animation from Tecplot RS, you could display each step of your animation and print or export the images. But the Auto-Export dialog, opened by the Export button, provides a more efficient approach. With this feature, Tecplot RS exports each step of the animation to the chosen output format.
Exporting an Animation or Group of Images

Click the Export button to open the Auto-Export dialog, which includes controls to export an animation. When you click OK, Tecplot RS begins the export.

**Type**

Use the Type menu to choose the format used to output the plots. Your choices include:

- Printer
- AVI
- Raster Metafile
- PostScript
- Flash

When you choose an output format, the options in the dialog change to reflect the output format. For example, AVI and Flash formats use a frame speed, but the printer does not.

When creating printed output, Tecplot RS uses your default printer settings. You can change these defaults using your operating system's printer options, but you must make any changes before beginning to export.

**File Name**

All formats except printing require a file name. By default, Tecplot RS uses the name of your current data file, appended with the appropriate extension. You can use the browse button to choose a different location and/or file name.

**Width**

You can control the size of the output image by specifying the width in pixels. The height will adjust to maintain the aspect ratio currently displayed on the screen.

**Anti-aliasing**

When the export controls instruct Tecplot RS to resize an image to fit into the specified width, the export can suffer a loss of definition and edge sharpness, especially if it includes text. You can use anti-aliasing to reduce the impact of resizing. It does slow down the export process, but generally results in much better images. Use the Anti-aliasing check box to choose whether to include anti-alias computations. Tecplot software uses a method called supersampling to perform anti-alias corrections. You can input the supersampling as a Factor in the text field. Accuracy increases as values increase, but so does the time and memory required to complete the operation. Generally, a value of 3 is sufficient. See Section E - 5 "Anti-aliasing Images" for more information on anti-aliasing and supersample factors.

**Frames/Sec**

When exporting in either AVI or Flash file format, you can specify the playback speed in frames per second. Values can range from 0.1 to 200.
Use Multiple Color Tables

The AVI and Raster Metafile formats support the use of multiple color tables. Most viewing applications now support this option, so this control should usually be turned on.

When this control is turned on, Tecplot RS will create a separate color table for each frame, giving the optimum color map at each step. This is generally more important for grid views than it is for XY plots, since XY plots usually use fewer colors.

Starting Page Number

In your Paper Layout template you can choose whether to include a page number on each page. You can use the text field labeled “Starting Page #” in the Auto-Export dialog to view the current page number and/or to reset the value.

Time Range

The Time Range settings (the Start % and End % boxes) apply only to grid plots. They allow you to limit the range of time steps that Tecplot RS will animate. Starting and ending points are expressed as percentages of the total time span. For example, to output only the second half of the available time steps, set the Start % to 50 and the End % to 100.

You can also limit the time step increments on a grid by clicking the Details button in the Times region of the sidebar and choosing time steps to skip in the Time Options dialog. For XY plots, use the Filter button in the sidebar to control which entities and variables to include in the playback.

OK

When you have set all options as you wish, click OK to begin. Tecplot RS will step through each time step, entity, or variable, and create the plot and output to the file or printer, as appropriate.

E - 4 Saving a Tecplot Product File

To share a view of your plot with another Tecplot user (such as a Tecplot 360 or Tecplot Focus user), you can save your plot as a Tecplot layout package file (.lpk) or write your data to either a binary (.plt) or ASCII (.dat) file.

E - 4.1 Tecplot Layout Package File Export

To create a Tecplot layout package file, choose “Tecplot Data” and then “Save Tecplot Layout” from the Project menu. Other Tecplot products, such as Tecplot 360 and Tecplot Focus, can read the file type that this method creates (.lpk).

Layout package files include data and style information of your plot, with an optional preview image of the Tecplot product workspace. When you use this file type, you lose much functionality of manipulating your plot, retaining basic image viewing, zooming and style representation.

Tecplot 360 does not support the display of stamp plots. If stamp plots are displayed in the exported plot, the .lpk file will show empty squares when loaded into Tecplot 360.

E - 4.2 Data File Writing

Using the Write Data File Options dialog, you can write out the data set in the active frame as either an ASCII or binary data file. Choose “Tecplot Data” and then “Write Tecplot Data File” from the Project
Saving a Tecplot Product File

menu to open this dialog, customize settings and choose file type in the dialog, and click OK to name and choose location for your data file.

The Write Data File Options dialog includes the following controls to help you choose the aspects of your data that you wish to include in the binary file, as well as whether to write the file as ASCII (.dat) or binary (.plt).

- **Details to Save** In the first region of the dialog, choose the details to include in the data file by turning on and off the appropriate check boxes. By default, Tecplot RS includes all details present in the active frame. You can customize whether to include:
  - **Text** Turn on this control to include all text in the active frame.
  - **Geometries** Turn on “Geometries” to include any and all geometries in the active frame.
  - **Custom Labels** Use this control to choose whether to include custom labels.
  - **Field Data** Turn on this control to include zone data in the file.
  - **Data Sharing Linkage (If Possible)** With this control turned on, Tecplot RS will include the variable and connectivity shared between zones in the data set, reducing the data set's size and loading time.

- **Face Neighbor Information Generated by Tecplot RS** Turn on this control to save face neighbor information generated by Tecplot RS for finite element zones. This increases data set size and loading time, but speeds performance after loading.

- **Save Data File Using** Use this control to choose whether to save the file as ASCII (.dat) or binary (.plt). When ASCII is selected, you can set the precision of the float and double variables with the Precision text field. Tecplot RS writes these variable types in exponent format and the precision determines the number of digits included to the right of the decimal point.

- **Zone/Geometry Format** When ASCII file type is selected, you can use this region to choose to write the file in Point or Block format. (Tecplot RS requires BLOCK format if the data set includes any cell-centered variables.) See the Tecplot 360 Data Format Guide (available on the Tecplot Web site) for more information on these formats.

- **Zone(s) and Variable(s)** Use the Zone(s) and Variable(s) regions of the dialog to choose the zones and variables to include in the file.
E - 5  Antialiasing Images

Antialiasing smooths jagged edges on text, lines, and edges of image output formats by the process of supersampling. Tecplot RS renders a large intermediate image and then reduces it to the final image size. It creates each pixel on the final image from multiple rendered pixels. The width and height of the intermediate image are the width and height of the final image times the scale factor, the Supersample Factor. You can use values from 2 to 16, although usually a factor of 3 renders sufficiently. Large scale factors take much more time and memory. Some graphics cards limit the dimensions of rendered images to a maximum of 2048x2048 or 4096x4096 pixels, and thus Tecplot RS cannot antialias if it results in an intermediate image larger than this limit.

Antialiasing uses many colors, although since certain image formats have limits of 256 colors, they cannot always represent antialiased images correctly. The image formats limited to 256 color include AVI, Raster Metafile, and any image format with the Convert to 256 Colors option selected. With these formats, the antialiasing works for plots with a very limited selection of colors (like a red mesh on a black field). Otherwise, antialiasing with 256 colors wastes time and may decrease plot quality.

Using animation formats can amplify the antialiasing and 256-color problem. Both AVI and Raster Metafile support only 256 colors, and need to use them to display multiple frames. For these formats, try a test animation of a few steps with antialiasing on before creating the entire animation.

You can use antialiasing only with image export rendering performed off-screen (the default setting). In some cases, you may find that you need to turn off the off-screen rendering (usually due problems with a graphics card).

E - 6  Movie File Creation with Macros

You can also export an animation using the Tecplot macro language, by using macro commands to export images to a movie file. You can also use loops to repeatedly rotate 3D objects, cycle from one zone to another, and so on, to create your movie. See Chapter 24: “Macros: Task Automation” for detailed information regarding the Tecplot macro language.

A typical macro file for making movies has the following form:

```plaintext
#IMC 1410
... optional commands to set up the first image
$!EXPORTSETUP EXPORTFORMAT = AVI
$!EXPORTSETUP EXPORTFNAME = "mymovie.avi"
$!EXPORTSTART
EXPORTREGION = CURRENTFRAME
$!LOOP 50
... commands to set up next image
$!REDRAWALL
$!EXPORTNEXTFRAME
$!ENDLOOP
$!EXPORTFINISH
```

E - 7  Advanced Animation Techniques

This section includes a couple advanced techniques to experiment with when creating animation files.

E - 7.1  Text Changes

If you wish to include information in your animation file which tells viewers about the time step, current zones, or a mapping, you can add dynamic text to your text box(es). See Section D - 4.6 “Dynamic Text”.

384
Movie File Viewing

E - 7.2 Multiple Frames Animation

Animation of plots in multiple frames requires the use of a macro. Macros can use the $FRAMECONTROL commands to switch between each frame. The following template demonstrates how to do this with a project in which each frame contains a similar plot:

```
$VARSET |NumCycles| = 10
$EXPORTSETUP EXPORTFORMAT = RASTERMETAFILE
$EXPORTSETUP EXPORTFNAME   = "2frames.rm"
BITDUMPREGION = ALLFRAMES

## Set the number of images (movie frames) in the animation.

## Outer loop
$LOOP |NumCycles|
## Inner loop cycles through each frame in the current plot.
$LOOP |NumFrames|

## Push the top (active) frame to the back.
$FrameControl MoveToBottomByNumber
## Activate new top frame
$FrameControl ActivateTop
$EndLoop

## This series of $IF statements ensures
## that a new AVI file will be created when
## the macro is started.
$IF |Loop| == 1
$EXPORTSTART
EXPORTREGION = CURRENTFRAME
$ENDIF
$IF |Loop| != 1
$EXPORTNEXTFRAME
$ENDIF
$ENDLOOP
$EXPORTFINISH
```

E - 8 Movie File Viewing

The following tools allow you to view movie files you have created with Tecplot RS.

E - 8.1 AVI Files

AVI format is the standard video format for Windows platforms. Below are some applications that can be used to view and/or edit AVI files:

E - 8.2 Flash Files

Playback

- Flash movies can be played in several freely distributed Flash players. Swiff Player is a very good stand-alone player that enables Flash users to easily play their Flash movies.
- You can play Flash movies using QuickTime® software.
- There are several tools at download.com that can help manage, browse, convert, and display all kinds of Flash files on your computer.

Flash in PowerPoint

The easiest way to insert and play SWF files into Microsoft® PowerPoint® presentations is to download the Swiff Player — a free Microsoft PowerPoint Add-In.

A secondary option is to play it in a PowerPoint presentation using a specific Microsoft® ActiveX® control and the Macromedia Flash Player. To run the Flash file, you add an ActiveX control to the PowerPoint slide and create a link from it to the Flash file. You also have the option of embedding the file in the presentation. The tutorial linked below will help you do this:

https://support.office.com/en-us/article/Play-an-Adobe-Macromedia-Flash-animation-in-a-presentation-3b681bae-6ca9-413f-b41a-eb748babc588

Flash on the Web

You can insert Flash files into Web and HTML documents using several different Web design tools, such as Adobe® Dreamweaver® and Adobe® GoLive®, as well as free tools. If you are familiar with hand-coding HTML, you can do that as well.

Once inserted, Flash movies play directly within your browser. You do not need an outside media player to launch the animation.
Plot Options

The Plot Options dialog enables you to control the appearance and style of your plots. Each page of the dialog focuses on customizing a particular aspect of your plot.

To access the Plot Options dialog, click the Plot Options button in the sidebar, or choose “Plot Options” from the Options menu. You can also quickly access most of the pages of the Plot Options dialog by double-clicking on the plot object that you want to edit.

The following options are available:

- Load/Save
- Variables
- XY Lines
- XY Axes
- Grids
- Grid Legend
- Grid Axes
- Cell Labels
- Wells

F - 1 Load/Save

The Load/Save page of the Plot Options dialog includes methods of saving and retrieving style settings, as well as ways to format your axes.

F - 1.1 Load/Save Settings

On the Load/Save page of the Plot Options dialog, you can load or save style settings. This useful function can help you save significant changes for future plots.

Toggle-on “Load at startup” to load the current style file whenever Tecplot RS is launched. The current style file that will be loaded at startup when that toggle is checked is listed as the Current Style heading at the top of the dialog.
Plot Options

When you save style settings, Tecplot RS stores all plot options settings in a Tecplot Style File (extension .rsstyx). When you save a project file, Tecplot RS embeds the style settings in the project file itself. You can load embedded style settings from a project file by clicking the Load button on the Load/Save page and then choosing the “RS Project with embedded data” file type in the Open File dialog.

Use the Save and Save As buttons to create and updated style files (.rsstyx) which can then be loaded automatically at startup (by toggling-on “Load at startup”) or manually at any time (by clicking the Load button and browsing to the file).

The Reset Defaults button will reset all Plot Options settings to the factory default states.

Previous versions of Tecplot RS saved style files with the .sty extension. To load style files with this extension, choose “Old format style file (*.sty)” from the Files of type menu in the Open File dialog.

F - 1.2 Miscellaneous Settings

Use the Misc Settings region of the Load/Save page of the Plot Options dialog to customize default time display and animation settings. The time and date formatting options apply only to XY plot axes.

You have the following options:

- **Default Time Variable** - Many simulators record both a Time and Date for the time variable. On XY plots, this selection controls which one (if both are available) that Tecplot RS displays by default on the X-axis. On Grid plots, this selection controls whether time or dates are displayed on the plot title and when choosing the time step.

  This setting controls only the default setting. Within the appropriate dialog you can choose any variable for any axis.

For additional control of the time increments displayed on your grid plot, use the Details button next to the “Delta” option in the sidebar. See Section 13 - 3.1 “Time Options” for more information.
• **Date Format** The Date Format menu provides options of how to format your axis label when displaying dates. Tecplot RS includes the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000.50</td>
<td>The year displays as a four-digit integer, followed by a decimal portion of the year (DEFAULT)</td>
</tr>
<tr>
<td>07/31/00</td>
<td>Two digits represent the month, two digits represent the day, and two digits represent the year</td>
</tr>
<tr>
<td>07/31/2000</td>
<td>The day and month are represented by two digits; the year displays as four digits</td>
</tr>
<tr>
<td>Jul-31-00</td>
<td>The three-letter month abbreviation displays, followed by a two-digit day and two-digit year</td>
</tr>
<tr>
<td>Jul-31-2000</td>
<td>Three-letter month, two-digit day, four-digit year</td>
</tr>
<tr>
<td>31/07/00</td>
<td>Two-digit day, two-digit month, two-digit year</td>
</tr>
<tr>
<td>31/07/2000</td>
<td>Two-digit day, two-digit month, four-digit year</td>
</tr>
<tr>
<td>31-Jul-00</td>
<td>Two-digit day, three-letter month, two-digit year</td>
</tr>
<tr>
<td>31-Jul-2000</td>
<td>Two-digit day, three-letter month, four-digit year</td>
</tr>
<tr>
<td>07/00</td>
<td>Two-digit month, two-digit year</td>
</tr>
<tr>
<td>07/2000</td>
<td>Two-digit month, four-digit year</td>
</tr>
<tr>
<td>Jul-00</td>
<td>Three-letter month, two-digit year</td>
</tr>
<tr>
<td>Jul-2000</td>
<td>Three-letter month, four-digit year</td>
</tr>
<tr>
<td>2000/07/31</td>
<td>Four-digit year, two-digit month, two-digit day</td>
</tr>
<tr>
<td>2000-Jul-31</td>
<td>Four-digit year, three-letter month, two-digit day</td>
</tr>
</tbody>
</table>

Date formats other than the default are not compatible with years before 1800. Numbers in dates in such years appear as all asterisks (e.g. **-***-**** instead of Jan-31-1700).

• **Time Format** The Time Format menu controls the axis label formatting when displaying elapsed time. You can display the time on your axis in any of the following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>40.75</td>
<td>The number of days displays, followed by a decimal portion of days.</td>
</tr>
<tr>
<td>40 18:30</td>
<td>The number of days displays, followed by the number of hours and the number of minutes</td>
</tr>
<tr>
<td>40 18:30:00</td>
<td>The number of elapsed days displays, followed by the number of hours, the number of minutes, and the number of seconds (separated by colons)</td>
</tr>
</tbody>
</table>

To change the range of your displayed dates or times, switch to the XY Axes page of the Plot Options dialog, or double-click on the date axis to bring up the XY Axes page.

**Animation Step Delay** This slide controls the length of the pause between each step of a plot that includes an animation option. If a plot animation cycles too quickly through all the available entities, variables, or time steps, use this slider to adjust the timing.
Plot Options

F - 2 Variables

The Variables page of the Plot Options dialog allows you to define default styles and alternative names for all variables in your project. On this page, choose a variable to customize from the Master Variables List on the left side of the dialog, then make the desired changes. The changes are automatically saved.

Specifically, the Variables page of the Plot Options dialog has the following options to help you customize variables.

F - 2.1 Master Variables List

The Master Variable List includes every defined and derived variable in your loaded data sets. The list includes all variable names from each of these sources:

- The RS Variables Files file
- All loaded data files
- All derived variables calculated from the Grid Equations dialog and the XY Equations dialog
- Any style files loaded using the Load button on the Load/Save page of the Plot Options dialog

The Master Variables List references each variable by its short name, generally derived from the simulator. A simulator usually generates short names as all uppercase and no more than 8 characters long, but these conventions do not reflect Tecplot RS limitations.

The Master Variable List also includes nine variables named ST1 through ST9. The long names of these variables appear as Entity 1 through Entity 9. Do not delete these variables from the RS Variables file. The XY Entities and XY Custom Entities plot types use these variables (XY Freestyle does as well, occasionally).

In these plot types, a frame contains plots of a single variable for multiple entities (other plot types show a single entity with the options for multiple variables). If the style was based on the variable being shown, a plot showing three wells would have no way of differentiating one well from another.

So for these plot types, Tecplot RS reads the style not from the variable but from the entity number. These ST1 through ST9 represent the nine different entity-specific styles, which you can customize. If you include more than 9 entities in a single frame, the cycle of styles will repeat.

F - 2.2 Sort and Active Toggles
Two toggles appear at the top of the dialog that allow you to control how the Master Variable List appears. When **Sort** is toggled on, variables appear in the Master Variable List in alphabetical order according to their short name. When toggled off, variables appear first as they do in the active RS Variables file, followed by the names that Tecplot RS added from the data files in the order that it opened the data files. The latter method helps if you want to use an RS Variables file to group variables in order of use.

The **Active** toggle becomes available when you have at least one data set loaded. When toggled on, Tecplot RS limits the variable list to only those variables that exist in the current data sets. In general, leave this toggled on unless you choose to specifically edit the MVL options for all variables. Derived variables that have been calculated in the **Grid Equations** dialog or the **XY Equations** dialog will automatically append to the Active list. Also, Tecplot RS will calculate saturation variables that are part of the simulation but excluded from the recurrent data file and include them in the Active list.

### F - 2.3 Aliases

In the Aliases region of the dialog, you can define a long name for any variable, as well as up to three short name aliases for that variable. For example, you could define “Oil/Water Ratio” as the long name for the “OWR” variable. In the Paper Layout plot type, you can choose where to display long variable names: in the frame title, the plot titles, and/or the axes of XY plots. See “Title Options” on page 367 for instructions.

- **Long Name** - To change a variable’s long name, choose the variable in the Master Variables List and type a new long name into the Long Name field in the Aliases region of the dialog. Tecplot RS will accept a long name of up to 80 characters in length, but we recommend no longer than 32 characters.

- **Alias 1, Alias 2, Alias 3** - You can define up to three short name aliases for each variable as well. Aliases are useful when you use the Compare toggle in XY plots to view data from multiple files, since Tecplot RS will equate a variable in either file known by one of the aliases with the associated short name in the Master Variable List. For example, if your simulator outputs “OWR” as the Oil/Water Ratio variable, but your historical data files name the Oil/Water Ration variable “WOR”, include WOR as an alias for OWR. Then Tecplot RS will recognize that the two names refer to the same variable, and will display the correct comparison of that variable between the two files.

Aliases do have a unique limitation: Once you define them, you cannot change them with Tecplot RS running. You can add a new alias, but you cannot change an existing one. This occurs because Tecplot RS merges the lists of aliased variables when it loads new data sets. To change an alias, edit the active RS Variables file directly. See Section “Editing RS Variables Files” for details.

### F - 2.4 Default Styles

Below the Aliases region of the Variables page, the Default Styles region enables you to choose default styles in which each variable displays. Use the Line Color, Line Pattern, Symbol Color, and Symbol Shape menus to set the styles used by default when displaying each variable. As with the Aliases region of the dialog, select the variable you wish to edit in the Master Variables List, change the default styles as you wish, and click Apply.
Plot Options

Since the XY Lines page of the Plot Options dialog enables you to choose even more customized variable styles, remember that the styles set on this page will affect the plot only if the selections on the XY Lines page are set to “Default”.

It may seem that the settings on the XY Lines page function identically to the Default Style settings on the Variables page of the Plot Options dialog, since on both pages you can choose styles that change depending on the variable or entity being plotted. Here is how they differ:

The settings on the XY Lines page define 20 different Style Sets (selected in the Style Set menu). Tecplot RS uses the Style Sets to plot comparisons of data from multiple files (Comp 1 is used for the first comparison data set, Comp 2 for the second, and so on). If you wanted to change the color for OPR lines from green to lime, you would have to change it 20 places on the XY Lines page.

The “Default” selection on the XY Lines page does defer the style settings of that compared variable to the settings on the Variables page.

F - 2.5 RSVariables

This section displays the path of the active RS Variables file, which contains variable name substitutions, aliases, and the default colors and line and symbol styles used in line plots. Click Change to choose a different file (sample files are provided for each simulator supported by Tecplot RS). See RS Variables Files for further information on these files.

F - 3 XY Lines

The options on the XY Lines page of the Plot Options dialog provide style controls to change line and symbol properties for the variables in your style sets. You can quickly access this page by double-clicking on any line representing data in an XY plot.

F - 3.1 Style Set

You can design up to 100 complete sets of styles – one for the active data set and one each for up to 99 comparison data sets. The Style Set menu controls which set you are altering. Initially, the settings in RS Variables Files define the “default” values for each property, with the exception that the Lines Pattern is cycled for the comparison style sets to differentiate them from the Active Style Set. Each Style Set is applied to the data set(s) included in a comparison plot according to the order specified on the Order page.
of the Compare Data Sets dialog. (For example, Comp 1 is applied to the first file listed on the Order page.) Refer to Chapter 10: "Comparing XY Data" for more information on specifying comparison values.

You can specify the style for each variable in each Style Set. Typically, you would only edit the styles applicable to the plots you are creating. Often the default settings display sufficiently. To quickly edit a line style, double-click on the specific line in the XY plot of interest. This will bring up the XY Lines page with the appropriate Style Set and Variable pre-selected in the dialog. After you make several changes to line styles you should save a style file using the Load/Save page of the dialog. If you create or use an existing Project file, Tecplot RS will automatically save all of the style changes to the Project file.

To edit multiple combinations of variables and style sets, click the Multi-Edit Styles button (see "Multi-Edit XY Line Styles" on page 394).

F - 3.2 Variables

The Variable box includes all the names included in Section F - 2.1 "Master Variables List", including settings for entities. Use it to choose the variable for which you want to change the comparison style settings. The variable is automatically selected if you accessed this dialog by double-clicking on a line in an XY plot. Click the button in the upper-right corner of the list to launch an expanded, searchable list. This helps particularly for very long lists.

You can also use the Variables page of the Plot Options dialog and manage this list of variables by sorting it alphabetically and limiting it to just the variables that appear in your data files.

Toggle-on “Long Names” to display the full name of the variable (as defined in the Master Variables List). When “Long Names” is toggled-off, Tecplot RS uses an abbreviation.

Tecplot RS uses the variables named “Entity1” through “Entity9” or “ST1” through “ST9” to customize the style settings for entities used in XY Entities plots. “Entity 1” / ST1 correspond to the first entity in the plot, and so forth.

F - 3.3 Style Selections

The style selection options are initially set to default settings defined in the RS Variables file for a given variable or set of variables. To edit the settings, use the Variables page of the Plot Options dialog to change them interactively, or create a personal RS Variables file and edit it. Refer to Section F - 2.1 "Master Variables List" and Section "Editing RS Variables Files" for instructions.

The options are grouped for lines and symbols, as follows:

- **Lines or Symbols** - Controls whether lines and/or symbols display. If you toggle-off both switches, Tecplot RS will display nothing in the plot for the corresponding variable and Style Set. These settings also depend on the master toggles for Lines and Symbols provided at the top of the sidebar for XY plot types.

  When you work with a variable that is repeated in multiple Style Sets and you wish to display it only once, toggle-off both “Lines” and “Symbols” for that variable in the other Style Sets. That variable will not be included in the plot of legend for the associated data set. This is useful when comparing multiple Eclipse history match runs in which the output file for each run includes the historical data.

- **Color** - Choose from 26 standard colors or Default, which uses the color defined in the Master Variables List. For symbols, you can also choose the “Match Line” option. This option sets the symbol color to match the color of the line. The symbol color will update whenever the line color is changed.

- **Pattern** - Six line patterns are offered, plus the Default option that reads the pattern from the Master Variables List.
Plot Options

- **Pattern Length** - You can alter the repeat length of the pattern. Values are expressed as a percentage of frame size.
- **Thickness** - You can select the thickness of the line. Again, Tecplot RS measures these values relative to the frame size.
- **Symbol Shape** - Seven shapes are offered, plus options for Default and Character. When Default is selected, the shape is taken from the Master Variables List. When Character is selected, a small text field will display. Use this to input the alpha or numeric character to be used as a line symbol. For example, you may want to use "W" for water variables, "G" for gas, and so on.
- **Symbol Spacing** - The "All" option will plot a symbol at each data point. Use the "D" options to space symbols at approximately even intervals along the line, with the spacing value expressed as a percentage of frame size. The "I" spacing options are skip values. For example, I = 6 will place symbols at every sixth data point.
- **Symbol Size** - Tecplot RS expresses sizes as a percentage of frame size.

### F - 3.4 Multi-Edit XY Line Styles

The XY Lines page of the Plot Options dialog allows you to define styles for each unique variable/style set combination, one at a time. To make multiple assignments at once, click the Multi-Edit Styles button in the lower right corner of the XY Lines page. The Multi-Edit XY Line Styles dialog appears.

When the Multi-Edit XY Line Styles dialog opens, the selections match the settings in the Plot Options dialog, but this is just a starting point. The basic style settings are identical to those in the Plot Options dialog: line color, pattern, etc. Two things are different:

1. **First**, you’re making style assignments to multiple variable/style set combinations. You choose the variables and style sets using the two multi-select lists in the lower half of the dialog. Most of the time, you will choose one variable and multiple style sets or one style set and multiple variables, although you can also choose one or multiple of both.
2. **Second**, the Include toggles control which styles you are setting. You may choose to set only one style or several in a single operation.

For example, suppose you wanted to always show any Oil values in green, but alter the line style to differentiate rates from cumulative values, and use a different symbol to differentiate files in comparison plots. You can do this as follows:

1. Set the line color:
   a. Check only the Include toggle next to Color, and set the color to green.
   b. Highlight the desired Oil values in the variables list that will be plotted in green.
   c. Highlight all the style sets using the Select All button.
   d. Click Apply.
   You’ve just made hundreds of changes – one per style set time the number of oil variables selected.
2. Differentiate OPR (rate) from OPC (cumulative):
   a. Turn off the Include toggle next to Color, and turn on the toggle for Pattern (and Pattern Length, if desired).
   b. Select the Oil Production Rate variable.
c. Choose the styles you want for Oil Production Rate—for example, a solid line.
d. Select all the style sets using Select All, then click Apply
e. Change the variable to the Oil Production Cumulative, change the line pattern to something different (e.g. short dash), and click Apply.

Repeat the last step for other oil values, using different line patterns for each.

3. Differentiate comparison plots
You may find it nice to use the line symbols for differentiating comparison plots. A character symbol is a good way to do this, and this can be done for all variables. For example:

a. Set the toggles to copy only the symbol options. You definitely want shape, but you may also want to set the size and spacing. Color is optional depending on what you want to do.
b. Choose a symbol shape of Character, and set the character to the number “1”.

c. Choose ALL variables.
d. Choose ONLY the Comp 1 style set, then hit Apply.

e. Repeat by changing the character to “2” and the style set to Comp 2.

You may choose instead to use symbols instead of line patterns to tell OPR from OPC, and use patterns to differentiate comparison plots. The choices are yours, but the Multi-Edit XY Line Styles dialog makes it easy to make mass edits.

F - 4 XY Axes

The settings on the XY Axes page of the Plot Options dialog control the axis ranges for each variable as well as the style of the axes on all XY plots. To quickly access this page, double-click on an axis or axis label (title) in any XY plot.
F - 4.1 Variables

Use the Variables list on the left of the dialog to choose a variable to customize. If you access this page by double-clicking an axis or label in your XY plot, the dialog will open with the variable assigned to that axis highlighted in the list. Click the button in the upper-right corner of the list to launch an expanded, searchable variables list. This button helps particularly for very long lists.

The Long Names toggle controls whether the Variables box displays the long variable names. Toggle-on “Long Names” to display the long variable names. Otherwise, the short (acronym) names display.

The list of variables that displays here comes from Section F - 2.1 “Master Variables List”.

You can also switch to the Variables page of the Plot Options dialog and manage this list of variables by sorting it alphabetically and limiting it to just the variables that appear in your data files. You can use the Variables page to add variables to your RS Variables file.

F - 4.2 Axis Scale

The Axis Scale region of the dialog controls the scale (range and display) of axes on XY plots. You can choose to instruct Tecplot RS to display a range that fits the data, or to customize the ranges manually.

The selections in the Axis Scale region of the dialog apply only to the variable selected in the Variable list. After clicking the variable in the Variable list that you wish to customize, choose from the following options in the Axis Scale region of the dialog.

- **Range** - The Range menu controls how the minimum and maximum axis values are determined. Choose from three options:
  - **Frame** - With this option selected, Tecplot RS will compute the limits to encompass the range of variable values plotted in a single frame. This option gives you the best “zoomed in” view of the data.
  - **Data** - If “Data” is selected, Tecplot RS will compute the limits to encompass the range for each variable in all entities of the same type. This gives a common scale for all frames, to show how one well compares to another.
  - **Manual** - Choose this option to manually type the minimum and maximum values for Tecplot RS to use for axes.

For the majority of applications, setting the range to either Frame or Data will produce good results.

- **Min and Max** - These text fields become active when you select “Manual” for the range. Type the minimum and maximum values of the range in these boxes. If you wish to adjust the range of your Time or Date variable, type the Min and/or Max in the decimal year format (for the Date variable; for example, 2000.50) or the decimal days format (for the Time variable; for example, 40.75).

- **Interval** - Choose the interval of units display between major markers (labels). A value of zero (0) instructs Tecplot RS to calculate the interval.

- **# of Minor Markers** - Choose the number of minor markers or grid lines to display between major markers. Use 0 to skip drawing minor markers.

- **Scale** - The Scale menu rescales axes labels. When you deal with very large values, you can direct Tecplot RS to reduce them to multiples of a thousand, million, and so forth by choosing a factor from this menu. Choose “Enter” to type a custom scaling factor in the text field beneath the Scale menu.
Grids

When you use a factor other than 1, the axis label will include the scaling information. For example, when the Oil Prod Rate variable Scale is set to 1000, the label reads “Oil Prod Rate (1000 STB/Day).”

- **Toggle-on “Log” to use a logarithmic scale.** In this case, it is usually best to select Manual range with “nice” values for the limits (such as 1, 10, 100, and so forth).
- **Unit Override** - Toggle-on “Unit Override” to specify your own unit label. The standard unit label is a combination of the scale factor and the unit label from the data file. After toggling-on “Unit Override”, type the unit label that you wish to display in the text field that appears underneath the Unit Override toggle. For example, you might type “MSTB/Day” to replace “1000 STB/Day”.

When zooming a plot in or out, the grid interval and tick mark spacing will temporarily reset to automatic settings calculated based on the chosen magnification. Click the **Reset plot view** button (or change the plot type) to return to the standard plot, which uses the settings defined here.

F - 4.3  Axis Style

The selections in the Axes Style region of the XY Axes page control how axes are drawn and labeled:

- **Label or Axis Color** - Choose the color of the displayed label or axis:
  - **Standard Colors** - Choose from 26 standard colors.
  - **Match Line** - Choose Match Line to match the color the text, axes, and/or grid and markers according to color of Axis Line Variable. When comparing data sets, Tecplot RS matches the color of the variable in the active data set. When multiple variables are plotted on a single axis, Tecplot RS uses the color of the first variable.
- **Font** - Choose from a list of the available fonts.
- **Size** - Choose the font size expressed as a percentage of frame height.
- **Major Markers** - Choose Ticks, Solid Lines, Dotted Lines, or Precise Dots.
- **Minor Markers** - Choose from the same options as for Major Markers (above).

Tecplot RS will apply the selections on this page as follows:

- Axes are always drawn with major markers and a border.
- Tecplot RS will use the same font for axes labels and the axes titles.
- If you specify an axis size in the dialog, the axes labels will also use this size. The titles will be 1.2 times as large as the specified axis size.
- The choices you make for major and minor markers will apply to both axes.
- Label size and color selections are used on all axes.
- Tecplot RS controls the plotting area within the frame, making adjustments according to how many axes are displayed and the selected font sizes. For multi-frame plots, Tecplot RS rescales the font size based on the aspect ratio of the frames.

Tecplot RS will choose a labeling interval automatically.

F - 5  Grids

The Grids page in the Plot Options dialog includes selections for formatting the grid styles of active cells, inactive cells, and see-through cells. To access this page, double-click on the reservoir grid in any grid plot, or choose “Plot Options” from the Options menu and switch to the Grids page.
Active Cell Grid Styles

When you have “Active Cells” selected on the left side of the Grids page, the settings that display on the Grids page control the Mesh and Contours of the active plot, for 2D Grid Plots or 3D Grid Plots.

Active Grid Styles

In the Active Grid Styles region of the Grid page, you can modify the color and mesh styles of the grid. The first set of options allow you to customize how Tecplot RS presents the selected grid variable on the cell faces. Choose one of the flood options to flood the cell faces with color to represent the variable value (such as oil saturation or porosity). If you choose to display contour lines, the Contour Lines region of the dialog will become active.

Your options include:

- **Cell Center Flood** - Tecplot RS fills the entire cell face according to the cell-center value of the selected variable.
- **Average Corner Flood** - Tecplot RS averages all four corners of a cell face and fills the area with a solid color. This is not useful for cell-centered data.
- **Continuous Flood** - Colors vary across the face according to the set contour levels. The color is constant between two contour levels.
  - **Lines** - With this option selected, contour level values display as lines. Solid lines depict positive values and dashed lines depict negative values.

The grid style for an XYZ Slice or Iso-surface will always display as flooded, regardless of the setting in this dialog.

To change the grid mesh color, choose a color for the grid mesh (wire frame) from the Mesh Color menu. The “Multi” selection colors each grid line segment according to the local values of the selected grid variable.

You can choose or type a thickness of the line used to draw the mesh in the Thickness box. This control expresses thickness as a percentage of frame size, with acceptable values ranging from 0.1 to 1.0.
Contour Lines

The Contour Lines region of the dialog controls the style settings for contour lines in the active plot, when “Lines” is selected in the Active Grid Styles region of the page. This includes the following options:

- **Line Color** - The Line Color menu controls the color of the contour lines. By default, Tecplot RS chooses the “Multi” value, which colors the contour lines according to the value of the contour variable. You can also choose single color options that set the contour lines to one color.
- **Thickness** - The Thickness box controls the width of the contour lines.
- **Labels** - Toggle-on “Show Labels” to include contour line labels in your plot. Use the Label Color, Label Size, and Font menus to customize the style of your contour labels. Use the Spacing menu to alter the spacing between the contour labels along a given contour line. Tecplot RS measures spacing as a percentage of the frame height.

F - 5.2 Inactive Cell Styles

To adjust the style of the inactive cells’ display, select “Inactive” on the left side of the Grids page. With the controls that appear, you can customize the display style of the inactive cells in your grid. These controls are also included in the Inactive Cells dialog; changes made in one dialog will be reflected in the other.

In the first set of options, you can choose whether to display the inactive cells as a simple mesh or shade, or whether to display a variable value:

- **No fill (mesh only)** - Choose this option to display the inactive cells as a mesh.
- **Solid Shade** - Choose this option to fill the inactive cells with a color.
- **Variable - match active** - Choose this option to color the inactive cells according to the solution data of the variable used by the active cells. If the inactive cells do not contain a value for that variable, they will display with a value of zero.
- **Variable - independent** - Choose this option to color the inactive cells according to solution data of a variable of your choice. If the inactive cells do not contain a value for that variable, they will display with a value of zero.

To learn how to select an independent variable for the inactive cells to display, refer to Section 14.1.6 “Inactive Cells”.

The remaining options in the Inactive Grid Styles region of the Grids page control the mesh color, mesh thickness, and/or shading color displayed by the inactive cells:

- **Mesh Color** - Choose a color from the Mesh Color menu to display a mesh of that color.
- **Thickness** - Choose or type a thickness value between 0.1 and 2.0 in the Thickness field to specify the width of the mesh lines as a percentage of frame size.
- **Shade Color** - Choose a color for inactive cell shading from the Shade Color menu.
Plot Options

Click the Apply button to view the results in your plot.

F - 5.3 See-through Grid Styles

Tecplot RS uses see-through styles in 3D views any time you select options in which viewing the interior of the grid is advantageous, for example, when toggling on “Ghost” while displaying Inside Views.

Ghost Gray is the recommended option; this will produce a translucent gray surface that shows the surface of the reservoir while also leaving the interior details visible. Use the Translucency slider to increase or decrease the visibility of the ghosted image.

The “Ghost Color” option displays a translucent reservoir surface colored by the selected grid variable. Generally, turn off the mesh when you have either of the ghost options selected for the best view, and turn on the mesh only when No Fill is selected.

The Show Mesh option is related to, but different from, the Mesh toggle in the sidebar. The sidebar toggle turns off all mesh displays, including the mesh for the see-through grid, if it is visible. The Show Mesh option in this dialog determines whether the see-through grid’s mesh is shown when the Mesh sidebar toggle is on.
Grid Legend

The Light Effect menu controls how light source shading is performed. This is done whenever “Light” is toggled-on in the sidebar. Choose Paneled for fastest performance, or Smooth for a more realistic (but slower) effect.

F - 6 Grid Legend

The Grid Legend page of the Plot Options dialog includes selections for formatting the range and style of the grid variable legend that displays for 2D Grid Plots and 3D Grid Plots. Access this dialog quickly from any grid plot by double-clicking on the legend.

F - 6.1 Variables

The selections you make on this page apply on a variable-by-variable basis. In the Variables region of the page, select the variable you wish to customize in the other regions of the page.

- **Variable** - The Master Variables List displays in the Variables box. When you double-click on the legend, the corresponding variable automatically displays as selected when the page displays. Click the button to launch an expanded, searchable variables list. This helps for very long lists.
  
  The variables in the box come initially from RS Variables Files. Tecplot RS appends derived variables and variables that occur in loaded data files to this list. To change a setting for a variable in this master variable list, refer to Section F - 2 “Variables” or Section “Editing RS Variables Files” for instructions.

- **Long Names** - Toggle-on “Long Names” to display long variable names in the box. Otherwise, the short (acronym) names display.

F - 6.2 Variable Range

In the Variables Range region of the page, you can customize the range for which each variable displays in your plot. This region includes the following options:

- **Variable Range** - This menu contains three options for determining the minimum and maximum limits for the ranges of the variables:
  
  - **Frame** - The limits will be computed to encompass the range of the variable values across all time steps. This gives an individual scale for each frame, making it easier to see how a variable functions in each frame.
Plot Options

- **Data** - The limits will be computed to encompass the range of the variable values across all time steps. This gives a common scale for all frames, making it easier to see how one well compares to another.
- **Manual** - Use this option to control the minimum and maximum values for the legend ranges manually, by typing the values in the fields.

In the case of grid legends, the Frame or Data selections operate identically. The legend will encompass the full range of variable values for all time steps.

- **Min and Max** - These text fields activate when the Manual range is selected. Type the minimum and maximum values of the ranges in these fields when using the Manual variable range.

For the majority of applications, setting the range to either Frame or Data will produce reasonable results.

- **Cutoff Below/Above** - Toggle-on “Below” or “Above” to remove contour variable values below or above a given cutoff, respectively. Type the cut-off value in the corresponding text field. The cells within the cut-offs will display without color.

## F - 6.3 Contour Legend

Use the Contour Legend region of the dialog to customize the style of your contour legend for each variable. You have the following options:

- **Labels** - Use the Labels box to specify the number of contour labels to display in your legend. Changing the number of labels in the contour legend will also change the number of labels on the contour lines themselves, and vice versa.
- **Levels** - Use the Levels box to specify the number of contour levels to display in your plot. The Levels and Labels values are used to calculate legend intervals that will display “nice” numbers for the legend labels.
- **Log** - Toggle-on “Log” to use a log scale for the levels used in the legend. Use Labels and Levels settings that produce a “nice” look for the legend.
- **Orient** - Specify whether to have a vertical or horizontal contour legend.
- **Colors** - Use this menu to specify the color map to use for your contour plot. Using colors from this menu instructs Tecplot RS to color different ranges of variable values different colors. For example, with the small rainbow color map (“Sm Rainbow”), Tecplot RS will shade the smallest values blue, then green, then yellow, and the highest values red.
- **Invert** - Use the Invert menu to invert the color map. Choose from one of the following color map settings:
  - **Auto Invert** - Select “Auto Invert” to invert the colormap only when water saturation is set to the contour variable. When using the small rainbow color map, this associates blue with the high end of the range. The colormap will be in its standard configuration for all other contour variables.
  - **Never Invert** - Select Never Invert to leave the colormap in its standard configuration for all contour variables.
  - **Always Invert** - Select Always Invert to invert the colormap for every contour variable.
The Grid Axes page includes selections for formatting the grid axes and 3D Views. You can quickly access this page of the Plot Options dialog by double-clicking on one of the axes in a 2D or 3D Grid plot. Or choose “Plot Options” from the Options menu.

This page allows you to customize axis labels and display (3D Grid only).

**F - 7.1 Axes Styles**

In the Axes Styles region of the Grid Axes page, you can customize the way axis labels appear on your plot with the following options:

- **Axis Color** - Choose from 26 standard colors in this menu to assign the color of the selected axis.
- **Label Color** - Choose from 26 standard colors to assign the color of the selected axis label.
- **Font** - Choose from a list of available fonts to assign the font in which the axis label will display.
- **Size** - Choose the size of the axis label's font as a percentage of frame height.

**F - 7.2 3D Views**

In the 3D Views region of the Grid Axes page, you can choose whether to include the axes display on 3D views (2D views always include the axes). Toggle-on “Show 3D Axes” to display the axes in a 3D Grid plot.

To customize additional characteristics of 3D Grid plots, use the Grid Options dialog, which you can access by clicking the Grid Options button or by clicking Grid in the 2D or 3D sidebar.
**F - 8  Cell Labels**

When you have “Labels” toggled-on in the sidebar (available for Grid Plots only), you can use the Cell Labels page of the Plot Options dialog to customize the label formatting.

Toggle on “Include text box” to put cell labels in a text box. This can make the labels easier to see.

Use the Font and Color menus to customize the display of cell labels.

Use the Size box to set the size of the cell labels, expressed as a percentage of the frame. You can select a value between 0.1 and 8 for the size of the labels.

**F - 9  Wells**

You can display wells on both 2D Grid Plots and 3D Grid Plots. Use the Wells page to control well symbols colors, sizes, and labeling options. To access the Wells page of the Plot Options dialog quickly, double-click on a well head symbol. Holding down the Ctrl key and double-clicking your pointer will interactively select an individual well.
Wells

F - 9.1 Well Symbols
In the Symbols region of the page, you can customize how well symbols appear, as well as where well symbols display relative to their well. Four selections control how well symbols appear on the grid plots. There are actually seven sets of well symbol settings, one for each of the Types in the first option menu.

The well types are read from the simulator files. Tecplot RS recognizes five basic types, including:
- Producer
- Gas Injector
- Water Injector
- Injector ("generic", or anything other than gas or water)
- Shut-In

You can select a different symbol / color / size for each type. These will be placed on the well head. Symbols are also placed on the well nodes (completions), and these are categorized as either Open or Closed.

For each of the listed types, you can choose the color, shape, and size. Sizes are expressed as a percentage of the frame size.

The selections for the symbol shape include:
- Square
- Circle
- Diamond
- Delta
- Gradient
- Left Triangle
- Right Triangle
- Cube
- Sphere
- Octahedron

The last three shapes (cube, sphere, and octahedron) are 3D symbols. In 2D Grid plots, they will be shown as squares, circles, and diamonds, respectively.

F - 9.2 Well Symbol Offset
The simulator output files describe the well geometry by designating the cells containing the well completions. The well head (or first node) is located within the grid, usually (but not always) in the first K plane. When Tecplot RS plots wells, it places the well head symbol in a position above the surface of the grid model so it is easily visible in both 2D and 3D views.

You have control over how this position is determined with a pair of controls in the Symbols region of the Wells page. The Well symb offset box contains four options. Use these options to select the point from which to measure the offset (from the first completion or from the highest elevation in the grid model), and the units for the offset (an actual distance or a percentage of the grid height). You can then use the Well symb offset text field to specify the actual percentage or distance.

When the offset is measured from the well head, the symbols generally follow the surface of the grid model. However, sometimes the well head or first completion falls in a cell significantly beneath the grid surface, causing the symbol to be hidden within the grid within 3D Views. In this case, you can designate that the starting point for the offset be the maximum elevation in the grid model. This guarantees that the symbols will all display visibly, but it also means that they will be at a constant height, possibly increasing the likelihood of interference.

F - 9.3 Labels
Plot Options

The Labels region of the Wells page controls how to display well labels. A “Show” toggle controls whether to include labels for the well names.

You can choose the font and color of the labels from the Font and Color menus in the Labels region of the Wells page.

To change the label size, type a value in the Size text field. The Units menu controls whether the size is expressed as a percentage of the frame size (the labels remain the same size when you zoom in) or a percentage of the grid area (when you zoom in, the labels get larger along with the image).

F - 9.4 Connect Nodes

Use the Connect Nodes region of the Wells page to specify the style of the line that is drawn between well nodes to represent the well path. The Connect toggle in the upper portion of the sidebar controls the display of these lines.

F - 9.5 2D View Settings

Use the 2D View settings region of the Wells page to specify how to treat wells in 2D Grid plots.

Choose from one of the following options:

- **All wells with connectivity** Select this option to draw all wells and display the connectivity between completions and well heads.
- **Wells with completions in current plane** Select this option to draw only wells with completions in the current plane.
- **Completion nodes only** Select this option to display only the completion nodes in the current plane. The well path will not display.

F - 10 Where Are Styles Set?

You have a multitude of options for customizing your plot to appear exactly as you like, with many different places to set the styles. You can control most of them from the Plot Options dialog, but others dialogs and menus may supersede the Plot Options dialog for different situations. Access most style options quickly by double-clicking on the object that you wish to change.

You can use the following table to determine where to set most styles. To jump to one of the subjects displayed following, select the Controlled By phrase, or type one of the Controlled By phrases into your search box.

<table>
<thead>
<tr>
<th>Item</th>
<th>Controlled By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend placement, legend labels</td>
<td>Paper Layout template</td>
</tr>
<tr>
<td>Legend range and style</td>
<td>Plot Options dialog (Grid Legend page)</td>
</tr>
</tbody>
</table>
### Where Are Styles Set?

<table>
<thead>
<tr>
<th>Style Type</th>
<th>Setting Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line styles (color, pattern, symbols)</td>
<td>Plot Options dialog (XY Lines page), RS Variables, Files</td>
</tr>
<tr>
<td>Frame size and placement</td>
<td>Multi-Frame Options dialog</td>
</tr>
<tr>
<td>Frame style (border, color)</td>
<td>Paper Layout templates</td>
</tr>
<tr>
<td>Text (other than axes labels)</td>
<td>Paper Layout template</td>
</tr>
<tr>
<td>XY Axes ranges</td>
<td>Plot Options dialog (XY Axes page)</td>
</tr>
<tr>
<td>Axes labels and grids / marks</td>
<td>Plot Options dialog (XY Axes page)</td>
</tr>
</tbody>
</table>
Plot Options
Shortcuts

Tecplot RS supports various sets of keyboard shortcuts to help you operate quickly in the Tecplot RS workspace. These keyboard shortcuts and extended pointer commands operate on all platforms that Tecplot RS supports, although on Linux platforms, Num Lock can interfere with keyboard shortcuts.

G - 1   Keyboard Shortcuts

You can use any of the following keyboard shortcut sets in Tecplot RS:

- Rotate Tools
- Polyline Tool
- Probe Tool
- Streamtrace Placement tools (3D grid plots only)
- Translate/Magnify Tools
- Zoom Tool
- Picked Object Options
- Other Keyboard Operations

G - 1.1   Rotate Tools

To use one of these rotation tools, first activate the rollerball rotation tool or the Z-axis rotation tool, unless otherwise noted.

<table>
<thead>
<tr>
<th>Drag</th>
<th>Rotate about the rotation origin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-Click and Drag</td>
<td>Rotate about the viewer position using the active Rotate tool</td>
</tr>
<tr>
<td>Middle-click and Drag</td>
<td>Smoothly zoom in and out of the data (you do NOT need to have a rotation tool activated to use this shortcut)</td>
</tr>
</tbody>
</table>
**Shortcuts**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click and Drag</td>
<td>Translate the data (you do NOT need to have a rotation tool activated to use this shortcut)</td>
</tr>
<tr>
<td>O</td>
<td>Set the center of rotation</td>
</tr>
<tr>
<td>R</td>
<td>Switch to Rollerball rotation</td>
</tr>
<tr>
<td>Z</td>
<td>Switch to Z-axis rotation</td>
</tr>
</tbody>
</table>

**G - 1.2 Polyline Tool**

Activate the Polyline tool to use these shortcut keys (choose "Polyline" from the Insert menu).

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Allow translation of polyline segments in all directions (useful after restricting translation to vertical or horizontal directions).</td>
</tr>
<tr>
<td>H</td>
<td>Restrict translation of the current polyline segment to horizontal.</td>
</tr>
<tr>
<td>U</td>
<td>End the current polyline and start a new one.</td>
</tr>
<tr>
<td>V</td>
<td>Restrict translation of current polyline segment to vertical.</td>
</tr>
</tbody>
</table>

**G - 1.3 Probe Tool**

Activate the Probe tool to use these shortcut keys (click the Probe button in the toolbar).

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>If the pointer is over a single valid cell, the interpolated field values from all nodes in the cell are returned. If multiple cells are candidates, the action is dependent upon the plot type: For 2D, the cell from the highest number zone is used. For 3D, the cell closest to the viewer is used.</td>
</tr>
<tr>
<td>CTRL-click</td>
<td>If the pointer is over a single valid cell, the field values from the nearest node in the cell are returned. If multiple cells are candidates, the action is dependent upon the plot type: For 2D, the cell from the highest number zone is used. For 3D, the cell closest to the viewer is used. If the pointer is not over any cell, then the field values from nearest data point (as measured in distance on the screen) are returned.</td>
</tr>
<tr>
<td>SHIFT-CTRL-click</td>
<td>The field values from the nearest point on the screen are returned (ignoring surfaces, zone number, and depth of the point). This is useful in 3D for probing on data points that are on the back side of a closed surface without having to rotate the object. In 2D, this is useful for probing on data points for zones that may be underneath other zones.</td>
</tr>
<tr>
<td>ALT-click</td>
<td>Probe only on streamtraces, iso-surfaces, or slices. If multiple cells are candidates, the action is dependent upon the plot type: For 2D, the cell from the highest number zone is used. For 3D, the cell closest to the viewer is used.</td>
</tr>
</tbody>
</table>
G - 1.4 Streamtrace Placement tools (3D grid plots only)
Activate the Streamtrace tool to use these shortcut keys. To activate this tool, click the Streamtrace tool in the toolbar.

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT-CTRL-click</td>
<td>Probe only on streamtraces, iso-surfaces, or slices.</td>
</tr>
<tr>
<td></td>
<td>If multiple cells are candidates, the action is dependent upon the plot type:</td>
</tr>
<tr>
<td></td>
<td>For 2D, the cell from the highest number zone is used.</td>
</tr>
<tr>
<td></td>
<td>For 3D, the cell closest to the viewer is used.</td>
</tr>
<tr>
<td></td>
<td>If the pointer is not over any cell, then the field values from nearest data point (as measured in distance on the screen) are returned.</td>
</tr>
<tr>
<td>ALT-CTRL-SHIFT-click</td>
<td>Probe only on streamtraces, iso-surfaces, or slices. The field values from the nearest point on the screen are returned.</td>
</tr>
<tr>
<td>X, Y</td>
<td>When probing variable plots, press X or Y to switch dependencies.</td>
</tr>
</tbody>
</table>

G - 1.5 Translate/Magnify Tools
You do not need to activate a specific tool to use these shortcuts.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click Drag</td>
<td>Translate the data.</td>
</tr>
<tr>
<td>Middle-click drag</td>
<td>Zoom smoothly in and out of the plot.</td>
</tr>
</tbody>
</table>

G - 1.6 Zoom Tool
Activate the Zoom tool by clicking it in the toolbar to access these shortcuts.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Center and zoom around the location of your click.</td>
</tr>
<tr>
<td>Ctrl-click</td>
<td>Center around the location of your click and zoom out.</td>
</tr>
<tr>
<td>Drag</td>
<td>Draw a box to set the frame view.</td>
</tr>
</tbody>
</table>

G - 1.7 Picked Object Options

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Reduce the size of the object.</td>
</tr>
<tr>
<td>+</td>
<td>Increase the size of the object.</td>
</tr>
<tr>
<td>DEL</td>
<td>Delete picked object.</td>
</tr>
<tr>
<td>Ctrl-C</td>
<td>Copy picked object to the clipboard.</td>
</tr>
</tbody>
</table>
G - 1.8 Other Keyboard Operations

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-A</td>
<td>Paste View - Paste stored frame view to active frame.</td>
</tr>
<tr>
<td>Ctrl-D</td>
<td>Redraw all frames.</td>
</tr>
<tr>
<td>Ctrl-F</td>
<td>Fit Data - Fit all data into the frame.</td>
</tr>
<tr>
<td>Ctrl-E</td>
<td>Fit Everything - Fit all data, text, and geometries into the frame.</td>
</tr>
<tr>
<td>Ctrl-L</td>
<td>Last - Restore the last frame view.</td>
</tr>
<tr>
<td>Ctrl-O</td>
<td>Open a project file.</td>
</tr>
<tr>
<td>Ctrl-P</td>
<td>Print.</td>
</tr>
<tr>
<td>Ctrl-Q</td>
<td>Exit.</td>
</tr>
<tr>
<td>Ctrl-R</td>
<td>Redraw the active frame.</td>
</tr>
<tr>
<td>Ctrl-S</td>
<td>Save the current project to a file.</td>
</tr>
</tbody>
</table>

G - 2 Extended Pointer Operations

The middle and right pointer buttons have powerful capabilities for zooming and translating data without requiring a switch to the Zoom or Translate tools on the toolbar. This advanced pointer functionality is available when using any Rotate, Geometry (except Polyline), Probe, Streamtrace, Translate, or Zoom tools. If you have a two button pointer, use the Ctrl key in conjunction with the right pointer button to achieve middle pointer button capabilities.

The following table lists all of the capabilities of the middle and right pointer buttons, when the active pointer tool is the “Selector” or the “Adjustor”.

<table>
<thead>
<tr>
<th>Action</th>
<th>Middle Button/CTRL+Right Button</th>
<th>Right Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Redraw. If the pointer is in the active frame, Tecplot RS will redraw the active frame. Otherwise, redraw all frames.a</td>
<td>Switch from the current tool to the Selector.b</td>
</tr>
<tr>
<td>Drag</td>
<td>Smoothly zoom in or out. An upward motion zooms out. A downward motion zooms in.</td>
<td>Translate.</td>
</tr>
<tr>
<td>ALT-drag</td>
<td>In 3D grid plots, move the viewer further from (upward motion) or closer to (downward motion) the object. In all other plot types, this behaves like the Drag action.</td>
<td>Same as the Drag action.</td>
</tr>
</tbody>
</table>

a. This is the default action for a click. You can configure it with the $INTERFACE MOUSEACTIONS {MIDDLEBUTTON... command.
b. This is the default action for a click. It can be configured with the $INTERFACE MOUSEACTIONS {RIGHTBUTTON... command.

Refer to the following sections for information regarding Toolbar buttons with special capabilities tied to pointer buttons or keyboard keys.
Command Line Options

You can launch Tecplot RS with specific instructions from the command line (on all supported platforms) or by using a shortcut icon (on Windows platforms). This section describes how to operate Tecplot RS by these methods.

H - 1  Tecplot RS Command Line

Launching Tecplot RS from the command line requires the following general form:

```
tecplotrs [options] [projectfile or macrofile]
```

where:

- `[projectfile]` indicates a file with the extension `.rsprj`, including the path. See also Chapter 21: "Projects". May not be specified with a macro file name.
- `[macrofile]` indicates a macro file name, with its directory path. See also Chapter 24: "Macros: Task Automation". May not be specified with a project file name.
- `[options]` represents one or more of the following optional flags (all supported platforms accept all flags unless noted otherwise):

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-b</code></td>
<td>Run in batch mode.</td>
</tr>
<tr>
<td><code>-cfgfile</code></td>
<td>Use <code>cfgfile</code> for the configuration instead of the default configuration file, <code>tecplot.cfg</code>.</td>
</tr>
<tr>
<td><code>-datafile</code></td>
<td>Load data file <code>filename</code>.</td>
</tr>
<tr>
<td><code>-display</code></td>
<td>Display on computer <code>computername</code> (Linux only). The computer, <code>computername</code>, must have X-server capability with the GLX extension.</td>
</tr>
<tr>
<td><code>-f</code></td>
<td>Use <code>fontfile</code> instead of the default font file, <code>tecplot.fnt</code>.</td>
</tr>
<tr>
<td><code>-m</code></td>
<td>Use <code>colormapfile</code> as the initial color map file.</td>
</tr>
<tr>
<td><code>-projectfile</code></td>
<td>List the project file you would like to load (<code>*.rsprj</code>).</td>
</tr>
<tr>
<td><code>-macrofile</code></td>
<td>List the macro file you would like to load (<code>*.mcr</code>).</td>
</tr>
<tr>
<td><code>-taskfile</code></td>
<td>Use <code>taskfile</code> instead of the default task file, <code>default.tas</code>.</td>
</tr>
</tbody>
</table>
Command Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-nobatchlog</td>
<td>Suppress creation of the file batch.log during batch mode operation.</td>
</tr>
<tr>
<td>-quiet</td>
<td>Turns off all standard-out messages (Linux only).</td>
</tr>
</tbody>
</table>

To use a command line option on a Windows platform, start Tecplot RS from the Run command or the command prompt.

For example, you can use the command line to instigate the following:

<table>
<thead>
<tr>
<th>Command Line Input</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>tecplotrs</td>
<td>Run Tecplot RS</td>
</tr>
<tr>
<td>tecplotrs myproject.rsprj</td>
<td>Run Tecplot RS, loading the project myproject.rsprj</td>
</tr>
<tr>
<td>tecplotrs a.mcr</td>
<td>Run Tecplot RS and play a macro called a.mcr</td>
</tr>
</tbody>
</table>

**Table H - 5: Tecplot RS Command Line Examples**

**H - 2 Using Command Line Options in Windows Shortcuts**

Instead of adding options in the command line, you can also create a Windows shortcut to prompt the same behavior. If you frequently run Tecplot RS using the same command line flags, it may be useful to create a shortcut on your Windows desktop that launches Tecplot RS with the desired command line flags. To do this:

1. Right-click in any blank space on your Windows desktop.
2. Choose **New > Shortcut** from the resulting context menu.
3. In the **Create Shortcut** dialog, type the location of the Tecplot RS executable, along with any command flags you want to specify. For example:
Using Command Line Options in Windows Shortcuts

"C:\Program Files\Tecplot\TecRS 2019 R1\bin\tecplotrs.exe" C:\Me\mymacro.mcr

4. Click the Next button.
5. Type a name for your shortcut and click Finish. A new shortcut icon will appear on your Windows desktop.

**H - 2.1 Changing Shortcuts**

You can alter an existing shortcut by doing the following:

1. Right-click on the shortcut icon you want to change and choose “Properties”. 
2. On the Shortcut page, modify the command line by changing the Target text. To change the folder that Tecplot RS runs from, change the Start in location.

H - 3 Additional Command Line Options on Linux Platforms

On Linux platforms, you can use additional command line flags which are passed to the window manager to control how the operating system displays the application window. These include -geometry (for specifying the location and position of the application window), -fg and -bg (for specifying foreground and background window colors), and others. See the X11 reference for your system for complete details on these options.

To determine the path or alias that the tecplot command calls, you would use:

```bash
which tecplot
```
License Management

I - 1 Entering Your License

The first time you launch Tecplot RS after a fresh installation, you will be prompted to enter your license information:
License Management

You will also see this dialog if Tecplot RS cannot validate your license information (for example, because your evaluation license has expired, or because the network license server is not available). Additionally, you may change your license information at any time from the Help menu.

SYSTEM ADMINISTRATORS
Tecplot products store their license configuration file in a platform-specific location. Each Tecplot product has its own license configuration file.
Windows: C:\Users\<username>\AppData\Local\Tecplot
Linux: ~/.local/share/data/tecplot

The above directories are specific to the individual workstation users. If you want all users of the computer to use the same license configuration for a given Tecplot product, you may move the license configuration file to the product installation directory after initial license setup.
To prevent users from editing the license configuration, you may then change the permissions on the license file to be writable only by an administrator or root user.

How you install your license information depends on what type of license you have.

- If you wish to evaluate the product before purchasing, you may obtain an Evaluation license with a single click. See Evaluation License Setup.
- If you have an Activation Code for a Single-User license and have Internet access, you enter the activation code. See Single-User License Setup Using An Activation Code.
- If you have a License File for a Single-User license, you select the license file. See Single-User License Setup Using A License File.
- If you have a Network license, you specify the server name and port number of the RLM license server on your network. See Network License Setup.
- If you have a License File for a Single-User license, you select the license file. See Single-User License Setup Using A License File.
I - 1.1 Evaluation License Setup

To obtain a time-limited evaluation license key so you can try the product before purchasing, make sure the “Evaluation” license type is selected in the Licensing dialog, then click Begin Evaluation. The product evaluation period begins. You will see a notice on the product’s Welcome Screen indicating when your evaluation license will expire.

This procedure requires an active Internet connection. If for some reason you cannot fully evaluate Tecplot RS on an Internet-connected computer, or if you need additional time to complete your evaluation, contact Tecplot Support for a time-limited single-user license file, which may then be installed using the instructions in “Single-User License Setup Using A License File” on page 420.

I - 1.2 Single-User License Setup Using An Activation Code

If you received an activation code for your product, allowing it to be activated over the Internet, follow the instructions below. If you received a license key file, or if the workstation you have installed the product on does not have Internet access, see “Single-User License Setup Using A License File” on page 420.

To activate the product, simply enter or paste your activation code in the field provided. Then click Activate.
License Management

The license key corresponding to your activation code is downloaded to your computer, and Tecplot RS uses that license.

I - 1.3 Single-User License Setup Using A License File

You will need the license file sent to you by Tecplot as an e-mail attachment. Please save it to a file on your computer in an easy-to-find location, such as the Desktop.

1. Make sure the "License File" option is selected in the Licensing dialog.
2. Click Open License File. A file browser appears. Select the license file e-mailed to you, then click Open. Alternatively, you can Copy and Paste the contents of the license file to the available field.
3. The message “Status: Valid” appears in the Current License Information panel at the upper right.
4. Click OK to save the license information.

Tecplot RS now uses the chosen license.

If you do not have your license file, or have lost it, click Request License in the Licensing dialog for instructions on how to obtain it.
I - 1.4 Network License Setup

To use a network license, you or your system administrator must first install the Reprise License Manager (RLM) and the license key for your product on a network server. (See the installation instructions included with the RLM download.) Once this has been accomplished, follow these steps:

1. Make sure the “Network” license type is selected in the Licensing dialog.
2. Enter the server name (you may use a hostname or IP address) and port number of the license server in the fields provided.
3. Click OK to save the license information.

Tecplot RS will now use a license obtained from the license server.

If the product is unable to obtain a license key, an error message will appear, and you should verify that you have specified the correct network license information.

I - 2 License Roaming

Network license users who need to use Tecplot RS while not connected to the same network as their license server (for example, while traveling) can use license roaming. License roaming allows you to use the product without access to the license server for a limited period of time. The roaming license is considered “in use” by the server continuously until it expires or is returned.

To manage license roaming, choose License Roaming from the Help menu. The License Roaming dialog appears.
License Management

I - 2.1 Starting Roaming

To start roaming, choose the expiration date for the roaming license using the pop-out calendar that appears when you click the roaming expiration date. Your license will expire at the end of that day, at midnight.

Click **Begin Roam** to obtain the roaming license and begin roaming.

While roaming, the license status is noted as Roaming in the Licensing dialog, and the expiration date of the roaming session is also shown. You may not change license information while roaming.

When you are getting close to your roaming license’s expiration date, a notification appears in the Welcome Screen at startup.

Do not upgrade Tecplot RS while roaming. If you do, your license may no longer work correctly. Set the `RLM_ROAM` environment variable to -100 before launching to rectify this situation (see `RLM_ROAM`).

I - 2.2 Ending Roaming

Your roaming license expires automatically at the end of the day (that is, midnight) on the day you selected when you began roaming. After this date, your computer must be able to connect to the network license server to run Tecplot RS.

You may also end roaming early and make your license available for other users. To do this, you must first connect your computer to a network that allows you to reach the license server. Then choose **License Roaming** from the Help menu and click the **End Roam** button in the License Roaming dialog.

I - 2.3 RLM_ROAM

You can initiate roaming from the command line by setting the `RLM_ROAM` environment variable to the number of days you wish to roam, then starting Tecplot RS from that command line session. The roaming session expires at the end of the day after the number of days specified (for example, if it is noon Tuesday, and you set `RLM_ROAM` to 2, the roaming license expires at the end of the day Thursday). `RLM_ROAM` may also...
License Roaming

be set to the special value today to have the roaming license expire at the end of the current day (the value 0 means that no changes to roaming will be made).

If RLM_ROAM is set permanently (for example, using the System Properties in Windows), the license roaming will be refreshed each time you run Tecplot RS while connected to the network. If RLM_ROAM is 1, for example, each time you start Tecplot RS, the roaming license is refreshed to expire at midnight the following day. This allows you to easily take your computer home with you any night and continue using Tecplot RS while disconnected from the license server, without needing to explicitly roam each day.

You may end a roaming session early by setting RLM_ROAM to -1 before launching Tecplot RS.

If you are having trouble ending your roaming early (a common cause is upgrading Tecplot RS while roaming), try setting RLM_ROAM to -100 before launching Tecplot RS. The roaming license will be forcibly removed from your workstation, and Tecplot RS will begin requesting a regular license from a license server at each startup. At this point you can obtain a fresh roaming license, if desired. The reservation for your previous roaming license will, however, continue to be held on the license server that issued it until it expires.
License Management
Utility Programs

Your Tecplot RS installation includes the following utility programs:

- **ResetRS** Use ResetRS to return to the factory default settings.
- **RSPreprocess** Use RSPreprocess to create rsgrid files for your data.

### J - 1 ResetRS

When you first install Tecplot RS, the program uses a set of factory defaults for styles, paper layout templates, file locations, and other elements. As you work with Tecplot RS, it tracks your preferences in the form of a list of last-used items. Some of these selections, such as the name of the last grid file opened, are automatic. With others, such as the name of a paper layout template file, Tecplot RS may prompt you to override or maintain your default.

On Windows systems, Tecplot RS stores the last-used list in the system registry. Although you can edit the registry, it is a task best left to experienced operators.

*ResetRS.exe* is a Windows-only utility program that clears the last-used list from the registry. This effectively resets the Tecplot RS program to its factory default state.

The Tecplot RS installation places the *ResetRS.exe* program in the *bin* folder of your Tecplot RS installation folder. To run *ResetRS.exe*, double-click on the file name in Windows Explorer, or type the file name in the Run command line. Tecplot RS also installs a shortcut to this reset program at *Start > All Programs > Tecplot RS 2019 R1 > Utilities > Reset RS*.

This will **NOT** erase any style, custom, or paper layout template files that you have created. It simply removes the option to load these automatically when you launch the program.

After resetting the list, it will rebuild through your normal program operations.

On Linux systems, this information is stored in a file named ".tecplot.reg". Linux users can erase their last-used list by deleting this file, or modify their list by editing this file in a text editor.

### J - 2 RSPreprocess

After loading a grid file with time-varying grid variables, when you choose a new time step for display, Tecplot RS retrieves the data from the file. This method of loading decreases the time needed to load the
Utility Programs

grid file initially. To do this efficiently, Tecplot RS creates a “map” to the start of each time step in the file. The minimum and maximum values for each variable over all time steps are also saved, to correctly set up the legend for contour values.

Tecplot RS stores the optimized version of the grid geometry in an .rsgrid file and uses it to make loading the data faster and more memory efficient. The .rsgrid file contains information only on active cells. A corresponding .rsgrid file may also be present for any inactive cells in the grid.

Tecplot RS creates a WELLNUM variable in each cell in a grid that identifies cells that contain completions or are penetrated by a wellbore. This variable is visible when probing and is also used when activating the Well Blanking option for Inside Views in a 3D grid. The process of computing intersected cells between completions can be a lengthy one, so Tecplot RS also creates an auxiliary .rswells file to store it so it does not need to be computed each time a grid is loaded.

Tecplot RS also saves the indexes and ranges in small index files. The index file with extension .rsinit stores the static data. The file with extension .rsrst stores the time-dependent data. The .rsrst file has the same root name as the grid file, except in the case of VIP data, where it matches the recurrent file.

Tecplot RS creates any auxiliary file that does not exist or is out of date when it loads the grid file. However, for Tecplot RS to create these files, the user must have create and modify rights to the folder containing the simulator files. Creating the files can also slow down the initial loading of the data, sometimes significantly (for very large grid files).

To avoid these difficulties, the Tecplot RS installation includes a small executable named rspreprocess.exe which you can run separately. This file runs as a simple command-line executable (there is no user interface). You can set this up to run at the conclusion of a simulator run, ensuring that the Tecplot RS files will exist when individual users first load the grid data.

The rspreprocess.exe file installs to the bin folder in your Tecplot RS installation folder. The utility program is available for both Windows and Linux systems.

For most formats, the preprocessor finds all associated data files and creates RSGRID, RSINIT, and RSRST files. For VIP files, the preprocessor does not search for any associated files. If you pass in an INIT map file, Tecplot RS creates RSGRID and RSINIT files. If you pass in a RECURR map file, Tecplot RS creates only the RSRST file. For VDB grids, Tecplot RS requires you to specify the path to the VDB folder and the case from within the folder that you wish to read.

RSPreprocess cannot be used with UTCHEM or GRODECL data files.

J - 2.1 Running RSPreprocess

To run the preprocessor, type the following on the command line (or include it in your script).

rspreprocess gridfilename

The gridfilename represents the name of the file that you would normally enter in the Grid field of the Load Grid Data dialog. If you wish to use a VDB folder, specify the location of the VDB. For all file types, you must include the file extension. For Eclipse file, if both the .grid and .egrid files exist, use the .grid file to use less RAM during the process. If your folder or file name contains spaces, enclose the grid file name in quotation marks. Even though you provide only the grid name, for Eclipse files, the program also requires that the restart data be available (either in individual or unified restart files).

Additionally, for VDB folders, you must include the case name after the grid file name, in the following format. Here, vdbdirectory replaces gridfilename:

rspreprocess vdbdirectory -case [value]

1. For Windows users, Tecplot RS typically installs to C:\Program Files\Tecplot\TecRS 2019 R1.
J - 2.2 Additional RSPreprocess Parameters

RSPreprocess also includes optional parameters that you can include if you wish to change the default settings. To include one or more optional parameters, add them to the same line required to run the preprocessor, in the following manner (do not include the brackets):

```
rspreprocess gridfilename -[flag] [value]
```

In the syntax given, the flag represents one of the following parameters, and the value indicates the string or number you wish to assign, according to the following definitions. Do not include the brackets.

- `smoothing [value]`
  The optional smoothing parameters enables you to specify a smoothing method. Use a number from one to three, to indicate the following:
  1 = No smoothing (smoothing may occur based on x, y, or z tolerances)
  2 = Smooth using shift method
  3 = Smooth using node averaging (Default)

- `xytol [value], -ztol [value]`
  Use either of these tolerance parameters instead of a smoothing method to indicate a tolerance used to determine whether adjacent corner nodes should be joined. (The X and Y values must match within this tolerance before corners are averaged to create the replacement node. The Z value determines the tolerance used when sharing nodes between K-planes.) Use a value greater than or equal to 0. The program uses a default of 0.05 for both `xytol` and `ztol` parameters.

- `inactive "VARIABLE [OP] VALUE"`
  This value specifies the inactive cell condition for VIP files. Use a `variable`, followed by an operator (`=, <, or >`), followed by a `value`. By default, the program uses KID<0.

- `units [value]`
  Use the specified units when reading CMG files. The value provided must be an integer between 0 and 8 inclusive, corresponding to one of the unit values listed below. The default value is 1 (FIELD).

<table>
<thead>
<tr>
<th>Number</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>SI (metric)</td>
</tr>
<tr>
<td>1</td>
<td>FIELD</td>
</tr>
<tr>
<td>2</td>
<td>LAB</td>
</tr>
<tr>
<td>3</td>
<td>MODIFIED SI</td>
</tr>
<tr>
<td>4</td>
<td>CHEARS/ECLIPSE</td>
</tr>
<tr>
<td>5</td>
<td>GEM SI</td>
</tr>
<tr>
<td>6</td>
<td>GEM FIELD</td>
</tr>
<tr>
<td>7</td>
<td>STARS LAB</td>
</tr>
</tbody>
</table>

On Windows, instead of using the command line, you can also run RSPreprocess by creating a shortcut on your desktop to the RSPreprocess executable, and drag and drop the grid file name to the executable icon. Refer to Section 12 - 5 “Index File (.rsrst)” for additional information.
Tecplot RS Files

K - 1   XY Data Files

Tecplot RS supports several different file formats that contain data suited for display as XY Line plots. The files may contain observed data or data output by a simulator.

Generally, the data are in the form of an independent variable and one or more dependent variables. While the independent variable is frequently time, this is not a requirement (for example, an RFT data set uses depth as the independent variable). The data are usually further divided by entity (for example, wells).

The list of supported files changes as new loaders are added regularly. Tecplot RS 2019 R1 supports the following XY data file formats:

- Eclipse Unified Summary files (.unsmry)
- VIP plot files (.plt) - including compositional plot data
- VIP observed data file (.obs)
- VIP RFT files (.rft)
- CHEARS history files (.hist)
- CHEARS comma-separated value files (.csv)
- Intersect historical data (.obsh)
- Eclipse RFT files (.rft or .frft)
- Eclipse USER files (.user)
- Generic ASCII files (see Section K - 1.1 “Generic ASCII Files”)
- Log ASCII Standard Files (.las)
- Sensor Fort.61 well production data files (*.61)
- 3DSL well allocation files (.waf)
- Frontsim well allocation files (.alloc)
- VIP/StreamCalc well allocation files (.dat)
- RS well allocation files (.rsawf)
- CMG files (.irf, .mrf, .sr3)
- VDB Folder (.vdb) - including compositional and observed plot data
Tecplot RS Files

- UTCHEM files (.OVERAL)

In some cases, Tecplot RS requires additional, related files to be present along with the referenced file. For example, the Unified Summary file also requires a Summary Specification file (.smspec). When these additional files are required you do not need to open them individually. Ensure that the files are available in the same folder, and that the root name matches that of the primary file. Tecplot RS finds the additional files automatically, and reports a problem only when they are not available.

In Windows operating systems, the file names are not case-sensitive; however, Linux systems do make the distinction. While the root name may contain a mixture of upper- and lower-case, Tecplot RS requires that the extensions be all of one case. In other words, Sample.unsmry and Sample.UNSMRY are acceptable, but Sample.UnSmry is not.

K - 1.1 Generic ASCII Files

In the case of loading generic ASCII files, Tecplot RS reads ASCII text files containing data which may come from a variety of sources, as long as it is formatted into a simple text file with a basic structure (defined following). By default Tecplot RS looks for files with a .txt extension, but you can use either a .txt extension or a .prn extension.

The format used in the file must conform to the following rules:

- Data can be separated by commas, tabs, or spaces.
- Lines can be a maximum of 2048 characters long, including the terminating carriage return/line feed.
- Well names, units, and variable names may not include spaces.
- By default, all entities described in the file are assumed to be wells, except when the VARS list includes a DEPTH variable, in which case the data is assumed to be RFT data for the specified well. You may include other entity types in the same file. To do this, include a line with the keyword TYPE followed by one of the following:
  - WELL
  - FIELD
  - LAYER or COMPLETION
  - AREA or GROUP
  - REGION
  - RFT
  - AQUIFER
  - NETWORK
  - CONNECTION
  - NODE

- A VARS line must immediately follow each TYPE line to define the variable names used by the entities of that type. If there is no TYPE line, a VARS line must appear before any data values. If it is repeated, only the first occurrence is recognized. Different entity types may have different variables, but all entities of a single type must have the same variables. You need at least two variables to produce XY plots.

  If fewer values occur in a data line than in the VARS line, Tecplot RS will assign zero values to the missing variables. If more items occur, the extra items are ignored. The first value on a data line is taken to be the name of the entity. This value is not named in the VARS line.

  You can include an optional line identifying the units of each measured variable. This line must begin with the identifier “UNITS.”
• Each line of data must begin with the entity name followed by values for each of the variables specified in the VARS line.
• The first variable after the entity name should be the independent variable (usually time or date), and the additional variables should be dependent values. However, this is not an absolute requirement, since you can choose any variables for the X- and Y-axes when you create the plot. To create meaningful plots, make sure that the independent variable is ordered in the file. Assuming time is the independent variable, organize the data so that time increases down the file.
• A variable identified as a “DATE” (all capitals) can be saved in any of these formats:

- yyyy-mm-yyyy
- dd-mm-yyyy
- dd-mm-yyyy

If your time value is not in one of these formats, use a variable name other than “DATE.” You can include both a DATE and TIME variable for your data. It is up to the user to make sure they are consistent.
• You can include comments or other header information. Use an octothorpe (#) as the first character of the line to tell the program to ignore these lines. Blank lines are also ignored.

This sample file displays example data:

```
TYPE, WELL
VARS, DATE, BHP
PB-01D, 1992.1726, 1794
PB-01D, 1997.6959, 955
PB-01D, 1998.8055, 1020
PB-07, 1969.54, 4648
PB-07, 1992.2137, 3557
PB-10, 1972.5151, 2959
PB-10, 1977.5662, 2863
PB-10, 1976.3315, 2820
PB-10, 1979.3288, 2778
PB-10, 1980.5151, 2731
PB-10, 1981.4822, 2755
PB-10, 1983.4548, 2724
PB-10, 1984.3479, 2658
PB-10, 1987.3644, 2691
PB-10, 1988.4795, 2673
PB-10, 1992.3141, 2537
PB-10, 1998.3425, 2491
TYPE, FIELD
VARS, DATE, CUMOIL, CUMGAS
TOTALS, 1992.1726, 3.724e5, 9.32e3
TOTALS, 1997.6959, 8.332e5, 5.64e4
```

For the WELL entity types, each line will contain two variables, DATE and BHP, after the well name. For the FIELD data, there are three variables. In the sample file, all the data are grouped by entity name, and commas are used as delimiters.

You can also group the data by date or other independent variable and use tabs rather than commas as delimiters. The following example illustrates this, and also includes the UNITS line and comments:

```
# Reservoir 0-41 readings from 1/1/87 through 1/6/87
VARS, DATE, QPR, WPR, GPR
UNITS, years, STB/Day, BBL/Day, MSCF/Day
WELL 1 1/1/87 0 0 0
WELL 2 1/1/87 0 0 0
WELL 3 1/1/87 0 0 0
WELL 4 1/1/87 0 0 0
WELL 5 1/2/87 351.5 0.451472 2
WELL 6 1/2/87 207.1 0.611004 8
```

431
Here is an example showing RFT data. Note the presence of the DEPTH variable, which causes Tecplot RS to consider this RFT data for the wells specified.

<table>
<thead>
<tr>
<th>VARS</th>
<th>DATE</th>
<th>DEPTH</th>
<th>PRESSURE</th>
</tr>
</thead>
<tbody>
<tr>
<td>LMB-01</td>
<td>1982.0847</td>
<td>5205.0</td>
<td>2709.3</td>
</tr>
<tr>
<td>LMB-01</td>
<td>1982.0847</td>
<td>5265.0</td>
<td>2727.8</td>
</tr>
<tr>
<td>LMB-01</td>
<td>1982.0847</td>
<td>5320.0</td>
<td>2744.7</td>
</tr>
<tr>
<td>LMB-01</td>
<td>1982.0847</td>
<td>5355.0</td>
<td>2755.4</td>
</tr>
<tr>
<td>LMB-01</td>
<td>1982.0847</td>
<td>5410.0</td>
<td>2772.3</td>
</tr>
</tbody>
</table>

Tecplot RS treats a data set loaded from an ASCII file like any other XY data set, and can load the data set in all the plotting options as either the active or comparison data set.

K - 1.2 CHEARS CSV Files

You can load CHEARS csv files into Tecplot RS, with the Load XY Data dialog. Refer to Section 4 - 1 "Loading XY Data" for details on loading XY data.

A given data set generated from CHEARS csv files can have up to three related files, each containing different data types. All files in the data set have a .csv extension, and the three characters immediately preceding the extension will identify them as containing the CHEARS data. The name formats are:

- `<name>prd.csv` Data for wells, groups, field and material balance regions
- `<name>lyr.csv` Data for layers
- `<name>cmp.csv` Data for completions

The root `<name>` must be the same for all related files. The identifier (prd, lyr, or cmp) and the csv extension must be in lower-case.

To load a CHEARS csv file, select one of the available files. Tecplot RS will load that file, along with any available files with the same root name that meets the name format criteria.

Do not choose all three files using the multiple-file loading options. This will create three separate, identical data sets with all the data in each.

K - 1.3 Well Allocation Factor Data Files

Tecplot RS supports well allocation factor (WAF) data so that you can further visualize the relationships between your injector and producer wells. WAF data files define how a producer well is influenced by the injectors nearby, or how an injector well influences nearby producer wells. Since well allocation factors are usually measured in percentages, the factors should add up to 100%. In addition, there must be at least a starting and ending time step in your WAF data file, and this range must encompass the range of the other data that will be utilizing the WAF values.

Follow these steps to include well allocation factor (WAF) data in your plot:

1. Output the WAF data from your simulator (extension .waf, alloc, or .dat) or create your own WAF data file (rename the file to use .rswaf as its extension).
2. Choose “Load XY Data” from the Project menu in Tecplot RS.
3. Click the Add button in the Load XY Data dialog that appears.
4. In the **Open Files** dialog that appears, choose a well allocation file type (3DSL Well Allocation, *.waf, Frontsim Well Allocation, *.alloc, VIP/StreamCalc Well Allocation, *.dat, or RS Well Allocation, *.rswaf) as the file type to open, browse to your data file, and click Open and OK to finish the loading process.

5. The XY Subsets plot type works best for viewing well allocation factor data, although you can also use the XY Variables plot type if you change the filtering of the entities displayed in the sidebar (click the Filter button in the sidebar to access the **Filtering** dialog). To change to the XY Subsets plot type, choose “XY Subsets” from the **Plot Type** menu.

To append WAF data to your XY or grid plot, load your primary data first, before loading your WAF data. If you load WAF data first, you cannot append XY or grid data to the WAF data.

**Creating a Well Allocation Factor Data File**

A WAF file created manually must follow a specific table format (described following), follow a comma or space delineation, and use the extension .rswaf in order for Tecplot RS to recognize the file. We recommend using a spreadsheet and saving it as a CSV (comma separated values) file, but you could also create a text file and add commas or spaces between each value. To create a spreadsheet, Microsoft Excel works well, and from Microsoft Excel you can directly save or export the spreadsheet into CSV format. Once you have saved your WAF file as a .txt or .csv file, manually rename the extension to .rswaf.

To easily create your own WAF file, create the table of values as described in this section in a Microsoft Excel spreadsheet. When finished, save the file as a CSV (.csv) file. Close the file, rename it to change the extension from .csv to .rswaf, and load the file into Tecplot RS from the **Load XY Data** dialog.

The WAF file usually defines well pairs, each consisting of one parent well and one or more child wells that either contribute to or receive contributions from the parent well. Each child well should have a WAF value that defines the percentage of that child well’s contribution to or from the parent well; usually the WAF values from all children wells should add up to 100%. You can also include additional variables for each child well.

Each line (row) of the WAF file should begin with a keyword identifier for the data in that line. Keywords must appear in the following order (keywords marked with an asterisk are optional):

- **RSVERSION**
- **STARTDATE**
- **VARIABLES**
- **UNITS**
- **TIMESTEP** (one or more per file)
- **PRODUCER** (one or more per time step)
- **CHILD** (one or more per producer)
- **INJECTOR** (one or more per time step)
- **CHILD** (one or more per injector)

Tecplot RS will treat any line in the file that does not begin with one of these keywords as a comment and ignore it.
RSVERSION
The RSVERSION row is optional but highly recommended. If it appears in the WAF file, this keyword must appear as the first non-comment line in the file. This row defines the version number as an integer value, which identifies the WAF file to Tecplot RS. This way, if later releases of Tecplot RS support WAF files with additional data, newer version numbers will indicate files with new capabilities. If this row defines a number other than a Tecplot RS version number, the program will not attempt to load the file.
To create your file, define the current version number as 5001, like this:

RSVERSION, 5001

STARTDATE
This optional line, if included, must include the date in European format (day-month-year). You can use most recognized European formats. However, the date may not contain spaces. A few possible formats include:

22-Apr-2009
22/04/2009
22-4-09
2009.3006

For example, this line could resemble the following:

STARTDATE, 22/04/2009

If you choose to include this line, you can omit the date field from the TIMESTEP; Tecplot RS will then compute the date based on start date plus elapsed time in days.

VARIABLES
If you wish to include additional variables (besides the WAF variable) in the file, use this line to indicate first the number of variables in the file and then the name of each of the variables. (WAF must appear as the first variable.)

Each variable should have a unique name (for example, you cannot include “WAT” twice in the list of variable names). If you have common values for injection and production, you can preface them with something indicating their association with the parent or child, such as “P_WAT” and “I_WAT”.

If you choose to include three additional variables, for instance, this line could display like this:

VARIABLES, 4, WAF, OIL, GAS, WAT

If you include WAF as the only variable, you do not need to include this line; it will default to:

VARIABLES, 1, WAF

UNITS
If your WAF file includes this optional line, it should immediately follow the VARIABLES line, and the number of units must match the number of variables (so that each variable name has an associated unit label). Follow the keyword with the number of units and then list each unit. For example:

UNITS, 4, %, rb/day, ncf/day, rb/day

Tecplot RS displays these units on the axis title of XY plots displaying WAF values.
XY Data Files

TIMESTEP
This required line should indicate the beginning of a time step, in the following format:

TIMESTEP, <time>, <date>

Tecplot RS recognizes the time as the number of days elapsed since the start date, and the date in European format as recognized on the STARTDATE line.

For example:

TIMESTEP, 1.5, 23 Apr 2009

You can omit the date if you included the STARTDATE line. If you choose to do this, Tecplot RS will compute the date by adding the time to the start date.

If you choose not to include the start date, and instead include the date with each time step, the time does not necessarily need to appear in days.

PRODUCER
This line marks the beginning of a well pair group, defining the role of the parent well as a producer. Include the name of the producer parent well immediately following the keyword in this line, like this:

PRODUCER, PWELL01

You can name the well whatever you like, but do not include your delineator (spaces or commas).

WAF file must include at least one PRODUCER or INJECTOR well pair group. A well pair group consists either of a single producer well and all of the injector wells that contribute to it, or a single injector well and all of the producer wells that contribute to it.

INJECTOR
Use the injector line to mark the beginning of a well pair group with an injector parent well, and to name the injector parent well. Include the name of the injector parent well after the INJECTOR keyword, like this:

INJECTOR, IWELL01

You can name the well whatever you like, but do not include your delineator (spaces or commas).

Be sure to include either one INJECTOR parent well with its CHILD well(s) in your WAF file, or one PRODUCER parent well with its CHILD well(s).

CHILD
One or more CHILD lines should follow the PRODUCER or INJECTOR parent well lines in the WAF file to indicate the child well(s) and their WAF value(s) (as well as additional variable values if desired). In this line, follow the CHILD keyword with the name of the child well (in general, match the names used in the XY or grid data sets included in your project), the WAF value for that child well, and then any other variable values, in the same order as on the VARIABLES line. For example, a CHILD line could look like this:

CHILD, IWELL_02, 39.2

If you want to include flow going into or coming from outside sources, you may wish to include this as a child well named descriptively, like “OTHER” or “BOUNDARY”, so that the WAFs add up to 100%.

Sample Data
To practice creating and using WAF files, copy either of the following tables into a spreadsheet, save it as a comma-separated values (CSV) file, rename it and load it into Tecplot RS.
This table shows a simple spreadsheet with three producer wells, each receiving from multiple child wells:

<table>
<thead>
<tr>
<th>RSVERSION</th>
<th>5001</th>
</tr>
</thead>
<tbody>
<tr>
<td>STARTDATE</td>
<td>15-APR-1992</td>
</tr>
<tr>
<td>TIMESTEP</td>
<td>3.17</td>
</tr>
<tr>
<td>PRODUCER</td>
<td>PRODUCER1</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_02</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_03</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_05</td>
</tr>
<tr>
<td>PRODUCER</td>
<td>PRODUCER2</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_01</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_02</td>
</tr>
<tr>
<td>PRODUCER</td>
<td>PRODUCER3</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_01</td>
</tr>
<tr>
<td>CHILD</td>
<td>IWELL_04</td>
</tr>
<tr>
<td>CHILD</td>
<td>BOUNDARY</td>
</tr>
</tbody>
</table>

The following table shows how to include optional variables. Tecplot RS will automatically solve the parent totals when loading the data. This also illustrates inclusion of the date on the time step line, instead of defining a start date:

<table>
<thead>
<tr>
<th>RSVERSION</th>
<th>5001</th>
</tr>
</thead>
<tbody>
<tr>
<td>VARIABLES</td>
<td>4 WAF OIL GAS WAT</td>
</tr>
<tr>
<td>UNITS</td>
<td>4 % rb/day mcf/day rb/day</td>
</tr>
<tr>
<td>TIMESTEP</td>
<td>03/01/2001</td>
</tr>
<tr>
<td>PRODUCER</td>
<td>PROD1</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ02 100.0 12000.0 0.0 0.0</td>
</tr>
<tr>
<td>PRODUCER</td>
<td>PROD2</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ02 48.4 3384.912 0.0 0.0</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ03 51.6 3615.187 0.0 0.0</td>
</tr>
<tr>
<td>PRODUCER</td>
<td>PROD3</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ02 7.9 1963.265 0.0 0.0</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ04 58.8 14708.182 0.0 0.0</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ01 15.3 3814.709 0.0 0.0</td>
</tr>
<tr>
<td>CHILD</td>
<td>INJ03 18.0 4533.842 0.0 0.0</td>
</tr>
</tbody>
</table>
K - 1.4 XyMulti File

You can load multiple XY files simultaneously by loading an .xymulti file. An .xymulti file is an ASCII file that contains list of XY data files. This file must include the absolute path of the files to be loaded. The files to be loaded can be in any of the supported XY file formats. An example of an xymulti file is shown following:

```
C:\MultiFileExample\RM6_PBUSTOP.UNSMRY
C:\MultiFileExample\RM1.UNSMRY
C:\MultiFileExample\spe1b_xyp.UNSMRY
```

K - 1.5 UTCHEM Files

Tecplot RS currently supports UTCHEM versions 9.3 and 9.95. To load the XY data, you need the *.OVERAL file, which contains the field data, and all *.HIST## files, which contain the data for one well each. The base filenames (ignoring the extension) must match for these files to be loaded together.

Well names are loaded from the *.HIST## files, but these files record only the first eight characters of the full well names provided in the INPUT file. To make sure the well names are unique, a number is prepended to the well name for display in Tecplot RS.

The wellbore pressure and pressure drop variables are loaded as completion data. For more information on plotting completion data, refer to "XY Subsets" on page 67 and "Completion Profiles" on page 89.

K - 2 Grid Files

Tecplot RS supports Eclipse grid files, VIP grid files, Sensor grid files, CMG grid files, UTCHEM grid files, and VDB folders, as described following.

K - 2.1 Eclipse Data Files

The Eclipse data are actually found in three or more files. These include:

- grid This Grid file contains the grid geometry.
- egrid This alternative format contains grid geometry. This file is more efficient and usually loads faster.
- init An init file contains time-independent properties, like porosity or permeability.
- unrst The unified restart file contains time stepped values, like pressure or oil saturation.
- Xnnn These individual restart files contain each time step in a separate file.

You need to specify only the grid file name. Tecplot RS will find the additional files automatically, as long as the root names (base names) match that of the grid file.

If both unified and non-unified restart files are available, Tecplot RS will use the unified file.

K - 2.2 VIP Data Files

In VIP files, the grid and solution data are both stored in files with a .map extension. The file names are generally selected to differentiate the "init" data (containing the grid geometry and other static properties) and "recurrent" data (containing the time-dependent values). Choose the init data in the Grid field and the recurrent file in the Solution Data list.
K - 2.3  **Streamline Files**
Streamline data can be loaded and displayed in 3D Grid plot views. Tecplot RS 2019 R1 supports the newer Frontsim data formats (.slspsc extension).

K - 2.4  **Survey Well Files**
The survey well files are in an ASCII format. The data may be comma or space delimited. The file contains a list of nodes that define well geometries. Each line contains a single node in the format:

coordinate values for the well nodes are arranged as follows:

```
WellName X Y Z
```

where the name of the well must begin each line.

For example:

```
survey_well1 1.40041E6 483051 7890.51
survey_well1 1.40041E6 483051 7935.38
survey_well1 1.40041E6 483051 8027.42
survey_well1 1.40041E6 483051 8153.24
survey_well2 1.40303E6 464384 7957.48
survey_well2 1.39311E6 474952 8166.88
```

Blank lines and comments (lines beginning with #) are ignored. Additional values after the first three are also ignored.

The data shown above represents two survey wells that can be displayed in grid plots. These can be shown in addition to the wells included in the simulator output.

Survey wells are loaded along with your grid data, either at the same time or in a later step. There is a separate field at the bottom of the Load Grid Data dialog for selecting the survey wells file.

If your survey wells are in a coordinate system different from the grid's, you may be able to transform the grid coordinates to match using the Scale page of the Grid Options dialog. The option “Apply to survey wells” controls whether transformations are applied to both the grid and the survey wells, or only to the grid.

K - 2.5  **VDB Folder**
A data set stored as a VDB (Virtual Database) typically uses a .vdb extension in the VDB folder name. Tecplot RS will read the static and transient grid solution data of a VDB.

K - 2.6  **Sensor Map Files**
All the data to display a grid in the Sensor Map format are stored in a file with a .*71 extension.

K - 2.7  **CMG Files**
CMG data are saved in multiple files with extensions such as .mrf and .dat. You need all of the files to work with the simulation. When opening CMG data in Tecplot RS, however, you should select the .irf, .mrf, or .sr3 file. This file contains a map that indicates where to find each piece of data needed.

K - 2.8  **UTCHEM Grid Files**
Tecplot RS currently supports UTCHEM versions 9.3 and 9.95. Since UTCHEM files do not specify a start date, the start date is set to January 1, 2000 when the file is loaded into Tecplot RS.

Well names are loaded from the *.ECHO files, but these record only the first eight characters of the full well names provided in the INPUT file. To make sure the well names are unique, a number is prepended to the well name when displayed in Tecplot RS.
Not all grid formats are supported. The ICOORD option in the INPUT file must be either 1 (Cartesian) or 4 (Curvilinear). Transient data will not be loaded if the grid is one-dimensional (that is, when two of the three IJK dimensions are 1, resulting in a single row or column or cells).

rspreprocess.exe cannot currently process UTCHEM files.

K - 3 Files Created by Tecplot RS

Refer to the following table to determine each type of file which Tecplot RS creates.

<table>
<thead>
<tr>
<th>File Name Extension</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>.rsstyx, .rssty</td>
<td>Style file. Holds all selections in Plot Options, plus other style settings. Pre-2009 R2 versions used extension .sty.</td>
</tr>
<tr>
<td>.rsgsx, .rsgs</td>
<td>State File for Grid data.</td>
</tr>
<tr>
<td>.rsrpl, .rsrpl</td>
<td>Paper Layout Template. Saves options for header/footer frames plus static and dynamic text.</td>
</tr>
<tr>
<td>.rsprj</td>
<td>Project file. An XML file that allows you to load multiple data and style files simultaneously.</td>
</tr>
<tr>
<td>.rsrst</td>
<td>Indexing file for grid Restart files.</td>
</tr>
<tr>
<td>.rsmt</td>
<td>Indexing file for grid Init files.</td>
</tr>
<tr>
<td>.rsgrid</td>
<td>RS optimized version of grid geometry (for active cells).</td>
</tr>
<tr>
<td>.rsgridi</td>
<td>RS optimized version of grid geometry (for inactive cells).</td>
</tr>
<tr>
<td>.rspts</td>
<td>If a grid contains coarsened cells, this file will accompany the .rsgrid file.</td>
</tr>
<tr>
<td>.rsxell</td>
<td>Calculated cell intersection data for wells.</td>
</tr>
<tr>
<td>.rsnc</td>
<td>Stores NNC data.</td>
</tr>
<tr>
<td>.rsvgml</td>
<td>Template file.</td>
</tr>
<tr>
<td>.rsx, .rss</td>
<td>Selection set definitions (see 7 - 2 “Selection Sets”).</td>
</tr>
<tr>
<td>.rsxss, .rsxs</td>
<td>Holds XY Custom definitions.</td>
</tr>
<tr>
<td>.rsxss, .rsxs</td>
<td>State file for XY data.</td>
</tr>
<tr>
<td>.eqn</td>
<td>Exported equation file.</td>
</tr>
<tr>
<td>.txt</td>
<td>Simulator Input or Extracted well cell file.</td>
</tr>
</tbody>
</table>

For types of files listed above with more than one extension, the first (ending with the letter x) is the XML-based file used by current versions of Tecplot RS. These files are text-based and so may be easily viewed or edited. The second extension indicates a binary format used by older versions of Tecplot RS. Current versions of Tecplot RS can read these files, but the file will be written in the XML format.

K - 3.1 State Files

State files are small files that save some of the last used settings associated with a particular data set. Their purpose is to return those settings to the same state the next time that file is used. State files have the same root name as the data file to which they refer. Grid state files are XML files and use an extension of .rsgsx, while state files for XY data use .rsxsx.

You are not given any choice about whether to save a state file, nor is there an option to name it. If you delete a state file, no harm is done other than the loss of the remembered settings. You may, however, direct where state files are saved. Tecplot RS attempts to save state files in the following locations, in order:

1. The folder defined by the RS_USER environment variable, if defined
2. The current working folder (Windows platforms) or Home directory (Linux platforms)
3. The designated Temp folder

State files are not necessarily saved with the data file to which they are attached. This means that you do not need to have write permissions to the folder containing the original data file. It also means that state
files are not only specific to a data file, they may also be associated with a particular user (when the RS_USER environment variable is set). Grid state files contain:

- Grid transformation options (accessible in the Grid Options dialog)
- Wells selected for display
- Wells selected for well blanking (Inside Views)
- IJK blanking selections
- IJK slicing selections
- Arbitrary slice definitions

XY state files record:

- Entity type filter setting
- Variables and axis assignments for XY Variables plot
- Variable assignments for XY Entities plot
- Variables and current entity for XY Subsets plot
- Variable assignments for bubble plots.

Note that state files do not include every possible setting and/or selection used to create a plot.

**K - 3.2 Style Files**

Style Files save the customizable settings that determine how your plot appears on the screen or paper. These are not associated with any data file or project, and thus are not loaded automatically, but rather may be reused as needed as part of your workflow:

- Paper Layout (.rslayx): A paper template that includes headers and/or footers (usually used for title blocks), placement and styles for plot labels, titles, and legends, background colors, paper size and orientation, and more.
- Plot Options (.rsstyx): Colors, patterns, and symbols for line plots, options for legends, settings for contour style, labeling options, styles used for displaying wells and bubbles, scaling values, etc.
- Custom Options (.rscsx): Defines a multi-frame view of a single entity (well) with the variable(s) shown in each frame. Used in XY Custom and XY Custom Entities plot types.

Any number of style files may be created and named as desired. The dialogs or sidebar that allow you to customize these files also include controls for loading and saving the files.

It is not generally necessary to load or save style files individually. These styles are embedded in the project file when it is saved. Saving them separately makes it easy to share styles among projects, but you can also read them directly from a project file.

**K - 3.3 Template Files**

Template files (.rstmpl) allow the user to define standard plots, generally a layout consisting of one or more frames where the contents of each frame are defined. Templates are independent of the data; you can define a template for a particular standard plot and use it with several different data sets. Once you have defined your templates, you can open a new data file and apply the templates to quickly create the desired plot for the new data.

Templates can include variable names that may not exist in the data file being used. However, in these cases the program makes some default substitutions, and the user can easily substitute the correct variable if needed.
RSGRID File Format

Template files essentially define the sidebar state. They select the plot type, the variable selections, and toggles for layers and certain other items. The exact list of what is saved depends on the plot type. They also include the paper layout and multi-frame settings.

When you apply a template, it chooses the plot type and selects the options needed to produce a certain type of plot, but without loading any data. You could record a macro that does the same thing that templates do. It is much easier, however, to save a template than it is to record the equivalent macro, and templates have an advantage of not causing an error if, for example, the desired variable doesn’t exist.

Templates files are in XML format. The current template (view) is automatically embedded in a project file in order to bring the program back to the most recently used view. The primary access to templates is via the Templates menu, where you can choose the folder that contains the templates you wish to use. The templates in this folder then appear on the template menu and can easily be applied to any project.

K - 3.4 Project Files

Project Files (.rsprj) shorten the number of steps needed to load all the different files (both data and style) that are needed when working on a particular project. Project files record:

- The names of all loaded data files, including which ones are selected as the active data set.
- Embedded versions of the Paper Layout, Plot Options, and Custom Options files
- All defined selection sets
- Grid and XY equations
- Display options (e.g. show wells, 2D view type)
- Multi-frame options (how many frames, linking options)
- XY Freestyle plots
- Selected comparison data sets and comparison options
- Template folder and 10 most recently used templates in this project
- The last plot type view (essentially a template)

Note that a project file does not repeat the information in the state file. However, since the project includes the names of individual data files, as each one is loaded, Tecplot RS also retrieves the information from the associated state file if it exists.

The style data (paper layout, plot options, and custom options) are embedded in a project file. However, after loading a project file, you can switch to another style file simply by loading it. In fact, since the style data that are embedded within a project file are in the same format as in a style file, when loading a style file you can choose style file or a project file.

K - 3.5 Well Files

Tecplot RS creates a WELLNUM variable in each cell in a grid that identifies cells that contain completions or are penetrated by a wellbore. This variable is visible when probing and is also used when activating the Well Blanking option for Inside Views in a 3D grid.

The process of computing intersected cells between completions can be a lengthy one, so Tecplot RS creates an auxiliary .rswells file to store it so it does not need to be computed each time a grid is loaded.

K - 4 RSGRID File Format

The .rsgrid file speeds up grid loading. It contains the same grid geometry as the original input file, but with all post-processing completed. Post-processing includes corner smoothing, removal of inactive cells, node sharing, and face neighbor calculation. The file format is used for both .rsgrid and .rsgridi files.

There are several ways to create the .rsgrid file. When you first load a grid file in Tecplot RS, Tecplot RS creates the file automatically. It is generally rebuilt only when the original grid file is updated or when you
Tecplot RS Files

change the grid loading options. It may also be updated when an updated version of Tecplot RS requires a change in the file format.

Tecplot RS also provides a utility called RSPreprocess. This creates the .rsgrid file outside the program environment, and is designed for use as a post-processing step after a simulator run. We also make the RSGRID file format public, giving you the option to modify the simulator to output the RSGrid file directly.

The format of this binary file is shown following.

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Data type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Version ID. Currently 2741. ID number will change if format changes.</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>File type ID from which RSGRID was originally created. 1=Eclipse, 2=VIP, 4=VDB, 5=Sensor, 6=CMG</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Corner optimization option used when rsgrid file was solved. 1 = no optimization, 2 = shift method, 3 = average method.</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Radial flag. 0 if Cartesian, 1 if radial.</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Dual-porosity flag. 0 if single grid, 1 if dual-porosity grid.</td>
</tr>
<tr>
<td>1</td>
<td>char[64]</td>
<td>Variable used to flag inactive cells (used only for VIP grids, but must be present in all files).</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Inactive cell operator: 1 = Equal to (* not recommended for use), 2 = Less than, 3 = Greater than</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Inactive cell comparison value</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
<td>Total number of grids (global grid plus all LGRs).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FOR EACH GRID</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>char[16]</td>
</tr>
<tr>
<td>1</td>
<td>char[16]</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
</tr>
<tr>
<td>1</td>
<td>4 byte integer</td>
</tr>
<tr>
<td>3</td>
<td>4 byte integer</td>
</tr>
</tbody>
</table>

NUMNODES * 3
### RSGRID File Format

<table>
<thead>
<tr>
<th>NUMBRICKS * 13</th>
<th>4 byte integers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items 1-3: Brick I, J, and K</td>
<td></td>
</tr>
<tr>
<td>Items 4-11: Connectivity list of 8 node numbers (1-based) which form the brick. See the following diagram.</td>
<td></td>
</tr>
<tr>
<td>Item 12: Brick status</td>
<td></td>
</tr>
<tr>
<td>0 = inactive</td>
<td></td>
</tr>
<tr>
<td>1 = active in matrix grid</td>
<td></td>
</tr>
<tr>
<td>2 = active in fracture grid</td>
<td></td>
</tr>
<tr>
<td>3 = active in both matrix and fracture</td>
<td></td>
</tr>
<tr>
<td>Item 13: Face neighbor flag</td>
<td></td>
</tr>
<tr>
<td>Each of the first 6 bits determines whether the face is shared by the adjacent (logical IJK) cell. A face is shared if all four nodes are shared.</td>
<td></td>
</tr>
</tbody>
</table>

/* node and face ordering
*

```
(\text{Max}, \text{Max}, \text{Max})
```

```
\text{n8} \ldots \text{n7}
```

```
\text{n6} \ldots \text{n5}
```

```
\text{f1} \ldots \text{f2}
```

```
\text{n4} \ldots \text{n3}
```

```
\text{n2}
```

*/

### NOTES

The efficiency of the RSGRID comes from the fact that shared nodes are not repeated. In other words, two adjacent bricks that share a common corner will point to the same node number.

The RSGRID file contains only active bricks, so the total number of bricks (NUMBRICKS) and the number of active bricks should be the same. (This duplication is a function of backward compatibility with earlier versions of the file). This value should correspond to the NACTIV value in the Eclipse Restart file.
Index

Numerics
2D Grid plots 155–157
2D plan in 3D 183
3D Grid plots 158–160
3D View Details 160
3D Views 400, 403
style 403
XML well allocation files 429
-999999 59
A
Active Data Set 60, 114, 228
Active Toggle 390
add streamtrace 34
adjust plot toolbar buttons 32
adjust view toolbar buttons 30
adjustor tool toolbar button 32
Aliases 391
Aliasing Variables 355
align start time 61
analyze data buttons toolbar 33
ANIMATE 281
Animate
advanced techniques 384
movie file 384–385
ANDDATE SETUP 281
Animation
controls 27
export 380
macro commands 281–283
speed (delay) 389
time options 161
Anti-aliasing 381
Antialiasing 384
Arbitrary slice 185
ARBSLICES ‘301
ASCII files 429
generic 430
log 429
Basic-Export 390
auxiliary data information 43
AVI files 375
Axes
style 395
Axis style
Style
axes 463
Axis
grids and marks 396
labels 396
orientation, 2D 157
orientation, 3D 164
range 396, 403
Axis scale 396
Axis variables
completion profiles 90
custom xy plots 81
RFT plots 87
xy entity plots 66
xy subset plots 68
xy variable plots 64
B
Batch processing 265–266
blank cells toolbar button 34
BLANKING 295
Blanking
cell blanking 221
IBK blanking 187
multi-frame plots, in 222
pick blanking 222
value 221
value blanking 221
well blanking 187
Branches 99–103
creation 102
overview 100
preparation 101
Bubble plots 177–179
C
Calculate
boundary values 349
elements 351
integrals 220
calculate 35
calculate PTIME 61
Cell blanking 221
Cell labels 176, 404
cells
blanking, 34
Cells, extract 244
Character
custom 334
CHEARS .csv files 429, 432
CHEARS history files 429
CLEARALLSLICES 302
ONSETUP 283
Color
select color 50
Color Tables 382
Command line options 413–416
Compare Data Sets dialog 125
COMPARE SETUP 314
Comparison data 125
Comparison plots 123
Completion Profiles 89–90
axis variables 90
COMPLETION SETUP 315
Composition plot data 429
Configuration files, customize 330
Contour
iso-surface 188
labels 399
plots styles 399
create project 29
cross plot
toolbar button 34
Cross Plots 235
CSV files 429, 432
Custom XY plots 79–82
axis variables 81
custom file 82
Customization 387–406
grid plots 397, 401
style set 392
styles
settings 396
wells 404
labels 405
symbol offset 405
symbols 405
XY 392
Customize 325–336
character definition 334
configuration files 330
interface configuration 333
plot rendering 325–330
symbol definition 334
D
Dashboard 22
Data
batch processing 265–266
macros 267–272
probing 195–203
spreadsheet 109, 217
viewing XY data 109–110
Write data as formatted text 60
data
analyze with toolbar 33
queries 36
Data Export 239, 250
Data Files 429
3DSL Well Allocation 429
ASCII 429, 430
CHEARS csv 429, 432
CHEARS history 429
composition plot data 429
custom file 82
Eclipse 437
Eclipse RFT 429
Eclipse UNSMRY 429
Eclipse USER 429
equations, xy 106
flow table 91
Frontsim Well Allocation 429
generic ASCII 430
grid files 437
index file 152
intersect 429
loading
flow tables 91
grid files 131–153
RFT files 83
xy files 53
Log ASCII 429
macro commands 283–294
order, comparison 117
project files 253–255
reloading 56
RFT files 83
appending 56
RS Well Allocation 429
RSCGrid 135
streamline files 438
templates 257–259
VIP 429
compositional plot data 429
pH 429
VIP files 429, 437
VIP/StreamCalc Well Allocation 429
Well allocation factors 432
XY data files 429
XYmulti 437
Data Format dialog 109, 218
Data Integration 237
Data loading
load xy data by folder 54
data probing
variables 202
data set info 40
auxiliary data 43
zone/variable info page 40
Data Sets
active 114, 228
comparison
grid files 227–232
history match 395
select data sets 116, 230
style sets 121, 392
within frame 115, 227
xy files 113–121
unloading 148
Date
display 388
Default Styles
variables 391
Delta
grid plots 163, 231
XY plots 119
delta grid files 231–232
Depth 183
Deviation band 126
Deviation data plot 124
Deviation distribution plot 124
Dialog
data format 109, 218
data spreadsheet 109, 217
export 375–380
group details 370
images 371
Macro Recorder 267
macro variables 274
performance 325–330
probe at 195–203
select color 50
streamtrace 206–216
streamtrace details 205–216
text details 361
write data file options 382
dialog
light source 170
Display
date 388
time 388
Displaying inactive cells 132
INDEX

GRIDOPTIONS 297
GRIDTRANSFORM 298

H
help using Tecplot RS 36 34
histogram tool bar button 34
Histogram 233
History 393
History data 125
History files 429
History match 393
History matching 123–126
calculations 126
calculations comparison data 125
history data 125
Hot Keys, see Keyboard shortcuts

I
IJK blanking 187
IJK slice 184
IJKBLANKING 302
IJKSLEICES 302
Image
adding an image 371
exporting 375
supersampling 384
Inactive cell 287
Inactive cell styles 399
Inactive cells
Loading 132
Inactive Cells Display 172
Inactive grid styles 399
Index file 153
insert text tool 33
Inside Views 183–188
arbitrary slice 185
custom slice 185
faults 188
grids 188
IJK blanking 187
IJK slice 184
iso-surface 188
LGRs 188
local grid refinements 188
NNCs 190
non-neighbor connections 190
streamlines 191
well blanking 187
INSIDEDEFAULTS 303
INSIDEIGORS 303
integrate 34
Integration 237
integration toolbar button 34
interface
frames 25
menu bar 25
plot area 25
sidebar 26
buttons 28
toolbar 28
Intersect 429
iso-surface 188

J
JPEG export 377

K
K Avg 225
K Sum 224
Keyboard shortcuts 409–412
Labels
axis 396
cell labels 176
contour 399, 402
depth (rt plots) 90
K-plane 90
well 405
Layer
lighting 170
Layout, paper 357–360
Left-handed System 164
Legend
grid 401
Legends
NNCs 174, 191
LGRs 157, 188
Light source 170
toolbar 31
Lighting layer 170
Line
xy style 392
Load Data
Grid data 131–153
VDB folder 57
XY data by folder 54
load data
toolbar buttons 29
Load Grid Data 131–153
Eclipse/Chears data 132
Sensor data 138
VDB folder 137
VIP Map data 134
load grid data
toolbar button 29
Load XY Data 53
load XY data
toolbar button 29
Load XY Data by folder 54
LOADCUSTOMPLOT 285
LOADFLOWTABLE 285
LOADGRIDDATA 285
LOADGRIDDELTA 286
LOADGRIDDEFAULTS 287
LOADGRIDNNCS 287
LOADGRIDSMOOTHING 287
LOADGRIDTRANSFORM 286
Loading inactive cells 132
LOADPAPERLAYOUT 288
LOADPLOTSTYLE 288
LOADXYZDATA 288
local grid refinements 188
Local Grid Refinements (LGR) 157

ISOSURFACES 303
Log ASCII 429
Log Scale 397
Long, variable names 401

M
Macro 267–272, 350, 384
create a macro 267
debug 273
equations 350
extended learning 271
macro structure 271
play a macro 35, 269
Recorder dialog 267
toolbar button 35
variables dialog 274
write a macro 270

 Macros 281–323
animation macros 281–283
command summary 281–323
file loading 283–294
grid plot commands 295–304
multi-frame commands 305
paper layout commands 305
performance commands 306
plot option commands 306–312
record 82
selection sets commands 312–313
standard options 323
user group, using with 102
well pattern, using with 102

MKEUSERGROUPS 313
MAKEWELLPATTERNS 314
Manage Data
Grid data 131–153
XY data 35
manage frames
toolbar 33
Manage XY Data 59
Markers
axis 396
Master Variable List 390
measure distance 33, 193
Menu
spreadsheet 109, 217
move plot tool 30
multi frame mode 46
multi-edit 394
multi-frame options
toolbar button 33
Multi-frame plots 168
macro commands 305
paper layout 358, 360
Quick 3D 136
value blanking 222
MULTIFRAMEOPTIONS 305
Multi-page Output 380
Multiple Color Tables 382

N
new project
toolbar button 29
NNOPTIONS 300
NNCs 173–174, 190–191
display 173
grid optimization 136
log ord 174, 191

O
Objects, derived streamtraces 205–216
Oil 429
Oil/Water/Gas display 162
Online variable 59
open project 29
Orientation
2D Grid 157
grid 164
paper 358
Output
export 373–384
antialiasing 384
EPS 376
JPEG 377
PNG 378
TIFF 379
WMF 380
OWG Display 162

P
Page Number 366
Paper Layout 357–360
animation options 382
footer 358
frame style 359
header 358
macro commands 305
multi-Frame 360
page number 366
saving 359
Paper layout
paper orientation 358
paper layout update 33
PAPERLAYOUT 305
Percentages, show 90
Performance dialog 325–330
periodic production rates 110
PERIODICPRODUCTIONRATES 289
perspective 160
Pick blanking 222
pie charts 177–179
play a macro 35
Plot
color 50
customize 325–336
export 373–384
antialiasing 384
EPS 376
JPEG 377
PNG 378
TIFF 379
WMF 380
eye coordinate system 214
geometries 367–368
SELECTIONSET_SAVE 312
selector tool toolbar button 32
Sensor Data well production data 429
Sensor data loading 138
SETACTIVEGRID 291
SETACTIVEVALUEDATASET 291
SETADEFALUTCUSTOMOPTIONS 291
SETADEFALUTPAPERLAYOUT 292
SETADEFALUTPLOTOPTIONS 292
Settings style 387–406
Shortcut, see Keyboard shortcuts
Show Percentages 90
Shut-down switch 126
Sidebar 26
animation controls 27
buttons 28
scrolling controls 27
Simulation Input 239–243
single frame mode 46
Slices arbitrary 185
custom 185
IJK 184
Solution Data display inactive cells 172
solve PTIME 61
SOLVEPTIME 317
Sort Toggle 390
STANDARDPTIONS 292
status line 35
STREAMLINESOPTIONS 317
Streamlines 191
data files 438
Streamribbon 207
Streamrod 207
Streamtrace 205–216
customize lines 209
details dialog 205–216
integrate 215
position 207
rod/ribbon 210
termination line 213
timing 210
streamtrace add 34
streamtrace tool toolbar button 34
Style
3D Views 403
axes 395
grid axes 403
grid legend 401
variables 390
XY Line 392
Style Files 387
Style sets 121, 392
Styles 387–406
contour plot 399
grid plots 397, 401
wells 404
labels 405
symbol offset 405
symbols 405
Supersampling 384
Survey well 133, 134, 138, 139, 140, 141, 144
file format 438
trajectory 248
SWAPGRIDFILE 293
SWAPPFILE 293
Symbol custom 334
T TDATE 434
TEMPLATEFOLDER 323
Templates 237–259
see Paper Layout
Termination line 213
Ternary Displays 162
text 360–367
details dialog 361
insert 33
options 361
TIFF export 379
time alignment 61
time options 161
time variable 388
time/date 181
Timestep 161
Tolerances 136
toolbar 28, 29
adjust plot buttons 32
adjust view buttons 30
adjustor 32
analyze data buttons 33
autotrace 35
blank cells 34
cross plot 34
custom 33
create cross plot 34
customize lines 209
details dialog 205–216
draw 31
equations 35
integrate 34
light source 31
load data 29
load grid data 29
load XY data 29
manage data 29
manage multiple frames 33
open project 29
plot options 33
probe 33
redraw 31
reset view 32
rotate (roller ball) 31
rotate about Z axis 31
save project 30
selector 32
streamtrace 34
translate (move) 30
translate tool 30
Translucency

451
INDEX

linking between frames 46
style options 400, 404
U
Undefined values 59
UNLOADFLOATABLE 293
UNLOADGRIDFILE 293
UNLOADDATASET 294
UNSMRY 429
update paper layout
toolbar button 33
Update Styles 406
UPDATEOPTIONS 312
UPDATESTREAMLINES 318
UPDATESTYLES 318
USER files 429
User Groups 99–103
creation 102
macros, using with 102
overview 100
preparation 100
Utility Programs 425–427
cell extraction 244
property modifier 239–243
resets.exe 423
rspreprocess.exe 425
V
Value Blanking 221
multi-frame plots 222
Values
undefined 59
Variable
independent display 172
Variable alias 117, 231
Variables
aliases 117, 231, 391
data integration 237
default styles 391
display inactive cells 172
integration 237
long names 401
multi-frame views 168
online 59
rs variables 353–356
saturation 132
sort and active toggles 390
style options 390
time 388
VDB data 428
VDB folder 57, 137
View 385
3D 400, 403
light source 31
movie file 385
redraw all frames 31
reset 32
rotate (roller ball) 31
rotate about Z axis 31
translate 30
Views, inside
See Inside Views
VIP 429
VIP data 437
inactive cell 287
VIP obs files 429
VIP plt files 429
VIPStreamCalc well allocation files 429
Virtual database 429
W
WAF files 432
CHILD 435
INJECTOR 435
PRODUCER 435
RSVERSION 434
sample data 435
STARTDATE 434
TIMESTEP 435
UNITS 434
VARIABLES 434
Welcome Screen 22
Well allocation
3DML file format 429
Frontsim file format 429
RS file format 429
VIP/StreamCalc file format 429
Well Allocation Factor data files 432
Well blanking 187
Well editor 248
Well Patterns 99–103
creation 102
macros, using with 102
overview 100
preparation 101
well production data 429
Well, survey 133, 134, 138, 140, 141, 144
file format 438
trajectory 248
WELLBLANKING 304
WELLOPTIONS 301
Wells 175
blanking 187
grid plots, in 175
labels 405
plot options 405
save 244
style options 404
labels 405
symbol offset 405
symbols 405
symbols 405
WMF export 380
workspace
basic operations 36
basic plot editing 35
status line 35
Write Data as Formatted Text 60
Write Data File Options dialog 382
X
X Variable 125
XY Axes
grid thickening 165
style 395
Z-Axis thickening 165
XY comparison 115–121
XY Custom Entities Plots 80
XY Custom Plots 79
XY Data 53, 429
manage 59
VDB Folder 57
XY multi 437
XY data
load by folder 54
XY Entity Plots 65-66
axis variables 66
XY Equations 105-107
Applying 106
saving and loading 106
XY Freestyle Plots 69-78
data comparison 122
dynamic text 367
paper layout 367
XY Line
multi-edit 394
style options 392
XY Plots 53-121
customization 392
History matching 123-126
macro commands 514-522
RFT plots 85-89
style settings 392
undefined values 59
XY Custom Entities Plots 80
XY Custom Plots 79
XY Entity Plots 65-66
XY Freestyle 69-78
XY Subset Plots 67-68
XX Variable 63-64
XY Subset Plots 67-68
axis variables 68
XY Variable Plots 63-64
axis variables 64
XYANIMATE 282
XYANIMATESETUP 292
XYCUSTOMSETUP 318
XY_DISPLAYNAME 319
XYDISPLAYNAME 319
XYEQUATIONS 319
XYFILTERING 320
XYFILTERSETUP 320
XYmulti Files 437
XYSORTING 321
XYSUBSETSETUP 321
XYVARIABLESSETUP 321
XYZSLICES 304

Y
Y Variable 126

Z
Z-Axis Thickening 165
zone/variable information 40
zoom 30

453